COPYRIGHT

Copyright © 1998, 2010, Oracle and/or its affiliates. All rights reserved.

Part No. E17380-01

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners.

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

If this software or related documentation is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS

Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject to the restrictions and license terms set forth in the applicable Government contract, and, to the extent applicable by the terms of the Government contract, the additional rights set forth in FAR 52.227-19, Commercial Computer Software License (December 2007). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

This software is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications which may create a risk of personal injury. If you use this software in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of this software. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software in dangerous applications.

This software and documentation may provide access to or information on content, products and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third party content, products and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third party content, products or services.
ABOUT THE DOCUMENTATION

Documentation consists of the following manuals and help systems. These manuals are delivered as PDF files that are stored in the documentation\language code\reference folder where the Developer is installed.

- **Installation & Administration**: provides instructions for installing the Developer in a single-user or multi-user environment as well as information on how to add and manage users and content in a multi-user installation. An Administration help system also appears in the Developer for authors configured as administrators. This manual also provides instructions for installing and configuring Usage Tracking.

- **Content Development**: provides information on how to create, maintain, and publish content using the Developer. The content of this manual also appears in the Developer help system.

- **Content Deployment**: provides information on how to deploy content to your audience.

- **Content Player**: provides instructions on how to view content using the Player. The content of this manual also appears in the Player help system.

- **Usage Tracking Administration & Reporting**: provides instructions on how to manage users and usage tracking reports.

- **In-Application Support Guide**: provides information on how implement content-sensitive, in-application support for enterprise applications using Player content.

- **Upgrade**: provides information on how to upgrade from a previous version to the current version.
## CONTENTS

1. **Get Started** ................................................................. 1-1
   - Review the Developer Interface .............................................. 1-1
   - Start the Developer .............................................................. 1-2
   - Create and Manage Content Profiles ......................................... 1-3
   - Configure Toolbars .............................................................. 1-5
   - Split the Work Area ............................................................. 1-6
   - Configure Toolpanes ............................................................ 1-7
   - Restore Default Toolbars and Toolpanes .................................. 1-10
   - Understand the Developer Basics ............................................. 1-10
   - Open and Close the Library .................................................... 1-11
   - Use Folders and Documents .................................................... 1-11
   - Understand the Developer Document Types ............................. 1-12
   - Work with Document Editors .................................................. 1-13
   - Link Related Documents ....................................................... 1-15
   - Reuse Documents ............................................................... 1-16
   - Document Properties .......................................................... 1-16
   - Undo/Redo Actions ............................................................. 1-17
   - Set Developer Defaults ......................................................... 1-17
     - General Developer Settings ................................................ 1-18
     - Library Settings ............................................................... 1-18
     - Content Defaults ............................................................. 1-20
     - Documents Defaults ......................................................... 1-24
     - Player Defaults ............................................................... 1-27
     - Preview Defaults ............................................................. 1-29
     - Recorder Defaults ........................................................... 1-29
     - Spelling Defaults ............................................................. 1-31
     - Target Applications .......................................................... 1-31
   - Convert Content from a Previous Version ............................... 1-33

2. **Use the Developer in a Multi-user Environment** ................. 2-1
   - Create and Manage Login Profiles .......................................... 2-1
     - Add a Login Profile .......................................................... 2-1
     - Edit a Login Profile .......................................................... 2-3
     - Delete a Login Profile ....................................................... 2-3
     - Switch the Library Login .................................................... 2-4
     - Change Password ............................................................ 2-4
   - Work Online or Offline ....................................................... 2-4
     - Switch Between Online and Offline Operation ........................ 2-6
   - Get Documents for Offline Use .............................................. 2-6
   - Check In and Check Out Documents ......................................... 2-7
     - Check In/Out Indicators ..................................................... 2-8
     - Check in a Document ......................................................... 2-9
     - Check out a Document ..................................................... 2-10
     - Cancel Check out ............................................................. 2-11
     - Open a Checked-in Document .............................................. 2-12
   - Version a Document .......................................................... 2-12
     - View Document History ..................................................... 2-12
     - Roll Back a Document ....................................................... 2-13
   - Refresh the Library and Outline Editor .................................... 2-14
   - Manage Folder Conflicts ..................................................... 2-14
   - Delete and Restore Documents ............................................... 2-16
     - Delete Documents while Online or Offline ............................ 2-16
View Deleted Documents .............................................................. 2-17
Restore a Deleted Document ...................................................... 2-17
Managing Workflow .................................................................... 2-18
Assign Content State ................................................................. 2-19
Assign Document Ownership ....................................................... 2-20
Use and Share Custom Views ........................................................ 2-21
About the Sample Custom Views .................................................. 2-21
Share a Custom View .................................................................. 2-22
Understand Content Permissions ................................................... 2-22

3. Manage the Library .................................................................. 3-1
   Library Design Considerations ................................................... 3-1
   Work with Folders ..................................................................... 3-2
      Create a New Folder ............................................................... 3-2
      Reserved Characters ............................................................. 3-3
      Rename a Folder .................................................................... 3-3
      Move a Folder ....................................................................... 3-4
      Copy a Folder ....................................................................... 3-5
      Delete a Folder ..................................................................... 3-7
      Expand and Collapse Folders .................................................. 3-7
      Print Library Folder Contents ............................................... 3-8
   Work with Documents ................................................................ 3-9
      Create a New Document .......................................................... 3-9
      Save a Document .................................................................... 3-12
      Open a Document from the Library ............................................ 3-14
      Close a Document ................................................................... 3-15
      Delete a Document and Related Documents .............................. 3-15
      Rename a Document ............................................................... 3-17
      Move a Document (Library) ...................................................... 3-17
      Copy Documents in the Library ................................................ 3-18
      Copy and Paste (Library) ........................................................ 3-19
      Copy and Paste Special (Library) .............................................. 3-20
   View Folder Content .................................................................. 3-22
      Sort Documents ....................................................................... 3-23
      Rearrange Columns ............................................................... 3-23
      Add and Remove Columns ...................................................... 3-24
      Size Columns ......................................................................... 3-25
   Create a Custom View ................................................................ 3-26
      Add a New View ..................................................................... 3-26
      Configure View Columns ....................................................... 3-27
      Configure View Sort Order ...................................................... 3-27
      Configure View Filter .............................................................. 3-28
      Edit an Existing View .............................................................. 3-32
      Copy a View .......................................................................... 3-32
      Delete a View ........................................................................ 3-33
      Reset Defaults for Views ......................................................... 3-33
   Understand the System Folder .................................................... 3-33
      Attachment Icons .................................................................... 3-34
      Publishing Styles ..................................................................... 3-34
      Roles ...................................................................................... 3-34
      Templates ............................................................................... 3-35
      Supported Languages ............................................................. 3-35
      Update the Library (Service Packs) .......................................... 3-35
      Back up Content ...................................................................... 3-36
      Restore a Database ................................................................. 3-37

4. Build an Outline ....................................................................... 4-1
   Navigate the Outline Editor .......................................................... 4-1
Open a Document from the Outline Editor .........................................4-2
Change the Outline Editor View .......................................................4-3
Develop an Outline........................................................................... 4-3
Link a New Module......................................................................... 4-4
Link a New Section......................................................................... 4-5
Link a New Topic........................................................................... 4-6
Link an Existing Document.............................................................. 4-7
Delete a Document Link ................................................................. 4-8
Rename a Document...................................................................... 4-9
Move a Document (Outline Editor) ................................................. 4-10
Copy and Paste a Document (Outline Editor) ...................................4-12
Print an Outline........................................................................... 4-14
Use Content Tools ....................................................................... 4-15

5. Record Topic Content .................................................................. 5-1
   Recorder Logic..................................................................................5-1
   Context Recognition in the Recorder ....................................................5-2
   Start the Recorder............................................................................. 5-3
   Record Topic Steps............................................................................ 5-4
   Record Different Action Types .............................................................5-4
   Record a Paste Topic ......................................................................... 5-4
   Undo ............................................................................................... 5-5

6. Use the Topic Editor...................................................................... 6-1
   Navigate Frames............................................................................... 6-1
   Save a Topic .................................................................................... 6-2
   Undo and Redo in the Topic Editor .......................................................6-3
   Manipulate Frames ............................................................................6-3
   Insert a Missing Frame or Frames ....................................................6-3
   Re-Record a Topic ........................................................................... 6-4
   Insert an Explanation Frame .............................................................6-5
   Insert a No-Context Frame ..............................................................6-6
   Copy a Frame or Frames ................................................................ 6-7
   Select Multiple Frames ...................................................................6-7
   Copy Paths ...................................................................................6-8
   Copy Decision Frames and Paths..................................................... 6-8
   Delete a Frame ............................................................................. 6-9
   Recapture a Screenshot .................................................................. 6-9
   Recapture an Action..................................................................... 6-10
   Use Context IDs .......................................................................... 6-10
   Recapture Context ID................................................................... 6-11
   Edit a Screenshot ........................................................................ 6-12
   Change the Print Setting ............................................................... 6-12
   Change the Print Setting ............................................................... 6-12
   Use Alternative Actions and Paths...................................................... 6-12
   Insert an Alternative Action........................................................... 6-13
   Insert an Alternative Path ............................................................... 6-13
   Display Alternative Actions/Paths .................................................. 6-14
   Set the Current Action as the Default Action ....................................6-14
   Change the End Frame of an Alternative Path ..................................6-14
   Delete an Action.......................................................................... 6-15
   Delete a Path .............................................................................. 6-15
   Use Decision Frames .......................................................................6-15
   Insert a Decision Frame ................................................................ 6-16
   Record Paths in a Decision Frame ..................................................6-16
   Rename Paths in a Decision Frame ..................................................6-17
   Edit Header Text ......................................................................... 6-17
   Reposition Paths.......................................................................... 6-18
   Remove Paths.................................................................................. 6-18
Delete a Decision Frame ............................................................... 6-18
Edit Frame Properties .............................................................................. 6-18
Edit Bubble Properties ............................................................................ 6-19
Add Text to the Introduction and End Frames ..................................... 6-19
Use Bubble Templates for a Frame ......................................................... 6-19
Change the Template Text Font .............................................................. 6-20
Add Custom Bubble Text ......................................................................... 6-20
Insert Template Text as Custom Text ................................................... 6-20
Edit Custom Bubble Text ........................................................................ 6-21
Format Custom Bubble Text ..................................................................... 6-21
Specify the Playback Mode for Custom Text ........................................ 6-22
Display Template Text in Know It Mode .................................................. 6-22
Control Text for Player and Print Output ................................................ 6-23
Preview Frame Text for Playback and Print Output ............................... 6-23
Hide the Bubble .......................................................................................... 6-23
Select a Bubble Icon .................................................................................... 6-24
Change the Bubble Pointer ......................................................................... 6-25
Change the Bubble Background Color ..................................................... 6-25
Edit Action Properties .................................................................................. 6-25
Action Types ................................................................................................ 6-25
Object Type .................................................................................................. 6-26
Object Name .................................................................................................. 6-37
Ignore Context Information .......................................................................... 6-38
Create a New Action Area .......................................................................... 6-38
Use Keep with Next ..................................................................................... 6-40
Set Frame Delay ............................................................................................ 6-41
Create a Jump-in Point ................................................................................ 6-41
Keyboard Action Options ............................................................................ 6-42
String Input Formatting Options ................................................................. 6-42
Edit External Content .................................................................................. 6-46
Link an Attachment as a Concept: Topic Editor ....................................... 6-46
Link to an Attachment from a Topic Frame ............................................... 6-47

7. Enhance Content with Attachments .............................................. 7-1
Attachment Considerations ........................................................................ 7-2
Enhance Content with Packages ................................................................. 7-5
Package Considerations ............................................................................... 7-6
Create a New Package ................................................................................ 7-8
Edit a Package .............................................................................................. 7-9
Add Items to a Package ............................................................................ 7-10
Move/Copy Items in a Package .................................................................. 7-11
Rename an Item in a Package .................................................................... 7-12
Delete Items in a Package ........................................................................... 7-13
Edit Files in a Package ................................................................................ 7-14
Delete a Package.......................................................................................... 7-14
Change the Package View ............................................................................. 7-15
Package Behavior in Publishing ................................................................. 7-16
Enhance Content with Web Pages .............................................................. 7-17
Create a New Web Page .............................................................................. 7-18
Edit a Web Page ............................................................................................ 7-19
Add and Format Text ................................................................................... 7-19
Insert a Hyperlink .......................................................................................... 7-21
Edit Hyperlink Properties .......................................................................... 7-22
Remove a Hyperlink ..................................................................................... 7-23
Insert an Image .............................................................................................. 7-23
Edit Image Properties .................................................................................... 7-24
Edit an Image in a Web Page ........................................................................ 7-26
Copy and Paste Web Page Content ............................................................ 7-26
Rename a Web Page ................................................................. 7-27
Delete a Web Page ................................................................. 7-27
Web Page Behavior in Publishing .............................................. 7-28
Enhance Content with URLs .................................................... 7-29
URL Behavior in Publishing ..................................................... 7-30
Link Attachments .................................................................. 7-32
Link an Attachment as a Concept: Outline Editor .................... 7-32
Link an Attachment as a Concept: Topic Editor ....................... 7-34
Link to an Attachment from a Topic Frame ............................ 7-35
Link to an Attachment from Bubble Text ............................... 7-36
Change the Tooltip of a Frame Link ....................................... 7-38
Change the Icon of a Frame Link .......................................... 7-38
Manage Linked Attachments .................................................. 7-39
Create a Custom Icon .......................................................... 7-46

8. Enhance Content with Sound ............................................. 8-1
Sound Recording Best Practices ................................................ 8-1
Record Sound ........................................................................ 8-2
Enable Sound ......................................................................... 8-3
Configure the Recorder for Sound ........................................ 8-3
Record Sound When Recording a Topic ................................. 8-4
Use the Recorder Deskband in Automatic Record Mode ........... 8-4
Record Sound in a Topic using the Sound Editor .................... 8-5
Record Sound in a Web Page using the Sound Editor .............. 8-6
Insert Sound .......................................................................... 8-6
Import a Sound File ................................................................ 8-7
Export a Sound File .............................................................. 8-7
Edit Sound ........................................................................... 8-8
Sound Editor Toolpane .......................................................... 8-8
Cut, Copy and Paste Sound .................................................... 8-9
Delete a Sound ..................................................................... 8-10
Deselect a Sound .................................................................. 8-11
Adjust the Start and Stop Point of Sound in a Frame .............. 8-11
Crop Sound to Selection ..................................................... 8-11
Zooming to a Sound .......................................................... 8-12
Adjust Volume Controls ...................................................... 8-13
Extend Timeline ..................................................................... 8-13
Add Silence .......................................................................... 8-13
Amplify Sound ..................................................................... 8-13
Play Sound .......................................................................... 8-14
Stop Sound File Playback .................................................... 8-15

9. Manage Document Relationships ...................................... 9-1
View Related Documents ..................................................... 9-1
View and Repair Broken Links .............................................. 9-2
 Broken Links in Published Content ........................................ 9-3

10. Define Glossary Terms .................................................. 10-1
Create a Glossary ................................................................ 10-2
Edit a Glossary ................................................................. 10-2
Add a Glossary Term .......................................................... 10-3
Select a Definition Link Attachment ..................................... 10-4
Edit a Glossary Term .......................................................... 10-6
Delete a Glossary Term ....................................................... 10-6
Assign a Glossary to a Document ........................................ 10-6
Update Glossary Links ....................................................... 10-8
Delete a Glossary ................................................................. 10-10

11. Create Roles for Content Filtering .............................. 11-1
   Edit a Master Role List .................................................... 11-1
   Add a Role ........................................................................ 11-3
   Rename a Role .................................................................. 11-3
   Delete a Role ...................................................................... 11-4
   Update a Master Role List .................................................. 11-5
   Create a New Role List ..................................................... 11-5
   Assign Roles to Modules, Sections, or Topics .................... 11-7

12. View Document Properties .............................................. 12-1
   Use the Properties Toolpane ............................................. 12-1
   Change Document Properties .......................................... 12-2
      Ways to Assign Properties ............................................. 12-3
      Assign a Property to Multiple Documents ....................... 12-3
   General Properties ......................................................... 12-4
      Context Property .......................................................... 12-5
      Glossary Property ........................................................ 12-7
      Keywords Property ....................................................... 12-8
      Language Property ....................................................... 12-9
      Name Property ............................................................ 12-10
      Resolution Property ..................................................... 12-11
      Roles Property ............................................................ 12-11
      Template Property ....................................................... 12-12
   Topic Properties .............................................................. 12-13
      Know It? Options .......................................................... 12-13
      Play Modes Property ..................................................... 12-14
      Show Bubbles Property ................................................ 12-15
   Document Output Properties ............................................ 12-17
      Required fields and Output results for the Business Process Document ........................................ 12-18
      Add Document Revision Text ........................................ 12-19

13. Preview a Topic ............................................................... 13-1
   Preview Player Modes ....................................................... 13-1
      Play See It! Mode .......................................................... 13-2
      Play Try It! Mode .......................................................... 13-2
      Play Know It? Mode ..................................................... 13-3
      Play Do It! Mode .......................................................... 13-4
   Preview Documents .......................................................... 13-5
      System Process ............................................................. 13-6
      Job Aid ........................................................................ 13-6
      Training Guide ............................................................ 13-6
      Instructor Manual ......................................................... 13-6
      Test Document ............................................................. 13-6
   Preview a Presentation ........................................................ 13-6

14. Publish Content ............................................................. 14-1
   Deployment Formats ......................................................... 14-1
      Player ........................................................................... 14-1
      HTML Web Site ............................................................ 14-3
      LMS Package ............................................................... 14-4
      Standalone Topic Files .................................................. 14-5
   Document Formats ............................................................ 14-6
      Attachments in Document Formats ................................. 14-6
      Options for Document Outputs ..................................... 14-7
      System Process ............................................................ 14-8
15. Export/Import Content .......................................................... 15-1
   Export Content ........................................................................ 15-2
   Import Content ......................................................................... 15-4
   Export Sound Files in Bulk ..................................................... 15-7
   Import Sound Files in Bulk ...................................................... 15-7
   Extract a Developer Archive ................................................... 15-8
   Understand Developer Archives .............................................. 15-8
   Recompress a Developer Archive .......................................... 15-11

16. Localization Content ............................................................ 16-1
   Export Content for Localization .............................................. 16-3
   Import Localized Content ....................................................... 16-6
   Localization Using XLIFF ...................................................... 16-7
17. Customize Templates ......................................................... 17-1
   Start the Template Editor ..................................................... 17-1
   Edit the Template.xml File .................................................. 17-2
      Edit a Class ........................................................................ 17-2
      Edit an Event in a Class ..................................................... 17-3
      Add a Local Template to an Event ....................................... 17-4
   Change Instructional Text ..................................................... 17-4
      Change Instructional Text for the Player ................................ 17-5
      Change Instructional Text for Know It? Mode ....................... 17-5
      Change Example Text for String Input Events ...................... 17-7
      Change the Font Format for Template Text .......................... 17-7
   Translate Templates .............................................................. 17-8
      Edit Event Names .............................................................. 17-8
      Edit Key Names ............................................................... 17-9
      Edit Shift Key Prefixes ...................................................... 17-9
      Use Genders ...................................................................... 17-9

18. Appendix A: Considerations for Setting Defaults ............ 18-1
   Set Workstation Defaults ..................................................... 18-1
      Set the Windows Default Color Scheme ............................. 18-1
      Set the Video Resolution and Color Depth ......................... 18-1
      Change the Taskbar Settings ............................................. 18-1
      Turning Off Other Applications ......................................... 18-1
      Set the Defaults in the Target Application ......................... 18-2
   Set Content Defaults .......................................................... 18-2
      Set Bubble Defaults .......................................................... 18-2
      Set Other Font and Color Defaults ................................... 18-2
      Set the Frame Delay ......................................................... 18-3
      Set Know It? Defaults ...................................................... 18-3

19. Appendix B: Development Considerations .................. 19-1
   Assign Development Tasks and Flow ................................. 19-1
   Create Scripts .................................................................... 19-2
   Suggestions for Developing Content .................................. 19-2
   Create Content in Multiple Languages ............................. 19-3
   Development Tips .............................................................. 19-4
   Test the Content ............................................................... 19-5
      Playback Modes ............................................................... 19-5
      Player Window ............................................................... 19-6
      Printed Documentation .................................................. 19-7

20. Appendix C: Develop Content for Different Deployments .... 20-1
   Develop Content for Deployment in the Player .................... 20-1
      Outline ............................................................................ 20-1
      Attachments: Web Pages and Packages ............................. 20-2
      What Appears in Which Playback Mode ............................. 20-2
      Fonts and Colors .............................................................. 20-2
   Develop Content for Deployment as Printed Documentation ........ 20-3
      Outline ............................................................................ 20-3
      Attachments ................................................................. 20-4
      What Appears in the Printed Outputs ................................. 20-4
      Control Bubble Text for Print Output ................................ 20-4
21. Index .................................................................................21-1
1. Get Started

The Developer is a synchronized content platform for creating documentation, training, and performance support across the enterprise. Its use is generally limited to a team of content authors. The content is made available to users through a Player or document output.

The Developer allows you to create and publish content easily. Content includes simulations, in-application support, and interactive documentation. Users gain a well-rounded knowledge of software functionality, complete with an understanding of the concepts, by learning how to use a program in both a simulated environment and while working with their own data in a live environment. Simulations can be viewed in any one of the following playback modes via the Player:

- **See It! Mode** enables a user to learn by watching an animated demonstration of the steps for a task being performed in a simulated environment. All of the required activities, such as moving the mouse and entering data, are completed automatically.

- **Try It! Mode** enables a user to learn interactively in a simulated environment. The user is prompted for mouse clicks and/or keystrokes to complete the task.

- **Know It? Mode** is an assessment-type playback mode in which users are instructed to complete a particular task. Users do not receive step-by-step instructions for completing a task. Instead, they complete the steps on their own in a simulated environment, and they are scored on how accurately they complete them.

- **Do It! Mode** enables a user to learn interactively using live data. A user is presented with a small window on top of the live target application that displays each step for a particular task. As the user completes each step, he/she can click a button or use a hot-key combination to display the next step in the process. Within the Do It! window, a thumbnail graphic of the screen is available with a highlight indicating the area where the action should take place.

- **Print It! Mode** enables a user to display linked documentation in the form of a Job Aid or Business Process Document.

Review the Developer Interface

The Developer interface is similar to most Windows applications with a movable menu and tool bar, status bar, and a main work area. The main work area can display the Library as well as any of the available document editors. If you display the Library, you can see a default set of folders and documents. The Library is the central repository of your content that can be accessed by one or more authors at the same time. The Library shows all content in the form of various folders and documents. Folders are similar to the folders on your computer that store files; however, folders in the Developer are used to store content-specific documents. Every object in the Developer is called a document and there are specific document types that you use to build content.

As you develop content and begin to create and open documents, additional work areas appear in new tabs. The document name appears in the tab and cannot be directly edited in the tab. If you want to change the name of a tab, you must change the name of the document.

Each tab is associated with a specific document editor that is launched when you open a document. For example, when you open a module document, a new tab appears, and the Outline Editor is launched in the work area. The name of the document appears in the tab with the appropriate document type icon. You can continue to open additional documents,
thereby opening a new tab for each new work area. You can navigate between each tab by clicking on it and close a tab when you are finished with the content that is displayed.

A work area may have multiple panes associated with it. For example, the Library has two panes where the left pane displays folders and the right pane displays the documents that are stored in the selected folder. The Outline Editor also has two panes where the left pane displays the outline of module, section, and topic documents and the right pane can display document details or conceptual and introduction content that is linked to each document. These different displays of document information are called views. For example, the Details View displays columns of document properties such as its Type, Last Modified Date, and so on. The Player View simulates the user interface of the Player and displays conceptual and/or introduction content that is linked to a specific document in the outline. This linked content can be web pages, documents, presentations, and so on. You can easily switch between these views using the View toolbar.

The remainder of this section describes how to start the Developer and customize various areas of the interface.

Since you can use the Developer in single or multi-user mode, the documentation includes a chapter on multi-user functionality as well various multi-user considerations. The following convention is used to identify specific multi-user functionality throughout this documentation:

Multi-user Considerations

Information about multi-user aspects of the Developer.

Start the Developer

You can start the Developer from the Windows Start menu, or you can create a shortcut on your desktop.

Create Profile

When you start the Developer for the first time in a single user environment, you are asked to create a content Profile that determines where the content Library is stored on your local computer. See the Add a Content Profile topic in the Create and Manage Profiles chapter of the Content Development manual for more information.

When you start the Developer for the first time in a multiuser environment, you are asked to create a login Profile that controls the connection to a specific content Library on a shared server. See the Create and Manage Login Profiles topic in Using the Developer in a Multiuser Environment chapter of the Content Development manual for more information.

After you create and open a Profile in either a single or multi-user environment, the Start Screen appears.

Set Primary Authoring Language

When you start the Developer for the first time, you are asked to choose a primary authoring language that controls the default language for content that you create in the Developer (Language property). This setting also controls the language of the default template, and several default font settings for text. For example, if you choose Japanese or Chinese, the default is automatically set to a font that is capable of rendering these characters onscreen and in print.

Launch the Start Screen

When you launch the Developer, the Start Screen presents you with the following options:
• Open the Library
• Open an existing document
• Create a new module
• Create a new topic
• Convert content (from a previous version)
• Import content

All of these options can also be performed using the menu commands. As you become familiar with the Developer, you may want to suppress the display of the Start Screen by deselecting the Show this screen at startup checkbox. When you launch the Developer without the Start Screen, the Library automatically appears. To display the Start Screen at any time, choose the Start Screen command from the View menu.

The Start Screen also displays the last six modules that you opened in the Recent Modules section. The Library always appears when you close the Start Screen.

To start the Developer:

1. Click the Start menu.
2. Point to the All Programs command.
3. Point to the User Productivity Kit command.
4. Click the UPK Developer command.

Multi-user Considerations

If you installed a multi-user version of the product, the word "Client" appears after the Program Group and Program Name in steps 3 and 4.

Create and Manage Content Profiles

In a single user installation, a content Profile determines the folder location on your computer where the content Library is stored. A default location is provided; however, you can choose any folder on your local computer.

You can create multiple content Profiles if you plan to use multiple libraries. You can also edit a content Profile and change the folder location and your content is moved accordingly.

Important Note: Deleting a content Profile will remove all content from your computer.

Add a Content Profile

You must create a content Profile when you start the Developer for the first time to identify the folder location on your computer where your content is stored. The folder location must be on your local computer and cannot be on a network drive. You must also have enough disk space to accommodate your content.
To add a content Profile:

2. Click Add to start the Profile wizard.
3. Click Next to display the Profile Name page.
4. Type a unique name for the profile. You will use this name if you have multiple profiles that you can use to switch between content Libraries. You cannot have multiple profiles with the same name.
   
   Also, if you create multiple profiles, you can configure one as the default that is automatically used every time you launch the Developer by clicking the Make this my default profile checkbox. The name of the active profile appears in the title bar of the Developer to identify the Library in which you are working.
5. Click Next to display the Data Storage Location page. You can either accept the default data storage location or choose a different folder on your computer. Click Browse if you want to change the default folder or click Next to accept the default folder. You must choose a folder on your local computer. Network drives are not permitted. The folder that you select must also be empty.
6. Click Next to complete the Profile Wizard.
   
   The last page in the Profile Wizard displays a summary of the profile including the name and data storage location.
7. Click Finish.

Edit a Content Profile

You can edit any content Profile that is not in use and change its name or the folder location where the Library content is stored. To edit a content Profile that is currently in use, you must first exit the Profile.

Note: Changing the location of the Library content does not change the location of other data such as preference, profile, view, or log files.

To edit a content Profile:

2. Select a profile from the list.
3. Click Edit or Exit Profile if you selected a profile that is in use.
4. Change the folder location and click Next.
5. Click Finish.
   
   Your content is moved from the old folder to the new folder that you specified. This may take some time depending on the size of your content.

Delete a Content Profile

Deleting a content Profile will permanently remove all content stored in the folder location defined in the profile.

To delete a content Profile:

2. Select a profile from the list.
3. Click **Delete**.
   You are warned that deleting a profile will also permanently delete all content in
   the Library (including any documents in the System folder).
4. Confirm the deletion or cancel.

**Switch Content Profiles**

If you have multiple content Profiles, you can switch between Libraries without having to
close the Developer. To do this, you must have a content Profile for each Library.

To switch content Profiles:

1. On the **Tools** menu, choose **Profiles**.
2. Click a profile for a different Library.
3. Click **Open** to switch to the Library.

**Configure Toolbars**

The Developer provides the following toolbars:

- **Outline Editor**: Displays icons for linking new documents, moving, and previewing
documents in the outline.
- **Standard**: Displays icons for common commands that are available across most
document editors.
- **Topic Editing**: Displays icons for common topic editing commands for context,
frames, screenshots, and so on.
- **Topic Navigation and View**: Displays icons for topic frame navigation and bubble
text display.
- **View**: Displays icons for changing the screen layout and views.
- **Web Page Editor**: Displays icons and controls for formatting a web page.

By default, the appropriate toolbar appears based on the document editor that is active.
For example, when you open a web page the formatting toolbar for the Web Page Editor
appears. When you close the Web Page Editor, the formatting toolbar is removed from the
screen. However, you can configure each toolbar to always appear by marking the
appropriate checkbox on the toolbar menu.

You can **restore** the toolbar display back to the installation defaults using the Restore
Default Layout command on the View menu.

**Multi-user Considerations**

The following toolbar is available only in multi-user installations.

**Versioning**: Displays icons for document check in and check out.

To hide/display toolbars:

1. Start the Developer.
2. On the View menu, point to Toolbars, and then choose the toolbar that you want to display.

To reposition toolbars:
1. Point to the left corner of a toolbar.
2. Drag the toolbar to any position on the screen.

Note: You can also reposition the menu bar using these same steps.

Use Menu Commands
When you are working in the Developer, you may prefer to use menu commands rather than toolbar icons. If you want to hide the toolbars to provide more space on the screen, you can do so. You can display the toolbars again at any time. On the Toolbars submenu (from View menu), a checkmark next to the toolbar name means the toolbar is visible; if there is no checkmark, the toolbar is hidden.

Note: You can also drag and drop each toolbar (and menu bar) and reposition it anywhere on the screen. Use the Reset command to restore the default toolbar positions.

Split the Work Area
By default, the work area appears in a single layout; however, you can split the work area horizontally or vertically depending on how you prefer to work. Regardless of your choice, the entire work area is separated by a split bar that you can use to resize each work area.

Splitting the work area is useful since you can explore different areas of a document in both work areas. You can also view different documents and drag/drop or copy/paste reusable documents between work areas to help make building content easier.

When you open a document in one work area, a tab for the newly opened document automatically appears in the second work area. In other words, the tabs that appear in split work areas. However, the document displayed within a tab can be different between two work areas. For example, you can have the same module document open in two work areas but explore different sections of the outline in each.

If you split a work area that has numerous tabs open that cannot be displayed for space reasons, left and right arrow buttons appear that allow you to scroll to the tabs that do not appear. Click X to close a selected tab or right click on the tab and choose Close.

Note: You cannot change the order of the tabs that appear in a window. The order is determined by the sequence in which you open documents.

To split the work area:
1. On the View menu, click Horizontal Layout to split the work area horizontally or click Vertical Layout to split the work area vertically.
2. Use the mouse to navigate between the different work areas.
3. Click Single Layout to remove a horizontal or vertical split.
Configure Toolpanes

Toolpanes are used to perform many common tasks. You can display and position the following toolpanes in the Developer:

- Properties toolpane to set and change various document properties.
- Related Documents toolpane to display documents linked to and from a document.
- Broken Links toolpane to display which documents contain broken links.
- Topic Editor toolpanes designed to work specifically with the Topic Editor to create and edit bubble text, change action and frame settings, link attachments to concepts, create frame links, and add sound, as well as navigate the topic frame structure.

It is not necessary to close a toolpane before an action takes effect; it can be left open and available while you continue to work.

To open a specific toolpane, you select the command or toolbar icon for that task. You can open a toolpane from the Library or any document editor.

By default, toolpanes open in a docked, vertical or horizontal pane on the right side or bottom of the work area depending on the document editor/library that is active. The name of the toolpane appears in the toolpane's title bar. You can open a single toolpane or multiple toolpanes at the same time and resize and position them. The Developer remembers the arrangement and size of your toolpanes.

Note: The toolpane does not split when you enable a split layout. The information in the toolpane refers to the selection in the active layout.

By default, the appropriate toolpane appears based on the document editor or the Library that is active. For example, when you open the library or any document editor other than the Topic Editor, no toolpanes appear. However, when you open the Topic Editor, the Frame Properties toolpane appears on the right side of the screen and the Frame Structure and Sound toolpanes appear at the bottom of the screen. When you open another document editor, these toolpanes are removed from the screen. However, you can display any toolpane in any document editor or the Library by selecting the toolpane on the Toolpane menu. If you explicitly choose to display a toolpane in the Library or document editor, it will appear in any document editor that you open. For example, if you open the Properties toolpane in the Library or Outline Editor, it will appear in the Topic Editor (as a tab at the bottom of the default Topic Editor toolpanes).

Some toolpanes are designed to function with specific document editors. For example, the Frame Properties, Frame Link and Frame Structure toolpanes are designed to function in Topic Editor only. If you decide to display one of these toolpanes in a document editor other than the Topic Editor, it will not function and it appears blank or disabled.

You can restore all toolpane displays back to the installation defaults using the Restore Default Layout command on the View menu.

To open and close a toolpane:

1. To open a toolpane, on the View menu, point to Panes, and then choose the toolpane that you want to display.
2. To close a toolpane, click X in the top right corner of the toolpane or deselect the corresponding menu command or toolbar icon.

**Resize a Toolpane**

You can resize docked or floating toolpanes. Docked toolpanes display a thick border, called a split bar, between the toolpane and the rest of the work area. Dragging the split bar allows you to increase or decrease the size of the toolpane. For floating toolpanes, drag any border or corner to resize its length and/or width.

To resize a toolpane:

1. To resize a docked toolpane, drag the split bar between the toolpane and the work area.
2. To resize a floating toolpane, drag a border or corner until the toolpane is the desired size.

**Move a Toolpane**

You can dock a toolpane vertically or horizontally on the right, left, top or bottom edge of the work area or float it anywhere on top of the Developer window. You move a floating or docked toolpane by dragging it by its title bar.

When you drag a toolpane, two sets of toolpane icons appear to help you select a position for docking the toolpane or positioning multiple toolpanes. One set displays icons around the perimeter of the work area and docks the toolpane at the corresponding edge. The other set, which initially appears in the center of the work area, helps you layer multiple toolpanes in a single stack or position them adjacent to one other.

You dock a toolpane by dragging its title bar to an icon corresponding to the desired docking position. If you want to float the toolpane, drop it anywhere on the work area except on a toolpane icon.

The following table describes the function of each toolpane icon:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Image" /></td>
<td>Docks the toolpane at the top of the work area. For displaying adjacent toolpanes, positions the toolpane above the other docked or floating toolpane.</td>
</tr>
<tr>
<td><img src="image2" alt="Image" /></td>
<td>Docks the toolpane at the bottom of the work area. For displaying adjacent toolpanes, positions the toolpane below the other docked or floating toolpane.</td>
</tr>
<tr>
<td><img src="image3" alt="Image" /></td>
<td>Docks the toolpane on the left side of the work area. For displaying adjacent toolpanes, positions the toolpane to the left of the other docked or floating toolpane.</td>
</tr>
<tr>
<td><img src="image4" alt="Image" /></td>
<td>Docks the toolpane on the right side of the work area. For displaying adjacent toolpanes, positions the toolpane to the right of the other docked or floating toolpane.</td>
</tr>
<tr>
<td><img src="image5" alt="Image" /></td>
<td>Stacks toolpanes on top of one another in layers. Tabs appear at the bottom of the toolpane area for displaying a toolpane in the stack.</td>
</tr>
</tbody>
</table>

To move a toolpane:

1. To dock a toolpane, drag it by its title bar and drop it on an arrow icon corresponding to the desired docked position.
Release the mouse button when the shaded image of the toolpane appears in the desired position.

2. To float a toolpane, drag it by its title bar and drop it anywhere in the work area, except on an arrow icon.

**Display Multiple Toolpanes**

When you open multiple toolpanes, you can display them in any of the following positions:

- **Individual docked or floating toolpanes**
  If you dock one toolpane in a vertical dock (left or right side) and another toolpane in a horizontal dock (top or bottom), the first toolpane you dock sizes to the full docking space, while the other toolpane resizes to fit the remaining docking space.

- **Stacked in a single docked or floating toolpane with multiple layers**
  Stacked toolpanes layer one on top of another, with the most recently opened toolpane on top.
  The name of each toolpane in the stack appears in a tab at the bottom of the toolpane area. Clicking a tab moves that toolpane to the top of the stack so that you can view it. Both floating and docked toolpanes support stacking. When you move the stack, all of the toolpanes move at the same time.

- **Adjacent toolpanes sharing the same docked or floating area**
  Toolpanes can share the same docked or floating area. You can position toolpanes adjacent (side-by-side) to one another in any direction, above, below, left, or right. Adjacent toolpanes that share the same docked area (top/bottom for a vertically docked toolpane and left/right for a horizontally docked toolpane) display a Maximize icon in the title bar to expand the toolpane to the full docking area.

To stack toolpanes:

1. Drag one toolpane on top of the other until a set of toolpane icons appear on top of the dragged toolpane.

2. Drop the toolpane on the stack icon in the center of the toolpane icons.

3. To display a toolpane in the stack, click the tab of the toolpane.

4. To separate stacked toolpanes, drag the tab of the toolpane you want to move to another location in the work area.

To display adjacent toolpanes:

1. Drag one toolpane on top of the other until a set of toolpane icons appear on top of the dragged toolpane.

   The icons that appear on top of the dragged toolpane correspond to adjacent positions rather than the perimeter of the work area. For example, the Up icon places the dragged toolpane above the toolpane under it.

2. Drop the toolpane on the arrow icon corresponding to the desired adjacent position.

   Release the mouse button when the shaded image of the toolpane appears in the desired position.
Note: When you position a toolpane above or below a vertically docked toolpane, or to the left or right of a horizontally docked toolpane, a Maximize icon appears on the toolpane’s title bar. Click to maximize a toolpane to fit the entire docked area or to restore it to a shared size.

**Autohide a Docked Toolpane**

There are two behaviors for a docked toolpane; to always appear on top of the work area, or to hide automatically when not in use. This behavior is controlled by the Pushpin icon, which appears in the right corner of the title bar for docked toolpanes. The pushpin points down when enabled and points left when disabled. By default, the pushpin is enabled and the toolpane always appears on top of the work area, sticking the toolpane to the window. Clicking the Pushpin icon unpins the toolpane. Three things happen when you unpin a toolpane; the direction of the pushpin changes, a tab for the toolpane appears, and the toolpane disappears into the border of the work area as soon as you move the mouse pointer off the toolpane. You can autohide multiple docked toolpanes.

To display a toolpane, either point to, or click the tab you want to view, or click the Pushpin icon to disable the autohide behavior. For stacked toolpanes, the pushpin controls the pinning actions for all toolpanes in the stack and creates a tab for each stacked toolpane.

To autohide a docked toolpane:

1. On a docked toolpane, click to unpin the toolpane.
   - The direction of the pushpin points to the left and a tab appears next to the toolpane with the name of the toolpane.
   - The toolpane hides when you move the mouse pointer from the toolpane.
2. To display the hidden toolpane, point to the toolpane tab.
   - Clicking the pushpin tab temporarily sticks the toolpane to the window.
3. To disable autohide and display the toolpane always on top, click .

**Restore Default Toolbars and Toolpanes**

After you configure toolbars and toolpanes in the Developer, you may find that you want to go back to the default layout from the original installation. The Restore Default Layout command can revert the Developer user interface to display the original toolbar and toolpane configuration that was initially installed. Toolbars and toolpanes for all document editors and the library are automatically reverted back to the default layout when you run this command from the View menu.

To restore the default layout:

1. On the View menu, choose Restore Default Layout.
   - The display and position of toolpanes and toolbars for all document editors and the Library is restore to the default layout of your original installation.

**Understand the Developer Basics**

You use the Developer to create, maintain, and publish your content Library. A typical content Library can contain hundreds, if not thousands, of documents. You can organize the Library using folders (similar to the way Windows Explorer lets you organize files on your computer). The main difference between Windows Explorer and the Library is that documents are stored in a relational database and not as individual files on a disk drive. However, this difference is largely transparent to you as you develop your content.
To help you visualize your content as you build it, the Developer offers various displays:

- The Library shows the entire content repository and its organization in folders. Each folder displays the documents that it contains or other folders and their corresponding documents. This folder structure is completely defined by an author although various folders are automatically created when you convert content from a previous version. A System folder structure is also created during installation that contains various system-wide documents for publishing styles, templates, roles, and attachment icons.

- Document Editors display the content of a single document in an editor. Each document editor appears in a new tab as you open or create documents. The document editor that appears depends on the type of document that you create or open.

Open and Close the Library

If you choose to display the Library, it opens in a Library tab in the Developer window. If the Library is not open, you can open it from the Start Screen when you start the Developer or from the View menu. You can close the Library just as you can close any document editor. If you have multiple document editors open at the same time, you may want to close the Library to eliminate some of the tab clutter. You can reopen the Library at any time. When you reopen the Library, it opens in the last tab position.

**Note:** You cannot change the order of the tabs that appear in the Developer. The order is determined by the sequence in which you open documents or the Library.

To open the Library:

1. From the Start Screen, click the Library link.
2. or
3. From the Developer, select the View menu and choose Library.

   If you have multiple tabs open, the Library command activates the Library tab.

To close the Library:

1. Click the Library tab and either click on the Library tab or choose Close from the File menu.

Use Folders and Documents

The Library lets you organize and manage your content using folders and documents similar to how Windows Explorer lets you manage and organize files on your computer. When the Developer is installed and a new content database is created, a System folder is automatically created that contains subfolders and various documents that control characteristics of the publishing styles, template text, roles, and attachment icons.

As you build new content, you will create additional folders in which to store various documents such as modules, sections, topics, web pages, packages, roles, glossaries, and so on. The folder structure you create is completely up to you; however, it is recommended that you keep your folder structure simple to avoid unnecessary navigation or confusion, especially if you are working in a multi-user environment. You will probably want to create a standard folder structure for your content before you start creating documents and avoid letting authors build complicated folder structures along the way.
A folder can be opened to view its contents, which can be additional folders or documents. These objects always appear in the right pane of the Library. You can also open any document in a folder, thereby launching the appropriate document editor. Folders and documents in the Library can also be moved, copied, and deleted, although the System folder and its documents should not be altered.

**Understand the System Folder**

The System folder is automatically created when you install the Developer. It contains a series of subfolders and documents that store publishing documents, templates, master role documents, and attachment icons. The System folder is only visible in the Library and contains the following subfolders:

- Icons
- Publishing
- Roles
- Templates

**Warning!** You should not move, delete, or rename the System folder, its subfolders, or any documents that are contained within them. Doing so may impair the operation of the software. However, you can remove and add documents to the Icons folder without causing problems.

**Understand the Developer Document Types**

When you build content, you create, edit, and link various documents that are stored in the Library folders. The Developer provides the various document types that allow you to:

- create an outline to facilitate content presentation and navigation
- record application simulations for playback
- construct conceptual and introductory content that link to outlines and recorded frames
- develop glossary terms
- define roles for document filtering
- customize publishing style output

The following table describes each document type:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Document Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📚</td>
<td>Module</td>
<td>A module (purple book) is used to organize a specific unit of learning. It can contain other documents such as sections, topics, or even other modules to form a component of an outline. A module can also have conceptual content linked to it that provides a general description of the content that is contained within it.</td>
</tr>
</tbody>
</table>
## Icon Document Type Description

<table>
<thead>
<tr>
<th>Icon</th>
<th>Document Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Section Icon]</td>
<td>Section</td>
<td>A section (blue book) is very similar to a module in that it also can contain other documents such as sections, topics, or other modules. The main difference between a section and module is its visual representation that can help you differentiate between the components of your outline and locate areas in the structure faster. A section can also have conceptual content linked to it that provides a general description of the content that is contained within it.</td>
</tr>
<tr>
<td>![Topic Icon]</td>
<td>Topic</td>
<td>A topic represents a series of recorded steps that complete a task in an application. Topics are where you record application-specific transactional content; whereas modules and sections provide the structural components of your outline.</td>
</tr>
<tr>
<td>![Package Icon]</td>
<td>Package</td>
<td>A package is a collection of one or more files that can be imported and attached to documents as additional content. For example, a package can be as simple as a document that contains an image file or more complex where it contains multiple files that comprise an entire web site.</td>
</tr>
<tr>
<td>![Web Page Icon]</td>
<td>Web Page</td>
<td>A web page is an HTML page that can contain text, audio, images, and hyperlinks to other content. It can be linked to modules and sections or frames and bubble text within a topic.</td>
</tr>
<tr>
<td>![Glossary Icon]</td>
<td>Glossary</td>
<td>A glossary is a list of specialized terms unique to your company, or terms that require further clarification for your users.</td>
</tr>
<tr>
<td>![Role Icon]</td>
<td>Role</td>
<td>A role generally represents the actions and activities assigned to or required or expected of a person or group. A role is used to filter topics in the Player.</td>
</tr>
<tr>
<td>![Template Icon]</td>
<td>Template</td>
<td>A template controls the bubble text that is automatically populated when you record a topic.</td>
</tr>
<tr>
<td>![Publishing Project Icon]</td>
<td>Publishing Project</td>
<td>A publishing project contains all of the files that are used in a publishing style. For example, the Training Guide publishing project has various Microsoft Word documents and XML files that control the output format of this style. You can customize a delivered style by copying the relevant publishing project document and editing the files to define your custom style.</td>
</tr>
</tbody>
</table>

## Work with Document Editors

When you create or open a document for viewing or editing, it appears in its corresponding document editor. For example, when you create or open a module or section, the Outline Editor appears in a new tab. If you create or open a web page, the Web Page Editor appears, and so on. The editor that appears depends on the type of document that is opened.

The following document editors are available in the Developer:

- Outline Editor
- Topic Editor
- Web Page Editor
- Package Editor
• Glossary Editor
• Role Editor

Outline Editor

The Outline Editor displays a hierarchy of documents that is similar in design to a common table of contents. This document hierarchy appears in the left pane of the editor and is called an outline. The outline can consist of any number of module and/or section documents and their related topics and can span as many levels as you want.

The content that you see in this editor is defined by the module or section document that you open and is typically not the entire content Library. This allows you to either explore a complete outline by opening what is referred to as the "root" document or focus in on a specific area of the outline by opening a specific module/section document depending on how you have designed your outline.

The Outline Editor lets you create and modify an outline by linking new or existing documents, moving or copying existing documents, removing document links, and so on. You can also display conceptual and introductory content such web pages, packages, and URLs or document properties such as Last Modified Date, Role, State, and so on.

Topic Editor

The Topic Editor is used to edit the frame content of a recorded topic.

Web Page Editor

The Web Page Editor allows you to create web pages that include formatted text and graphics, sound, as well as hyperlinks to other documents, images, or web sites. You can then use any web page that you create and link it to a module, section, or topic document as conceptual or introductory material or to any topic frame as supplemental transactional information.

The Web Page Editor provides basic formatting capabilities such as:

• Text formatting including bold, italics, underline, and font selection
• Paragraph alignment including left, right, centered, and justified
• Graphics support
• Hyperlinks to other documents, web pages, web sites.
• Sound recording and editing

You can use the Outline and Topic Editors to link a web page to documents in the outline or individual frames in a topic.

Package Editor

The Package Editor lets you import one or more files (such as a web site, image, Microsoft Word document, PowerPoint presentation, and so on) into a package in the content Library. You can then use any package that you create and attach a file to a module, section, or topic document as conceptual or introductory material, or to any topic frame as transactional information.

The Package Editor lets you manage a package that you create by:
• Adding or removing files/folders in a package
• Navigating folders in a package
• Renaming files in a package

You can use the Outline and Topic Editors to link a file in a package to documents in the outline or frames within a topic.

**Role Editor**

The Role Editor is where you define a list of roles that can be used to filter topics in the Player.

**Glossary Editor**

The Glossary Editor allows you to create a list of terms and links to other documents such as web pages that contain their definitions.

**Document in Use Message**

As you open and edit documents in the various document editors, you should note the following document editing concurrency rules:

• If a document is edited in one document editor, it cannot be modified in any other document editor or the Library or deleted. For example, if you have a web page open in the Web Page editor, you cannot rename or delete that web page from the Library. Or, if you edit a module in one Outline Editor tab but that same module is open in another Outline Editor tab, you can edit the module only in the first Outline Editor tab in which you initiated editing. A "Document in Use" message is displayed in any such document editing concurrency scenario.

• Editors other than the Outline Editor (such as Web Page, Package, and Topic Editors) lock the document as soon as it is opened. Once a document is locked it cannot be changed until you close the editor.

• The Outline Editor is different from the rest of editors in that it edits multiple module/section documents. Note that, from this perspective, the root outline document is co-equal with the other module/section documents in the outline. Since a section can be part of multiple outlines, the same section can be present in multiple Outline Editors simultaneously.

• The Outline Editor does not lock the module/section documents in the outline when they are displayed or expanded. It locks them before it executes the first operation that modifies them (add or remove links to it, rename it or do anything that actually changes the document). If you create a section in an Outline Editor, the new document is created but it is not locked, but as soon as you insert something into the new section, it is locked. If you unlink the new section from the module, the document still remains locked because you can undo the unlink and then undo the changes you made to the document.

**Link Related Documents**

As you create documents, you can also link them together to form a basic content outline. For example, you might start with a module document and link several sections to it. Then, for each section, you can link one or more topics that demonstrate how to perform a series of specific tasks or transactions in an application. This is just one example of how you could link and structure content, but you have the flexibility to design it in many ways to meet your needs. For example, you could also start with a section document and link topics or other module documents to it.
As you build an outline for your content, you may also want to supplement it with conceptual information in the form of web page or package links. For example, any module/section or topic can have a link that appears as conceptual or introductory information for the document. This link can be a specific page of a web site on the Internet, a custom web page that you create within the Developer, a Microsoft PowerPoint presentation, Microsoft Word document, Flash movie, and so on. Your users can view this content from the Player once you publish the content. These are just two examples of how you can build content by creating and linking documents.

At any time you can review the links that a document contains by displaying the Related Documents toolpane or by adding the Link count or Links to property columns to the Library.

Related Document Definition by Operation
As you begin to work with the Developer, you will notice that there are many document functions that consider the inclusion of related documents such as delete and export (as well as check in/out and restore in a multi-user environment). Based on the function that you perform, different related documents are considered. For example, when you delete a module, you can also request to delete its related sections and topics. However, the module is also linked to a template and deleting a template does not make sense since a template is usually linked to many different documents in the Library. Therefore, when you delete a document and choose to include related documents, linked templates are not considered.

When you perform an operation that can impact related documents, you see a prompt asking whether you want to include the related documents as well as a View related documents hyperlink to display a list of related documents.

**Note:** Regardless of whether a document is included as a related document, it can always be explicitly selected, thus ensuring that it is included in the operation.

Reuse Documents
As you begin to build your content Library, you may find a need to reuse documents in multiple outlines. Any document that you create can be reused across multiple outlines. However, please note that any changes you make to the document are reflected in all instances where they appear. For example, if you reuse a section document that has several topics across many modules, any changes you make to the section are reflected in each module that includes the section. Changes could be as simple as a rename of the section or include additional topic links. If you do not want changes to impact other areas of reuse, then you should copy the document and use the various Paste or Paste Special options to create additional documents.

Document Properties
Documents have specific properties that provide additional information about the document. There are two types of properties: calculated properties that are automatically set and changed by the Developer and editable document properties that can be manually set and changed by an author.

Calculated properties provide useful information about documents. For example, every document has a unique ID, document type, creation date, and link statistics showing the number of links to and from the document. These properties appear when you are working in the Details View from the Library or the Outline Editor.

Documents such as modules, sections, topics, web pages, and packages also have editable properties that impact functional aspects of the document. For example, properties for a
topic include glossary, language, screen resolution, template, application, playback modes, Know It? options, and documentation fields. The properties you set are saved with the history of the document and travel with it on operations such as export and import. These properties appear on the Properties toolpane.

**Multi-user Considerations**

In a multi-user environment, additional document properties appear that display the name of the author who has checked out the document for editing and their computer name.

**Undo/Redo Actions**

As you work with documents in the various document editors, you may find it necessary to undo or redo the editing actions that you perform. Most document editors provide an Undo and Redo command on the Edit menu for just this purpose. For example, in the Outline Editor you can undo the linking of any document in the outline, undo the deletion of links, and so on. If you are working on a web page, you can undo the addition or editing of text, as well as any formatting commands that you perform. You can also redo actions in the same way.

There is no limit to the number of actions you can undo/redo in most document editors. However, undo/redo in the Topic Editor is limited.

**Important Note:** Undo/Redo is not available from the Library or the Package Editor. Also note that you cannot undo glossary term links that are created using the Update Glossary Links command.

**Multi-user Considerations**

If you perform any action that requires a parent document check out such as Link New Topic (from the Outline Editor), when you undo this action, the parent document check out is NOT undone.

Any action that involves document versioning/history cannot be undone. These actions include check in, check out, delete, restore, and rollback.

To undo/redo an action:

1. Perform an action that can be undone.
2. On the Edit menu, choose "Undo" or "Redo" depending on the action that you want to perform. Some editors such as the Outline Editor display the name of the action that can be undone; for example, Undo Document Rename.

**Set Developer Defaults**

The Developer provides a set of default settings that affect the appearance of the content that you create, as well as other settings for content preview, player and recorder behavior, spell check, and so on. Before you begin to create content, you should, at a minimum, review the settings in the Content Defaults category since these settings impact the appearance of any newly created content.
The Options dialog box (from the Tools menu) displays the categories that you can use to configure default settings for the Developer, Player, and the content that you create.

When you click on a category, the options appear in the frame on the right. Some categories such as Content Defaults have subcategories that list additional options. Click Apply when you want to save your settings for a category and then move to another category.

**Restore Defaults**
If you make changes for any category that you no longer want to use, you can reset them back to the original installation defaults by clicking the Restore Defaults button at the bottom of the options frame. This only resets the options for the category you are viewing and does not change the settings for any other category. To reset the defaults for another category, you must display the options frame for that category and then click the Restore Defaults button.

**General Developer Settings**
Use this page to configure the following general Developer default settings:

- **Image Editor:** Use this option to specify the program you want to use to edit topic frame screenshots if it is different than the default image editor that is configured on your computer. The image editor that you configure here is launched when you use the Edit Screenshot command from editable frames in the Topic Editor. You can enter the path and file name of the executable file of your image editor, or you can use the Browse button to navigate to and select the executable file.

- **Do Not Ask Again:** There are several dialog boxes in the Developer that display a Do Not Ask Me Again checkbox that allows you to suppress their display. Use this option to reset all dialogs that provide this option to the original installation defaults (which is always ask).

**Library Settings**
Use this page to configure the following default settings for the Library:

- **Automatically save changes every:** Allows you to set the time interval (from 1 to 100 minutes) that the Developer uses to automatically create a temporary backup copy of any open document. If the Developer unexpectedly terminates while you are editing one or more documents, you may be able to recover all or part of the unsaved content depending on the situation. See the table below for details. When you restart the Developer, the Recovered Documents dialog box lists any documents that have been recovered. You have the option to discard the recovered documents (reverting back to the last explicitly saved version) or open all recovered documents in their appropriate editors. When you open a recovered document, the word "(Recovered)" is appended to the name of the document in the editor tab as a visual indicator that the document is recovered. The "Recovered" indicator is not actually part of the document name and is removed when you save or close the document.

Do not use AutoRecover as a substitute for regularly saving your work by clicking **Save**.

**Note:** The Developer does not autosave package documents.

An action is required to resolve any recovery situation. These actions and the resulting behaviors are described below:
<table>
<thead>
<tr>
<th>Situation</th>
<th>Action</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document was previously saved and an autorecover copy exists that the author wants to save</td>
<td>Save</td>
<td>The autorecover copy becomes the current version and the older autosave version is discarded.</td>
</tr>
<tr>
<td>Document was never saved but the author wants to save the autosave copy.</td>
<td>Save</td>
<td>The author is prompted to provide a document name and save the document. The saved document becomes the latest version and the autosave is cleared. If the Developer unexpectedly terminates before an autosave was created, the document is lost because there is no copy to revert back to.</td>
</tr>
<tr>
<td>Author chooses to save an autosave copy by another name.</td>
<td>Save As</td>
<td>A copy of the autosave document is saved as the user supplied name and the autosave copy is discarded.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Documents linked from the newly saved document (for example, concepts linked to a Topic) retain links because the links are contained within the saved document.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Documents linked to the newly saved document (for example, the Section linked to the Topic) must be linked again because the new document has a different ID.</td>
</tr>
<tr>
<td>Author chooses to discard an autosave document.</td>
<td>Close</td>
<td>If the document is closed without being saved, it reverts back to the last explicitly saved version and the autosave is cleared.</td>
</tr>
</tbody>
</table>

**Multi-user Considerations**

When the author chooses to save an autorecover document, the Developer verifies that the original version is checked out (and checks it out if necessary) and replaces that version with the autorecover version. The author can then check in the new version as the current version.

- **Scan for Lost Documents:** You should not have to run this scan unless you are experiencing problems with documents in the Library. Contact technical support for more information on recovering lost documents.

**Multi-user Option: Available Disk Space**

This option controls the amount of disk space that is allocated to a folder that stores documents that are automatically downloaded to your computer when you access (view or open) documents while online or when you explicitly download documents using the Document, Get or Check Out commands.

Use the Clear Now button to remove read-only documents from your local cache and restore used disk space. This button only removes documents that exceed the Available Disk Space setting.
Multi-user Option: Network Connection

This option controls the timeout value that determines the maximum amount of time for a transaction such as document check out/in, Get document, or document download to finish. For example, if you use the Medium setting (300 seconds), each document download should finish in five minutes; otherwise you will receive a "timeout" error message.

If the Library contains large documents and you have a slow network connection, the Low setting is better (1000 seconds), since you will not get the "timeout" error message. If you have a fast network connection, the High setting is better because if the server goes down for some reason, you will be notified after 100 seconds (and you do not have to wait 1000 seconds to receive the "timeout" error message).

Content Defaults

This category lists various subcategories that allow you to configure default properties that are automatically applied to new documents that you create such as modules, sections, topics, and web pages. These properties control how your content will appear when published and deployed to your audience. For example, when you record a topic, the Developer uses these defaults to determine the display characteristics of topic bubbles as well as for the text they contain. Other defaults affect the appearance of text for string input actions and Introduction/End frames as well as the background and text color in web pages.

Tip: It is recommended that you set the content defaults before you add documents and record content. When the content defaults are changed, existing documents are NOT affected and continue to use the defaults that were in effect when those documents were created.

General Defaults

Use the Language field to override the default language setting for all documents.

Use the Template and Screen Resolution fields to set the defaults for module, section, and topic document types only. You can override these defaults when you add each of the documents or by editing the document properties.

- Frame Delay: In the See It! playback mode, there is a predetermined delay time between each action or frame. This frame delay controls the amount of time that elapses between the appearance of the frame and the start of the action. The delay gives the user time to read the text in the bubble before the action starts. By default, the delay for all frames is 5 seconds. However, you can change the default frame delay time. You can either use a selection from the Frame Delay list or enter another delay time manually. If you choose the 0 or skip option, a 0-second frame delay is applied to all action frames, and Skip is applied to non-action frames. As a result, the playback for action frames starts immediately when the frame appears, and for non-action frames, the playback skips the frame and move immediately to the next frame. If you choose the Infinite option, the playback waits for the user to press ENTER before advancing to the next step. The bubble automatically displays the text "Press Enter to continue." when this option is selected.

- Required Percentage and Remediation: Know It? mode is an assessment mode of topic playback that enables users to test knowledge gained from training. When a topic is played in this mode, the user is expected to complete a task with little or no assistance in a simulated environment. Upon completion of the task, a user
receives a score.

Required Percentage: Enter the default passing score for all topics. You can also change this percentage for an individual topic using the Properties toolpane.

Remediation: When users fail to complete a step in Know It? mode, they can see up to four levels of remediation. By default, all four remediation options are active for any new topic that you create. You can configure the default settings for the first three levels, but the fourth level is always active. See Remediation Levels in Topic Properties for a definition of each level.

These settings do not affect converted content. For example, if you make remediation level configuration changes first and then convert content, the converted content will have all four levels active (default settings).

Recorded Content Defaults

Use this page to configure the following defaults for recorded content:

- Automatically record keyboard shortcuts: While you are recording content, the Developer can automatically capture keyboard shortcuts for menu items in standard Windows menus. The Developer determines the shortcut using underlined letters in the menu name. When you record keyboard shortcuts, it is the same as recording an Alternative Action. In the Player, the keyboard shortcut appears as the Alternative Action for the current step in Try It! mode. In the Player, users are marked correct if they use the keyboard shortcut for a step in Know It? mode. Deselect this option if you do not want to capture the shortcuts in recorded content.

- Automatically ensure consistent sound recording levels: When recording sound, signal levels and noise can vary widely. Use this option to ensure a consistent recording level, from start to finish, by automatically raising or lowering the signal. The signal level adjustment is performed at the moment a recording is created from the Recorder or Sound Editor.

- Enable automatic recording: As you record a drag action, the Developer can create "incremental" screenshots automatically as you drag the mouse. This process is called automatic drag and drop recording. If you do not want the Developer to automatically capture the "incremental" screenshots, deselect this option. When automatic drag and drop recording is disabled, you need to press PRINTSCREEN (or the designated screen capture key) to capture the "incremental" screenshots as you drag.

- Distance & area size: The Distance between screenshots option allows you to specify how far the mouse must move before another screenshot is captured. This distance is measured in pixels. A larger number means that the mouse must move a longer distance before the next screenshot is captured. The Action area size option allows you to control the size of the action area for each frame captured during the drag action. The size is measured in pixels, and a higher number indicates a larger action area. The area size is also the default size used for an action area that the Recorder recognizes as a Universal Object, Workspace, Window, or Active X object.

Bubble Defaults

This option allows you to configure default settings that control the visual display for bubbles that appear in all frames OTHER than the Introduction and End frame. You can also configure the default text that appears in the bubbles.
These defaults are in effect when you create and record new topics; however, you can override any of these bubble attributes when you edit a topic in the Topic Editor.

**Note:** You can control the default settings for the Introduction/End Frame bubbles using the Introduction/End Frame option.

Use the following icons to configure the visual attributes of the bubbles. The sample bubble that appears in the center of the pane reflects the current default settings and automatically changes as you edit the settings.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Choose an icon that appears inside of the bubble and to the left of the bubble text.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Click the icon to display a menu of the various pointer positions that you can choose for bubbles.</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Choose the bubble background color. You should choose a color that makes sense for the text color (default is black) that you are using. Text color can be changed when you edit a topic in the Topic Editor.</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>Choose the font, font style and size for the bubble text. If you are using an expanded font, such as Arial or Times New Roman, you can choose from an extended list of language characters, including Greek and Russian (Cyrillic), if available in the Script field.</td>
</tr>
</tbody>
</table>

- **Use Template Text:** In addition to the bubble attributes, you can also control the text that appears in the bubbles. By default, the Developer uses templates to automatically generate bubble text as you record an application, depending on the keystroke or mouse action you performed during each step. Therefore, the Use Template Text option is selected by default. If you deselect the Use template text option, the templates are disabled, and the bubbles are empty after recording. You can choose this option to control the contents of the bubble and not have it automatically populated with template text.

  If you decide to use templates, you can also add your own (custom) text to the bubble. By default, this text appears before the text that is populated by the template. The Show template text first option allows you to switch the order and have custom text appear after template text.

**Introduction/End Frame Bubble Defaults**

This option allows you to configure default background color and text font settings that control the visual display for the bubble that appears in the Introduction and End frame only. These settings also affect the appearance the Introduction pane in the Developer and the Player.

**Tip:** If you want to control the background color and text font that appears for content displayed in the Concept pane, you should create and link a web page as the concept. In this way, you can also create a consistent appearance for content that appears in both panes.

These defaults are in effect when you create and record new topics; however, you can override any of these bubble attributes when you edit a topic in the Topic Editor.

**Note:** You can control the default settings for other bubbles using the Bubble option.
Use the Background color and Font icons to configure the visual attributes of bubbles. The sample bubble that appears in the center of the pane reflects the current default settings and automatically changes as you edit the settings.

**String Input Defaults**

As you record content, one of the action types you record is a string input. This action occurs when you are typing text in a document or in a field in a dialog box. When a user plays the topic in Try It! mode, the user must enter the specified text to move to the next step. The action area (the area in which the user must type the text) uses the default MS Sans Serif font and white background color.

You can change these options using the Background color and Font icons to better simulate the application in which you are recording.

**Glossary Defaults**

Glossary terms can appear in bubble text, Introduction/End frame bubble text, and web page text.

By default, when a glossary term appears multiple times in one location, only the first occurrence is hyperlinked after you perform the Update Glossary Links command. You can, however, select the Every occurrence of the term option to have a glossary term hyperlinked whenever it appears in custom bubble text, Introduction/End frames, or web pages, regardless of the number of times the term appears.

**Web Page Defaults**

Use this option to preset the background color and font name, size, and text color for any web page that you create. You can also override these settings by editing a web page using the Web Page Editor.

**Export/Import Content Defaults**

After you configure the options in the Content Defaults, Documents, and Player categories, you can share these preferences with other authors. This is particularly useful in workgroup environments where multiple authors are working on the same content that requires consistent output regardless of who authored the content. In this scenario, you can create a "master" set of Content Default options, export the settings, distribute the options file to the other authors, and then have all authors import the master options into their Developer installation.

To export content defaults:

1. Configure the Content Default options that you want to export. Only the settings defined for the Content Defaults, Documents, Target Applications, and Player categories are exported.
2. On the Tools menu, point to Export and choose Content Default Options.
3. Browse to where you want to store the exported options file.
4. Type a name for the options file and click Save. You should distribute the options file (.ops) to the authors that need to import the standard settings.

To import content defaults:

1. On the Tools menu, point to Import and choose Content Default Options.
2. Browse to where the exported options file is stored. To import content defaults, you need to know the location of the exported content defaults file (.ops).

3. Select the file and click Open.

Documents Defaults

You can configure options for each document output that are in effect whenever you preview documents from the Developer. These options are also used as the defaults when you publish documents for the first time; however, you can also override these options from the Publishing Wizard.

From the Outline Editor only, you can publish or preview the following documents for any topic:

- Business Process Document
- Job Aid
- Training Guide
- Instructor Manual
- Test Document
- HP Quality Center (publish only)
- Presentation

Options for Document Outputs

The following options are available for each document format except HP Quality Center and Presentation.

- Output format: By default, published output is in Microsoft Word, but you can choose Adobe Acrobat PDF format or both. You must have Adobe Acrobat 7.0 (or greater) Standard or Professional edition installed to create PDF output.

  After Adobe Acrobat is installed, make the following changes to the PDF conversion settings in Microsoft Word: From the Adobe PDF menu, choose Change Conversion Settings, and deselect the View Adobe PDF result and Prompt for Adobe PDF file name options.

  **Note about PDF Publishing with Microsoft Office 2007:** Adobe Acrobat is not required for PDF output if you are using Microsoft Office 2007. However, you will need the 2007 Microsoft Office Add-in: *Microsoft Save as PDF*. You can obtain this add-in from the Microsoft Office Download Center.

- Microsoft file type: If you choose the Microsoft Word output format, you can use this option to indicate whether you want the documents to be in .doc (Word 2003) or .docx (Word 2007) format.

- Include: By default, screenshots are included in a document based on the settings for the topic in the Topic Editor. This option allows you to override those settings and choose to include one screenshot per topic, one screenshot for each frame, or no screenshots. You can choose a different setting for each document format you print.

- Convert screenshots to 256 colors: By default, screenshots are converted to 256 colors. This option allows for screenshots in more than 256 colors. This is especially useful for the Player formats so that the screenshots in the simulated playback modes are clearer.
• Paper size: By default, the paper size is set based on the Location setting in the Regional & Language options for your operating system locale. You can override this setting by choosing a different paper size. If you customize the print template to have a special paper size (for example, to print Job Aids on smaller cards), choose the option to use the print template setting; otherwise, it will be overridden during publishing. You can choose a different setting for each document format you print.

• Text mode: By default, each document output uses the text from a specific mode. Some document outputs default to the See It/Try It mode text, and the others default to the Do It mode text. With this option, you can specify the mode text to use.

• Use encoded folder and file names: Publishes the content using hexadecimal names instead of actual module, section, and topic names. Encoding ensures that path names are not too long to publish.

• Include alternatives: By default, Alternative Actions and Paths are set to appear in document and Presentation outputs. This option is useful if you want to make the output simpler, with only one set of steps.

• Include images from packages: By default, images will appear if they are attached to a frame or to the concept pane. Images larger than ½ page will be scaled to fit the page. This option is not available for the Job Aid, Test Document, or Presentation outputs.

• Include images in web pages: By default, images appear if they are attached to a frame or to the concept pane. Images larger than ½ page will be scaled to fit the page. This option is not available for the Job Aid, Test Document, or Presentation outputs.

**System Process**

This format is useful for creating documents that not only include the procedures and conceptual information for business processes, but also contain information relating to intended audience, roles and responsibilities, document status, versions, and dates. Each topic is published to a separate document which includes a concept page, with information about the document and task, and the procedures for completing the task.

**Job Aid**

This format results in a quick reference guide, enabling users to view only the procedures for completing a task, without conceptual information. Each topic is published in a separate document which includes only the procedures for completing the task.

**Training Guide**

This format allows instructors to create manuals quickly for Instructor-led training. The document includes a title page, copyright information, table of contents, conceptual information, and procedures for completing all tasks included in the published outline. In addition, if the content you publish contains glossary markups, then a glossary is included at the end of the document.

**Warning!** Be aware that when you publish a Training Guide, your entire selection is published as one document. If you publish a large amount of content at one time, you may encounter memory problems with Microsoft Word. Consider publishing your content in smaller chunks and then merge the contents of each Microsoft Word file after publishing from the Developer.
**Instructor Manual**

This format allows instructors to publish the Training Guide including instructor notes. The instructor notes are inserted in the document per topic, after the Concept, and before the Procedure. An Instructor Note heading appears in the output in the same style as Procedure text. The instructor notes are formatted like web page attachments (indented 1/2 inch from the margin in a box with a rule and shading). This is designed to make the notes stand out from the other text. The outside margin is adjusted to 2.5 inches. This allows instructors room to write their own notes.

---

**Warning!** Be aware that when you publish an Instructor Manual, the entire selection is published as one document. If you publish an entire outline, the document could be very large, and you might experience problems with Microsoft Word.

---

**Test Document**

This format allows you to create documents for testing software applications. Each topic is published to a separate document. The document includes the purpose of the test, test history, time to test, test setup, and test procedure. The test procedure contains the steps for completing the task.

---

**Presentation Defaults**

You can configure options for the Presentation output that are in effect whenever you preview a Presentation from the Developer. These options are also used as the defaults when you publish a Presentation package for the first time; however, you can also override these options from the Publishing Wizard.

- Convert screenshots to 256 colors: By default, screenshots are converted to 256 colors. This option allows for screenshots in more than 256 colors. This is especially useful for the Player formats so that the screenshots in the simulated playback modes are clearer.

- Include action areas: In the Player outputs, a marquee - or highlight - appears around the action area for each frame. You can choose to include this marquee in the Presentation. You can also change the color of the marquee. Changing the color for the Presentation output does not affect the marquee color for the Player outputs.

- Use encoded folder and file names: Publishes the content using hexadecimal names instead of actual module, section, and topic names. Encoding ensures that path names are not too long to publish.

- Include alternatives: By default, Alternative Actions and Paths are set to appear in document and Presentation outputs. This option is useful if you want to make the output simpler, with only one set of steps.

- Microsoft file type: You can use this option to indicate whether you want the documents to be in .ppt (PowerPoint 2003) or .pptx (PowerPoint 2007) format.

- Text mode: By default, each document output uses the text from a specific mode. Some document outputs default to the See It/Try It mode text, and the others default to the Do It mode text. With this option, you can specify the mode text to use.

---

**HP Quality Center**

This format allows you to create documents for testing software applications that can be imported into HP Quality Center. If you select multiple items in the outline, the published output is combined into a single Excel file with each topic separated by a blank row. This file can then be exported into HP Quality Center in a single operation.
Note: To export this output from Microsoft Excel and into HP Quality Center, you need the TestDirector Microsoft Excel Connectivity add-in installed. See the HP Quality Center documentation for more information or go to http://update.merc-int.com/testdirector/td80/.

Only topics with content are included in the output; empty topics do not appear. In addition, modules and sections are not included in the output.

By default, Alternative paths and actions are not included in this format but you can change the publishing option to include them. Decision Frames are automatically included and cannot be suppressed. You need to edit the output in Microsoft Excel or in HP TestDirector to remove any unwanted Decision Frame material. Explanation Frames are not included.

If context ID information is available for a frame, it is included at the end of the Action cell. The type of information will differ or may not appear, depending on the target application of the topic.

The following publishing options are available for HP Quality Center:

- Text mode: By default, each document output uses the text from a specific mode. Some document outputs default to the See It/Try It mode text, and the others default to the Do It mode text. With this option, you can specify the mode text to use.
- Include alternatives: By default, Alternative Actions and Paths are set to appear in document and Presentation outputs. This option is useful if you want to make the output simpler, with only one set of steps.
- Use encoded folder and file names: Publishes the content using hexadecimal names instead of actual module, section, and topic names. Encoding ensures that path names are not too long to publish.
- Group actions by context ID: By default, each action appears in a separate row in the Test Procedure table. When you select this option, the actions when the same context ID are grouped together into one test step.

Player Defaults

You can configure the following Player options that are in effect whenever you preview the Player modes from the Developer. This allows you to preview topics directly from the Developer in a Player environment that emulates what your users experience when they play your content from their Player environment. These options are also used as the defaults when you publish a Player package for the first time; however, you can also override these options from the Publishing Wizard.

- Convert screenshots to 256 colors: By default, screenshots are converted to 256 colors. This option allows for screenshots in more than 256 colors. This is especially useful for the Player formats so that the screenshots in the simulated playback modes are clearer.
- Create links for backward compatibility: You also can choose to create links for backward compatibility. This is an important option if you have created web pages or HTML links to content from a previous version that you have converted into the current version. If you choose this option during publishing, a folder structure is generated that will allow you to keep the existing links without needing to update them. After you publish, open the folder in which you published the content and rename the Linked_folders directory to match the name of the application folder from the previous version. For example, in a previous version, you published a Player package for the WordPad application. Within that Player package, there is a folder
called WordPad, in which all the content is located. If you convert that title to the current version and republish it to a Player package using the backward compatibility option, you would rename the Linked_folders folder to WordPad. The pages within this folder will redirect your existing links appropriately into the new content structure.

**Note:** If you want to use this option, the module names in the content you publish MUST be unique, as the module name is used to determine the folder name.

- Include HTML Web Site: You can choose to include the HTML Web Site format when you publish to the Player. The HTML format is contained in a folder called html within the PlayerPackage folder. If this folder is present, the HTML Web Site format will launch if a user has a browser that is not supported by the Browser.

- Sound: By default (None), sound files are not included in any of the Player formats. To include sound with the Player, select the quality for sound playback; Low (5.5 kHz), Medium (11 kHz), or High (22 kHz). Medium produces sound files (.FLV) in the published output roughly double that of the Low setting. High produces published sound files (.FLV) roughly double that of the Medium setting.

Format for Print It! mode: If you enable Print It! mode for topics using the Play Modes property, you can use this option to determine which document style is included when you publish formats that support Print It! mode. Choose "none" if you do not want publish Print It! mode (even when topics are assigned this mode). By default, Job Aid and System Process are the only options for Print It! mode. However, other styles can appear as choices by copying the PrintItStyle setting XML from Style.xml file of the Job Aid or System Process document styles and pasting the XML into the document style that you want included in the Print It list.

- Also, if you are using a custom category to store the styles, you must make sure you choose it in Publishing Preview on the Tools, Options dialog box. The style you choose here will be the default when you publish any format that supports Print It! mode. However, you can also change the document style options when you publish content.

With the Player output, you also have the following presentation options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marquee color</td>
<td>Set the color for the marquee (or highlight) that appears in See It!, Try It! and Do It! modes. The default marquee color is red.</td>
</tr>
<tr>
<td>Play audio</td>
<td>- All available sound option (default) - Play any available sound files during playback.</td>
</tr>
<tr>
<td></td>
<td>- Keyboard and mouse clicks - Play only keyboard and mouse clicks during playback in See It! mode. These sounds are FLV files, delivered in the Audio folder of published content, that play automatically when keyboard and mouse clicks occur in See It! mode playback.</td>
</tr>
<tr>
<td></td>
<td>- No Sound - Disables sound during playback. <strong>Note:</strong> The user must have Flash 9.0 or greater installed to play sound in the Player.</td>
</tr>
<tr>
<td>Show introduction text</td>
<td>This option controls whether the Introduction frame appears when a topic is played in the Player. Select this option to show the Introduction frame as the first frame during playback and deselect it to suppress the frame.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable users to change their Player</td>
<td>If you enable this option, the Player will include a Preferences link that enables any user to change the settings. If you disable this option, the Preferences link does not appear in the Player.</td>
</tr>
<tr>
<td>preferences</td>
<td></td>
</tr>
<tr>
<td>Enable skipping in Try It! mode</td>
<td>Select this option to enable the user to advance to the next step in Try It! mode by pressing Enter instead of performing the action in the bubble.</td>
</tr>
<tr>
<td>Enable Direct Do It!</td>
<td>When a user launches Player content in a context-sensitive manner from a target or web application and only one topic is returned, the topic is automatically launched in Do It! mode when this option is on. This option is off by default. Note that the topic must also be configured for Do It mode using the Play modes property. You can close Direct Do It and display the full TOC with the View Outline link on the Action menu.</td>
</tr>
<tr>
<td>Key combination for advancing in Do It! mode</td>
<td>Configure a key combination for advancing to the next step in Do It! mode, if you do not want to use the default combination</td>
</tr>
<tr>
<td>Default playback mode</td>
<td>This option controls the default mode launched when double clicking on a topic in the outline. The default is Try It! mode.</td>
</tr>
</tbody>
</table>

**Preview Defaults**

Use this page to configure the default publishing style used for previewing documents from within the Developer, as well as options for displaying content in the Concept pane of the Outline Editor.

- **Publishing Styles:** This option controls the category of publishing projects that is used when you preview any of the output formats. By default, the Developer includes one category of publishing projects but you can also create your own by copying and modifying the delivered publishing projects, or by importing publishing project documents from another author. If you do this, you can then use this option to choose the category that you want to use when you preview a document.

  The list of styles that appear in the Preview toolbar list is determined by the category selected here and the language of the content. If there are no styles that can be previewed based on the selected language, then the language of the Developer is used. If there are no styles that can be previewed based on language of Developer, then the Preview toolbar is disabled. Also note that the Preview list appears in the language of the Developer.

- **Outline Editor:** This option allows you to control the display of linked content in the Concept pane of the Outline Editor Player view as you navigate through documents in the outline. This option is very useful if you have linked multimedia-based content that you do not want launch and play as you navigate through an outline. By default, any linked document in Concept pane displays as you click a document in the outline. However, you can turn off the display of all linked content or selectively turn off the display based on document type such as package, web page, and URL. If you turn off the display completely (by choosing the All option) or by document type, a message appears in the Concept pane of the Outline Editor telling you how to preview the content by clicking on the Concept pane toolbar.

**Recorder Defaults**

Use this page to configure the following Recorder defaults:
• Screenshot Capture: use the following options to control the mode of the recorder during recording:

Manually record screenshots: Default recorder behavior that requires a PRINTSCREEN to capture a screenshot and another PRINTSCREEN to capture the associated action.

Automatically record screenshots: Recorder behavior that requires a PRINTSCREEN to start the recording process and a PRINTSCREEN to end the recording process. All frames and actions (with the exception of point events) that occur between the two PRINTSCREENS are recorded.

**Tip**: Automatic recording should be used when you know the system process you are going to record well. Since Automatic recording records every action you perform, it will also record any actions you perform inadvertently or incorrectly. You will then have to edit the topic in the Topic Editor to correct any errors. Since Manual recording requires you to press PRINTSCREEN after each action you perform, you have the opportunity to rehearse the next step without it being recorded. If the action you performed does not give the desired result, you can immediately correct it by performing the correct action before you press PRINTSCREEN.

Time to hide recorder window before screen capture: As you record a topic, the appearance of some screens in the target application may change after a certain amount of time has elapsed. For example, some menus expand to display additional options after the mouse pointer hovers over the menu for a few seconds. To capture the correct screenshot, you can set a delay time between hiding the Recorder and capturing the screen.

• Screenshot capture key: By default, the Recorder uses the PRINTSCREEN key to capture screenshots and actions for a topic. If the PRINTSCREEN key is difficult or inconvenient for you to use, you can change the Recorder screenshot key. You can use any of the function keys, or a combination of any of the function keys (F1 thru F12) and the ALT key, CTRL key, and/or SHIFT key.

If you change the Recorder screenshot key, you should select a key or key combination that is not used in the target application for another purpose. For example, pressing the F1 key in some applications opens a Help window. Therefore, for those applications you would not want to use the F1 key to capture the screenshots.

• Sound Recording: Use these options to control how sound is recorded with a topic.

Record sound with topic: By default, the recorder is not set to record sound with a topic. Click this option to enable sound recording on the Recorder. The display of the Recorder depends on the state of this option and the Screenshot capture mode (Automatic or Manual). See Recorder Logic for more on Screenshot capture mode.

Sound pause key: By default, the Recorder uses the PAUSE key to pause sound recording for a topic. If the PAUSE key is difficult or inconvenient for you to use, you can change the Recorder sound pause key. You can use any of the function keys, or a combination of any of the function keys (F1 thru F12) and the ALT key, CTRL key, and/or SHIFT key.

If you change the Sound pause key, you should select a key or key combination that is not used in the target application for another purpose. For example, pressing the F1 key in some applications opens a Help window. Therefore, for those applications you would not want to use the F1 key to capture the screenshots.
Get Started

- Open the Topic Editor: Use the following options to control the launching of the Topic Editor during recording:
  
  At the end of recording: Opens the Topic Editor only after you have finished recording the entire topic. This option allows you to complete all the steps in the task and then go back and confirm the actions and bubble text.
  
  After each screenshot: Opens the Topic Editor after you record each frame. This option allows you to confirm the action and bubble text after every step.

**Note:** Recorder options are stored per user. These defaults are used regardless of the Library being accessed.

**Spelling Defaults**

Use this page to control the behavior of the Spell Check tool. When you create any document, you must choose a default language for use during a spelling check.

**Note:** These options do not apply to Japanese and Chinese content since the Developer does not provide spelling dictionaries for these languages. During spell check, the Developer ignores any document that has a Japanese or Chinese Language property.

- Ignore words in UPPERCASE: You can choose to have words that appear in all uppercase letters be identified as errors or ignored.

- Try to split compound words into two words: The Spell Check tool identifies compound words as errors. You can choose to have the Developer try to split such terms into individual words.

- Custom dictionary: As content authors work with the Spell Check tool, they may want to add words to a custom user dictionary. This dictionary allows authors to indicate words that should not be identified as misspellings during future spelling checks. By default, all content authors working with a shared installation of the Developer use the same custom dictionary, Userdic.tlx. Content developers do, however, have the option to create their own custom user dictionaries, to add dictionaries used by other content authors, or to remove dictionaries. If you want to create a new dictionary for use during spelling checks, you can do so. Creating your own dictionary allows you to control which words are identified as misspellings during your spelling checks without affecting the userdic.tlx list used by all content authors.

  Another content author may have already created a dictionary file that you want to use to check the spelling of content as well. You can easily add an existing dictionary to the list of lexicons used in the Spell Check tool. The existing dictionary file is not required to be a .tlx file.

  You may decide that you do not want to use a custom dictionary that you have added. You can easily remove a lexicon file from the list of dictionaries you use with the Spell Check tool. Removing the file does not delete the dictionary file from the location where it is stored; it simply removes it from the list of files you can use during a spelling check.

**Target Applications**

The Developer recognition engine has “targeted” solutions for recognizing context in browser-based applications. These solutions are built specifically for each application that has a targeted solution. The Recorder currently auto detects whether the application being
recorded is a targeted solution by inserting and running JavaScript detection methods for each targeted application in the web page being recorded. If none of the scripts recognize the page as part of a targeted application, the recognition engine associates a generic SmartMatch context with the page.

If you have many target application enabled (all target applications are enabled by default) the time needed to determine that a recorded page does not belong to any one of them can be long and can slows down recording. You can alleviate this issue by disabling target applications that you do not use on this page.

Disabling a targeted application does not mean turning it off completely. There is a fast version of the application detection script that can not recognize all pages in the targeted application, but still work with reasonable accuracy, and much faster than the full script. The fast script is still run for disabled applications.

The Recorder displays a context icon that identifies the type of the context (ExactMatch, SmartMatch, or NoMatch) being recorded.

**ExactMatch Recognition**

- When you start recording in a targeted application, the recognition triggered by the first event may suffer some delay, depending upon the position of the application in the enabled applications’ list. Since the rest of the recording session is likely to take place in the same application, the Developer will move it to the top of the enabled list. This way, the recognition of subsequent pages in the same application is fast.

- At the end of the recording session, the Recorder will save a list of the most recently recorded targeted applications. Before the next session starts, the recorder will restore the applications order from this list. If you record in the same targeted application, this will eliminate the initial delay.

- The Developer collects usage data on targeted applications. The number of times a context in a targeted application is recorded is accumulated and stored. The Developer also stores the date/time of the last usage. This helps to determine what targeted applications the author recorded against recently. Usage data is stored on the Windows user level on each workstation and is not exported or imported with content defaults.

**SmartMatch Recognition**

- In non-targeted browser applications, SmartMatch recognition is in effect. To avoid delays, you are able to configure the targeted applications you also record against. For the applications you exclude, the Developer will use the fast scripts.

This Configuration page lists all targeted applications and indicates the frequency of usage in the Use column. For example, frequently used applications are those that launched within the last 30 days. Rarely-used applications are those launched longer than 30 days. Applications with a value of Never are those that have never been launched. You can turn applications off and on in this dialog box by clicking the appropriate checkboxes next to the target application (or use the Select All/Clear All buttons).

Click **Both ExactMatch and SmartMatch** radio buttons to display a list of applications to enable or disable. Or click **SmartMatch Only** to enable SmartMatch for all applications.

All applications are referenced by their user-friendly names; however, you can provide your own text for each application in the Description column. These descriptions are exported and imported with content defaults.
The Recorder detects when recognition is getting slow and provides you with visual feedback. For example, the Recorder will provide a hint as to why recording is slow. You can then activate this dialog box from the Recorder and disable/enable target applications as needed.

If the Recorder recognizes a disabled application, a warning message appears to provide visual feedback that you should enable it for improved recording.

The enabled/disabled state of the applications will export and import together with content defaults. This way, administrators can set up a default environment.

If a new release or service pack adds a new targeted application, it will appear in the list as enabled.

**Convert Content from a Previous Version**

You can convert content from a previous version of the Developer to the current version. The conversion process imports your content into the Library you are currently using and leaves it intact for use in the previous version as well. This process may take some time depending on the size and complexity of the content you convert.

---

**Note:** You can convert content from version 2.5 and above. You do not need to convert content from version 9.1 and above.

---

During the conversion, various folders and subfolders are created in the Library to store the converted documents such as modules, sections, topics, web pages, packages, glossaries, and so on. You should review the content conversion logic for more information on how content is converted.

Use the Library to display the folders and documents that result from the content conversion.

Before you convert content, you need to know the location of the OnDemand.ini file that contains references to the previous version content that you want to convert.

---

**Warning!** Before you convert content from a previous version, all content authors should be logged out of the Developer environment that contains the content to be converted.

---

The following are general guidelines for converting content from a previous version into a content Library:

- You can convert multiple titles from a previous version into one content Library. You can also convert content from multiple Developer installations into one Library.

- Content in multiple languages can be converted into one content Library.

- You can convert the same content multiple times. If you convert the same title from a previous version multiple times, a number is appended to the "root title" folder name in the Library. For example, if you convert a title called "My Content", a root title folder with the same name is created in the Library. If you convert this title again, a new folder called "My Content_1" is created and the original "My Content" folder is left intact. When you convert content multiple times, you are creating duplicate documents in the Library.

- TPC and Saved Publishing Setting (.xos) files are not converted.
Multi-user Considerations

After you convert content from a previous version, the converted content is stored locally and checked out to you. To make the converted content available to other authors in a multi-user environment, you must make sure you are online in the Developer and then you can check in the converted content. After you have checked the content in, other authors can proceed to check out the content they want to use and edit. To ensure that all converted documents are checked in, it is recommended that you select the main folder and check in the content. However, note that, if the content you converted resulted in the creation of new packages for custom icons, the packages are not checked in unless you explicitly check them in from the System\Icons\Custom folder. You can also use the Check In All command to check in all content in the Library at one time.

If you click the Keep checked out option on the Check In Comment dialog box during check in, the content is checked in and the version number increased but the document remains checked out and unavailable for edit by other users.

See Check In and Check Out Documents in Use the Developer in a Multi-user Environment for more information.

Content Conversion Logic

Since the content structure from previous versions is different than the current version, the following rules and logic are applied during the conversion process:

**Document Conversion**

A title is converted to a module document and stored in a folder of the same name below the root folder in the Library.

A module is converted to a module document with the name of the module. Each new module document is stored in a subfolder (of the same name) beneath the folder that was created for the converted title.

A lesson is converted to a section document with the same name of the lesson. The section document is stored in the same folder as the module to which it is linked.

A topic is converted to a topic document with the same name and stored in the same folder as the section to which it is linked. Both empty and recorded topics are converted.

---

**Note:** There are several reserved characters / \ ? < > : " | that cannot be used in Library folder names. If these characters are detected in content you covert, they are replaced by an underscore (_).
Font Substitution
The current version supports only TrueType and Open Type fonts. If your content uses any other font type, a matching TrueType or Open Type font is used, if possible. In cases where a match can not be made, the font definition in the original content is left intact; however, it should be changed in the converted content.

Infoblock Conversion
In previous versions, Infoblocks were stored per module. In the current version, they are available for the entire Library and stored in the folders that are created for modules during conversion.

The term Infoblock is no longer used in the current version. Infoblocks are converted into web pages, packages, or URL/File links depending on the type of Infoblock in the original content. For example, Plain Text and Web Page Infoblocks used as concepts are converted to Web Page documents and Document and Bitmap Infoblocks are converted to Package documents. Web Page Infoblocks that are not used as concepts such as links on topic frames are not converted to Web Page documents but are linked to frames as URLs.

Depending on your content, it may be necessary to create multiple documents in the converted content to reproduce your original content. For example, if you have a bitmap image Infoblock linked to a module as a concept, the Converter will create a Package document that contains the image (in PNG format). It will also create a Web Page document that has a link to the image in the Package document. In this case, the Package document will have the same name as the Bitmap image Infoblock ID and the Web Page document will have the same name as the Module document to which it is linked as a concept. Since the new Web Page is used as a concept link, the text "_Concept" is also appended to the document name.

The Infoblock ID is converted as the document name during conversion.

Web page Infoblock tooltips are converted. In previous versions, the tooltip text was part of the Infoblock itself. Now the tooltip is part of the document that links to the attachment.

Infoblocks are converted as follows:

<table>
<thead>
<tr>
<th>Original Infoblock Type</th>
<th>Is Converted To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Text</td>
<td>Web Page</td>
</tr>
<tr>
<td>Web Page</td>
<td>URL (if the web page is used as a concept, a new web page is created that contains the URL link).</td>
</tr>
<tr>
<td>Bitmap (stored within content or stored with content at publishing)</td>
<td>PNG File within a Package</td>
</tr>
<tr>
<td>Bitmap (stored external to content)</td>
<td>URL</td>
</tr>
<tr>
<td>Document (stored within content or stored with content at publishing)</td>
<td>File within a Package</td>
</tr>
<tr>
<td>Document (stored external to content)</td>
<td>URL</td>
</tr>
</tbody>
</table>

Custom Infoblock Icon Conversion
Standard icons that are installed in the previous version are not converted; however a similar set of standard icons are installed with the new version. Standard icons that are installed in the new version are stored in the System/Icons/Standard folder in the Library.
A custom icon is converted and stored in the System/Icons/Custom folder in the Library. Each custom icon is converted from a bitmap image to a GIF image that is added to a new Package document with a name of Custom. If there are multiple custom icons, each Package will be named and numbered consecutively (for example, Custom, Custom1, Custom2, Custom3, and so on). This will minimize the number of duplicate names, but it may not completely eliminate duplicate names, since multiple authors can be converting at the same time.

Since custom icons are stored at the module level, there may be identical custom icons in different modules. The Converter will detect if the icons are identical and, if they are the same icon, only one custom icon Package document will be created.

**Glossary Conversion**

In previous versions, glossary terms are stored per module. In the current version, Glossary documents that contain glossary terms are stored in the Library.

All glossary terms for a module are combined into a separate Glossary document and stored in the same Library folder where the module resides. In addition, each Glossary document has the same name as the module.

Glossary term Infoblocks are converted to either Web Page or Package documents or URL/File links depending on the type of Infoblock that was used. See Infoblock Conversion for more information.

Markup Conditions defined for each term and glossary markups in the original content are converted. However, in previous versions, the target of a glossary link could link to itself; for example, the definition of the term could include the term itself. This is not allowed in the current version and therefore, these markups are not converted.

**Keyword Conversion**

In previous versions, keywords are stored per title and then assigned to topics. In the current version, keywords are stored as a property of the topic to which they are assigned. There is no Keyword Editor in the current version.

Any keyword that is assigned to a topic in the original content is converted and assigned to the same topic in the current version. Trailing spaces are trimmed from keywords during conversion. Keywords that are not assigned to any topic in the original content are not converted.

**Template Conversion**

Any customizations that you have made to templates are not converted.

**Optional Name Conversion**

The Optional name field is dropped from the Topic Editor. For topics containing optional names, the Converter converts the Optional name text to Object name text. If a topic contains both Object name and Optional name text, the Optional name takes precedence over the Object name.

**Bubble Text Language Markup**

Any bubble text that was marked up for a different language is not converted as this feature is not available in the current version.

**Sound**

Any sound that you may have created for custom bubble text, or Introduction or End frames is converted with the content. The sound is embedded in the topic and becomes part of the topic itself. It will not be converted to a separate file in the Library. You can edit it as necessary using the Sound Editor in the Topic Editor.
Publishing Styles
Any customization that you may have made to any publishing style is not converted (for example, a logo replacement for the Player). You will need to reapply any customization to the Publishing Project documents installed in the current version (System/Publishing/Styles/category/language code folder).

Role Conversion
In previous versions, roles are stored per title. In the current version, roles are stored in a master Role document in the Library and then assigned to topics using the Roles Property. When you install the current version, the Library is automatically populated with a master Role document for each supported language. The appropriate language property is preset for each of the master Role documents and the name of each document is Role.<language code>. For example, Role.en for English, Role.fr for French, and so on.

If you convert a title in a language for which there is no default master Role document, a new Role document is created with the language property of the converted title.

Duplicate roles are removed during conversion.

If you convert multiple titles at the same time that have different roles, the roles in all titles are added to the appropriate master Role document (based on language of the titles being converted).

In addition to adding roles to a master document during conversion, role assignments to topics are also made. In the previous versions, there were the following options when defining roles that impact how role assignments are made in converted content:

- If a Topic was set to “never appear” when role filtering is enabled, no roles are assigned to topics.
- If a Topic was set to “always appear” when role filtering is enabled, the Converter determines the list of roles that were available for the specific title, and assigns all roles to the topic.

Multi-user Considerations
During conversion, the appropriate Role document (based on the language of the title you are converting) is automatically checked out and all roles from the original content are added to the document. If a master Role document can not be checked out during conversion, the content is converted and the roles are assigned to topics. When the master Role document becomes available, all additional roles can be automatically added to the master document.

To convert content:
1. Launch the Developer and log into the Library where you want to store the converted content.
2. On the Tools menu, point to Convert from 2.x, and choose Content.
3. Click Next on the Welcome screen.
4. Browse to the location where the OnDemand.ini file is stored in the content from the previous version and click Next.
5. Select the titles that you want to convert by marking the checkbox next to each title. By default, all titles are selected and clicking the checkbox deselects a title.
Choose as many titles as you want. You do not have to convert all titles at one time but you must select at least one title to proceed.

6. Click **Convert** to start converting content. The final screen displays the titles that are converted. You can click the View activity log link to display the results of the conversion with comments, if appropriate.

7. Click **Finish** to return to the Developer.
2. Use the Developer in a Multi-user Environment

This chapter describes functionality that is specific to using the Developer in a multi-user environment such as:

- Library Login Profiles
- Online and Offline Operation
- Document Check In and Check Out
- Document Version Control
- Library and Folder Synchronization
- Document Deletion and Recovery
- Workflow Properties
- Sample Custom Views

The remaining chapters describe functionality that is common to both a single-user and multi-user environments. However, you will find various multi-user considerations in places where common functions vary depending on whether you are using the Developer in a single- vs. multi-user installation.

Create and Manage Login Profiles

When you start the Developer for the first time in a multi-user environment, you are asked to create a login Profile. A Login Profile identifies the server where the content Library is installed as well as your login credentials. If you plan to access multiple content libraries, you need a separate login Profile for each.

Note: You can configure the login Profile so that you do not need to enter a user name and password each time you login to a Library.

To create a login Profile, you need the following information:

- URL of the Library location (for example, http://server/virtual directory)
- Login credentials such as user name and password (Standard authentication only)
- a Profile name of your choice

Add a Login Profile

The login Profile wizard walks you through the following steps to create a login Profile.

Step 1: Identify the Library Location
The first step in creating a login Profile is to identify the server URL where the content Library is installed.

The URL must contain the virtual directory that points to web service (asmx files) and web configuration files. This allows the Developer to communicate between the local document cache and the server-side database.

Note: The Library location is not case-sensitive.
When you enter the Library URL, the Developer determines whether the Library is configured for Standard or Windows authentication and prompts for the appropriate login credentials.

**Step 2: Enter Login Credentials**
Your administrator will predefine each author on the server based on whether the server is configured for Windows or Standard user authentication. When you create a login Profile that connects to the server, you must enter the same login credentials that the administrator defined on the server. You will receive an error message if your login credentials do not match those defined on the server.

- If the server is configured for Windows authentication, the Use my current Windows login account option is automatically selected and your Windows user name and password are used. However, you can use a different login account if your administrator used different values when adding your account on the server. Please note that if you enter a different user name, you must include the domain or machine name as the prefix to the user name separated by a backslash (domain name\user name).

- If the server is configured for Standard authentication, the Use a different login account option is automatically selected and you are prompted to enter the same user name and password that the administrator created for you on the server. Your administrator should provide you with these credentials before you create a login Profile.

Mark the Save my password as part of this profile option if you do not want the Developer to prompt you for your password each time you log in using the profile.

**Step 3: Name the Login Profile and Login**
The next step is to name the login Profile. You will use this name if you have multiple Profiles that you can use to switch between content Library servers. Also, if you create multiple profiles, you can configure one as the default that is automatically used every time you launch the Developer. The name of the active Profile appears in the title bar of the Developer.

**Step 4: Choose a Data Storage Location**
As you use the Developer to create, view, and edit documents that are stored centrally on the server, a copy of each document is downloaded and stored locally on your computer. In this step, you can either accept the default data storage location or choose a different folder on your computer. Click Browse if you want to change the default folder or click Next to accept the default folder. The folder that you select must be empty.

*Note:* You must choose a folder on your local computer. Network drives are not permitted.

**Step 5: Complete the Login Profile**
The last step to complete a new profile is to confirm your entries and choose to login with the new Profile or return to the Profile Editor.

To add a login Profile:

1. On the *Tools* menu, choose 🗂 *Profiles*.
2. Click *Add* to start the Profile wizard.
3. Click *Next* to display the Library Location page.
4. Type the URL to the server and virtual directory that contains the content Library that you want to access using this login Profile (for example, http://server/virtual directory). Your administrator will provide you with this information.

5. Click **Next** to display the Credentials page.

   The Developer automatically detects whether the server was installed using Standard or Windows authentication and disables the login credential options that are not valid. For example, if Windows authentication was installed, the Use a Different Login Account option is disabled. If Standard authentication was installed, you must enter a valid user name and password. Your administrator will provide you with this information.

6. Enter your login credentials and click **Next** to display the Profile Name page.

7. Type a name for the login Profile. Consider using the name of the server (Library) to identify a profile when you will have multiple Profiles that connect to different servers.

8. Click **Make this my default profile** to configure this profile as the default that is used when you launch the Developer.

9. Click **Next** to display the Data Storage Location page. Click **Browse** to change the data storage location, if desired.

10. Click **Next** to complete the Profile Wizard.

    The last page in the Profile Wizard displays a summary of the Library location, login credentials, profile name choices, and data storage location choices you have made. Before you complete the wizard, you can also choose to start the Developer automatically and log in using the default profile or return to the Profile Editor and continue to add or edit profiles.

11. Choose an option and click **Finish**.

### Edit a Login Profile

You can edit any login Profile that is not in use and change the Library URL, profile name, or the location of the local cache. If you try to edit a login Profile that is currently in use, you must first exit the profile.

To edit a login Profile:

1. On the **Tools** menu, choose **Profiles**.
2. Select a profile from the list.
3. Click **Edit** or **Exit Profile** if you selected a profile that is in use.
4. Make the necessary changes and click **Finish**.

### Delete a Login Profile

If you have multiple login Profiles to different Libraries, you can delete any login Profile that is no longer needed. You should avoid deleting a login Profile that is currently in use or those that you may still want to use to connect to different servers. You should also ensure that you do not have documents checked out from a server before you delete a profile that connects to that sever. Deleting a login Profile discards any changes that the author made to checked out documents.

To delete a login Profile:

1. On the **Tools** menu, choose **Profiles**.
2. Select a profile from the list.
3. Click **Delete**.

You are warned that any changes to documents that the author has checked out will be discarded. You may want to login first and check in all documents before you proceed to delete the Login Profile.

**Switch the Library Login**

If you have multiple login Profiles, you can switch between Libraries without having to close the Developer. To do this, you must have a login Profile for each Library. You can perform the switch from the Profiles dialog box or by clicking **Connection State** in the bottom right corner of the Developer screen and choosing the Switch Profile command.

To switch profiles from the Profile dialog box:

1. On the **Tools** menu, choose **Profiles**.
2. Click a profile for a different Library.
3. Click **Open** to switch to the Library.

To switch profiles from the Connection State icon:

1. Click the **Connection State** icon in the lower right corner of the Developer screen.
2. Choose **Switch Profile** from the menu and follow steps 2 and 3 above.

**Change Password**

You can change your current password at any time while you are working online. You are prompted for the new password the next time you log in.

**Note:** If you stored your password in a login Profile, it will be automatically updated when you complete the password change.

To change your password:

1. Make sure you are working online.
2. On the **Tools** menu, choose **Change Password**.
3. Enter your current password.
4. Type a new password.
5. Type the new password again to confirm the change.
6. Click **OK**.

**Work Online or Offline**

In a multi-user installation, you can use the Developer in either an online or offline mode. When you work online, you are connected to the content server through the network, an intranet, or the Internet. In this mode, you can access any document that is checked in to the server. When you access any document while online (by opening it in an editor and viewing its content), a read-only copy of the document is automatically downloaded to a local cache on your computer. If you want to edit a document that is on the server, you must first check out the document. When you do this, an editable copy of the document is
downloaded to your local data storage location. After you make changes to the checked out document, you must check the document back in to the server to save the changes to the content server.

The default location for the local data storage location on your Microsoft Windows computer is stored in C:\Documents and Settings\<your user name>\Local Settings\Application Data\UPDev5. The default location for the local data storage location on your Microsoft Windows Vista computer is stored in C:\Users\<username>\AppData\Local\UPDev5. However, you can determine the location of the local data storage location when you create a login profile for the first time.

You can set the maximum available disk space for the local data storage location using the Library settings in the Developer category in Tools, Options.

**Note:** As you work with documents, you may see “downloading” messages when documents in the Library are downloaded from the server to your local data storage location.

---

**Client - Server Synchronization**

When you are working online, the Developer (client) installation on your local computer automatically synchronizes with the content server approximately every minute or so. The Library then updates to display all of the changes that have been checked in to the server, including new documents and folders, changes to folder and document names or properties, deleted documents, and so on. The Outline Editor also displays some of the results of this synchronization (for example, changes to document names), except for changes that were made to the outline structure (the links between the documents). To display any structural changes to the outline from the Outline Editor, you must refresh the display manually using the Refresh command on the View menu or by pressing F5. The Library also automatically synchronizes when you use commands on the Document menu such as Check In, Check Out, Get, Get All, and so on. However, you will still need to perform a refresh in the Outline Editor to see the any structure changes in the outline you have open.

**Work Offline**

You can also work offline where you are not connected to the server. You are working strictly with the documents that are stored in your local data storage location. You might choose to work offline for the following reasons:

- There is no connection available to the server (such as on an airplane or at another remote location with no connectivity to the content server).
- There is a connection to the content server, but it is slow (such as a dial-up connection).
- The server is unavailable for a period of time for technical reasons (such as maintenance or a power outage).

When you work offline, you can edit only the documents that you have previously checked out; however, you can view other documents that you have in your local cache that you do not have checked out. You can also create new documents but you cannot delete documents under version control when you are offline.

**Note:** If you are working online and your connection with the server stops (for example, the server goes offline unexpectedly), the connection state will change to Disconnected. When the server is available again, the Developer connects automatically, and the state changes back to Online.
If you plan to explicitly work offline, you should always check out documents that you need to edit before going offline. You may also want to use the Get command from the Document menu to ensure that you have local copies of the most recent documents that you want to view in addition to those that you want to edit. If you go offline and do not have copies of some documents in your local data storage location, those documents will be unavailable to you. To remedy this, you will need to go back online and "get" the documents that you need.

**Note:** When you create a login Profile and log in to the Developer for the first time, all documents in the System folder are automatically downloaded to your local computer. If another author checks in modifications to any of these documents such as a master role list document or publishing style, you should periodically go online and download updated documents using the Get command.

**Server Connection States**
There are four connection states in a multi-user environment: Online, Disconnected, Offline, and Offline/Login failed. The Connection State icon in the bottom right corner of the Developer screen identifies the state in which you are currently working.

- **Online:** You are currently connected to the server.
- **Disconnected:** You do not have a connection to the server, but would like to. You can get in this state if the network connection is dropped. When this happens, the Developer will regularly try to reconnect to the server.
- **Offline:** You explicitly chose to work offline. The Developer does not try to reconnect to the server until you explicitly go online.
- **Offline/Login failed:** The user password is incorrect, or the account does not exist on the server. You are notified of the failure to log in, and the Developer remains offline. You may also experience this state if the administrator changes your login credentials while you are working online.

**Switch Between Online and Offline Operation**
You can manually switch the Developer between online and offline modes, even while you are still connected to the server.

To manually switch between online and offline operation:

1. If you are currently working online and would like to work offline, choose **Work Offline** from the **File** menu or click the **Connection State** icon at the bottom right corner of the Developer screen and choose **Work Offline**.
2. Repeat the procedure to switch from offline to online mode.

**Get Documents for Offline Use**
If you want to work offline, there may be documents that you want to refer to, create links to, or simply view but not edit. You do not need to check these documents out from the server, since you do not want to change them. In most cases, you may already have local copies of the documents that you may need or want if you accessed these documents while working online. However, in some cases, you might not have accessed some documents that you may want to have in your local data storage location when you go offline. In this case, you use the Get command to retrieve read-only copies of these documents before you go offline.
If you are not able to identify the specific documents that you need to work offline, you can use the Get All command to download all documents in the Library to ensure that you have everything you need. However, this may take some time to download depending on the number of documents that need to be downloaded, their sizes, and the connection speed. When you use this command, there is no need to select any documents.

To get specific documents for offline use:

1. Identify the documents that you want to download locally and navigate to them using the Library or Outline Editor.
2. Select the document(s) or folder containing the documents that you want to download.
   
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
   
   You can also right-click on your selection and choose Get.
   
   The Related Documents dialog box appears when you perform an action on any document that has links to other documents. You can choose to process only the document(s) you selected or to process your selection and all of the related documents.
   
   Click the View related documents link to display a list of the related documents if you are not sure whether you want to include related documents.
   
   After you have made your selection, click OK.
   
   You might also receive a message if some documents could not be processed because of other constraints. You can click OK to close the message box or click the View activity log link to view the results of the action.

To get all documents for offline use:


Check In and Check Out Documents

In a multi-user environment, you use the Developer to connect (online) to a centralized content server and share documents using a version control system that allows you to check documents in and out. When you check out a document, it is copied to your local computer for viewing or editing. The document is also locked on the server to prevent any other author from making changes (however, other authors can view it). When you check in a document, it is copied from your local computer to the content server and the lock is then removed, making it available to other authors.

You can check in an interim version of a document and leave it checked out while you continue working by clicking the Keep checked out option on the Check In Comment dialog box during check in. The content is checked in and the version number incremented but the document remains checked out and unavailable for edit by other users. However, other users can view the latest version of the content.

Any document in a Library can be checked in or out depending on its current state. For example, a checked out document can only be checked in and vice versa.

New documents are automatically checked out to you as well as any content that you convert. To make this content available to other authors, you must check it in.
Note: You must be online to check documents in or out.

You can check in or out one document at a time or multiple documents all at once. Just select the documents that you want from either the Library or Outline Editor. Also note that, from the Library, you can select folders on which to perform check in/out. In this case, ALL documents in the selected folders are processed. If any document in a folder has links to other documents in different folders, you have the option to process related documents.

You can also choose to include related documents during check in or out. For example, when you check a module in or out, you can choose to include all its related documents such as its sections, topics, web pages, packages, and so on. This option is available for any document type that can have links to other documents. If you check in/out a Library folder (which checks in/out every document in that folder), you can also check in/out related documents that are stored in any folder outside of the current folder that you have selected.

Important Note on Related Documents: The definition of related documents can vary based on specific operations that you can perform. For example, documents that are considered as related during check in/out operations are different than those considered during import/export. See the Link Related Documents topic in the Work with Document Editors chapter of the Content Development manual for more information.

To ensure that ALL documents are checked in/out, you should consider checking in/out content by a Library folder or use the Document, Check in All command.

Also note that if you check out a document with a related parent object, you must check out the parent document as well. For example, if you check out a topic that belongs to a section that is not checked out, you are prompted to check out that section as well.

Note: You can only check in/out documents from the Library or the Outline Editor.

You can open any document regardless of its check in/out state. However, if you edit a document that is not checked out to you and attempt to save it, you are given the option of saving the changes (i.e., check out the document, if available, and save the changes), save the document with a different name, or cancel without saving the changes.

Note: Saving changes to a document that is not checked out to you is not a recommended best practice. This functionality is designed to allow you to save changes to a document that was un-intentionally edited in Read-Only mode.

Check In/Out Indicators

As documents are checked in and out, icons appear to the left of the document name indicating the check in/out state as follows:

✔ indicates that the document is checked out to you.

阪 indicates that the document is locked and checked out to another author.

No icon indicates that the document is checked in and available to any author.

These icons appear in various places such as the Library and Outline Editor as well as on
document editor tabs and various views. Also note that additional columns in the Details view of the Library and Outline Editor display the check in/out state and version number. The Checked Out By column displays the name of the author who is currently using the document.

Check in a Document

Checking in a document updates the Library with any changes made to the document or documents or, if it is a new document, adds it to the Library. Check in also assigns a version number if the document has changed since it was checked out. For documents that you edited, the version number is incremented by 1. For new documents, the first version is NEW.

**Note:** You cannot check in a document that is open in a document editor. You must close the document and then check it in.

Comments

During check in, you can add comments that are attached to the document and can be accessed through the document history and reviewed by other authors. You will be prompted for comments in the following situations:

- If you check in a document that you have edited. If you check out a document but do not make any changes and then check it back in, you are not prompted to add comments. A new version number is also not applied.

- If you create a new document and check it in for the first time.

- If you check in multiple (new or changed) documents at one time. You can specify a different comment for each document, or you can click the Apply to all documents checkbox to have the same comment applied to all documents in your selection.

**Note:** Document comments are not exported or included in any published output.

You can check in an interim version of a document and leave the document checked out so you can continue editing. The version number is incremented by 1. Other users can view the updated content but cannot edit the document because it is still checked out.

To check in a document:

1. Make sure you are working online.

2. From the Library or Outline Editor, select one or more documents or folders containing the documents that you want to check in. These documents can only be documents that were previously checked out to you. You cannot check in a document that was checked out by another author.

3. On the **Document** menu, choose ![Check In].

   You can also right-click on your selection and choose Check In.

   The Related Documents dialog box appears when you perform an action on any document that has links to other documents. You can choose to process only the document(s) you selected or to process your selection and all of the related documents.

   Click the View related documents link to display a list of the related documents if you are not sure whether you want to include related documents.
After you have made your selection, click OK.

You might also receive a message if some documents could not be processed because of other constraints. You can click OK to close the message box or click the View activity log link to view the results of the action.

**Note:** You can also use the Check In All command to check in all documents that you currently have checked out rather than selecting specific documents.

To check in content changes but leave the document checked out:

1. Make sure you are working online.
2. From the Library or Outline Editor, select one or more documents or folders containing the documents that you want to check in. These documents or folders must be checked out to you.
3. On the **Document** menu, choose **Check In**.

   You can also right-click on your selection and choose Check In.

   The Related Documents dialog box appears when you perform an action on any document that has links to other documents. You can choose to process only the document(s) you selected or to process your selection and all of the related documents.

   Click the View related documents link to display a list of the related documents if you are not sure whether you want to include related documents.

   After you have made your selection, click OK.

   You might also receive a message if some documents could not be processed because of other constraints. You can click OK to close the message box or click the View activity log link to view the results of the action.

4. Type any comments about the document (if applicable) in the Provide check in comments.
5. Click **Keep checked out** to check in content changes but leave the document checked out.

   If checked, content changes are checked in and the version number is incremented. The document can be viewed but not checked out and edited by other users.
6. Click OK.

Instead of selectively checking in documents, you can also check in all of the documents that you have checked out at one time. However, please note that this action may take some time depending on the number of checked out documents that you have in the Library. Any document that you currently have checked out will be checked in to the server when you perform this action.

To check in all documents:

1. Make sure you are working online.
2. On the **Document** menu, choose **Check in All**.

**Check out a Document**

Checking out a document locks it in the database so that you are the only one who can edit it. The document is also downloaded to the local data storage location on your
computer. This allows you to disconnect from the network and work offline. The documents remain checked out and locked until you explicitly check them in to the server.

To check out a document:

1. Make sure you are working online.
2. From the Library or Outline Editor, select one or more documents or folders containing the documents that you want to check out. These documents can only be documents that are checked in to the server and not checked out to another author.
3. On the **Document** menu, choose **Check Out**.
   
   You can also right-click the selected document(s) or folder and choose Check Out.
   
   The Related Documents dialog box appears when you perform an action on any document that has links to other documents. You can choose to process only the document(s) you selected or to process your selection and all of the related documents.
   
   Click the View related documents link to display a list of the related documents if you are not sure whether you want to include related documents.
   
   After you have made your selection, click **OK**.
   
   You might also receive a message if some documents could not be processed because of other constraints. You can click OK to close the message box or click the View activity log link to view the results of the action.

### Cancel Check Out

If you check out a document and make changes but decide that you do not want to commit your changes to the server, you can cancel the check out and revert to the server version of the document. This action discards any changes you made to the document after it was originally checked out.

To cancel a document check out:

1. Make sure you are working online.
2. From the Library or Outline Editor, select one or more documents or folders containing the documents for which you want to cancel a check out. These documents can only be documents that are checked out to you.
   
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
3. On the **Document** menu, choose **Cancel Check Out**.
   
   The Related Documents dialog box appears when you perform an action on any document that has links to other documents. You can choose to process only the document(s) you selected or to process your selection and all of the related documents.
   
   Click the View related documents link to display a list of the related documents if you are not sure whether you want to include related documents.
   
   After you have made your selection, click **OK**.
   
   You might also receive a message if some documents could not be processed because of other constraints. You can click OK to close the message box or click the View activity log link to view the results of the action.
4. Click **Yes** to complete the action or **No** to abort.
Open a Checked-in Document

You can open any document such as a topic, web page, package, glossary, and so on, that is checked in to the server without checking it out. When you open a checked in document, a (Read-Only) label appears on the tab next to the document name.

If you edit a checked in document, upon exit you are given the option to save the changes, save the changes to a new document or discard the changes. If you choose to save the changes, the document is checked out and the content is saved. If you choose to save as a new document, click Yes when the Save Document message appears. If you choose to discard the changes, click No.

Module and section documents that are checked in do not display a Read-Only label when you open them in the Outline Editor. You can view these document types but you cannot edit them unless you check them out first. For example, to rename a module or section, you must first check it out. Also, if you attempt to link a document to a checked in module or section, you are always prompted to check out the document before you can continue.

Version a Document

The Developer’s version control system automatically keeps track of new documents and changes to existing documents as they are checked in and out of the server. A running history of each document is created as changes are checked in. The history of a document is a sequential list of the document versions starting with 1, along with their dates, who made the changes, and any comments made during check-in to explain the changes in the document. This history allows you to view a previous version of the document and/or roll back to a previous version. History is only available when you are online.

Note: A new or converted document is automatically assigned a version of NEW until it is checked in for the first time. The document is assigned a version of 1 after the first check in.

View Document History

History displays the list of document versions with the most recent version at the top of the list. History is not available for new documents that are not under version control. You must also work online to review document history.

For each document, the following properties appear:

- Version (automatically generated during the check in, delete, or restore process)
- Author that changed the document
- Date when the document version was created
- Comments that were either user-defined when the document was checked in or automatically generated based on actions that were performed on the document. For example, system-generated comments of Deleted and Restored appear when those actions were performed on a document.

You can open and view any version of the following document types:

- Topic
- Web Page
- Package
When you view any version of a document, the document opens in the appropriate document editor in read-only mode.

**Note:** You cannot view Module, Section, or Publishing Project documents from the History dialog box.

You can also roll back to previous versions of a document.

You can resize the History dialog box to display more information such as long comments or additional vertical space for historical records, etc. The Developer remembers the History dialog box size after you close it.

To view the version history of a document:

1. Make sure you are working online.
2. From the Library or Outline Editor, select ONE document. If you select multiple documents, the History command is unavailable.
3. On the **Document** menu, choose **History**.
4. Review the document history and choose to view or rollback to a previous version, if necessary.

**Roll Back a Document**

You can roll back a document to a previous version only if the document is checked in. Rollback replaces the current document content with the content of the version you selected for rollback. Rollback also creates a new version of a document. For example, if the current version of a document is 10 and you roll back to version 6, the Developer creates a new version number of 11 with the content from version 6. This new version of the document becomes the current document.

**Note:** You can roll back a document only if there is more than one version in the history and the document is checked into the server.

To roll back to a previous version:

1. Make sure you are working online.
2. From the Library or Outline Editor, select ONE document that is currently under version control and one that has more than one version.
3. On the **Document** menu, choose **History**.
4. Select a version of the document to roll back to. You might want to view the document before you perform a rollback to ensure that it is the version that you want since a rollback cannot be undone. You cannot view module and section documents.
5. Click **Rollback** to create a new version of the document. A comment is automatically provided to identify the document version that you rolled back to.
6. Click **Close**.
Refresh the Library and Outline Editor

When you use the Developer in a multi-user environment and you are working online, the Developer (client) installation on your local computer automatically synchronizes with the content server every minute. The Library then updates to display all of the changes that have been checked in to the server, including new documents (that are checked in) and folders, changes to folder and document names or properties, deleted documents, and so on.

The Outline Editor also displays the results of this synchronization, except for changes that were made to the outline structure (the links between the documents in the outline). To display these structural changes in the Outline Editor, you must refresh the display manually using the Refresh command on the View menu or by pressing F5. You can also manually refresh the Library using the same command or key.

The Library also automatically synchronizes when you use commands on the Document menu that involve the Library, such as Check In, Check Out, Get, and so on. However, you will still need to perform a refresh in the Outline Editor to see any changes in the content structure.

Note: Performing a manual refresh (F5) from the Library does not immediately refresh new (empty) folders that were created by other authors. The client-to-server synchronization will refresh the view of folders. However, new folders that contain documents will become visible when you perform a manual refresh.

To refresh the Library or Outline Editor:

1. On the View menu, choose Refresh.
   You can also press F5.

Manage Folder Conflicts

Regardless of whether an author is working online or offline, folder operations are performed locally on the client computer and then synchronized with the server. Synchronizations occur in the background if the author is working online or when the author switches from offline mode to online.

Unlike documents, folders are not checked out, so they are available at all times to all authors. Consequently, your local folder structure may differ from the structure on the server due to delays in synchronization while you are working online or because you are working offline. For instance, while working offline, you create a folder under a parent that another author has deleted. The server resolves these conflicts by following prescribed conflict resolution rules. The following tables describe the server side conflicts that can occur for folder operations performed on the client side and the rules the server uses to resolve them.

Add Folder

<table>
<thead>
<tr>
<th>Conflict</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent folder is renamed or moved.</td>
<td>The new folder is added to renamed/moved folder.</td>
</tr>
<tr>
<td>Parent folder is deleted (not yet purged).</td>
<td>Undelete parent and add new folder to it</td>
</tr>
</tbody>
</table>
### Conflict Resolution

<table>
<thead>
<tr>
<th>Conflict</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>New folder has same name, but different document ID, folder already on server under the parent.</td>
<td>The client folder is updated to the same document ID as the folder on the server. No new folder is created.</td>
</tr>
<tr>
<td>Folder on server already exists and was deleted.</td>
<td>Undelete the folder and parent(s) if needed (rule 2), and update client folder to server folder document ID (rule 3).</td>
</tr>
<tr>
<td>Parent does not exist; was purged.</td>
<td>Client folder is placed in root directory of Library.</td>
</tr>
</tbody>
</table>

### Move Folder

<table>
<thead>
<tr>
<th>Conflict</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Old parent folder is renamed or moved.</td>
<td>No problem. Folder moves to new location.</td>
</tr>
<tr>
<td>New parent folder is renamed or moved.</td>
<td>No problem. Folder moves to new location.</td>
</tr>
<tr>
<td>New parent is deleted (not yet purged).</td>
<td>Undelete new parent and move folder.</td>
</tr>
<tr>
<td>Folder already moved on server (parent folder on server already contains folder with same document ID).</td>
<td>No action necessary.</td>
</tr>
<tr>
<td>Another folder with the same name is found in the new parent.</td>
<td>Contents of move folder are moved into server side folder with same name. Purge (not mark as deleted) both server and client side old move folder.</td>
</tr>
<tr>
<td>A deleted folder with the same name is found in new parent.</td>
<td>Undelete the server side folder and parent(s) if needed and execute rule 5.</td>
</tr>
<tr>
<td>New parent does not exist (was purged).</td>
<td>Abort the move. Restore the folder to old location.</td>
</tr>
<tr>
<td>No conflicts.</td>
<td>Move the folder.</td>
</tr>
</tbody>
</table>

### Rename Folder

<table>
<thead>
<tr>
<th>Conflict</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder name already changed.</td>
<td>Override name with client name. Basically last one to change the name wins.</td>
</tr>
<tr>
<td>Folder marked as deleted.</td>
<td>Undelete folder, parents if needed and rename it.</td>
</tr>
<tr>
<td>Parent renamed or folder has moved.</td>
<td>No problem since parent identified by document ID. Renamed folder moves to updated parent.</td>
</tr>
<tr>
<td>Folder does not exists (was purged)</td>
<td>Abort operation. Folder will be totally removed when done.</td>
</tr>
<tr>
<td>No conflicts.</td>
<td>Rename folder.</td>
</tr>
</tbody>
</table>

### Delete Folder

<table>
<thead>
<tr>
<th>Conflict</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder not empty (contains undeleted documents or folders).</td>
<td>If all of the documents are checked in, delete the contents of the folder and then the folder. If server side folder contains checked out documents, folder is not deleted.</td>
</tr>
<tr>
<td>Parent folder is renamed or moved.</td>
<td>No problem since parent identified by document ID. Delete the folder.</td>
</tr>
</tbody>
</table>
Conflict | Resolution
--- | ---
Deleted folder was renamed. | No problem finding folder since identified by document ID. Delete the renamed folder.
Folder already deleted. | Do nothing - work already done.
Folder does not exist; was purged. | Do nothing - work already done.
No conflicts. | Mark the folder as deleted.

Delete and Restore Documents

You can delete a document only from the Library; however, the implications of deleting a document vary depending on a number of factors in a multi-user environment. Some of these factors include whether you are working online or offline, whether you are working from the Library or a document editor, and whether the document is new or under version control.

This section describes the implications of a deleting a document from the Library in a multi-user environment. Note that deleting a document from the Outline Editor deletes only the link between documents and not the actual document.

Delete Documents while Online or Offline

When you are working online, you can delete a document ONLY when it is new and not under version control or when it is checked in to the server. You cannot delete a document that is under version control but checked out to you. If you try to delete a version-controlled document that is checked out to you, you will receive the message "Not all of the documents you selected were processed". If you click the View activity log link, you will also see the comment "Document must be checked in to delete".

A document is deemed "under version control" after the first check-in to the server. From that point on, the Developer keeps track of changes that are made by various authors and automatically assigns a version number. This is important since a deleted document that is under version control is restorable, unless purged by your administrator. You can also roll back to earlier versions of a document that are under version control using the History command on the Document menu. It is important to note that new documents NOT under version control can be deleted but CANNOT BE RESTORED.

Note: You cannot delete versioned documents when the Developer is offline.

View Deleted Documents in the Library

Version-controlled documents that are deleted can be displayed and restored from the Deleted documents view in the Library.

View Deleted Documents and the Outline Editor

When you delete a document from the Library it is immediately removed from the folder in which it lives. However, the appearance of a deleted document in the Outline Editor is not as immediate. For example, if you delete a version-controlled module, section, or topic from the Library, the document name will continue to appear in the hierarchy of any outline in which it is used. The following icons identify a deleted, but restorable document:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Document Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Module</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Section</td>
</tr>
</tbody>
</table>
When you select a deleted document from the Outline Editor, you may see a message in either the Concept or Introduction pane that a linked document is deleted. For example, this message appears if you select a section with a linked web page (as the Concept) that has been deleted. To correct this situation, you should restore the deleted document or remove the link.

Non version-controlled documents that are deleted from the Library display the Missing Document link in the Outline Editor. Since these documents are not restorable, your only option is to remove the document from the outline using the Delete Link command on the Edit menu.

**View Deleted Documents**

The Deleted documents view shows documents under version control (checked in or out) that were deleted by all authors. Only documents that have not yet been purged by the administrator appear in this view.

For each deleted document, you can see the name of the document, the path where the document was stored when it was deleted, the deletion date, the name of the author who deleted the document, and the document type.

You can sort the documents and rearrange and resize the columns using the same procedures that you use to customize the details in the Library.

The only operation you can perform from this view is to restore any of the deleted documents list. You can also restore deleted documents from the Outline Editor.

---

**Note:** You cannot open a deleted document. It must be restored before you can view its contents.

To view deleted documents from the Library:

1. On the **View** menu, choose **Library**, if necessary.
2. Click the drop-down list on the View toolbar and choose **Deleted Documents**.

**Restore a Deleted Document**

You can restore any deleted document under version control to the Library and its linked position in the Outline Editor. The Deleted Documents view in the Library displays the documents that have been deleted, but not yet purged by the content Administrator. Documents that appear in this view are only those that have been deleted after being under version control (checked in at least once). New documents that are deleted after they are created or converted and never checked in can not be restored and do not appear in the Deleted Documents view. The Deleted Documents view and the Outline Editor let
you restore documents to their original locations in the Library as well in any outline in which they are used.

If the folder where the deleted document was stored has also been deleted, the deleted folder is restored when the document is restored. If the folder has been renamed or moved, the document is restored to the renamed/moved folder.

**Note:** You must be working online to restore a deleted document.

If related documents were also deleted, you have the option to restore only the selected document or all related documents.

Restoring a deleted document creates a new version that is viewable in Document History. A comment of “Restored” is automatically assigned so you know that the new version was a result of performing the Restore command.

**Warning!** You cannot undo a Restore command.

To restore a deleted document from the Library:

1. Make sure you are working online.
2. Switch to the Deleted Documents View.
3. Select the documents that you want to restore.
   - You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
4. On the *Edit* menu, choose *Restore*.
   - The Related Documents dialog box appears when you perform an action on any document that has links to other documents. You can choose to process only the document(s) you selected or to process your selection and all of the related documents.
   - Click the View related documents link to display a list of the related documents if you are not sure whether you want to include related documents.
   - After you have made your selection, click **OK**.
   - You might also receive a message if some documents could not be processed because of other constraints. You can click OK to close the message box or click the View activity log link to view the results of the action.
5. If prompted, choose the option to restore the selected document only or the selected document and all related documents and click **OK**.

To restore a deleted document from the Outline Editor:

1. Make sure you are working online.
2. Open the module or section in the Outline Editor that contains deleted documents.
3. Select the deleted documents that you want to restore and perform step 4 above.

**Managing Workflow**

The Properties toolpane contains special properties that allow authors to track document status or State. Unlike document properties, workflow properties are maintained on the server. To change them, you must be working online and the document must be either...
checked in, checked out to you, or checked out to another author. Workflow properties are not embedded with the document and do not travel with them on export, import or rollback. In addition, unlike other document properties, a document can not inherit a workflow property from a parent document.

**Note:** When you import content, the workflow properties for documents are reset to blank, which is the default value.

### Assign Content State

The State property is an editable property for communicating the status of a document. This is particularly helpful when collaborating with other authors in a development team. Authors can assign a state to documents from the master list defined by the administrator. The default list of States includes (blank), Not Started, Draft, In Review, and Final. Administrators can customize the list by adding, deleting or renaming the values.

A State value must be assigned; it can not be inherited from a parent document. You can assign a State to a single document or multiple documents at the same time, but only one State can be applied to a document. You can also view the State for a document in the Details View in the Library and the Outline Editor, but you can not assign State values directly from this view, unless you display the Properties toolpane.

**Note:** To assign or change the state of a document, you must be online. You can change the state of a document regardless of its check-in/out status.

The State property is a workflow property. Unlike other document properties, workflow properties are external properties that are saved to the server and do not travel with the document. State values are not included when you import or export content. The State field is set to blank for new documents imported into the Library. Since State values are not embedded with a document, they are not part of a document's version and do not roll back when you roll a document back to a previous version. However, since State values are saved to the server, when an author restores a deleted document to the Library, the value for the state is also restored.

**Warning!** Be careful when changing a property for multiple documents that already contain values for the same property. The new values you enter for the property overwrite any existing values for all selected documents.

To assign a State value to a document:

1. Make sure you are working online.
2. Display the Properties toolpane.
3. Select the document(s) to which you want to assign a state.
   - You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
4. In the **Workflow** category, click ▼ in the **State** cell.
5. Select a value from the list.

**Note:** To remove a value, choose the blank value from the list (first value).
Assign Document Ownership

In many enterprises, multiple authors often work together developing content in a team environment. Team leaders typically handle large projects by assigning specific development responsibilities to authors. The Owner property allows team leaders and authors to assign documents to themselves and other authors to track who is responsible for a specific document.

You view and change document assignments for a document using the Owner property in the Properties toolpane. Document assignments also appear in the Owner column in the Details View (and other views) in the Library and Outline Editor. You cannot edit the document Owner from a view, but you can sort documents by their owner assignment.

Owner values are set by selecting an author from a predefined Owner list which is populated based on the names of the authors defined by your administrator. When the administrator deletes an author's name from the system, the name is also removed from the list and the Owner property for documents assigned to that author is reset to blank. If the administrator renames an author that was assigned to a document, updates to the Owner property occur when the document is checked into the server.

---

**Note:** The Owner list displays the author's name for Standard Authentication and the author name and domain name for Windows Authentication.

---

You can change the Owner to a single document or multiple documents at the same time. Only one Owner can be set for each document.

To change the assignment of a document, you must be online and the document must be either checked in, checked out to you, or checked out to another author. When selecting multiple documents, the Owner property is not available if any of the documents in the selection are checked out to another author.

The Owner property is an external workflow property that is saved to the server and does not travel with the document. Therefore, Owner values are not included when you export a document.

---

**Note:** On import, the Owner value for documents is set to blank, which is the default value.

---

Since Owner values are not embedded with a document, they are not part of a document's version and do not roll back if you roll a document back to a previous version. However, if you delete a document with an Owner value and later restore the document, the server also restores the last value assigned to the document.

---

**Note:** Owner values are preserved by the server. If you delete a document and then later restore it, the server also restores the value.

---

To assign a document owner:

1. Make sure you are working online.
2. On the **View** menu, choose **Properties**.
   - You can also right-click any document and choose **Properties**.
   - You cannot open the Properties toolpane from the Topic Editor.
3. Select the document(s) to which you want to assign document responsibility. You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).

4. In the **Workflow** category, click ▼ in the **Owner** cell.

5. Select a name from the list.

**Use and Share Custom Views**

Several custom views of the Library are provided for each author in a multi-user installation. Each view is designed to show document attributes that are specific to a multi-user environment such as checked out documents, documents by State, documents by Owner assignment, and so on.

Each custom view can be customized, copied to create a new custom view, or removed. Any new custom view that an author creates can also be shared with another author.

**About the Sample Custom Views**

The following sample custom views are available in a client Developer installation (multi-user environment). These views appear on the View toolbar list for each author (if they were not deleted from your installation). You can use or modify any of these views or create new views to display documents based on custom criteria. You can also reset these views back to the original settings if changes were made.

- **All by owner** - This view lists all documents in the Library sorted by Owner and document Name. Documents appear in a flat view (no folder structure) and display Owner, State, Checked Out By, Version, and document Type columns.

- **All by state** - This view lists all documents in the Library sorted by State and document Name. Documents appear in a flat view (no folder structure) and display State, Owner, Checked Out By, Version, and document Type columns.

- **All checked out** - This view lists all checked out documents in the Library sorted by the author that has documents checked out (Checked Out By) and document Name. Documents appear in a flat view (no folder structure) and display Checked Out By, State, Last Modified Date, Version, and document Type columns. This view is useful for administrators who want to determine if there are any checked out documents in the Library before they perform software upgrades or other maintenance activity.

- **Checked out to me** - This view lists the documents in the Library that are checked out to the author that is running this view. The selected documents are sorted by document Name. Documents appear in a flat view (no folder structure) and display Checked Out By, Last Modified Date, Version, document Type, and Checked Out Hostname columns.

- **Deleted documents** - This view lists only deleted (but restorable) documents in the Library sorted by Owner and document Name. Documents appear in a flat view (no folder structure) and display columns for Original Location, Deletion Date, Deleted by, and document Type.

- **Details view** - This view lists all documents in the Library sorted by document Name. Documents appear in a folder structure and display columns for Checked Out By, Permission, Last Modified Date, Version, Type, Roles, State, and Owner.

- **Lost documents** - This view lists documents that are considered "lost" due to permission changes or a problem in the Library. The status bar of the Developer
notifies you when lost documents are detected. When you display this view, you can either move the documents to a folder in the Library or delete the documents.

- **Owned by me** - This view lists the documents in the Library that have been assigned (Owner property) to the author that is running this view. The selected documents are sorted by document Name. Documents appear in a flat view (no folder structure) and display Owner, State, Checked Out By, Version, and document Type columns.

### Share a Custom View

A custom view is specific to the author that created it. For example, if Author_A creates a view called CustomView1, Author_B will not have this view in their list. However, an author can share any custom view with another author by distributing a copy of a view file from the local cache on their computer. Any author who receives a shared custom view will need to copy the view file to the local data storage location on their computer.

The default location for the local data storage location on your Microsoft Windows computer is stored in `C:\Documents and Settings\<your user name>\Local Settings\Application Data\UPDev5`. The default location for the local data storage location on your Microsoft Windows Vista computer is stored in `C:\Users\<username>\AppData\Local\UPDev5`. However, you can determine the location of the local data storage location when you create a login profile for the first time.

To share a custom view:

1. Navigate to the `ViewFilters\<language code>` folder in your local data storage location.
2. Copy the XML file with the same name as the custom view that you want to share.
3. Distribute this file to another author and have that person copy the XML file to their local data storage location in the `ViewFilters\<language code>` folder on their computer.

   The author receiving the shared view should close and restart the Developer to refresh their list of views.

### Understand Content Permissions

By default, all authors have complete access to all Library folders and all actions that you can perform to develop, modify, publish, and export content. However, your administrator can also restrict your ability to access content in any Library folder and perform actions on that content. An administrator can assign the following permissions:

The following permissions can be set for any folder in the Library:

- **List Folder Contents** - Authors cannot save to folders with this permission. An author can view the names of documents in a Library folder but cannot open a document in any editor and perform actions that would change the document content or its location in the Library. An author also cannot make a copy of the document in any way.

- **Read** - An author can open a document in an editor, but cannot perform any actions that would change the document content or its location in the Library. An author can make a copy (including Save as) of the document and store it in a folder location to which they have appropriate permissions.

- **Modify** - An author has complete access to the folder and its documents and can perform any action (create, modify, copy, delete, publish, export, and so on).
When an author works in a folder with documents that have List or Read permissions, they are alerted when they cannot perform an action due to permission restrictions. Each folder and document in the Library (or the Details view of the Outline Editor) displays the active permission setting in the Permission column which can appear in any view.

If you need access to a document that has permission restrictions, you should contact your administrator to determine whether you can obtain the access that you need.

Also note the following about permissions:

- The Permission column only appears in the Details view. You can add this column to any other custom view.
- If you move a document from one folder to another, the document inherits the permissions of the folder to which it is moved.
- If you create a new folder in the Library, it will have no permissions of its own, but will inherit the permissions from the parent folder.
- Permissions are not preserved on exported content.
- Permissions are enforced when you are working online or offline.
- All authors should have at least Read permission to the System folder or any subfolder within it. If an author has List Folder Contents permission to the System folders, functions such as publishing/preview, role and template assignment, topic editing and recording, attachment icon assignment, and so on, will not work.
- If you are working offline and your administrator changes your permissions, the changes will be in effect the next time you are online. Also note that if you create documents in a folder to which you no longer have permissions, these documents will not appear in the folder when you connect to the server and work online. They will appear in the Lost document view. You can switch to the Lost document view and decide whether to delete the document or move it to a folder in which you have the appropriate permissions. Also, if you move a document to a folder in which you no longer have permissions, the move is ignored when you connect to the server and work online. A message appears on the Developer status bar alerting you when there are lost documents in the Library. You can double click on the message to automatically display the Lost documents view.
- Permissions have no impact on your ability to assign any author as the Owner. Therefore, you could assign an author as the Owner of a document in cases where the author may not have access to the document. Authors should be careful to only assign ownership to documents that are accessible to other authors.
3. Manage the Library

The Library is used to organize the documents that comprise your content for non-presentation purposes. You use these documents to create an outline in the Outline Editor for presentation to your audience in Player or document formats.

The Library displays two panes that are resizable by dragging the vertical bar to the left or right to view more of either pane. The Folders pane on the left shows the hierarchy of folders, and the Content pane on the right displays additional folders or the documents that are stored in a selected folder. The right pane also displays various folder or document properties such as icon and name, document type, and so on.

### Multi-user Considerations

As documents are checked in and out, icons appear to the left of the document name indicating the check in/out state as follows:

- ✓ indicates that the document is checked out to you.
- ✐ indicates that the document is locked and checked out to another author.
- No icon indicates that the document is checked in and available to any author.

These icons appear in various places such as the Library and Outline Editor as well as on document editor tabs and various views. Also note that additional columns in the Details view of the Library and Outline Editor display the check in/out state and version number. The Checked Out By column displays the name of the author who is currently using the document.

### Library Design Considerations

Although you can organize the Library in many ways to suit your needs, the following are some possible ways to design a folder structure in the Library:

- **Project centric** - Create folders for each project. Within each project you can create subfolders for each application within that project. You can further organize within each application by the various document types (modules, sections, topics, packages, web pages, etc.)

- **Application centric** - This is the default organization when content is converted from a previous version. A folder is created for each title that you convert and within each title folder there are folders for each module. Within each module are the documents that are linked to that module. You may want to create additional subfolders by document type or move your documents into one of the other Library organization structures.

Also consider how you intend to version your content. For example, if you are building content for an application, you may want to design your Library folder structure around the version of the application and duplicate all your content from version to version.

- **Author or Team** - If you normally divide workload by content author or teams of content authors, organizing your Library documents by team may be your best approach. This allows multiple authors to quickly see who owns a particular set of content and makes it easy to locate your documents. To organize by author or team, create a folder for each content author or group of authors. Within these folders you can employ one of the other
organization methods above to further organize your documents. You may even want to organize by locations if you have different groups in different locations working on content.

**Document Type** - If you are doing a lot of content sharing you may find it beneficial to organize the Library by document type. This allows content authors to focus on specific types of content. For example you may want specific authors creating all of your glossary terms or creating packages that will be used by other content authors. Organizing by type may make more sense as a second layer of organization.

**Localization** - If you are planning to localize your content you will want to make a complete duplicate of the source content before it is translated into the target language. To keep all of the different languages organized you should create sub-folders within your content folder hierarchy for each language.

One guideline is to keep your Library simple. Do not make overly complex folder structures and try to keep the Library between a maximum of three to five levels depending on your content.

**Work with Folders**

The Library displays a series of folders that contain various documents. The System folder, created by default, contains a series of folders with the system documents that are part of the Developer application. System documents include standard icon packages, publishing styles, templates, and master role lists for all supported languages.

You should create additional folders in the Library to organize your content development, similar to how you use folders on your computer to organize and manage files. However, keep in mind that the folders in the Library are not the same as folders on your computer since Developer content is stored in a database and not on a file system. The folders in the Library are purely for organization purposes.

**Create a New Folder**

You can create as many folders as you need to store and organize your content. Creating a logical folder structure makes it easier to locate documents when building an outline. It is best to start with a simple organization for your documents. If you later decide to change your folder structure, you can move folders and the documents in them to other folders.

When creating a folder, you can insert it at the root of the Library or nest it as a subfolder in another folder. In a folder hierarchy, there are parent folders and child folders. The folder currently selected in the Folders pane is the parent folder and the default location for new a folder. New folders created as subfolders of a parent are called child folders. Therefore, if you want to create a folder at the root level, you must select the folder at the top of the Library.

The following restrictions apply when creating folders:

- A parent folder cannot contain two subfolders with the same name.
- A folder name cannot be blank.
- A folder name cannot contain special reserved characters.

Long document names are supported for folders, but folder names are limited to 256 characters.
Reserved Characters

The following characters cannot be used in folder names. If you use reserved characters in document names, the characters appear in the published Player and print output. However, when you publish to document formats such as the Job Aid and Training Guide, the documents themselves cannot be saved with these characters in the file name, so they are converted to underscores.

- Back slash \\n- Forward slash /
- Question mark ?
- Less than symbol <
- Greater than symbol >
- Colon :
- Asterisk *
- Double quote ”
- Bar |

Multi-user Considerations

You can create, rename, move, copy, or delete a folder when you are working online or offline. The Developer follows specified rules to resolve folder conflicts. When working offline, you can only delete folders that are empty or contain new documents that have never been checked in.

You do not have to check in or check out a folder. As you create new folders, they are created automatically on the server during synchronization or when you check in a document saved to that folder. In a multi-user environment, the team leader should create the folder structure before authors start creating content.

To create a new folder in the Library:

1. From the Library, select the folder in which you want to create a subfolder, or select the root node / of the Library to create a new folder under the root node.
2. On the File menu, point to New and choose Folder.
   You can also right-click the folder and choose New Folder.
3. Type a name for the folder (up to 256 characters).
4. Click OK.

Rename a Folder

You can change the name of a folder if you decide that the name does not fit the contents. The name can be any character length up to 256 characters, but blank names, duplicate names, and special reserved characters are not allowed.

Note: A parent folder cannot contain two subfolders with the same name.
Multi-user Considerations

Folders can be renamed in the Library regardless of whether you are working online or offline.

The following rules apply when you are working offline and then return to online status: if the renamed folder or parent folder is marked for deletion, the folder or parent will be restored; if the parent folder has been renamed/moved, the renamed folder moves to the new location; if the renamed folder has been purged, the folder will be deleted; if another author also renames the folder, the last rename is used.

To rename a folder in the Library:

1. Select the folder you want to rename in the Folders pane or Contents pane.
2. On the Edit menu, choose Rename.
   
   After selecting a document, you can also click the document name or press F2 to start edit mode.
   
   You can also right-click a document and choose Rename.
3. Type the new folder name.
4. Press ENTER to save your changes.
   
   You can also click anywhere outside the name to save your changes.

Move a Folder

As you build your Library, you may find that you need to move folders in order to change your folder structure. The entire contents of the folder, including documents and subfolders, move with the folder. If the documents in the moved folder contain links, the links are not broken when the documents move. If you move a folder to a destination with a folder of the same name, the contents of the moved folder are merged with the contents of the destination folder and the moved folder is deleted.

The destination for a moved folder can be another folder or the root level of the Library. Folders can be moved in the Library using drag-and-drop or cut and paste. A cut folder does not move until it is pasted; if you do not paste the folder, it remains in its original location.

**Note:** When merging folders, the destination folder can contain documents with the same name; because documents have unique IDs, multiple documents with the same name can exist in the same folder.

Multi-user Considerations

You can create, rename, move, copy, or delete a folder when you are working online or offline. The Developer follows specified rules to resolve folder conflicts. When working offline, you can only delete folders that are empty or contain new documents that have never been checked in.

When an author moves a folder, the Developer moves all the documents in the folder, even if a document is checked out to another author.
To move a folder using cut and paste.

1. Select the folder you want to move in the Folders pane or Contents pane.
   You can select more than one folder in the Contents pane using the standard Windows selection keys (CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select All from the Edit menu.

2. On the Edit menu, choose \Cut. You can also right-click the folder and choose Cut.

3. Select the destination folder.

4. On the Edit menu, choose \Paste. You can also right-click the folder and choose Paste.

To move a folder using drag-and-drop:

1. Select the folder you want to move in the Folders pane or Contents pane.

2. Drag the folder and drop it on the destination folder in the Folders pane or Contents pane.

   As you drag a folder, a yellow arrow also moves, indicating the selected folder in the folder hierarchy. Release the mouse button when the arrow points to the destination folder.

Copy a Folder

When you copy a folder to another folder in the Library, the Developer creates duplicate copies of the entire contents of the folder. If the documents in the selected folder are organized in a structure of subfolders, the Developer re-creates the subfolder structure in the copy.

Note: When you paste a folder to the same parent folder, the Developer creates a new folder named “Copy of <folder name>”.

Copy and Paste

When you copy a folder that contains documents, you can paste it to create new copies of the folder and its contents. The new copies are independent documents that you can edit and rename without affecting the original documents.

Copy and Paste Special

If the copied folder contains parent documents related to child documents, such as a section linked to a topic or a topic linked to a web page, you can use the options in the Paste Special dialog box to select the type of copy you want to create. Each option produces a different result.

- **Copy (selection only)** - Choose this option to create a copy of the documents in the folder that maintain their links to the original child documents. Therefore, if the copied folder contains Section A that is linked to Topic 1 and Topic 2, the Copy (selection only) option creates a new Section B that still links to Topic 1 and Topic 2.

  If the copied folder contains both parent documents and related child documents, the Copy (selection only) option creates copies of all of the documents in the folder, BUT the new parent documents maintain their links back to the original child documents, not to the newly created child documents.
• **Duplicate (selection and related)** - This option creates duplicate copies of the parent documents and all related child documents, even if they are not stored in the folder. The links between new copies are updated so that new parent documents link to new child documents. The Duplicate option breaks all links to the original documents and creates an entirely new replica of the original. If the copied folder contains Section A that is linked to Topic 1 and Topic 2 (which can reside in any folder), the Duplicate (selection and related) option creates new copies of all of the documents and related documents and links the new Section B to new Topic 3 and new Topic 4.

When duplicating a folder with related documents, the Developer creates a copy of the folder structure for each related document.

**Note:** The Duplicate (selection and related) option does not create copies of templates, master role lists, sound files, and custom icon packages. The new copies still point to the original documents for those components.

### Multi-user Considerations

Any new document that you create or link is automatically checked out to you. If you want to make a new document available to multiple authors and place the document under the Developer’s version control system, you must check it in.

To copy a folder using Copy and Paste:

1. Select the folder you want to copy in the Folders pane or Contents pane.

   You can select more than one folder in the Contents pane using the standard Windows selection keys (CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select All from the Edit menu.

2. On the **Edit** menu, choose 📝 **Copy**.

   You can also right-click the folder and choose Copy.

3. Select the destination folder in the Folders pane.

4. On the **Edit** menu, choose 📝 **Paste**.

   You can also right-click the folder and choose Paste.

To copy a folder using drag-and-drop:

1. Select the folder you want to copy in the Folders pane or Contents pane.

2. Hold CTRL and drag the folder to the destination folder.

3. Release the mouse button and then the CTRL key.

To copy a folder using Copy and Paste Special:

1. Select the folder you want to copy in the Folders pane or Contents pane.

   You can select more than one folder in the Contents pane using the standard Windows selection keys (CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select All from the Edit menu.

2. On the **Edit** menu, choose 📝 **Copy**.

   You can also right-click the folder and choose Copy.
3. Select the destination folder in the Folders pane.


5. Choose Copy (selection only) to create a new copy of the selection only and maintain links to the original related documents or Duplicate (selection and related) to create a new copy of the selection and all related documents and create the links among the copies.

6. Click OK.

Delete a Folder

If you find that you no longer need a folder, you can delete it from the Library. Deleting a folder deletes the entire contents of the folder, including all documents and subfolders. A Confirm Delete dialog box opens prompting you to confirm your deletion.

If the folder you are deleting contains documents that are linked to other documents stored in another folder, you are prompted with the choice of deleting the selection only or the selection and all related documents in other folders. Clicking the View related documents link displays a list of the related documents.

Selecting Cancel during the deletion process displays a message with a link to view the documents that have already been deleted.

---

**Note:** If a document in a deleted folder is linked to an outline, the link is broken and a Missing Document link appears in its place in the outline.

---

**Warning!** Folder deletions cannot be undone.

---

**Multi-user Considerations**

You can delete a folder only when all of the documents in it can also be deleted. Documents under version control must be checked in and you must be working online to delete a document from the Library. You can delete new documents that have never been checked in (are not under version control) while working online or offline.

Deleted documents that are used in any outline will continue to appear in the outline. You can either remove these links from the outline or restore the deleted documents as long as the administrator has not purged them.

If you delete a folder that contains a mixture of checked in and checked out documents, the checked in documents will be deleted, and the checked out documents and the folder will remain in the Library.

You can create, rename, move, copy, or delete a folder when you are working online or offline. The Developer follows specified rules to resolve folder conflicts. When working offline, you can only delete folders that are empty or contain new documents that have never been checked in.

Deleted documents that have been checked in to the Library can be restored if they have not been purged by your Administrator. New documents that have never been checked in cannot be restored. Restoring a document that was part of a deleted folder restores the document and the folder.
To delete a folder:

1. Select the folder you want to delete in the Folders pane or Contents pane.
   
   You can select more than one folder in the Contents pane using the standard Windows selection keys (CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select All from the Edit menu.

2. On the Edit menu, choose **Delete**.
   
   You can also press DELETE or right-click the folder and choose Delete.

3. If prompted that one or more documents are not restorable, click **Yes** to complete the action or **No** to abort.
   
   The Related Documents dialog box appears when you perform an action on any document that has links to other documents. You can choose to process only the document(s) you selected or to process your selection and all of the related documents.

   Click the View related documents link to display a list of the related documents if you are not sure whether you want to include related documents.

   After you have made your selection, click **OK**.

   You might also receive a message if some documents could not be processed because of other constraints. You can click OK to close the message box or click the View activity log link to view the results of the action.

### Expand and Collapse Folders

When the Library opens, only the top level folders appear in the Folders pane. The Folders pane, which appears in the left pane in the Library, displays the folder hierarchy in a tree view. When you select a folder in the folder tree, its contents appear in the Contents pane to the right.

Expand/collapse symbols (+/-) appear next to folders that contain subfolders. A plus (+) symbol means that the folder is collapsed and the subfolders are hidden in the folder tree. A minus (-) symbol means that the folder is expanded and the subfolders appear in the folder tree.

**Note:** When selecting folders, you can select a single folder in the Folders pane and multiple folders in the Contents pane.

To expand and collapse folders:

1. Click the + (plus symbol) in the folder tree to expand a folder.
   
   You can also double-click a parent folder in the left or right pane to expand it.

2. Click the - (minus symbol) in the folder tree to collapse a folder.

**Note:** You can also press ENTER to expand and collapse the selected folder in the Folders pane (left pane) or open the selected folder in the Contents pane (right pane).

### Print Library Folder Contents

You can print a report listing the contents of any folder in the Library. Included in the report is a list of folders or documents as well as the columns in the active View. To print
the contents of folder you must first select a folder from the Library. You can also customize a view to display a flat list of documents in the library for a report.

**Note:** The report does not honor column sizes that appear in the active View. You can change the page orientation or adjust the margins to modify the column sizes, or save the report to Microsoft Excel and adjust the columns there.

The report opens in a new window. Use the following toolbar icons to print the report, configure printer settings, export the report to file or graphic format, and so on.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Search Icon" /></td>
<td>Searches the report for text.</td>
</tr>
<tr>
<td><img src="image" alt="Printer Icon" /></td>
<td>Displays the current printer settings such as the active printer, status, page range, number of copies, and so on.</td>
</tr>
<tr>
<td><img src="image" alt="Print Icon" /></td>
<td>Prints the report to the active printer.</td>
</tr>
<tr>
<td><img src="image" alt="View Setup Icon" /></td>
<td>Displays the current page setup such as paper size, orientation, and margins that you can change.</td>
</tr>
<tr>
<td><img src="image" alt="Scaling Icon" /></td>
<td>Displays scaling options such as scaling by a percentage of normal size and fit options.</td>
</tr>
<tr>
<td><img src="image" alt="Scroll Icon" /></td>
<td>Scrolls the report.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Out Icon" /></td>
<td>Zoom out. You can also enter a Zoom Factor percentage to zoom in or out.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom In Icon" /></td>
<td>Zoom in.</td>
</tr>
<tr>
<td><img src="image" alt="First Page Icon" /></td>
<td>Move to the first page.</td>
</tr>
<tr>
<td><img src="image" alt="Previous Page Icon" /></td>
<td>Move to the previous page.</td>
</tr>
<tr>
<td><img src="image" alt="Next Page Icon" /></td>
<td>Move to the next page.</td>
</tr>
<tr>
<td><img src="image" alt="Last Page Icon" /></td>
<td>Move to the last page.</td>
</tr>
<tr>
<td><img src="image" alt="Save Icon" /></td>
<td>Saves the report to PDF, HTML, Excel, or graphic format. Your selection displays additional options based on the file type you selected.</td>
</tr>
<tr>
<td><img src="image" alt="Close Preview Icon" /></td>
<td>Close preview.</td>
</tr>
</tbody>
</table>

To print folder contents from the Library:

1. Open a folder to display its contents in the right pane of the Library.
2. On the **File** menu, choose **Print** and use the toolbar icons to print, view, or save the report to a file.

**Work with Documents**

Your content is constructed by creating and linking various documents. The way you add, edit, delete, find, and save documents is very similar regardless of the document type.

**Create a New Document**

You can create a new document from the Library. The new document launches in the appropriate document editor in a new tab.
Each document type has an icon associated with it that appears next to the document name in the Library and Outline Editor. For example, the icon for a module is a purple book and the icon for a topic is a piece of paper with a yellow text bubble.

Module and section documents perform the same functions and contain the same document properties. Modules and sections do not inherently contain content. They are used to link documents together to create the hierarchy for an outline.

There is no difference between a module or section document in an outline. You can create a hierarchy using all module documents, all section documents, or a combination of the two. The two document types are represented by different icons so that you can easily identify them. For instance, to visually differentiate the structure of your content, you can use modules for the highest levels in your outline and sections for sublevels.

Multi-user Considerations

Any new document that you create or link is automatically checked out to you. If you want to make a new document available to multiple authors and place the document under the Developer's version control system, you must check it in.

Create a New Module or Section

You can create a new module or section document from the Library or any document editor. After you create and save the module/section, it opens in the Outline Editor, where you can link documents to it and build your outline.

When you create a module/section, the New Module or New Section dialog box opens giving you the opportunity to set certain document properties. Most of the default properties that appear are inherited from the settings in Tools, Options. Module and section documents contain the same properties. You can change the properties when you create the module/section or change them later. However, because all new documents that you create/link to the new module or section in the Outline Editor inherit its property settings, it is a good idea to set the necessary properties when you first create the new module/section.

A module/section has the following default properties that you can change:

- Name: A descriptive name for the document.
- Location: The folder location in the Library where this document is stored. The default folder that appears depends on where you are when you create the new document, as follows:
  - If you create a new document from the Library, the default folder is the folder that is selected in the Library when you create the new document.
  - If you link a new document from the Outline Editor, the default location is the same as the location of the parent document to which you are linking the new document.
- Language: The Language option allows you to choose the default dictionary that is used to check the spelling of a document's content. Dictionaries for English (UK & US), German, French, Spanish, Dutch, Danish, Portuguese (Brazil), Swedish, Finnish, Norwegian, and Italian are provided.
- Template: The Template option allows you to select another folder of template files. The template sets included with the Developer are the Standard and
Microsoft templates. The Microsoft template conforms to the standards as stated in the Microsoft Manual of Style for Technical Publications. In addition to these templates, other template sets may be available to you. Alternate template sets are most useful when you are creating content for more than one application. Please contact Technical Support for more information on this option and its implementation.

- **Glossary**: The glossary document that is currently assigned to the document. The glossary document lists the words you have assigned as glossary terms. After you have set up the glossary terms and their definitions, the Developer can automatically create the links to the terms found in any document text.

- **Screen Resolution**: The Screen Resolution option allows you to determine the resolution in which the topic content is recorded. If authors attempt to record in a resolution other than the one listed in the Screen Resolution list box, a message box informs them that their resolution does not match the topic setting and indicates in what resolution they should record. While content authors are not prevented from recording in a different resolution if they choose, this option does help to create greater consistency in the content.

Please note that the Developer detects the current resolution of your computer and automatically sets the screen resolution property to match when you create new documents. Once screen resolution for a topic is set and you have saved a recording; the screen resolution cannot be changed.

To create a new module or section document in the Library:

1. Select the folder where you want to store the document.
2. On the **File** menu, point to **New** and choose **Module** or **Section**.
3. Type a name for the new document.
4. To change the folder in which the document is stored, type the folder path in the **Location** field or click **Browse**, select a different folder, and click **OK**.
   When browsing for a folder, you can use the Make New Folder button to create a new subfolder in the currently selected folder.
5. Choose the properties for the new document.
6. Click **OK**.

The module or section opens in a new tab in the Outline Editor.

**Create a New Topic**

Topics are the documents in which you record the steps (and sound if applicable) of a task or transaction in an application. You can create a topic in the Library or while working on an outline in the Outline Editor.

When you create a topic in the Library, the Recorder automatically launches for you to capture the topic steps. After finishing the recording, the new topic opens in the Topic Editor. From the Topic Editor, you save the topic by naming it and selecting a folder in the Library in which to store it. Unlike module and section documents, you do not set properties for a topic when you create it. You can however, change the properties for a topic at any time.
Note: The Recorder does not launch when you create a new topic in the Outline Editor by linking it to an outline. When you name the topic, it is saved automatically to the same folder as the parent document.

The icon for a topic is a piece of paper with a yellow text bubble. To visually differentiate between recorded and blank topics, the topic icon appears with lines on the paper and bubble for topics with recorded content and as a blank paper and bubble for blank topics.

To create a new topic in the Library:

1. Select the File menu, point to New and choose Topic.
2. When the Recorder opens, record the steps (and sound, if applicable) of the topic.
3. When you are done recording the steps, click Finish in the Recorder window.
4. To save the topic from the Topic Editor, select the File menu and choose Save.
5. In the Save As dialog box, type a name for the new topic.
6. Navigate to the folder where you want to store the topic.
7. Click Save.

Save a Document

As you modify a module or section in the Outline Editor, the Developer automatically saves your changes. However, when you open other editors to modify a document such as a topic, package, web page, glossary, or role, you need to save the changes. If you have not saved your latest changes when you close the document editor, a Save Document message opens asking if you to save the document.

The first time you save a document, the Save Document dialog box opens allowing you to name the document and select a folder for storing the document. The Save Document dialog box automatically filters the document display for the document type you are saving. However, if you want to see the names of all documents stored in a folder, you can use the Type field to view all documents. Once a document has been saved, its name appears in the document editor tab. Subsequent saves do not display the Save Document dialog box; instead, your changes are saved to the existing document.

Note: By default, the Developer automatically creates a temporary backup copy of any open document every 10 minutes if a change has occurred. This option can be disabled or the time interval between autosaves changed in the AutoSave section of the Library category on the Options dialog box.

Naming Documents

Each document in the Library is identified with a unique Document ID made up of a long series of letters and numbers, such as 3c4c7b1a-a50a-4d54-3719c6b47732. No two documents in the Library have the same Document ID. When you save the document, you give it a meaningful name, one that identifies its contents or use. There are no restrictions on the length of the name or on the characters used. You can use any combination of letters, numbers, special characters and spaces to name a document. Since the Developer treats this name as a property of the document and does not use this name to identify the document, a folder can contain multiple documents with the same name.

Save As

The Save As command provides the opportunity to create a copy of a document by opening the Save Document dialog box, where you can give the document a new name.
and select a folder in which to store the document. This creates a new document identical to the original, with all links to the original document preserved in the new copy. For example, if a topic is linked to a web page, and you save the topic with a new name, the new copy is also linked to the same web page. The Save As command is available in any document editor except the Outline Editor. You cannot use Save As to create a new copy of an outline or section document. To create copies of these documents, you can use copy and paste.

---

**Warning!** Using Save As to save a document with the same name and to the same folder creates a copy of the original rather than overwriting it. You will be prompted that a document already exists at the save location and that saving will create a new document.

---

### Multi-user Considerations

When you save a checked out document, it is saved to your data storage location regardless of whether you are working online or offline. You must check the document in to insure that the server has the most recent copy. A new document is not added to the server until you check it in. If a document has never been checked in, your local copy is the only copy of that document.

If you click the Keep checked out option on the Check In Comment dialog box during check in, the content is checked in and the version number incremented by 1 but the document remains checked out and unavailable for editing by other users.

Open documents display check in/out indicators in the document editor tab. While you can edit a checked in or locked document, you cannot save your changes to the original document.

If you edit a document that you did not check out (in other words, a checked out document was opened in Read-Only mode and edited) and you want to save the changes, you may still be able to save it. If you have access rights to the document and it has not been checked out by someone else, you are given the option to save the changes to the original document name. If you choose to save the changes, the document is checked out and the changes are saved. If you do not want to save the changes to the original document, you can save the document as a different document name or you can abandon the changes without saving.

---

**Note:** Saving changes to a document that is not checked out to you is not a recommended best practice. This functionality is designed to allow you to save changes to a document that was unintentionally edited in Read-Only mode.

---

To save a document:

1. On the **File** menu, choose **Save**.
2. Type a name for the document.
3. Navigate to the folder where you want to store the new document.
   
   You can use the Save in list and the icons in the dialog box to navigate folder levels. Click **$** to create a new subfolder in the currently selected folder.
4. Click **Save**.
Note: You can also open an existing document and use Save As on the File menu to save a copy of the document with a new name and/or to another folder.

Note: If you split the layout of the work area, you must first activate the pane containing the document before saving it. The tab of the active pane shows the document name in bold text, while the text is not bold in the inactive panes.

Open a Document from the Library

Opening a document launches the appropriate document editor in a new tab. The document editor that launches depends on the type of document that you open. For example, when you open a module or section, the Outline Editor launches in a new tab. Opening a package or web page launches the Package or Web Page Editor in a new tab. When you open a topic containing recorded content, the Topic Editor launches. However, opening a topic that contains no recorded content launches the Recorder. Documents that open in tabs appear as the last tab on the right in the Developer window.

You can open a document from any view in the Library or Outline Editor, or use the options in the Open dialog box, which allow you to navigate and filter Library folders for specific document types. You can open multiple documents at the same time from the Library or Outline Editor, with each document opening in its own editor. You cannot, however, open two unrecorded topics at the same time because the Developer can launch only one instance of the Recorder.

Note: You can also open documents from the Start Screen, which appears when you start the Developer.

Multi-user Considerations

If you open a document that is not checked out to you, it opens in Read-Only mode. If you decide to make any changes to a Read-Only document, upon exit you are given the option to save the document (check out and save the changes), save it as a new document, or discard the changes.

To open a document:

1. To open a single document, double-click the document.
   
   You can also press ENTER to open the selected document.

2. To open multiple documents, select the document(s).
   
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select All from the Edit menu.

3. Right-click any document in the selection and choose Open.
   
   You can also press ENTER to open all selected documents.

To open documents using the Open dialog box:

1. On the File menu, choose Open.
2. In the Open dialog box, navigate the Library to the folder containing the document you want to open.
   You can use the Look in list or the icons in the dialog box to navigate folder levels.
3. To filter the document display, select the document type from the Type list.
   To remove the filter, select All types from the Type list.
4. Select the document to open.
5. Click Open.

Note: To open a document from the Start Screen, click a link for a recently opened outline or click the Document link to open the Open dialog box.

Close a Document
CLOSING A DOCUMENT REMOVES THE TAB FROM THE WORK AREA. WHEN YOU CLOSE A DOCUMENT, YOU ARE PROMPTED TO SAVE IF THE DOCUMENT HAS CHANGED. THE OUTLINE EDITOR DOES NOT PROMPT YOU TO SAVE YOUR CHANGES WHEN YOU CLOSE SINCE THE OUTLINE EDITOR AUTOMATICALLY SAVES CHANGES.

After you close a document, the next tab to the right of the closed tab becomes the active tab. However, if there are no document tabs to the right of the tab you are closing, the tab to the left becomes the active tab.

To close a document:

   1. Click the document tab that you want to close.
   2. On the File menu, choose Close.

   You can also right-click a tab and choose Close, or press CTRL+F4, or click ✕.

Note: Choosing Close from the File menu in the Library closes the Library. You can reopen the Library by choosing Library from the View menu.

Delete a Document and Related Documents
You can delete a document only from the Library. Deleting a document from the Outline Editor removes the link between documents, but does not delete the document from the Library. You cannot restore deleted documents in a single-user installation. The Developer alerts you when you delete a document that cannot be restored.

If you attempt to delete a document from the Library that is used by other documents, you have the choice to delete the selection only or the selection and all related documents. Clicking the View related documents link displays a list of the related documents. The related documents list includes the direct and indirect links for each parent document selected. The direct links are the child documents that are linked to the deleted document, and the indirect links are the child documents that are linked to those documents. For example, consider a section that is linked to a topic, whose concept is linked to a web page. Deleting this section with related documents not only deletes the topic, but also deletes the web page linked to the topic. However, the Developer will NOT delete a document that is also linked to another parent not related to the deletion.
Note: When deleting a parent document with its related documents, the following document types are not included as related documents and are not deleted: sound packages, icon packages, templates, and glossary documents. You can delete sound packages, icon packages, templates, and glossary documents directly from the Library. When you delete a glossary document, the web page and package documents linked to it are not deleted unless you choose the delete with related option.

Warning! When you delete a package as a "related document", you delete the entire package and all of the files it contains, even if only one file of a multi-file package is linked to the document(s) selected for deletion.

When you delete a document in the Library that is linked to an outline, the document is removed from the outline and a Missing Document link appears in its place. You can delete this link in the outline as well.

Note: You cannot delete a document if it is open in another document editor. For example, you cannot delete a section from the Library that is currently open in the Outline Editor. When deleting an open document, you will be prompted to close the document in the other editor.

In some instances, you may have problems deleting a document if it was previously linked to an outline that is currently open in the Outline Editor. If Developer cannot delete the document, close the outline and try deleting the document again.

Multi-user Considerations

Documents under version control must be checked in and you must be working online to delete a document from the Library. You can delete new documents that have never been checked in (are not under version control) while working online or offline.

Deleted documents that are used in any outline will continue to appear in the outline. You can either remove these links from the outline or restore the deleted documents as long as the administrator has not purged them.

Deleted documents that have been checked in to the Library can be restored if they have not been purged by your Administrator. New documents that have never been checked in cannot be restored.

To delete a document:

Note: Before deleting a document, you must close it if it is open in a document editor.

1. In the Library, select the document that you want to delete.

You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select All from the Edit menu.

2. On the Edit menu, choose Delete.

You can also press DELETE or right-click the document and choose Delete.
The Related Documents dialog box appears when you perform an action on any document that has links to other documents. You can choose to process only the document(s) you selected or to process your selection and all of the related documents.

Click the View related documents link to display a list of the related documents if you are not sure whether you want to include related documents.

After you have made your selection, click OK.

You might also receive a message if some documents could not be processed because of other constraints. You can click OK to close the message box or click the View activity log link to view the results of the action.

Rename a Document

You can rename any document from the Library. From the Outline Editor, you can rename a module, section, or topic document only.

Document names do not have to be unique. Since documents are identified by their ID, two documents with the same name can exist in the same Library folder or outline.

Note: You can also rename a document using the Name property in the Properties toolpane (General category). However, you cannot rename multiple documents at the same time using this toolpane.

Multi-user Considerations

Before you can perform this action, you must check out the document. After you save any changes, you should check in the document to make it available to other authors and add the changes to the Developer's version control system.

The Developer preserves the name of versioned documents. When you roll back a renamed document to a previous version, the document name rolls back as well.

To rename a document:

1. Click the document that you want to rename.
2. On the Edit menu, choose Rename.
   
   After selecting a document, you can also click the document name or press F2 to start edit mode.

   You can also right-click a document and choose Rename.
3. Type a document name.
4. Press ENTER or click anywhere outside the name to save your changes.

Move a Document (Library)

As you work with documents in the Library, you may find that you need to move them to another folder due to a change in your folder structure or because the document was saved to the wrong folder. When you move a document to another folder, all links to modules, sections and other documents are maintained. Because each document is assigned a unique ID, you can move the document into a folder that already contains a document with the same name. You can move a single document or multiple documents to another folder using drag-and-drop or cut and paste. A cut document does not move until it is pasted. If you do not paste the document, it remains in its original location.
In addition to moving documents within the Library, you can also move documents from the Library to an outline, within an outline, and from one outline to another. Dragging a document from the Library into an outline links the document to the outline, but does not physically move the document from its original folder. Moving documents within an outline or to another outline, unlinks the document from its current location in an outline and relinks it to its new location in an outline.

**Note:** A summary message appears if some of the documents you selected could not be processed. Clicking the View activity log link in the message displays a list of the results for each document.

---

**Multi-user Considerations**

You can move a document to another folder regardless of its check in/out state. If you move a document while working offline, the move does not appear in the Library until you switch to online mode.

To move a document in the Library using cut and paste:

1. Select the document you want to move.
   - You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select All from the Edit menu.
2. On the **Edit** menu, choose 🗑️ Cut.
   - The icon for the document appears shaded until the document is pasted.
   - You can also right-click your selection and choose Cut.
3. Select the destination folder in the Folders pane.
4. On the **Edit** menu, choose 📏 Paste.
   - You can also right-click the folder where you want to move the document and choose Paste.

To move a document in the Library using drag-and-drop:

1. Select the document you want to move.
2. Drag the document and drop it on the destination folder.
   - As you drag a document, a yellow arrow also moves, indicating the selected folder in the folder hierarchy. Release the mouse button when the arrow points to the destination folder where you want to move the document.

**Copy Documents in the Library**

You can copy documents from one folder in the Library to another. When you create a copy of a document, the Developer creates a new document with a new Document ID. The new copy and the original source document are not directly linked, so you can make changes to the copy without affecting the source. For example, you may want to copy a topic if two tasks are almost identical except for the final frames. You can record the first topic, create a copy of it with a new name, and then change the copy by re-recording the final frames.
Paste vs. Paste Special
There are two paste commands in Developer for copied documents; Paste and Paste Special. If the copied document is a parent linked to other related child documents, it is important to choose the paste command that gives you the desired results. Examples of a parent document include a module or section linked to a topic, web page, package, or glossary; or a topic linked to a web page, package, or glossary.

Note: Before copying a document, it is a good idea to check the document links in the Related Documents toolpane.

Copy and Paste (Library)
You can create copies of documents in the Library using copy and paste and drag-and-drop. Copying a document creates a unique document, with a new Document ID. After creating the copy, you can edit or rename it without affecting the source document.

If the original document links to other documents, the Developer breaks or maintains the links in the copy depending on the direction of the link. Pasting a copy maintains the links that go down the hierarchy (from parent to child) and breaks the links that go up the hierarchy (from child to parent).

Note: Before copying a document, it is a good idea to check the document links in the Related Documents toolpane.

The following table describes how using Paste to create a copy in the Library affects document links.

<table>
<thead>
<tr>
<th>Document Link</th>
<th>Results</th>
</tr>
</thead>
</table>
| Original document links to a parent.                                         | The link is broken. The new copy does not link to the source document's parent.  
  Example: Topic1 links to SectionA                                              |
  Result: Topic1_copy not linked to SectionA                                    |
| Original document links to child documents.                                  | The new copy links to the source document's children.                   |
  Example 1: Section A links to Topic1 and Topic2                              |
  Result 1: SectionA_copy maintains links to Topic1 and Topic2                  |
  Example 2: Topic1 links to Web page1                                          |
  Result 2: Topic1_copy links to Web page1                                     |
| Original document is both a child document linked to a parent and a parent document linked to child documents. | The new copy does not link to the source document's parent, but links to the source document's children.  
  Example: SectionA links to parent ModuleA, and in turn, links to child documents Topic1 and Topic2  
  Result: SectionA_copy not linked to ModuleA, but maintains links to Topic1 and Topic2 |

Note: See Copy and Paste Special for information about creating a true replica where the parent and its children are copied and links are created to the new copies.
Multi-user Considerations

Any new document that you create or link is automatically checked out to you. If you want to make a new document available to multiple authors and place the document under the Developer's version control system, you must check it in.

To copy a document using Copy and Paste:

1. In the Library, select the document you want to copy. You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select All from the Edit menu.

2. On the Edit menu, choose Copy. You can also right-click the document and choose Copy.

3. Select the destination folder in the Folders pane.

4. On the Edit menu, choose Paste. You can also right-click the folder and choose Paste.

To copy a document using drag-and-drop:

1. In the Library, select the document you want to copy.

2. Hold CTRL and drag the document to the destination folder.

3. Release the mouse button and the CTRL key.

Copy and Paste Special (Library)

If the document you are copying is a parent to related documents (child documents), you can use the options in the Paste Special dialog box to create two different paste scenarios.

Copy (selection only)
The Copy (selection only) option creates a new copy of all of the selected documents. However, the new copies of parent documents link to the original child documents, even when the child documents are included in the selection. For example, if you include a parent document and its related child documents in the copy selection, the Copy (selection only) option creates copies of all of the documents you copied, BUT the new parent documents maintain their links back to the original child documents, not to the newly created child documents.

Note: When copying within the Library, the Copy (selection only) option provides the same results as using the Paste command.

Duplicate (selection and related)
The Duplicate (selection and related) option creates new copies of the entire selection and all related documents, even if you did not include the related documents in your copy.
selection. The Developer updates the links so that the new parent documents link to the new child documents.

When you create a duplicate copy of a selected document or documents, the Developer creates new copies of all the documents and the documents related to the selection, including:

- Modules
- Sections
- Topics
- Web pages
- Packages
- Glossaries

**Note:** The Duplicate (selection and related) option does not create copies of templates, master role lists, sound files, and custom icon packages. The new copies still point to the original documents for those components.

To create a duplicate copy of an outline, you only need to select the highest-level document. The Developer automatically compiles a list of all related documents to include in the copy. For the highest-level parent document, the Developer creates the folder structure and substructure. Related documents that do not exist in the folder structure are copied to a new folder named Additional Related Documents.

**Multi-user Considerations**

Any new document that you create or link is automatically checked out to you. If you want to make a new document available to multiple authors and place the document under the Developer's version control system, you must check it in.

To copy documents using Copy and Paste Special:

1. In the Library, select the document you want to copy.
   
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select All from the Edit menu.

2. On the **Edit** menu, choose **Copy**.
   
   You can also right-click the document and choose Copy.

3. Select the destination folder in the Folders pane.

4. On the **Edit** menu, choose **Paste Special**.

5. Choose **Copy (selection only)** to create a new copy of the selection only and maintain links to the original related documents or **Duplicate (selection and related)** to create a new copy of the selection and all related documents and create the links among the copies. If you choose Duplicate, you can click the **View related documents** link to display a list of the related documents if you are not sure whether you want to duplicate related documents.

6. Click **OK**.
View Folder Content

When working in a view in the Library, you can select a folder in the Folders pane on the left and the contents of the folder appear in the Contents pane on the right. To open a subfolder of a parent, you can either select it from the expanded folder tree or double-click the folder name in the Contents pane.

A view displays the properties for the documents in the selected folder in a grid arrangement. The grid displays a column heading for each property. The active view appears in the View toolbar. You can customize the view by sorting the contents by another property and rearranging and resizing the columns. The Name column appears by default as the first column on the left in the grid. This column displays the document name and an icon denoting the document type.

When working with a large amount of documents and properties, you may want to resize the panes by dragging the split bar between the Folders pane and Contents pane. You can also explore different parts of the Library by splitting the work area into a horizontal or vertical layout. Horizontal and vertical scroll bars appear in the view when the contents exceed the dimensions of the pane.

Changes to the active view are preserved, so that the next time you open the Library, you will see the same view. Using the same procedures, you can customize any view. However, each view must be customized separately. You can also customize a view using the Manage Views command on the View menu.

Document Count

When working in a view in the Library, a Count in View appears on the status bar. This allows an author, at a glance, to see the amount of content in the Library. The objects that appear in the count depend on the selection set. When selecting a folder in the left pane, the count displays the number of objects that appear in the right pane. When selecting in the right pane, the count displays the number of objects selected. For example, if you selected a folder (with three documents under it) and a document, the count would display two objects, one for the document and one for the folder. If your display is in a flat view, the count displays the number of objects selected. If nothing is selected, count displays the total of all objects in the view.

Multi-user Considerations

As documents are checked in and out, icons appear to the left of the document name indicating the check in/out state as follows:

- ✓ indicates that the document is checked out to you.
- ⚒ indicates that the document is locked and checked out to another author.
- No icon indicates that the document is checked in and available to any author.

These icons appear in various places such as the Library and Outline Editor as well as on document editor tabs and various views. Also note that additional columns in the Details view of the Library and Outline Editor display the check in/out state and version number. The Checked Out By column displays the name of the author who is currently using the document.
Sort Documents

By default, items in the Contents pane are sorted by the Name column in ascending order. Clicking on a column heading sorts the items by that property. Items can be sorted in ascending or descending order. When a column heading is clicked, a triangle appears in the column label indicating the direction of the sort. A triangle pointing up means that the items are sorted in ascending order and a triangle pointing down means that the items are sorted in descending order. Each time you click the column heading, you reverse the sort order.

**Note:** You can also set the sort order by editing the view definition.

If the selected folder also contains subfolders, they will appear at the top of the view, in the selected sort order.

Your last sort is saved as the default sort for the active view until you change the sort. You can also split the work area with a horizontal or vertical layout and apply a different view and sort to each work area. For example, you may want to compare documents in the same folder or different folders using two different sorts. The sort in a split layout is also preserved and the documents appear in that sort the next time a split layout opens.

**Note:** You can also sort the items in dialog boxes and panes that use a column heading layout.

To sort documents:

1. Click the column heading for the property on which you want to base the sort.
2. To change the sort order, click the column heading until the triangular indicator points up for an ascending sort or down for a descending sort.

To configure document sort order in a view definition:

1. On the **View** menu, choose **Manage Views**.
2. Add a new view or edit an existing view.
3. Click the **Sort** tab.
4. Click the down arrow and select a document attribute by which to sort documents.
5. Choose **Ascending** or **Descending** order.
6. Continue to specify secondary sort orders (optional).
7. Click **Apply** to save your changes. If you are editing the active view, the results of the view definition are immediately visible.
8. Move to the next tab or click **OK** to save the view.

Rearrange Columns

The property columns in the Library can be rearranged in an order that suits the way you work. Frequently-used columns can be moved so that they appear in any view without scrolling and the less frequently used columns moved to the end of the grid.

You can move a column by dragging its column heading to another position in the headings row. When you drag a column heading, a transparent image of the column heading moves with the mouse pointer. As you drag the transparent image left or right in the headings row, a black border appears around a heading below it and continues to
move to the next heading as you move the mouse pointer. When you release the mouse button, the column moves to the left of the heading that displays the black border.

**Note:** You can also configure the column arrangement by editing any view definition. Column changes made to the active view are automatically saved in the view definition.

The Developer remembers your column order, so that the next time you open the Library or Outline Editor, the columns appear in the active view as you last arranged them.

If you split the work area into separate horizontal or vertical layouts, you can create a separate column arrangement for each work area.

.strategy To rearrange columns:

1. Drag the heading of the column you want to move and drop it on a heading in the headings row, to the left of which you want to insert the moved column.

.strategy To sequence columns in a view definition:

1. On the **View** menu, choose **Manage Views**.
2. Add a new view or edit an existing view.
3. Click the **Column Selection** tab.
4. Select one or more columns in the Used in view section and use the up or down arrows to change the position.
5. Click **Apply** to save your changes. If you are editing the active view, the results of the view definition are immediately visible.
6. Move to the next tab or click **OK** to save the view.

### Add and Remove Columns

You can remove property columns while working in the Library or Outline Editor. Views in the Library and Outline Editor display a different subset of the total list of available property columns. If you need more information in a view, you can add one or more columns from the list of available properties.

Removing columns simplifies the view and lets you concentrate on the properties you use. If you find that you need to see the data in a deleted column, you can add the column back to the view.

The Developer preserves your last column display in the active view for the Library and the Outline Editor.

.strategy To remove a column:

1. Drag the heading of the column you want to remove down into the view and release the mouse button when a large X appears on top of the column heading.

.strategy To add a column:

1. Right-click on any column heading and choose **Column Chooser**.

   The Column Chooser window opens displaying the column headings for the hidden columns.
2. From the Column Chooser window, drag the column you want to add and drop it in a position on the column heading row.

**Note:** Dropping a column on top of another column heading adds the dropped column to the left of the column heading. To add a column to the end of the column headings, drop it on the right border of the last column heading.

To configure columns in a view definition:

1. On the **View** menu, choose **Manage Views**.
2. Add a new view or edit an existing view.
3. Click the **Column Selection** tab.
4. From the Available section, choose one or more columns and click <right arrow> to move your selection to the Used in view section. To remove one or more columns, make your selection and click <left arrow>.
5. Click **Apply** to save your changes. If you are editing the active view, the results of the view definition are immediately visible.
6. Move to the next tab or click **OK** to save the view.

### Size Columns

You can adjust the width of a property column to view more or less of the data in the column. For instance, if you do not need to view the entire Document ID, you can decrease the width of that column. If a column is not wide enough to view the entire contents, the view of the data is truncated and ends with an ellipsis (...).

Columns can be resized manually by dragging the right column border in the headings row to the desired width. You can also autofit a column using Best Fit, which automatically resizes the width of the column to fit its widest text. You can autofit a single column or all columns at the same time.

You can split the work area into separate horizontal or vertical layouts and resize the columns independently. The column widths in the split layout are preserved during the session.

**Note:** You can also resize columns in dialog boxes and panes that use a column heading layout.

To size columns using drag-and-drop:

1. In the headings row, point to the right border of the column you want to resize. The mouse pointer changes to a horizontal two-headed arrow.
2. Drag the column border left to decrease the column size or right to increase the column size.

To size columns using Best Fit:

1. Right-click the heading for the column you want to size.
2. Choose **Best Fit** to autofit a single column or **Best Fit (all columns)** to autofit all columns.

You can also double-click the right column border in the headings row to autofit a column.
Create a Custom View

You can create an unlimited number of custom views for the Library and control the following characteristics of each view:

- Selection and order of the data columns in the view
- Sort order of the documents in the view
- Selection of documents in the view

**Note:** Custom views are not Library-specific and are available in any Library.

After you create a custom view, it will appear in the View toolbar list.

**Note:** You cannot create a custom view for the Outline Editor; however, you can manually customize the Outline Details View.

If you modify the configuration settings (column selection/width and sort) of any active view outside of the View Editor, your changes are automatically saved in the view definition. For example, if you define specific columns to appear in a view, then activate that view in the Library and remove columns, those changes will be reflected in the view definition the next time you edit it in the View Editor.

### Multi-user Considerations

A custom view is specific to the author who created it. It will not appear as a choice on the View toolbar list of views for all authors.

Also note that the Developer provides sample custom views in the multi-user environment for displaying documents by owner, state, check out status, and so on.

### Add a New View

Before you can add a new view, you must display the Library (View, Library). You cannot create a new view from any other document editor, including the Topic Editor.

From the Library, you can manage all existing views that are delivered with the Developer as well as create your own.

To add a new view:

1. On the **View** menu, choose **Manage Views**.
2. Click **New**.
3. Type a unique view name. You cannot have duplicate view names.
   - You cannot use reserved characters in the view name.
4. Continue to define the column selection, sort, and filter criteria.
5. Click **OK** to save the view.
Configure View Columns

The Column Selection tab controls the data columns that appear in the view as well as their sequence from left to right. By default, each new view includes the Name column (to identify each document in the view). The Available section lists the columns you can choose to include and the Used in view section show the list of selected columns. For each column you include in the view, you can determine its position and width (in pixels).

To configure columns in a view definition:

1. On the View menu, choose Manage Views.
2. Add a new view or edit an existing view.
3. Click the Column Selection tab.
4. From the Available section, choose one or more columns and click <right arrow> to move your selection to the Used in view section. To remove one or more columns, make your selection and click <left arrow>.
5. Click Apply to save your changes. If you are editing the active view, the results of the view definition are immediately visible.
6. Move to the next tab or click OK to save the view.

To sequence columns in a view definition:

1. On the View menu, choose Manage Views.
2. Add a new view or edit an existing view.
3. Click the Column Selection tab.
4. Select one or more columns in the Used in view section and use the up or down arrows to change the position.
5. Click Apply to save your changes. If you are editing the active view, the results of the view definition are immediately visible.
6. Move to the next tab or click OK to save the view.

To size columns in a view definition:

1. On the View menu, choose Manage Views.
2. Add a new view or edit an existing view.
3. Click the Column Selection tab.
4. Select one column in the Used in View section and enter a number (in pixels) in the Column Width field (or click the up/down arrows next to the default value).
5. Click Apply to save your changes. If you are editing the active view, the results of the view definition are immediately visible.
6. Click Apply to save your changes. If you are editing the active view, the results of the view definition are immediately visible.
7. Move to the next tab or click OK to save the view.

Configure View Sort Order

The Sort tab controls the order that documents appear in a view. You can enter a primary sort order followed by two secondary sort criteria. Choose ascending or descending to determine the sort order.
The Organize by folders checkbox controls whether the documents appear in a folder structure (default) or as a flat list with no folders.

To configure document sort order in a view definition:

1. On the View menu, choose Manage Views.
2. Add a new view or edit an existing view.
3. Click the Sort tab.
4. Click the down arrow and select a document attribute by which to sort documents.
5. Choose Ascending or Descending order.
6. Continue to specify secondary sort orders (optional).
7. Click Apply to save your changes. If you are editing the active view, the results of the view definition are immediately visible.
8. Move to the next tab or click OK to save the view.

Configure View Filter

The Filter tab lets you control the documents that appear in a view. If you do not define filter criteria, all documents in the Library will appear when the view is active. If you want to limit the documents that appear, you should define filter criteria. For example, you could filter documents by Type and choose to show only topics.

You filter documents by creating "selection statements" that include a Column data element followed by a Condition and a specific data Value. For example, to define a filter that displays only topics you would create the following "selection statement":

<table>
<thead>
<tr>
<th>Column</th>
<th>Condition</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>in</td>
<td>Topic</td>
</tr>
</tbody>
</table>

The following table lists the Columns that you can use to construct selection statements for filtering.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checked Out By</td>
<td>The author that has checked out a document.</td>
<td>One or more valid author names.</td>
</tr>
<tr>
<td>Hostname</td>
<td>The computer name for the author that has a document checked out.</td>
<td>Self can be used to identify the author currently logged into the Developer and running the view. For example, use Self to create a view that lists documents that are currently checked out to you.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>The date a document was created.</td>
<td>A valid date.</td>
</tr>
<tr>
<td>Document ID</td>
<td>The unique document identifier.</td>
<td>Any text.</td>
</tr>
<tr>
<td>Frames</td>
<td>The number of frames in a topic.</td>
<td>Any number from 0 to 1000.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
<td>Values</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Language</td>
<td>Language code assigned to the document.</td>
<td>One or more valid language codes.</td>
</tr>
<tr>
<td>Last Modified By</td>
<td>The author that made the most recent modification to a document.</td>
<td>One or more valid author names.</td>
</tr>
<tr>
<td>Last Date Modified</td>
<td>The most recent date when a document was modified.</td>
<td>A valid date.</td>
</tr>
<tr>
<td>Link Count</td>
<td>The total number of document links.</td>
<td>Any number from 0 to 1000.</td>
</tr>
<tr>
<td>Links To</td>
<td>The number of links to a document.</td>
<td>Any number from 0 to 1000.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the document.</td>
<td>Any text.</td>
</tr>
<tr>
<td>Original Location</td>
<td>The folder path in the Library where the document resides.</td>
<td>Folder path in library. For example, /system/icons/standard.</td>
</tr>
<tr>
<td>Owner</td>
<td>The author currently assigned as the document owner.</td>
<td>One or more valid author names.</td>
</tr>
<tr>
<td>Path</td>
<td>The folder path in the Library where the document resides.</td>
<td>Folder path in Library. For example, /system/icons/standard.</td>
</tr>
<tr>
<td>Roles</td>
<td>The role(s) assigned to a document.</td>
<td>One or more valid roles.</td>
</tr>
<tr>
<td>State</td>
<td>The current state value assigned to a document.</td>
<td>One or more valid state values.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of document.</td>
<td>One or more valid document types.</td>
</tr>
<tr>
<td>Version</td>
<td>The current version of the document.</td>
<td>Any number or New or new documents.</td>
</tr>
</tbody>
</table>

Condition values act as operators such as equals, not equals, is more than, is less than, contains, does not contain, and so on. Both the Condition and data Value lists are constrained by the Column data type.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Applicable Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>in</td>
<td>Last Modified By</td>
<td>Select documents that match one or more values specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Type</td>
<td>Multi-user only: Owner Check Out By State</td>
</tr>
<tr>
<td>Multi-user only:</td>
<td>Owner</td>
<td></td>
</tr>
<tr>
<td>not in</td>
<td>Last Modified By</td>
<td>Select documents that do not match one or more values specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Type</td>
<td>Multi-user only: Owner Check Out By State</td>
</tr>
<tr>
<td>Multi-user only:</td>
<td>Owner</td>
<td></td>
</tr>
<tr>
<td>Condition</td>
<td>Applicable Column</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>is empty</td>
<td>Role</td>
<td>Select documents with one or more property attributes that are empty.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Multi-user only:</strong></td>
</tr>
<tr>
<td></td>
<td>Owner</td>
<td>Multi-user only:</td>
</tr>
<tr>
<td></td>
<td>Checked Out By</td>
<td>Multi-user only:</td>
</tr>
<tr>
<td></td>
<td>State</td>
<td>Multi-user only:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select documents with one or more property attributes that are not empty.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Multi-user only:</strong></td>
</tr>
<tr>
<td>on</td>
<td>Creation Date</td>
<td>Select documents that have a matching date.</td>
</tr>
<tr>
<td></td>
<td>Last Modified Date</td>
<td>Select documents that have a date that is before the date specified in the Value field.</td>
</tr>
<tr>
<td>on or before</td>
<td>Creation Date</td>
<td>Select documents that have a date that is after the date specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Last Modified Date</td>
<td>Select documents that have a date that is after the date specified in the Value field.</td>
</tr>
<tr>
<td>equals</td>
<td>Frames</td>
<td>Select documents that have an exact matching value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Link Count</td>
<td>Select documents that have an exact matching value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Links to</td>
<td>Select documents that have an exact matching value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Version</td>
<td>Select documents that have an exact matching value specified in the Value field.</td>
</tr>
<tr>
<td>not equals</td>
<td>Frames</td>
<td>Select documents that do not exactly match a value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Link Count</td>
<td>Select documents that do not exactly match a value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Links to</td>
<td>Select documents that do not exactly match a value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Version</td>
<td>Select documents that do not exactly match a value specified in the Value field.</td>
</tr>
<tr>
<td>is more than</td>
<td>Frames</td>
<td>Select documents that have a value greater than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Link Count</td>
<td>Select documents that have a value greater than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Links to</td>
<td>Select documents that have a value greater than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Version</td>
<td>Select documents that have a value greater than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td>is less than</td>
<td>Frames</td>
<td>Select documents that have a value less than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Link Count</td>
<td>Select documents that have a value less than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Links to</td>
<td>Select documents that have a value less than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Version</td>
<td>Select documents that have a value less than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td>is at least</td>
<td>Frames</td>
<td>Select documents that have a value equal to or greater than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Link Count</td>
<td>Select documents that have a value equal to or greater than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Links to</td>
<td>Select documents that have a value equal to or greater than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Version</td>
<td>Select documents that have a value equal to or greater than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td>is at most</td>
<td>Frames</td>
<td>Select documents that have a value equal to or less than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Link Count</td>
<td>Select documents that have a value equal to or less than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Links to</td>
<td>Select documents that have a value equal to or less than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Version</td>
<td>Select documents that have a value equal to or less than the numeric value specified in the Value field.</td>
</tr>
<tr>
<td>contains</td>
<td>Document ID</td>
<td>Select documents that contain the text specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Location</td>
<td>Select documents that contain the text specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>Select documents that contain the text specified in the Value field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Multi-user only:</strong></td>
</tr>
<tr>
<td></td>
<td>Checked Out Hostname</td>
<td>Multi-user only:</td>
</tr>
<tr>
<td>is (exactly)</td>
<td>Document ID</td>
<td>Multi-user only:</td>
</tr>
<tr>
<td></td>
<td>Checked Out Hostname</td>
<td>Multi-user only:</td>
</tr>
</tbody>
</table>
### Multi-user Considerations

The data Values for the Checked Out By Column are based on the users defined in the system by the Administrator. However, to filter documents that are checked out to you, choose the Self option.

You can also use the "is empty" or "is not empty" to filter documents by check out status. For example, as an administrator, you may want to create a view that lists all documents that are checked out by any author. To do this, you can create a filter that selects documents that have the Checked Out By column that is "not empty".

You can add as many "selection statements" as you need for filter criteria. Each statement appears in the area below the Match all/any options. These options control how the selection statements are applied. For example, use Match all (and) if you only want documents that meet all of the selection criteria listed. You can also use Match any (or) if you want documents that meet any of the selection criteria listed.

You can modify the parameters of any selection statement after it is added. You can also remove one or more statements from the list or clear the entire list.

To add a selection statement:

1. On the **View** menu, choose **Manage Views**.
2. Add a new view or edit an existing view.
3. Click the **Filter** tab.
4. Edit the Column, Condition, or Value fields.
5. Click **Add**.
6. Click **Apply** to save your changes. If you are editing the active view, the results of the view definition are immediately visible.

To edit an existing selection statement:

1. On the **View** menu, choose **Manage Views**.
2. Add a new view or edit an existing view.
3. Click the **Filter** tab.
4. Choose a selection statement from the list.
5. Edit the Column, Condition, or Value fields.
6. Click **Apply** to save your changes. If you are editing the active view, the results of the view definition are immediately visible.

To remove a selection statement:
1. On the **View** menu, choose **Manage Views**.
2. Add a new view or edit an existing view.
3. Click the **Filter** tab.
4. Choose a selection statement from the list.
5. Click **Remove** to erase only the selected item.
6. Click **Apply** to save your changes. If you are editing the active view, the results of the view definition are immediately visible.

To remove all selection statements:
1. On the **View** menu, choose **Manage Views**.
2. Add a new view or edit an existing view.
3. Click the **Filter** tab.
4. Click **Clear** to remove all existing selection statements.
5. Click **Apply** to save your changes. If you are editing the active view, the results of the view definition are immediately visible.

**Edit an Existing View**
You modify any existing view at any time and make changes.

To edit an existing view:
1. On the **View** menu, choose **Manage Views**.
2. Select a view from the list.
3. Choose **Edit**.
4. Modify the view configuration settings on the Column Selection, Sort, and Filter tabs.
5. Click **OK**.

**Copy a View**
You can make a copy of an existing view as a starting place for a new view definition. When you copy an existing view, it is automatically created with the same name with the prefix "Copy of". You should change the name to make it more meaningful and unique: then proceed with your modifications.

To copy an existing view:
1. On the **View** menu, choose **Manage Views**.
2. Select a view from the list.
3. Choose **Copy**.
4. Change the name of the view.
5. Modify the view configuration settings on the Column Selection, Sort, and Filter tabs.
6. Click **OK**.

**Delete a View**

You can delete any custom view that you create; however, you cannot delete the Details View.

*Multi-user Considerations*

You cannot delete the Deleted documents and Lost documents views.

If you delete the active view, the Details view appears in its place.

To delete an existing view:

1. On the **View** menu, choose **Manage Views**.
2. Select a valid view from the list.
3. Choose **Delete**.
4. Confirm the deletion.
5. Click **OK**.

**Reset Defaults for Views**

The Developer provides one or more sample views depending on your installation type (single vs. multi-user). For example, the Library Details View is a sample view deliver with the Developer. You can modify a sample view to meet your requirements. You can also discard your changes and reset each view back to its original settings.

To reset a sample view:

1. On the **View** menu, choose **Manage Views**.
2. Select a sample view from the list.
   
   You cannot reset the values for a custom view that you add.
3. Choose **Reset**.
4. Confirm your choice to reset the view.
5. Click **OK**.

**Understand the System Folder**

The System folder is automatically created when you install the Developer. It contains a series of subfolders and documents that store publishing documents, templates, master role documents, and attachment icons. The System folder is only visible in the Library and contains the following subfolders:

- **Icons**
Warning! You should not move, delete, or rename the System folder, its subfolders, or any documents that are contained within them. Doing so may impair the operation of the software. However, you can remove and add documents to the Icons folder without causing problems.

Attachment Icons

When you link an attachment to a topic frame, an icon is added as a clickable link that navigates to the attached content from the Player. The Developer provides five standard icons that you can use, or you can create and use custom icons of your own in addition to the standard icons.

The Icons folder contains two subfolders, called Custom and Standard. The Standard folder stores the icons that are delivered with the Developer. Each icon is included in a separate Package document. If you do not want the standard icons to appear as choices in the Frame Link Properties dialog box (Topic Editor), you can delete the package documents from the Standard folder. The Custom folder is where you should store any custom icons that you decide to create.

Publishing Styles

The Developer provides a variety of deployment and document styles that you can use to publish content. In addition, the Developer gives you the ability to launch published content from the Help menu of an application.

The Publishing/Styles folder contains the publishing styles. Each publishing style has specific formatting attributes that are controlled by Publishing Project documents that are delivered with the Developer. Each category or "brand" has its own subfolder. You can customize publishing styles to fit your business needs.

The Help Menu Integration folder contains the files necessary for launching content from the Help menu of an application. Each category or "brand" has its own subfolder. Within the subfolder, the files necessary for supported target applications are in stored in a package document. These files are automatically published with the Player content. The Help Menu Integration folders and documents that appear depend on the product category that you are using. You should not alter the contents of any of these package documents. For more information, see the In-Application Support guide.

Roles

The Developer provides a series of empty master role documents for each supported language. For example, the Roles.en document is the master role document for roles in the English language as determined by the language property of the document. You should not create additional role documents for the same language, as the Developer uses only the first one created for role assignment. For example, if you make a copy of a role document for English and add roles to it, those roles do not appear as assignment choices from any topic Properties toolpane. You should also not move these documents to any other folder in the Library.

You should always use these documents to store roles that can be assigned to topics for role-based filtering in the Player. These documents are also used to store roles from content that you convert from a previous version.
Templates
The Developer uses templates to generate bubble text automatically for topics as you record an application, depending on the keystroke or mouse action performed during each step. These templates are stored in the Templates folder. There is a subfolder for each supported language, named according to the code for each language. The Developer provides two template sets for each language that you can assign to module, section, and topic documents.

Supported Languages
In the Library, each supported language has a specific language code. The language code is used as the name of the subfolders in the Templates folder:

<table>
<thead>
<tr>
<th>Code</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>da</td>
<td>Danish</td>
</tr>
<tr>
<td>de</td>
<td>German</td>
</tr>
<tr>
<td>en</td>
<td>English</td>
</tr>
<tr>
<td>es</td>
<td>Spanish</td>
</tr>
<tr>
<td>es-mx</td>
<td>Spanish (Mexico)</td>
</tr>
<tr>
<td>fi</td>
<td>Finnish</td>
</tr>
<tr>
<td>fr</td>
<td>French</td>
</tr>
<tr>
<td>fr-ca</td>
<td>French (Canada)</td>
</tr>
<tr>
<td>hu</td>
<td>Hungarian</td>
</tr>
<tr>
<td>it</td>
<td>Italian</td>
</tr>
<tr>
<td>ja</td>
<td>Japanese</td>
</tr>
<tr>
<td>ko</td>
<td>Korean</td>
</tr>
<tr>
<td>nl</td>
<td>Dutch</td>
</tr>
<tr>
<td>no</td>
<td>Norwegian</td>
</tr>
<tr>
<td>pl</td>
<td>Polish</td>
</tr>
<tr>
<td>pt</td>
<td>Portuguese</td>
</tr>
<tr>
<td>ru</td>
<td>Russian</td>
</tr>
<tr>
<td>sv</td>
<td>Swedish</td>
</tr>
<tr>
<td>zh-CHS</td>
<td>Chinese (Simplified)</td>
</tr>
<tr>
<td>zh-CHT</td>
<td>Chinese (Traditional)</td>
</tr>
</tbody>
</table>

Update the Library (Service Packs)
If you have installed one or more service packs, you will need to update the Library using the Library Update command in the Developer. When you run this command, you will see a list of the service packs that you have installed. You can then selectively choose the service pack updates that you want to process, although it is highly recommended that you update the Library with each service pack listed. However, if you are using multiple Libraries, it may make sense for you to selectively choose the service pack updates for each Library.

This process updates various documents in the System folder but does not impact your content.
As a result of running this update process, a System/Service Packs/ folder is created that contains an empty package document for each service pack. You should not edit or remove these package documents or folders as they are a record of each update that was applied to the Developer.

The About the Developer (Help, About) dialog box also lists the service packs that have been applied.

**Note:** If you have a Single User installation, the Library is updated automatically. You do not need to run the updates manually.

### Multi-user Considerations

Service pack document updates are automatically checked in to the Library. Therefore, only one author in a multi-user environment would need to run the Library Update command.

To update the Library with a service pack:

1. Start the Developer and open the Library that you want to update.
2. On the **Tools** menu, choose **Library Update**.
3. Choose the service packs that you want to process.
4. Click **OK** to update the Library.

### Back up Content

A well-executed backup plan is your only defense against losing all your data in the event of a disaster. Your company's system administrator should review any backup and disaster recovery plan before it is implemented.

Any backup process should be evaluated against the following criteria:

- Back up as often as you feel is necessary or your company dictates.
- Back up frequency should be based on the amount of data you are willing to lose if disaster strikes.
- Backups should be verified to ensure that the process was successful.
- Backups should be tested periodically to ensure that data can be recovered.

There are different types of Development environment installations to consider when establishing a backup plan. These installation types are not mutually exclusive; a company's backup plan should address each type that is in use.

### Single User Environment

The following items must be considered for a single user installation where the Developer and the content are installed on a local workstation:

- Export the outline(s) you are currently developing on a daily basis.
- Export your entire Library on a routine basis to backup all of your content.
- Use backup software to backup your entire file structure on a routine basis.
Multi-user Environment

The following items must be considered for a multi-user installation where the Developer is installed on client machines and the Library is installed on a server:

- Ensure that all content authors have checked in all documents.
- Ensure that all content authors have logged out of the Developer.
- Perform a routine backup of the SQL or Oracle database.

Encourage authors to back up their new and checked out documents by exporting the content.

Restore a Database

If a database administrator restores the server database from a backup, the UpdateRestoreDate.sql script must be run to update specific fields. This is necessary because clients normally synchronize with the server in a way that only uploads or downloads the latest changes that occurred after the last synchronization. This is a differential or incremental update. This works because the server and the client assume that the time can only go in one direction: ahead, but cannot go back. This rule is violated when the server database is restored to an earlier point in time. Therefore, a special flag must be updated in the database which indicates that an incremental refresh would not work, but a full refresh is needed, because the server “went back in time”. The system cannot normally handle this situation correctly, unless the script is run.

The UpdateRestoreDate.sql script is located in the Utils folder in the location where the Developer server is installed.
4. Build an Outline

You build an outline by linking documents together in a way that best conveys the information that you want to communicate to your audience. Although there are several ways to create documents, you must use the Outline Editor to define the outline by linking module/section and topic documents to one another. For example, you can create new documents from the Library without any links and then use the Outline Editor to design the outline by linking the various documents that you have created in the Library. You can also create the outline "on the fly" by linking new documents directly from the Outline Editor.

Consider the following before deciding how to build your content:

- If you create a new document from the Library (File, New), you can predetermine the folder in which it is stored; however, you cannot link a document or view its relationship to other documents.
- If you link a new section or topic document from the Outline Editor, it is stored in the same Library folder as the parent document to which it is linked. When you link a new module, you are prompted to define its properties, at which time you can adjust the location where it is stored.

Regardless of how you build content, you will use some combination of module, section, and topic documents.

Navigate the Outline Editor

The Outline Editor displays the outline on the left and a view of either document details (or properties) or linked content on the right. By default, the Outline Editor displays the Player View that shows the Concept/Introduction panes depending on the document type you have selected. For example, module, section, and topic documents can have Concepts while topics can have both a Concept and an Introduction.

Text appears in the Introduction pane after you record topic content and enter text for the Introduction frame bubble. Only text that is marked as Visible in See It/Try It modes or Visible in Player appears in the Introduction pane.

The Concept pane displays linked content such as a web page, package, or URL. You can control the display of linked content using the Preview category in Options (on the Tools menu).

---

**Publishing Note:** When you publish content to the Player, topic introduction text will appear in the Player Concept pane if there is no linked content in the Developer Concept pane.

---

You can navigate the outline and display linked documents by clicking the + icon next to the document name. You can also use the left or right arrow keys or the ENTER key to expand/collapse a parent document with links. The ENTER key can also be used to open recorded topics in the Topic Editor or launch the Recorder for empty topics. Use the up or down arrow keys to move the document selection up and down the outline.

To initiate any action on a document such as link a new document, you must select it by clicking the document name. When you select a document in the outline, linked Concept/Introduction content also appears (if you linked this content to the document).

You can adjust the size of each pane by clicking and dragging the vertical or horizontal split bars that separate each pane. The Developer remembers any sizing changes that you make to these panes.
Build an Outline

Note: You can also use the keyboard to navigate in the Outline Editor.

Expand/Collapse Modules or Sections
You can expand or collapse selected module or section documents to display its related child documents. Use the or toolbar icons or the Expand and Collapse commands on the View menu to expand or collapse selected modules or sections.

Multi-user Considerations
As documents are checked in and out, icons appear to the left of the document name indicating the check in/out state as follows:

☑ indicates that the document is checked out to you.

☒ indicates that the document is locked and checked out to another author.

No icon indicates that the document is checked in and available to any author.

These icons appear in various places such as the Library and Outline Editor as well as on document editor tabs and various views. Also note that additional columns in the Details view of the Library and Outline Editor display the check in/out state and version number. The Checked Out By column displays the name of the author who is currently using the document.

Open a Document from the Outline Editor
You can open module, section, and topic documents from the Outline Editor. Opening a module or section displays a new Outline Editor tab so you can focus your attention on a specific part of the outline. You can open as many modules or sections as you want and then copy and paste or drag-and-drop documents between tabs or the Library.

Opening a topic displays the Topic Editor if the topic has recorded content. Opening an empty topic starts the Recorder.

Note: You can select and open multiple documents at the same time from the Library or Outline Editor.

Multi-user Considerations
If you open a document that is not checked out to you, it opens in Read-Only mode. If you decide to make any changes to a Read-Only document, upon exit you are given the option to save the document (check out and save the changes), save it as a new document, or discard the changes.

To open a document from the Outline Editor:
1. Select one or more documents in the outline.
2. Right-click any document in the selection (if you have more than one selected) and choose Open.
   Modules and sections open in new Outline Editor tabs. Topics open in new Topic Editor windows.
Change the Outline Editor View

The default view in the Outline Editor is called the Player View, which allows you to link additional content to a module, section, or topic such as a web page, presentation, image, or other document. It has a Concept and Introduction pane. The Concept pane can display conceptual or explanatory information about a module or section, or topic that is selected in the outline. The Concept and/or Introduction panes are empty until you link content to a document.

The Introduction Pane typically provides a short statement introducing a topic selected in the outline. The Introduction pane does not appear when a module or section is selected in the Outline Editor.

**Note:** Linked documents in the Concept/Introduction display only when you select one document in the outline. If multiple documents are selected, the pane is blank and disabled.

In addition to the Player View, there is also a Details View that shows document properties such as Last Modified Date, Role assignment, and so on. Although you can sort the Details View by property column in the Library, you cannot sort by property column in the Outline Editor. Also note that you can add or remove columns from the Details View.

Multi-user Considerations

If you work offline and do not have a local copy of a document that is linked as a Concept or Introduction, you will see a message in the Player View instructing you to go online and perform the Document, Get command to retrieve read-only copies of the necessary documents for viewing. You can also check out the necessary documents if you want to edit them and they are not in use.

To change the Outline Editor view:

1. Launch the Outline Editor by opening a module or section document.
2. On the View toolbar, choose either the Details View or Player View depending on the view that currently appears.

Develop an Outline

You create an outline by linking new or existing documents in a multi-level hierarchy that you design using the Outline Editor. You will use a combination of modules, sections, or topics to design the outline hierarchy using as many levels as you want. Although you will typically create topic documents to capture transactional recordings of how to perform a task in an application, your use of module or section documents is completely your choice as these documents are merely containers for other documents. For example, you can choose to design an outline using just modules and topics, sections and topics, or a combination of modules, sections, and topics.

After you create an outline, you can refine it by changing document relationships, copying documents, deleting incorrect or unnecessary links, and so on. You can also embellish your outline with additional attachments in the form of web pages, packages, and URLs.

The Outline Editor will also display broken link documents.
Multi-user Considerations

When you work in a multi-user environment, you may want to periodically refresh the outline to update the content with the latest document information from the server.

Link a New Module

Using the Outline Editor, you can link a new module under any existing module or section document; however, you cannot link a module under a topic document. Linking a module creates a new document that is stored in the Library, as well as a new link between the module and its parent document.

Note: You can also link an existing outline.

A module/section has the following default properties that you can change:

- **Name**: A descriptive name for the document.
- **Location**: The folder location in the Library where this document is stored. The default folder that appears depends on where you are when you create the new document, as follows:
  - If you create a new document from the Library, the default folder is the folder that is selected in the Library when you create the new document.
  - If you link a new document from the Outline Editor, the default location is the same as the location of the parent document to which you are linking the new document.
- **Language**: The Language option allows you to choose the default dictionary that is used to check the spelling of a document's content. Dictionaries for English (UK & US), German, French, Spanish, Dutch, Danish, Portuguese (Brazil), Swedish, Finnish, Norwegian, and Italian are provided.
- **Template**: The Template option allows you to select another folder of template files. The template sets included with the Developer are the Standard and Microsoft templates. The Microsoft template conforms to the standards as stated in the Microsoft Manual of Style for Technical Publications. In addition to these templates, other template sets may be available to you. Alternate template sets are most useful when you are creating content for more than one application. Please contact Technical Support for more information on this option and its implementation.
- **Glossary**: The glossary document that is currently assigned to the document. The glossary document lists the words you have assigned as glossary terms. After you
have set up the glossary terms and their definitions, the Developer can automatically create the links to the terms found in any document text.

- **Screen Resolution:** The Screen Resolution option allows you to determine the resolution in which the topic content is recorded. If authors attempt to record in a resolution other than the one listed in the Screen Resolution list box, a message box informs them that their resolution does not match the topic setting and indicates in what resolution they should record. While content authors are not prevented from recording in a different resolution if they choose, this option does help to create greater consistency in the content.

Please note that the Developer detects the current resolution of your computer and automatically sets the screen resolution property to match when you create new documents. Once screen resolution for a topic is set and you have saved a recording; the screen resolution cannot be changed.

When you link a new module from the Outline Editor, the default properties from the parent document are automatically inherited until you change them.

---

**Multi-user Considerations**

A *Check Out Parent Document* message appears when you perform actions that impact a parent document that you do not have checked out such as linking a document, moving a document, pasting a document, deleting document links, and so on.

Any new document that you create or link is automatically checked out to you. If you want to make a new document available to multiple authors and place the document under the Developer's version control system, you must check it in.

See *Check In and Check Out Documents* in *Use the Developer in a Multi-user Environment* for more information.

---

To link a new module:

1. Display the Outline Editor by opening the module or section for which you want to link a new module.
2. Select the parent document to which you want link the new module.
3. On the **Link** menu, choose **New Module**.
4. Type a name for the new module and continue to modify any of the default properties, if desired.
5. Click **OK**.

A new module is linked (and automatically saved) beneath the parent document. You can also rename the new module after it is linked and saved.

---

**Link a New Section**

Using the Outline Editor, you can link a new section under any module or section document; however, you cannot link a section under a topic. Linking a new section creates a new document that is stored in the Library (same folder as the parent document) as well as a new link between the section and its parent document.

---

**Note:** You can also link an existing section.
When you link a new section from the Outline Editor, the default properties from the parent document are automatically inherited until you change them.

Each section that you link is automatically named "New Section" and placed directly beneath the parent document that you have selected. If the parent document has existing linked documents, the new section appears at the end of the list. For example, if you link a new section under a module that has three existing sections, the new section appears after the third section. You should rename the new section after it is linked.

**Multi-user Considerations**

A Check Out Parent Document message appears when you perform actions that impact a parent document that you do not have checked out such as linking a document, moving a document, pasting a document, deleting document links, and so on.

Any new document that you create or link is automatically checked out to you. If you want to make a new document available to multiple authors and place the document under the Developer's version control system, you must check it in.

See Check In and Check Out Documents in Use the Developer in a Multi-user Environment for more information.

To link a new section:
1. Display the Outline Editor by opening the module or section for which you want to link a new section.
2. Select the parent document to which you want link the new section.
3. On the Link menu, choose New Section. A new section is linked (and automatically saved) beneath the parent document with a default name that you should change. You can also rename the new section after it is linked and saved.

You can also right-click the parent document and choose Link New Section.

**Link a New Topic**

Using the Outline Editor, you can link a new topic under any module or section document. Linking a new topic creates a new document that is stored in the Library (in the same folder as its parent document) as well as a link between the topic and its parent document.

---

**Note:** You can also link an existing topic.

Each topic that you link is automatically placed beneath the parent document that you have selected. If the parent document has existing linked documents, the new topic appears at the end of the list. For example, if you link a new topic under a section that has three existing topics, the new topic appears after the third topic.

When you link a new topic from the Outline Editor, some of the default properties that appear are initially inherited from the parent module or section to which the topic is linked and other properties are initially set to the values that you have configured in the Options dialog box. For example, the general properties (Template, Language, Resolution, and
Glossary) are inherited from the parent document, whereas topic-specific properties (Play Modes and Know It options) are the same as the defaults set in Options dialog box.

**Empty vs. Recorded Topic**

A new topic is empty until you open it and start recording. An empty topic is distinguished from a recorded topic by its icon. When you open an empty topic, the Recorder starts. You can continue to record an application or you can click Finish to cancel the recording and return to the Outline Editor. Once you start recording and click Finish, the topic opens in the Topic Editor ready for editing.

**Publishing Note:** Empty topics are not included in any published output.

**Multi-user Considerations**

A Check Out Parent Document message appears when you perform actions that impact a parent document that you do not have checked out such as linking a document, moving a document, pasting a document, deleting document links, and so on.

Any new document that you create or link is automatically checked out to you. If you want to make a new document available to multiple authors and place the document under the Developer's version control system, you must check it in.

See Check In and Check Out Documents in Use the Developer in a Multi-user Environment for more information.

To link a new topic:

1. Display the Outline Editor by opening the outline or section for which you want to link a new topic.
2. Select the parent document to which you want link the new topic.

   You can also right-click the parent document and choose Link New Topic.

   A new topic is linked (and automatically saved) and appears beneath the parent document with a default name that you should change. You can also rename the new topic after it is linked and saved.

**Link an Existing Document**

In addition to linking a new document into the outline, you can also reuse content by linking an existing document into the structure. There is no limit to the number of times you can reuse an existing document. However, inserting an existing document creates a link to the original document and does not create a copy of the existing document. Therefore, if you link multiple instances of the same document into your outline and then modify one instance of that document, your changes are reflected in all linked instances.

**Note:** You can also copy an existing document and link it to another document. When you copy a document, you have the option to link it as the original or link it as a copy. When it is linked as a copy, you can change the content of the copy without changing the content of the original document.
In addition to linking new and/or existing documents from the Outline Editor, you can also drag-and-drop or copy/paste documents from the Library into the outline. To do this, you need to split the view and open the Outline Editor in one pane and the Library in another. Then you can select one or more documents in the Library and either copy/paste or drag-and-drop them into the Outline Editor.

**Note:** When you link an existing document into the outline, the linked document retains its original property settings from when the document was created and does not inherit properties from its parent.

---

**Multi-user Considerations**

A **Check Out Parent Document** message appears when you perform actions that impact a parent document that you do not have checked out such as linking a document, moving a document, pasting a document, deleting document links, and so on.

See **Check In and Check Out Documents** in Use the Developer in a Multi-user Environment for more information.

---

To link an existing document:

1. From the Outline Editor, select a parent document to which you want to link the existing document.
2. On the **Link** menu, choose **Existing Document**.
   
   You can also right-click the document and choose Link Existing Document.
3. Browse to a Library folder to locate the document that you want to link.
4. Select a document and click **Link**. If you selected a module or section as the parent document, the document is linked as a child document. If you selected a topic as the parent document, the document appears directly beneath the topic at the same level (since a topic cannot have child documents).

**Delete a Document Link**

From the Outline Editor, you can delete any link between a document and its parent document. For example, you can remove a section (or module) from a module, a topic from a section or module, a section from another section, and so on.

Deleting a link does not remove a document from the Library; it only removes the link between the selected document and its parent. Deleting a link in the Outline Editor also does not remove other linked content from the document such as a web page or package attachment.

You can use either the Delete Link or Cut command to remove links. The Cut command makes the document available for pasting; however, the Delete Link command does not.

**Note:** You cannot remove the root document in the Outline Editor.

---

**Find Orphan Documents**

When you delete document links from an outline, the result may be orphan documents that are no longer needed. You can use the Library to find orphan documents with no relationships to other documents. To do this, add the Links to column to the Library and
sort the column show documents with zero links first. You should review the list and identify those documents that you want to delete. Keep in mind that module and section documents with zero links may be used as the root document in one or more outlines.

---

**Multi-user Considerations**

A *Check Out Parent Document* message appears when you perform actions that impact a parent document that you do not have checked out such as linking a document, moving a document, pasting a document, deleting document links, and so on.

See *Check In and Check Out Documents* in *Use the Developer in a Multi-user Environment* for more information.

---


To delete a document link:

1. From the Outline Editor, select the document(s) that you want to unlink.
   
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
   
2. On the **Edit** menu, choose **Delete Link**.
   
   You can also right-click the document and choose Delete Link.

To delete a document link using Cut:

1. From the Outline Editor, select the document(s) that you want to unlink.
   
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
   
2. On the **Edit** menu, choose **Cut**. You can now paste the cut document anywhere in the outline hierarchy.
   
   You can also right-click the document and choose Cut.

---

**Rename a Document**

You can rename any document from the Library. From the Outline Editor, you can rename a module, section, or topic document only.

Document names do not have to be unique. Since documents are identified by their ID, two documents with the same name can exist in the same Library folder or outline.

---

**Note:** You can also rename a document using the Name property in the Properties toolpane (General category). However, you cannot rename multiple documents at the same time using this toolpane.
**Multi-user Considerations**

Before you can perform this action, you must check out the document. After you save any changes, you should check in the document to make it available to other authors and add the changes to the Developer's version control system.

The Developer preserves the name of versioned documents. When you roll back a renamed document to a previous version, the document name rolls back as well.

To rename a document:

1. Click the document that you want to rename.
2. On the **Edit** menu, choose **Rename**.
   - After selecting a document, you can also click the document name or press F2 to start edit mode.
   - You can also right-click a document and choose Rename.
3. Type a document name.
4. Press ENTER or click anywhere outside the name to save your changes.

**Move a Document (Outline Editor)**

You can change the sequence of documents within a parent and/or change the link between any documents in the hierarchy by moving documents (with the exception of the root document) that are displayed in the Outline Editor. Moving a document in the Outline Editor does not change where it is stored in the Library; it only changes its sequence or link to a parent document.

To move a document, you can either drag-and-drop it using the mouse, cut and paste the document, or use the Move Up/Move Down commands on the **Edit** menu. Cutting a document removes it from the hierarchy until you paste it in another location (although pasting a cut document is optional). Cutting is similar to deleting a link in that it removes the relationship between a document and its parent. The difference between cutting a document and deleting a link is that cut makes the document available for pasting and the Delete Link command does not.

When you move or cut an outline or section document that has related child documents, all child documents are moved as well. For example, if you move a section that has several topics, all topics are moved and linked to the new destination document.

---

*Note:* If you move a document between outlines using drag-and-drop, the Paste Special dialog appears so you can choose the action that you want to perform.

Also note that you cannot drag-and-drop documents from the Outline Editor to the Library.

The Move Up/Move Down commands can only be used to move a document within its parent. These commands cannot be used to move documents to different parent documents. For example, if a section has multiple topics, you can use these commands to change the sequence of the topics within that section only. You cannot move a topic from one section to another. Use drag/drop or cut/paste to change parent document relationships.
Multi-user Considerations

You can move or cut a document regardless of its check in/out state.

A Check Out Parent Document message appears when you perform actions that impact a parent document that you do not have checked out such as linking a document, moving a document, pasting a document, deleting document links, and so on.

See Check In and Check Out Documents in Use the Developer in a Multi-user Environment for more information.

To move a document in the Outline Editor using drag-and-drop:

1. Select the document you want to move.
   
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).

2. Drag the document and drop it in the desired destination within the outline.
   
   As you drag a document, a yellow arrow also moves along with a <documents will be inserted here> node across the content structure. Release the mouse button when the arrow and <documents will be inserted here > node appear at the destination that you want in the structure.

   If you want to move a document to a different level in the outline you must move the mouse to the left. In some cases, you may have to drag the document to the bottom of list beneath its parent to move it to higher level in the outline. For example, if you have a section that has several topic child documents and you want to move the first topic to be on the same level as the parent section, you must drag the first topic to the end of the list first and then drag the document to the left.

To move a document in the Outline Editor using cut and paste:

1. Select the document(s) that you want to cut.

   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).

2. On the Edit menu, choose 🛠 Cut.

   You can also right-click your selection and choose Cut.

   The document(s) immediately disappears from the outline. You can stop now if you do not want to paste the cut documents or continue to establish a new link for the cut document.

3. Point to the document where you want to establish a new link.


   You can also right-click the document where you want to paste your selection and choose Paste.

To move a document in the Outline Editor using Move Up/Move Down:

1. Select the document that you want to move.
You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).

2. On the **Edit** menu, choose **Move Up** or **Move Down** depending on the direction in which you want to move the document. The first document of the parent can only be moved down and the last document of the parent can only be moved up. You cannot move a document to a new parent using these commands.

**Copy and Paste a Document (Outline Editor)**

In addition to moving documents in the hierarchy, you can copy and paste documents to further refine the outline. When you paste a copied document, you can choose to paste it either as a link to the original document or as a copy of the original document.

You can use one of the following two Edit, Paste commands to paste copied documents:

- **Paste** - always pastes a new link to the original document(s). If the content of the original document changes, the changes are reflected in all linked instances of the document.

- **Paste Special** - presents options to either paste a new instance of the original document (Link), paste a copy of the original document as a new document but maintain links to the original related document (Copy), or paste a copy of the original document and all related documents as new documents (Duplicate).

When you duplicate a document that has child documents, all child documents are copied as well. For example, if you duplicate a section that has several topics, all topics are copied along with the section. Also, when you duplicate a document that has related documents such as web pages, packages, and glossaries, copies of the related documents are made.

**Note:** The Duplicate (selection and related) option does not create copies of templates, master role lists, sound files, and custom icon packages. The new, duplicated documents will reference the original documents of these types.

You can not copy documents from the Outline Editor and paste them into the Library.
Multi-user Considerations

You can copy a document regardless of its check in/out state. However, when you paste a copied document you may be prompted to check out the parent document.

A Check Out Parent Document message appears when you perform actions that impact a parent document that you do not have checked out such as linking a document, moving a document, pasting a document, deleting document links, and so on.

See Check In and Check Out Documents in Use the Developer in a Multi-user Environment for more information.

If you copy and paste a document checked out to another author, the Developer uses the latest document checked into the server.

If you copy and paste a document while working offline, the Developer copies the document in your local cache.

If you paste new copies of all documents using the Duplicate option of the Paste Special command, all new documents are automatically checked out to you. Document history from the original documents is removed and the version number is set to New.

To copy and paste a new instance of original document:

1. Select the document(s) that you want to copy.
   - You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).

2. On the Edit menu, choose 📝 Copy.
   - You can also right-click your selection and choose Copy.

3. Select the document where you want to paste your selection.

4. On the Edit menu, choose 📝 Paste to paste a new instance of the original document.
   - You can also right-click the document where you want to paste your selection and choose Paste.

**Note:** You can also use the Paste Special command (from the Outline Editor) and choose the Link option to paste a link to the original document in addition to the options listed next.

To copy and paste new documents without related documents:

1. Select the document(s) that you want to copy.
   - You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).

2. On the Edit menu, choose 📝 Copy.
   - You can also right click your selection and choose Copy.

3. Select the document where you want to paste your selection.
4. On the **Edit** menu, choose **Paste Special** and select the **Copy** option to create new documents but retain links to the original related documents such as web page and package attachments, glossaries, and so on.

**To duplicate documents:**

1. Select the document(s) that you want to copy. You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).

2. On the **Edit** menu, choose **Copy**.

   You can also right click your selection and choose Copy.

3. Select the document where you want to paste your selection.

4. On the **Edit** menu, choose **Paste Special** and select the **Duplicate** option to create new copies of both the original selected documents and new copies of all related documents such as web page and package attachments, glossaries, and so on. Click the **View related documents** link to display a list of the related documents if you are not sure whether you want to duplicate related documents.

**Print an Outline**

You can print any outline or portion of the outline structure to a printer or file. Included in the output is the outline structure as well as the layout defined in the Details View of the Outline Editor. To print an outline, you must open either a module or section in the Outline Editor. A set of default data columns is automatically included in the output; however, you can configure which columns you want to appear in the report by switching to the Details view and customizing the columns. The Details View does not have to be displayed to print a report; however, only the Name column is included in the report when printed from the Player View.

---

**Note:** The report does not honor column sizes that appear in the Details View. You can change the page orientation or adjust the margins to modify the column sizes, or save the report to Microsoft Excel and adjust the columns there.

To print an outline, first expand the documents to show the detail that you want included in the report. For example, if you want the report to show child documents for modules/sections, make sure you expand these nodes first. Also note that deleted or missing documents are included.

The report opens in a new window. Use the following toolbar icons to print the report, configure printer settings, export the report to file or graphic format, and so on.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon" alt="Search" /></td>
<td>Searches the report for text.</td>
</tr>
<tr>
<td><img src="icon" alt="Print" /></td>
<td>Displays the current printer settings such as the active printer, status, page range, number of copies, and so on.</td>
</tr>
<tr>
<td><img src="icon" alt="Print" /></td>
<td>Prints the report to the active printer.</td>
</tr>
<tr>
<td><img src="icon" alt="Print" /></td>
<td>Displays the current page setup such as paper size, orientation, and margins that you can change.</td>
</tr>
<tr>
<td><img src="icon" alt="Print" /></td>
<td>Displays scaling options such as scaling by a percentage of normal size and fit options.</td>
</tr>
<tr>
<td><img src="icon" alt="Print" /></td>
<td>Scrolls the report.</td>
</tr>
</tbody>
</table>
To print an outline from the Outline Editor:

1. Open a module or section document in the Outline Editor.
2. Expand the documents to display the details that you want included in the report.
3. On the File menu, choose Print and use the toolbar icons to print, view, or save the report to a file.

Use Content Tools

After you build an outline, you can use the following techniques to manage and refine your content:

- Find and replace text in documents
- Replace fonts in document text
- Spell check content
- Find a document in the Library

Find and Replace Text

The Find and Replace tool allows you to locate text in your content and replace it with alternative text, if desired.

Text in the following areas is included in this operation:

- Module, section, and topic names
- Text and Object names in the Frame toolpane
- Implicit text for string inputs
- Decision frame headings and path names
- Jump-in point text
- Text in web pages
- Tooltips
- Glossary terms and definitions
You can start this tool from the Library or the Outline Editor only. From the Library, you must have at least one document selected or the tool is disabled. If nothing is selected in the Outline Editor, the entire outline is searched; this is equivalent to selecting the root of the outline.

In the Find and Replace dialog box, you can type the search and replacement text or select from a list of previous entries. The Developer maintains a history of the search and replace text entries in both the Find what and Replace with lists. You can search for an entire sentence, a specific word, or a portion of a word. If the word or phrase for which you are searching has capitalization or formatting, the word or phrase with which it is replaced will have the same formatting or capitalization. You can also replace text with an empty string (to delete the text) or with one or more spaces, except for document names.

By default, the selection and its related documents are searched. Clicking the View related documents link displays a list of the related documents. For this process, related documents are defined as all searchable documents that are directly or indirectly linked as children of the selection. For example, if you select a section that has topics and each of the topics has a web page linked as its concept, choosing to search related documents searches the section, the topics, and the web pages linked to the topics. Templates and package contents are not included in this operation.

If you want to search only the selected item(s), you can deselect the Include related documents option in the Find and Replace dialog box. If you deselect this option after starting a search operation, the Developer completes the current document and then proceeds to the next document in the selection, if any. You can also select this option after starting the search to include related documents for the rest of the selection.

To further define a search, you can choose options that allow you to ignore occurrences of the search text that appear as part of another word (Match whole word only) and/or to find text that exactly matches the capitalization of the search text (Match case). Special characters in a search string, such as * and ?, are treated as normal text during a search; they do not act as wildcards.

When the Developer finds the first instance of the text, it indicates the path in the Library to the document, plus information about where the word appears, such as a document name or web page text. You can choose to replace the text, keep searching the remainder of the content, or close the Find and Replace dialog box.

You can precisely control text replacement by confirming each instance, or you can automatically replace all occurrences of the search text if you do not want to review each replacement.
Warning! Use Replace and Replace All with caution. You cannot undo any text replaced using this tool.

Multi-user Considerations

For changes to be made to a document using this tool, the document must be checked out. If you plan to use this tool offline, you should check out all affected documents before going offline.

When you execute this process, the Developer searches through all of the documents in the selection, regardless of their check in/out state. If a change is necessary and the document is not checked out and if you are working online, the Developer automatically checks the document out to you and makes the change. If the document cannot be checked out, for example, if it is open in another editor or checked out to another user or you are working offline, it is skipped. At the end of the process, a summary message appears with a link to an activity log. Clicking the View activity log link in the message displays a list of the documents that were checked out to you during the process and those that could not be checked out. After you save any changes, you should check in the documents to make them available to other authors and add the changes to the Developer's version control system.

To find text:

1. From the Library or Outline Editor, select one or more documents or folders containing the documents in which you want to find text.

   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).

2. On the Edit menu, choose Find and Replace.

3. Type the text you want to find in the Find what field. You can also select a previous entry from the Find what history list.

4. Select the desired Find Options.

5. Click Find Next.

   The first occurrence of the search text is displayed in the Location section, along with information describing the location of the text within the document and the location of the document within the Library. If the text cannot be found, a message box displays informing you that the text was not found in the selected content. Click OK to close the message box.

6. Click Find Next as needed to search for additional occurrences of the text.

   Each subsequent occurrence of the search text is displayed in the Location section of the Find and Replace dialog box.

7. Click OK when notified that the search is completed.

8. When you are done finding text, click Close.

To find and replace text:

1. From the Library or Outline Editor, select one or more documents or folders containing the documents in which you want to replace text.

2. On the Edit menu, choose Find and Replace.
3. Type the text you want to find in the **Find what** field. You can also select a previous entry from the **Find what** history list.

4. Type the replacement text in the **Replace with** list box. You can also select a previous entry from the **Replace with** history list.

5. Select the desired **Find Options**.

6. Click **Find Next**.

   The first occurrence of the search text is displayed in the **Location** section, along with information describing the location of the text within the document and the location of the document within the Library. If the text cannot be found, a message box displays informing you that the text was not found in the selected content. Click **OK** to close the message box.

7. For each occurrence of the search text, you can do one of the following:

   - Click **Replace** to replace the current occurrence with the replacement text and advance to the next occurrence. If you are working in the Outline Editor, the first time you replace text, a Replace Confirmation message appears indicating that you cannot undo changes made during find and replace. Click **Yes** to replace the text and continue the search or **No** to cancel the find and replace process.

   - Click **Replace All** to replace all remaining occurrences with the replacement text. If you are working in the Outline Editor, a Replace Confirmation message appears indicating that you cannot undo changes made during find and replace. Click **Yes** to replace all occurrences of the text or **No** to cancel the find and replace process.

   - Click **Find Next** to skip the current occurrence without replacing the text and advance to the next occurrence.

8. When the find and replace process has completed, click **OK** to close the confirmation message box.

   If you made one or more replacements, you can also click the View activity log link to see a list of documents in which replacements were made and the number of replacements in each document.

9. When you are done replacing text, click **Close**.

**Replace a Font**

The Replace Font tool allows you to locate text with specific formatting in your content and change the formatting, if desired. Only text in web pages and topics is included in font replacement.

You can start this tool from the Library or the Outline Editor only. From the Library, you must have at least one document selected or the tool is disabled. If nothing is selected in the Outline Editor, the entire outline is searched; this is equivalent to selecting the root of the outline.

In the Replace Font dialog box, you can specify the properties of both the search and replacement fonts. These properties include font family (such as Arial or Verdana), font size (in points), and font style (bold, italic, underline). In the Font field, you can type a font name or select from a list of all installed system fonts. In the Size field, you can type a value (in points) or select from a predefined list ranging from 8 to 72 pt. You can enter smaller and larger sizes if needed, but only integer values are allowed. In the Style field, you can select from a list of predefined options only.

---

**Note:** Font replacement does not include font color, paragraph justification, or bulleted/numbered list styles.
If you do not specify any of these properties, that property is ignored in the search and/or replacement. For example, if you set the Find what options to Arial, blank, and Bold, respectively, the Developer will search the selected content for bold Arial text of all sizes. Similarly, if you set the Replace with options to blank, 10, and blank, respectively, the Developer will change the size of the located text to 10 pt, but will leave the font family and style unchanged.

By default, the selection and its related documents are searched. Clicking the View related documents link displays a list of the related documents. For this process, related documents are defined as all searchable documents that are directly or indirectly linked as children of the selection. For example, if you select a section that has topics and each of the topics has a web page linked as its concept, choosing to search related documents searches the section, the topics, and the web pages linked to the topics. Templates and package contents are not included in this operation. If you want to search only the selected item(s), you can deselect the Include related documents option in the Replace Font dialog box.

To further define a search, you specify the type(s) of text to include in font replacement. In topics, you can apply font replacement to bubble text, Introduction/End frame text, string input text, and/or template text. You can also apply font replacement to web page text. You must select at least one type of text to include before you can start the font replacement process.

During font replacement, the Developer searches the specified type(s) of text in the topics and/or web pages included in the selection and replaces all occurrences of the search font with the replacement font. Font replacement is completed automatically for the entire selection, and you are not prompted to confirm each replacement.

**Warning!** Use font replacement with caution. You cannot undo any fonts replaced using this tool.

---

**Multi-user Considerations**

For changes to be made to a document using this tool, the document must be checked out. If you plan to use this tool offline, you should check out all affected documents before going offline.

When you execute this process, the Developer searches through all of the documents in the selection, regardless of their check in/out state. If a change is necessary and the document is not checked out and if you are working online, the Developer automatically checks the document out to you and makes the change. If the document cannot be checked out, for example, if it is open in another editor or checked out to another user or you are working offline, it is skipped. At the end of the process, a summary message appears with a link to an activity log. Clicking the View activity log link in the message displays a list of the documents that were checked out to you during the process and those that could not be checked out. After you save any changes, you should check in the documents to make them available to other authors and add the changes to the Developer’s version control system.

To replace a font in your content:

1. From the Library or Outline Editor, select one or more documents or folders containing the documents in which you want to replace a font.

You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
2. On the **Edit** menu, choose **Replace Font**.

3. In the **Find what** row, select the font family, font size, and/or font style you want to replace.

4. In the **Replace with** row, select the font family, font size, and/or font style with which you want to replace the search font.

5. In the **Apply to** field, select the text to which the font replacement should be applied.

   You can replace fonts in topic bubble text, Introduction/End frame text, string input text, template text, and/or web page text.

6. Click **OK**.

   If you are working in the Outline Editor, a Replace Confirmation message appears indicating that you cannot undo changes made during font replacement. Click **Yes** to continue or **No** to cancel the font replacement process.

   The Developer searches the topics and/or web pages included in the selection and replaces every occurrence of the search font with the specified replacement font.

7. Click **OK** when notified that the font replacement is completed or that the font cannot be found in the selected content.

   If one or more replacements were made, you can also click the View activity log link to see a list of documents in which replacements were made and the number of replacements in each document.

8. When you are done replacing fonts, click **Close**.

**Spell Check Content**

After recording and editing content, and especially before publishing, you should verify that the spelling of text included in the content is correct.

Text in the following areas is included in this operation:

- Module, section, and topic names
- Text and Object names in the Frame toolpane
- Implicit text for string inputs
- Decision frame headings and path names
- Jump-in point text
- Text in web pages
- Tooltips
- Glossary terms and definitions
- Keywords
- Roles
- Document output fields in the Properties toolpane

**Note:** The names of the following document types are not included in this operation: web pages, packages, glossaries, role lists, and publishing styles.
You can start this tool from the Library or the Outline Editor only. From the Library, you must have at least one document selected or the tool is disabled. If nothing is selected in the Outline Editor, the entire outline is searched; this is equivalent to selecting the root of the outline.

If the document(s) selected for spell checking are linked to other documents, you are prompted with the choice of checking the selection only or the selection and related documents. Clicking the View related documents link displays a list of the related documents. For this process, related documents are defined as all searchable documents that are directly or indirectly linked as children of the selection. For example, if you select a section that has topics and each of the topics has a web page linked as its concept, choosing to search related documents searches the section, the topics, and the web pages linked to the topics. Templates and package contents are not included in this operation.

By default, the Spell Check tool ignores words that are in all uppercase letters and attempts to split compound words into two words. However, you can change these settings either before initiating a spelling check or while checking your content from Spelling page of the Options dialog box.

When a misspelled word is found, the Developer identifies the Library path of the document in which the word appears, as well as the context of the word within the document. You then have the option of ignoring that particular instance or all instances of the word, changing the word in that particular location or in all locations where it appears, or adding the word to the custom dictionary.

**Warning!** You cannot undo any changes made during a spelling check.

When you add a word to your dictionary during a spelling check, the word is added to the custom dictionary specified in the Spelling category in the Options dialog box. While performing a spelling check, you can also switch custom dictionaries or create a new one.

**Language Property**
The Developer provides a dictionary for each of the following supported languages:

- Danish
- Dutch
- English
- English (United Kingdom)
- English (United States)
- French
- French (Canada)
- Finnish
- German
- Italian
- Norwegian
- Portuguese (Brazil)
- Spanish
Swedish

During a spelling check, the Developer uses the dictionary that matches the Language property of the document it is currently checking. If the content selected for a spelling check includes documents with different assigned languages, the spelling checker switches dictionaries as needed. If no dictionary of the same language exists, the spelling checker skips the document and adds a message to the activity log.

Multi-user Considerations

For changes to be made to a document using this tool, the document must be checked out. If you plan to use this tool offline, you should check out all affected documents before going offline.

When you execute this process, the Developer searches through all of the documents in the selection, regardless of their check in/out state. If a change is necessary and the document is not checked out and if you are working online, the Developer automatically checks the document out to you and makes the change. If the document cannot be checked out, for example, if it is open in another editor or checked out to another user or you are working offline, it is skipped. At the end of the process, a summary message appears with a link to an activity log. Clicking the View activity log link in the message displays a list of the documents that were checked out to you during the process and those that could not be checked out. After you save any changes, you should check in the documents to make them available to other authors and add the changes to the Developer’s version control system.

To spell check a document:

1. From the Library or Outline Editor, select one or more documents or folders containing the documents whose content you want to spell check.

   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).

2. On the Tools menu, choose Spelling.

   You can also press the F7 key.

   The Related Documents dialog box appears when you perform an action on any document that has links to other documents. You can choose to process only the document(s) you selected or to process your selection and all of the related documents.

   Click the View related documents link to display a list of the related documents if you are not sure whether you want to include related documents.

   After you have made your selection, click OK.

3. If a misspelling is found, it is displayed in the Location section, along with information describing the location of the text within the document and the location of the document within the Library. Click Ignore, Ignore All, Change, Change All, or Add, as appropriate.

   If you are working in the Outline Editor, the first time you change a word, a Replace Confirmation message appears indicating that you cannot undo replacements made during a spelling check. Click Yes to continue or No to cancel the spell check.

4. If necessary, click Options to change the spelling options or the custom dictionary.
To change the custom dictionary, select the dictionary from the Custom dictionary list in the Options dialog box and click OK. You can also click User Dictionaries in the Options dialog box to create a new custom dictionary. After you change the custom dictionary, clicking Add in the Check Spelling dialog box adds the word to the newly selected dictionary.

5. Click OK when the spelling check is complete.

If you changed one or more misspelled words, you can also click the View activity log link to see a list of documents in which changes were made and the number of changes in each document.

Find a Document in the Library

From the Outline Editor, you can select one document and find its folder location in the Library.

In a single layout, the Library tab will open if the Library is not already displayed. If the Library is open, it will become the active tab.

Note: If the Library is using a custom view when finding a document, the view is automatically switched to the Details view.

In a split layout (horizontal or vertical), the Library is activated in the layout other than the one in which you selected the document from the Outline Editor. For example, if you have a horizontal split layout with a document selected in the Outline Editor from the top layout and you run this command, the Library is opened in the bottom layout with the folder location and document are highlighted.

To find a document in the Library:

1. Open an outline in the Outline Editor.
2. Select one document that you want to locate in the Library.
3. On the View menu, choose Find in Library to display the selected document in the Library.
5. Record Topic Content

The Recorder appears on top of the application while you are recording the task. When the Recorder is active, the Outline Editor closes, allowing the Recorder to take screen captures as you perform the steps. Each time you capture an action while recording, the Recorder disappears while the screen is captured to prevent the Recorder from appearing in the results.

The Recorder contains brief instructions to help you during the recording process. The Last recorded event field tells you the last action you captured. The Next screenshot records field indicates the next action that you will capture.

Note: If you are recording in automatic mode, the Recorder disappears after you press PRINTSCREEN and records each screen and action until you press PRINTSCREEN again. The Recorder contains brief instructions that tell you to press PRINTSCREEN to start recording and press PRINTSCREEN again to stop recording.

Note: If you are recording content that will be deployed to end users in the Player format, you should record the topics using the same version of the target application that the end users will have when playing the content. Otherwise, context sensitivity may not function properly in the Player.

Recorder Logic

The Recorder functions like a screen capture utility. When you record a topic, you are taking a series of pictures of the way the screen looks after each step in a task. Each screen image you capture also has an associated action. This action that you perform (mouse click or keyboard action) moves you to the next screen. The screenshot and associated action are called a frame. The recorder can be set up to function in manual recording mode (default) or automatic recording mode. You can change the recording mode in the Recorder category from Tools, Options by selecting the desired mode (Manually or Automatically record screenshots).

Automatic vs. Manual Recording

Use Automatic Recording when you are recording a familiar system process to keep errors to a minimum. In this mode, every action after you press PRINTSCREEN is recorded until the next PRINTSCREEN. Inadvertent actions are recorded and will have to be edited out in the Topic Editor.

Use Manual Recording mode when you are less familiar with the system process you are recording. This mode requires you to press PRINTSCREEN after each action you record, giving you the opportunity to correct mistakes before the recording is saved with the next PRINTSCREEN.

Manual Recording

To manually capture a screen, you press the PRINTSCREEN key on your keyboard. Because of the way the Recorder works in manual mode, two PRINTSCREENS are necessary to capture the information for one frame; one for the screenshot and one for the action. When you press PRINTSCREEN at the beginning of the topic, the Recorder captures the first screen and creates a screenshot file. When you then perform an action and press PRINTSCREEN again, the Recorder captures the action you performed and associates it with the first screen to create the first frame, and it also captures the screen as it appears as a result of performing the recorded action and creates a screenshot file.
As you record frames, two display fields in the Recorder help you keep track of what is being recorded. The Next screenshot records field displays the action that you have performed that will be captured the next time you press PRINTSCREEN. The Last recorded event field tells you the action that was captured the last time you pressed PRINTSCREEN.

**Automatic Recording**
To automatically capture a screen, you press the PRINTSCREEN key on your keyboard. Because of the way the Recorder works in automatic recording mode, only two PRINTSCREENS are necessary to capture the information for all frames, one to start recording and one to end the recording. When you press PRINTSCREEN at the beginning of the topic, the Recorder captures each screen and its associated action until you press PRINTSCREEN again.

Before you begin recording, the recorder displays instructions for you to press PRINTSCREEN to start recording and press PRINTSCREEN again to stop recording. The recorder is hidden after the first PRINTSCREEN so it is not recorded with the application.

**Note:** Point events are not recorded when using the automatic recording mode because there is no way to record the action without an event such as a mouse click; for example, when you click on a menu then move your cursor to a menu item that opens a submenu. No action occurs until you click on the submenu item. Use manual recording mode to record this type of situation because you can PRINTSCREEN on the menu item and submenu item to capture without a click.

Automatic recording mode is not supported when re-recording a topic. Re-recording a topic is always a manual process.

You can configure the Recorder to record sound during the screen capture process. The Recorder behavior depends on the configuration of several options in the Record category on the Options dialog box. See Configure the Recorder for Sound for more information.

**Context Recognition in the Recorder**
Context information can be used in conjunction with in-application support to provide context-sensitive help. In-application support allows the user to use SmartHelp or the target application's Help menu to launch topics that correlate to their current screen rather than the entire list of topics. The Developer provides context recognition support differently for target applications than it does for non-target applications.

For target applications, the Developer acquires the context information for each screen when the content is recorded. This type of recognition is called "ExactMatch" because content is tied to a specific screen's context ID ensuring a 100% match. A content developer just records the target application screen. The ExactMatch context indicator appears when the Recorder recognizes the context of the object. This indicator means that the context information will be captured. When the content is launched in the Player using in-application support, the Player searches for "applicable" documents and returns content containing the specific context ID.

For non-target browser-based applications, the Developer uses a statistical engine to calculate an identifier on the application screen based on information it gathers on various parts of the screen. This type of recognition is called "SmartMatch". When help is launched through SmartHelp, the SmartHelp engine searches for SmartMatch context that will match the current context. You can add a SmartHelp toolbar button to the browser which will launch context-sensitive help content for target applications. SmartMatch is not as precise as ExactMatch but it narrows the content down significantly, giving the user some level of context-sensitive help. Additionally, SmartMatch becomes more effective as you
record content because more data points are accumulated to help determine the correct screen. The SmartMatch context indicator 📈 appears when the Recorder is in the SmartMatch recognition mode.

If the Recorder can not operate in either ExactMatch or SmartMatch mode, the NoMatch 📃 context indicator appears.

A warning indicator ⚠️ may also appear next to the context indicator when one of the following situations is detected:

- When the Recorder determines that context recording is taking too long. Recording performance can be improved by disabling unused Target Applications.
- When the Recorder determines that you are recording against a disabled Target Application. Recording quality may be improved by enabling the Target Application you are recording. You may also need to recapture actions for other frames taken during this recording session.

Click on the currently displayed context icon (or warning icon) in the Recorder (or on the AutoRecorder deskband) to configure target application support (or stop the recording and choose the Target Applications category in Tools, Options). You can use the Target Application Configuration dialog box to enable or disable target applications or enable just SmartMatch recognition. Eliminating target applications that you do not record can increase recording performance.

**Note:** If the Recorder does not recognize certain objects within the target application that you are recording, you can modify the frame in the Frame Properties toolpane in the Topic Editor.

If the application you are recording is not supported, you can create Context IDs manually in the Topic Editor. For more information, see Use Context IDs. If the application you are recording is supported, and the correct context information was not recorded, you can also recapture the context ID in the Topic Editor.

**Note:** Explanation, Decision, and No Context frames are informational and do not have Context IDs.

### Start the Recorder

When you start the Recorder, the Outline Editor closes and the Recorder opens. The title of the topic appears in the Recorder's title bar. Below the title bar, the screen capture instructions tell you what key or key combination to use to record an action/screen capture.

**Note:** The status indicator does not appear when in automatic record mode. The recorder disappears when you press PRINTSCREEN and records each screen and action until you press PRINTSCREEN again. You can configure a Deskband that displays recording controls in the Taskbar when recording in automatic record mode.

To start the recorder:

1. From the Outline Editor or the Library, select an empty topic.
2. Click 📌 **Record Topic**.
Record Topic Content

You can also double-click the topic or select the topic and press ENTER to start the Recorder.

Record Topic Steps

As you record a topic, you can edit the steps after each screen capture or at the end of recording, depending on the behavior option you chose for the Recorder. You can change this option as often as you feel is necessary, depending on the situation.

Record Different Action Types

When recording in the Developer, you press PRINTSCREEN after each action. There are three categories of actions: Mouse, String Input, and Keyboard.

A Mouse action is any action performed with the mouse, including clicking, dragging, or pointing. The frames for each type of mouse action are recorded differently, as described in the following list:

- **Click:** A click action includes clicking, double-clicking, or triple-clicking the left, middle, or right mouse button. This action is the simplest to record. You press the PRINTSCREEN key after each click, double-click, or triple-click.
- **Drag:** A drag action is defined as clicking and holding the left, middle, or right mouse button while moving the mouse. This can include dragging to select text or cells or dragging an object (such as a graphic) across the screen. This action includes pressing the mouse button (left/middle/right button down), moving the mouse, and releasing the mouse button (left/middle/right mouse button up). A drag action, then, has several parts and involves more than one frame. First, you press and hold the mouse button and press the PRINTSCREEN key to record the first frame. By default, the Developer creates several "incremental" screenshots as you drag that serve to illustrate the area as it is highlighted, or the movement of the object you are dragging. Then, you release the mouse button to complete the action and press PRINTSCREEN again. If you disable automatic drag and drop recording, you need to press PRINTSCREEN as you drag to capture the "incremental" screenshots. When you release the mouse button after dragging, you need to press PRINTSCREEN again.
- **Point:** A point action is defined as using the mouse to point to an object on the screen, such as pointing to a menu item to display the submenu. You press the PRINTSCREEN key to capture the frame after you point to the submenu.
- **Wheel:** A wheel action is defined as rolling the center wheel button on the mouse. You press the PRINTSCREEN key after each wheel action.

**Note:** You can select or deselect the Enable automatic recording option on the Recorder page of the Options dialog box to enable or disable automatic drag and drop recording.

A String Input action is defined as entering text into a document or field by typing on the keyboard. You press the PRINTSCREEN key after you have typed the text to capture the screen with the text.

A Keyboard action is defined as pressing any function key, cursor movement key, or any other single key, such as ENTER, TAB, ESC, INSERT, or DELETE. This action type also includes key combinations, such as CTRL+A and SHIFT+ENTER. You press the PRINTSCREEN key after pressing the key or key combination to record the result.

Record a Paste Topic

If the topic you are recording contains Cut or Copy and Paste steps, it is very important that you are aware of the following situation. When you press the PRINTSCREEN key to
capture a screenshot, the screenshot is placed on the Windows Clipboard; therefore, the screenshot overwrites the result of the copy or cut operation.

To record the content correctly, you must perform the Cut or Copy step again immediately before you record the Paste step. This extra step places the proper information into the live application so that the screenshot is correct. If you perform several actions before pressing the PRINTSCREEN key to capture the screenshot, the Developer only captures the last action. Therefore, you should make sure that the Paste step is the last action you perform before pressing the PRINTSCREEN key.

Note: To restore the cut text or object before recording the paste action, you need to undo the previous actions until the cut text or object reappears in the application. You can then cut it again and record pasting it in a new location.

The following procedure steps you through a basic Cut/Copy and Paste operation using the method to open the Topic Editor at the end of recording.

To record a paste topic:

1. Set up the application in which you want to record in the correct position to begin the task.
2. Switch back to the Developer.
3. Select a topic.
4. Start the Recorder.
5. Press PRINTSCREEN to record the Start screen.
6. Select the text or object you want to cut or copy.
7. Press PRINTSCREEN to capture the results of the first step.
8. Cut or copy the selected text or object.
9. Press PRINTSCREEN to capture the results of the step.
10. Select the location where you want to paste the text or object.
11. Press PRINTSCREEN to capture the results of the step.
12. In the live application, cut or copy the selected text or object again.
13. In the live application, return to the location where you want to paste the text or object.
14. Paste the selected text or object.
15. Press PRINTSCREEN to capture the results of the step.
16. Finish recording the topic as appropriate.

Undo

As you record a topic, you may inadvertently press the PRINTSCREEN key and capture the wrong action. You can use the undo command in the Recorder to undo all actions back to the beginning of the topic, including the Start screen. Keep in mind that clicking Undo does NOT undo actions in the application in which you are recording. You must do that manually.
6. Use the Topic Editor

The Topic Editor allows you to edit the frames you have recorded for a topic. You can also edit the Concept and Introduction information for the topic.

The Topic Editor contains a menu bar, toolbars, and the screenshot for the current frame. The Topic Editor also includes five properties toolpanes that provide additional information about each frame: Frame Properties, Frame Structure, Sound Editor, Concept, and Frame Link.

Navigate Frames

You can navigate the frames in a topic easily using the navigation icons in the toolbar of the Topic Editor. You can move forward or back one frame or jump to the Introduction or End frame of the topic. If a topic contains branches with different End frames, a menu with the available End frames appears to allow you to choose the End frame you want.

The Frame Structure is a graphical representation of each step in a topic. When displayed, it appears in its own pane in the Topic Editor. The Frame Structure pane contains a circle for every frame of the topic as follows:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Frame Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Introduction Frame</td>
</tr>
<tr>
<td>F</td>
<td>Frame</td>
</tr>
<tr>
<td>E</td>
<td>End Frame</td>
</tr>
<tr>
<td>D</td>
<td>Decision Frame</td>
</tr>
<tr>
<td>X</td>
<td>Explanation Frame</td>
</tr>
</tbody>
</table>

Move to any frame in the topic by clicking the appropriate circle. You can also navigate using the ALT+left arrow and ALT+right arrow keys (following the default path). When you select a frame, the frame's circle changes to green and the screenshot for that frame displays in the Topic Editor.

**Note:** When you first open a topic, the Introduction frame displays a green circle only because it is the selected frame.

The circles are connected by lines, which indicate the flow of the topic. If an Alternative Path is available, it appears below the primary path. In addition, if an Alternative Action or Alternative Path is available for a frame, the number of available actions is displayed above the frame's circle and to the left. When you move the mouse pointer over the circles, a thumbnail image of the frame, and the unique ID of the frame appear, allowing you to identify frames easily.

**Note:** You can view the total number of frames for each topic from the Library or Outline Editor by adding the Frames column to any view.

To navigate frames using the navigation icons:

1. To move to the next frame, click **Next frame**.
Use the Topic Editor

2. To move to the previous frame, click Previous frame.
3. To move to the Introduction frame, click First frame.
4. To move to the End frame, click Last frame.
5. Click the End frame destination, if necessary.

To navigate frames using the frame structure:

1. Display the Frame Structure toolpane, if necessary.
2. Move the mouse pointer over the circles in the Frame Structure toolpane to display a preview of the frame in a small window.
3. Click to display the corresponding frame in the Topic Editor.
4. Click to display the End frame in the Topic Editor.
5. Click to display the Introduction frame in the Topic Editor.

Save a Topic

You can save a topic at any time from within the Topic Editor with the Save command. You can also use the Save As command to save a copy of a topic with a different name or to a different location in the Library.

Multi-user Considerations

When you save a checked out document, it is saved to your data storage location regardless of whether you are working online or offline. You must check the document in to insure that the server has the most recent copy. A new document is not added to the server until you check it in. If a document has never been checked in, your local copy is the only copy of that document.

If you click the Keep checked out option on the Check In Comment dialog box during check in, the content is checked in and the version number incremented by 1 but the document remains checked out and unavailable for editing by other users.

Open documents display check in/out indicators in the document editor tab. While you can edit a checked in or locked document, you cannot save your changes to the original document.

If you edit a document that you did not check out (in other words, a checked out document was opened in Read-Only mode and edited) and you want to save the changes, you may still be able to save it. If you have access rights to the document and it has not been checked out by someone else, you are given the option to save the changes to the original document name. If you choose to save the changes, the document is checked out and the changes are saved. If you do not want to save the changes to the original document, you can save the document as a different document name or you can abandon the changes without saving.

Note: Saving changes to a document that is not checked out to you is not a recommended best practice. This functionality is designed to allow you to save changes to a document that was unintentionally edited in Read-Only mode.
To save a topic in the Topic Editor:

1. On the **File** menu, choose **Save**.

   **Note:** You can also open a topic and use **Save As** on the File menu to save a copy of the document with a new name and/or to another folder.

To save a topic with another name or in another location in the Library:

1. From the **File** menu, choose **Save As**.
2. Type a new name for the topic, if desired.
3. Navigate to the desired location to save the topic, if necessary.
4. Click **Save**.

**Undo and Redo in the Topic Editor**

You can undo changes that you make in the Topic Editor. If you made changes to frames other than the current frame, the Topic Editor will navigate to the frame where the change was made. For example, if you add custom text to the bubble for three different frames, and then undo all three additions, the Topic Editor navigates back to each frame where the bubble text is being undone.

If you are using sound in the Topic Editor, Undo will undo frame by frame recordings. The Topic Editor updates the frame view, frame structure, and waveform while undoing.

Undo does not affect operations with attachments in the Frame Link Properties window.

You can also redo actions that you have undone. Like Undo, if the action you are redoing occurs on another frame, the Topic Editor will navigate to that frame.

**Manipulate Frames**

When you record a topic, you record the primary path. After recording, you can manipulate this path in several ways. You can insert missing frames and delete unnecessary ones, or you can add alternative paths to the topic. If any of the screenshots or actions were not recorded correctly, you can recapture them as well.

**Insert a Missing Frame or Frames**

You can insert frames in an existing topic. When you insert a single frame, you are recording a single action; therefore you must take two screenshots, so that the Recorder can capture the screenshot and the action you perform. When you insert multiple frames, the recording process is identical to recording a topic; the Recorder captures the starting screenshot and the successive actions and resulting screenshots for new frames.

You insert a new frame after the current frame. You should make sure that you know where in the topic you want to place the frame. You should also be sure that the screen in the application you are recording is set up to match the correct step in the task where you want to insert the frame.

To insert a missing frame or frames after the current frame:

1. Open or switch to the application in which you want to record the missing step(s), and set it up in the correct position to begin the step(s).
2. Switch back to the Developer.

3. On the **Insert** menu, choose **Missing Frames**.

4. Press PRINTSCREEN to record the screenshot.

5. Perform the action you want to record.

6. Press PRINTSCREEN to capture the results of the step.
   
   Repeat as necessary.

7. Click **Finish**.

8. Verify and edit the settings and the bubble text as necessary.

**Re-Record a Topic**

Re-recording a topic allows you to capture screenshots and actions using the original topic as a guide. This feature is useful when the topic text has been translated and the frame screenshots need to be recaptured in a different language. It can also be used to capture new screenshots if the screens have changed or if steps have been added to or removed from procedures in the target application.

When you re-record a topic, you can start from any frame you choose. The Recorder opens with a Preview of Original window that displays the frame screenshot on the left and the frame bubble text on the right. The cursor changes to a magnifying glass, as it moves over the Preview the Original window, allowing you to zoom in/zoom out as necessary to set up the screenshot. The bubble text used in the preview window is from the active preview mode in the Topic Editor. As you press PRINTSCREEN to record these steps, the Recorder advances to the next frame automatically.

**Note:** Two visual cues are displayed when re-recording a decision frame. First, the Next screenshot records field shows Decision Frame Screenshot. Secondly, the decision properties of the decision frame display in the bubble area of the re-recorder (however, the links are not active).

The re-recording process begins on the currently selected frame, so you can choose the frame on which you want to begin by navigating to it in the Topic Editor. Once the Re-record dialog box is open, the Previous and Next Frame arrows allow you to navigate forward and/or backwards within the current path to locate the appropriate frames to be re-recorded. Frames can be added within the flow of the re-recording process via the Insert Frame icon. Inserted frames can be undone by clicking the Undo icon. As you navigate the frames, only the steps where you press PRINTSCREEN are re-recorded.

The re-recording process ends automatically when you reach the end of the topic. You can also end the process at any time using the Finish button in the Recorder. This flexibility allows you to stop re-recording and restart it again on any frame.

The re-recoding process and the Preview of Original window handle the different types of frames as follows:

- **Action frame:** After the screenshot has been recorded, it advances to the next frame in the sequence of the topic.

- **Explanation frame:** These frames are skipped. The Topic Editor automatically copies the screenshot from the following frame and uses it as the background for the Explanation frame.

- **Alternative Actions/Paths:** When a frame has an Alternative action or path, the Alternative icon appears in the Preview of Original window between the screenshot.
and the bubble. Clicking this icon will scroll through all of the alternatives. You can
choose which alternative you want to record. Note that Alternative actions that
were automatically captured when you recorded the topic will not be captured
during re-recording.

- Decision frames: The Preview of Original window displays the Decision frame links,
and you can choose which path to re-record.

**Note:** Automatic recording mode and the Undo button are not supported when re-recording a
topic. Re-recording a topic is always a manual process.

To re-record the topic starting at the current frame:

1. On the **Edit** menu, choose **Re-record Topic**.
2. Set up the target application at the appropriate screen.
3. If necessary, use the Previous Frame or Next Frame arrows to navigate to the
   frame to be re-recorded.
4. Zoom in or out on the preview window to set up the screenshot.
5. Press PRINTSCREEN to capture the screenshot.
6. If necessary, use the Previous Frame or Next Frame arrows to navigate to the next
   frame to be re-recorded.
7. Press PRINTSCREEN to capture the actions and screenshots.
8. Repeat Steps 6 and 7 as necessary.
   The Recorder closes automatically when you re-record the last frame in the topic.
   If you want to stop the re-record process before the end of the topic, click **Finish**
   in the Recorder window.

To insert a frame during re-recording of a topic:

1. On the **Edit** menu, choose **Re-record Topic**.
2. Set up the target application at the appropriate screen.
3. Press PRINTSCREEN to start the re-record process.
4. If necessary, use the **Previous Frame** or **Next Frame** buttons to navigate to the
   frame before where you want to insert a frame.
5. Click the **Insert Frame** button to start Insert mode.
6. Press PRINTSCREEN to capture the screenshot. The **Undo** button activates if you
   want to undo the insert.
7. If want to continue re-recording, click the **Insert Frame** button to exit Insert
   mode and use the **Previous Frame** or **Next Frame** buttons to navigate to the
   next frame to be re-recorded.
8. Press PRINTSCREEN to each time you want to re-record any action and screenshot.
   The Recorder closes automatically when you re-record the last frame in the topic.
   If you want to stop the re-record process before the end of the topic, click **Finish**
   in the Recorder window.

**Insert an Explanation Frame**

You can insert an Explanation frame to provide additional information about a step in the
topic. No action is associated with this type of frame; it is simply a screenshot image and a
bubble with text.
An Explanation frame is always inserted after the current frame. The screenshot used for the Explanation frame is the same screenshot used for the frame that follows the Explanation frame. In the empty bubble, you can enter text that explains something about the step or call the user's attention to something on the screen. Explanation frames appear in See It!, Try It!, and Do It! modes; they do not appear in Know It? mode unless the bubble text is marked to appear in that mode.

To insert an Explanation frame after the current frame:

1. On the Insert menu, choose Explanation Frame.

   The frame is inserted, as indicated by the X in the Frame Structure, and the bubble contains the default text “Press Enter to continue.”

2. Enter text and adjust the settings as necessary.

Insert a No-Context Frame

After you have recorded a topic, including all actions that reference recognized objects, you can insert a No-context frame to incorporate actions you were unable to record during the initial recording. On a No-context frame, you can specify an action and reposition and resize the action area to reference the appropriate object. These frames appear in See It!, Try It!, and Do It! modes in the Player.

A No-context frame is always inserted after the current frame. The screenshot used for the No-context frame is the same screenshot used for the frame that follows the No-context frame. You must also enter any bubble text that should be displayed, as there is no template text for No-context frames. No-context frames can be inserted after any action, Introduction, Explanation or Decision frame.

Note: Explanation, Decision, and No Context frames are informational and do not have Context IDs.
To insert a No-context frame after the current frame:

1. On the **Insert** menu, choose **No-context Frame**.
2. Type text and adjust settings as necessary.

**Tip:** You can also create a No-context frame during the initial recording by pressing PRINTSCREEN a second time to record an additional frame. If no action is associated with a frame, the frame is recorded as a No-context frame. If the frame is recorded with an action, you can display the frame in the Topic Editor and click the **Ignore context** icon in the Frame toolpane to turn the frame into a No-context frame.

### Copy a Frame or Frames

You can copy a frame or frames to another location in the same topic or into another topic. This feature allows you to easily duplicate sections of a topic that have the same steps, without having to record them again.

Any frame can be copied, including the Start frame. The copied frames are not linked to the original frames, but any links they contain to other documents such as attachments, icons, manual hyperlinks, glossary terms, and sound properties will be preserved.

**Tip:** You can duplicate a frame by copying and pasting it without changing the selected frame in the frame structure.

When you copy a frame, the frame’s properties are also copied, including the screenshot, all actions and alternative actions, jump-in points, bubble text and bubble properties, Context IDs, "include this screenshot" settings, frame link settings and tooltips, custom sound, links and broken links, action areas, and the "keep with next" setting. The template language and the screen resolution are not copied.

To copy a single frame:

1. Select the frame you want to copy.
2. On the **Edit** menu, choose **Copy Frames**.
3. Select the frame after which you want to paste the copy.
   - You can open a different topic in the Topic Editor, or switch to a topic already open, if desired.
4. On the **Edit** menu, choose **Paste Frames**.

### Select Multiple Frames

You can select multiple consecutive frames with SHIFT+click. Selected frames are indicated in a dark green color. When multiple frames are selected, the active frame is the last frame you selected. Its screenshot and properties appear in the main Topic Editor window, and it is highlighted in the frame structure with the same light green selection color used to indicate an active single frame.

You cannot edit multiple frames. When you select multiple frames, the topic editor displays the screenshot and properties of the last selected frame, because it is the active frame. If you click anywhere in the editor, the frame structure shows only the active frame as selected.
You can deselect multiple frames by clicking any frame without pressing the Shift key or by editing the active frame.

When you paste frames, they appear after the selected frame in the frame structure. You **cannot** paste frames in these situations:

- after an end frame
- into an empty topic
- into topics with different screenshot resolutions

In a recorded topic, the screenshot for the first recorded action frame is also used for the Start frame. Therefore, if you paste a frame immediately after the Start frame, the screenshot for the start frame will update to match the new first frame. The same is true if you paste a frame immediately before the End frame of the topic; the screenshot for the end frame updates to reflect the newly pasted frame.

To select multiple frames:

1. Select a frame.
2. Press SHIFT and click another frame to select multiple frames.
   
   The frames you clicked are selected, along with all frames in between them.

**Copy Paths**

You can select and copy an entire path or multiple paths. When you paste a path immediately before the end frame of a topic or a branch path, the screenshot for the end frame updates to reflect the last frame of the path you pasted.

When you copy an end frame into a path that already has an end frame, the end frame you are pasting is converted to an explanation frame. When you copy an action frame with alternative paths, the currently chosen path will be copied and pasted with the frame.

**Select Paths**

You can select multiple paths using CTRL+click. The CTRL+click method will select the path from the first frame in the path that you select through the end of the path, either the end frame of a branch path or the point where an alternative path rejoins the main path.

To select a path:

1. Click the first frame in the path that you want to select.
2. Press CTRL and click another frame later in the same path.
   
   The path is selected from the first frame you clicked through the last frame on the path.
3. To add another path to the selection, press CTRL and click in the path.

To copy multiple frames or paths:

1. Select the frames or paths you want to copy.
2. On the **Edit** menu, choose **Copy Frames**.
3. Select the frame after which you want to paste the copied frames or paths.
You can open a different topic in the Topic Editor, or switch to a topic already open, if desired.

4. On the **Edit** menu, choose **Paste Frames**.
5. Click **OK** to respond to any prompts as necessary.

### Copy Decision Frames and Paths

Several rules apply when you copy and paste a Decision frame and its paths.

<table>
<thead>
<tr>
<th>What is selected and copied</th>
<th>What is pasted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part of the primary path, including a Decision frame; not including a branch or alternative path</td>
<td>The selected frames, including the Decision frame</td>
</tr>
<tr>
<td>Decision frame and the primary path including the frame where the alternative path rejoins, add the alternative path to the selection</td>
<td>The selected path structure, including the Decision frame, the primary path, and the alternative path</td>
</tr>
<tr>
<td>Decision frame and part of an alternative path or a branch path</td>
<td>The frames are pasted into an existing path, not as a new alternative or branch path</td>
</tr>
<tr>
<td>Decision frame and entire branch path, including the end frame</td>
<td>The frames are pasted into an existing path, and the end frame of the path is converted to an Explanation frame</td>
</tr>
<tr>
<td>Decision frame and multiple branch paths</td>
<td>The Decision frame and the first selected branch are pasted into the existing path, and the structure of the other branch paths is pasted</td>
</tr>
</tbody>
</table>

### Delete a Frame

Before a frame can be deleted, you must delete all Alternative Actions or Alternative Paths that begin on the frame. Although you can select multiple frames, you can only delete individual frames. Be sure to verify that you have selected the frame you want to delete, as you cannot undo a deletion.

To delete the current frame:

1. On the **Delete** menu, choose **Frame**.
2. Click **Yes**.

### Recapture a Screenshot

If the screenshot for a frame is incorrect, you can recapture it without having to re-record the entire frame. Make sure that the screen in the target application is set up correctly. When you press PRINTSCREEN, the Recorder captures the screen and automatically reopens the Topic Editor.

To recapture the screenshot for the current frame:

1. On the **Edit** menu, point to **Recapture** and choose **Screenshot**.
2. Activate the target application and navigate to the appropriate screen.
3. Press PRINTSCREEN.
Recapture an Action

If the action for a frame is incorrect, you can recapture it without having to re-record the entire frame. While you do not necessarily have to be on the same screen in the target application as when the screen was first captured, it is recommended. When you press PRINTSCREEN, the Recorder captures the action and automatically reopens the Topic Editor.

To recapture the action for the current frame:

1. On the Edit menu, point to Recapture and choose Action.
2. Activate the target application and perform the action you want to recapture.
3. Press PRINTSCREEN.

Use Context IDs

Context IDs are provided by target applications and non-target browser-based applications as identifiers for individual screens. They can be used in conjunction with in-application support to provide context-sensitive help. In-application support allows the user to use SmartHelp or the target application's Help menu to launch topics that correlate to the current screen. The Player then launches the topic at the specified screen, rather than at the beginning of the topic.

For target applications, the Developer automatically acquires the unique context ID for a screen when the content is recorded. This creates an ExactMatch Context ID type. For non-target browser-based applications, a Context ID can be generated. This generated Context ID is called a SmartMatch Context ID type and cannot be edited. When you record an application screen, the Context ID type is set in the Type field on the Context ID dialog box. Recording non-target applications that are not browser-based, creates blank Context IDs.

Note: You cannot edit Context IDs for the Start/End, Decision, Explanation, and No context frames. Context IDs created when recording browser-based applications have a context type of SmartMatch can not be edited. If the application screen changes, you must recapture the context to change the context ID.

The Context ID dialog box has five columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A user-friendly name for the value. It can be any text. For unsupported applications, the default value for this field is Context ID. For supported applications, the caption for the value is captured and placed in this field.</td>
</tr>
<tr>
<td>Value</td>
<td>The value of the context ID.</td>
</tr>
<tr>
<td>ID</td>
<td>Allows you to indicate a specific part of the Context ID for search purposes. It can be used as a grouping mechanism. It is a required field, and it must be unique.</td>
</tr>
<tr>
<td>ID as Prefix</td>
<td>When deselected, allows the search engine to ignore the prefix. For unsupported applications, this field must be false.</td>
</tr>
<tr>
<td>Searchable</td>
<td>Indicates whether the Context ID information for the frame is indexed. If it is not indexed, you will not be able to use it to integrate context-sensitive help. The default is true.</td>
</tr>
</tbody>
</table>
The Context ID dialog box differs for supported target applications vs. non-supported applications. Supported target applications have information in all five columns, and may have multiple rows for a single frame. Non-supported applications simply display Context ID in the Name column.

You can add new rows to the bottom of the grid. This allows you to provide additional context values or to fix a corrupt context ID. You can also delete rows as necessary. All editing is done inside the grid itself; simply click the cell you want to edit.

**Note:** You can add the Context IDs field to document outputs by customizing the document format publishing projects. See Customize Document Formats for more information on customizing document output.

To enter or modify a context ID for the current frame:

1. On the **Edit** menu, choose **Context ID**.
2. Click in the cell you want to edit, and change text as necessary.
3. Click + to add a row at the bottom of the grid.
4. Click - to delete the selected row.
5. Click **OK** to save your changes or **Cancel** to exit without saving.

**Recapture Context ID**

If you previously recorded content with context (of type SmartMatch or ExactMatch) and the Context ID changed in the application, you can recapture the context ID instead of re-recording the content.

To add context recognition for previously recorded content, you need to capture the context ID for each screen that has a new context. Recapturing the action replaces any customization you have made to the object type, object name, action, or action area. Recapturing the context ID captures the values for the screen without overwriting your action modifications.

**Note:** You can manually change the ExactMatch context IDs in the Context ID dialog box. SmartMatch context IDs cannot be edited so you must recapture the Context ID if the application screen changes. See Context Recognition in the Recorder for more information on the difference between ExactMatch and SmartMatch.

To recapture the context ID for the current frame:

1. On the **Edit** menu, point to **Recapture** and choose **Context ID**.
2. Activate the target application and navigate to the screen or field corresponding to the action for the frame.
3. Click the same object on which the action takes place.
4. Press PRINTSCREEN.
Edit a Screenshot

When you choose to edit a screenshot, the Developer starts the frame image editor you specify on the General Developer Settings page of the Options dialog box and opens the screenshot in that application. You then edit the screenshot using that application. When you save the file and close the application, the Developer updates the screenshot in the Topic Editor.

**Note:** When you edit screenshots in a frame image editor, the Developer temporarily converts the screenshots, which are in .png format, into .bmp format. Therefore, the frame image editor you use must be able to support .bmp format images.

To edit the screenshot for the current frame:

1. On the **Edit** menu, choose **Edit screenshot**.
2. Edit the screenshot as necessary.
3. Save the screenshot in the frame image editor application.
4. Close the frame image editor.

Change the Print Setting

You can change the inclusion of screenshots when a topic is published in one of the document formats. Note that screenshots do not appear in the HP Quality Center format. The Auto Select Screenshot to Print automatically option includes screenshots based on changes in the context settings as determined by the Developer during the publishing process. This is the default setting. The Include Screenshot in Print and Do not Include Screenshot in Print options offer manual control over which screenshots appear in the printed document.

These options are available on all frames except the Introduction frame, which takes its screenshot from the first frame. If you include Decision or End frames, the color graphic, rather than the grayscale graphic that appears during topic playback, appears in the document.

**Note:** Changing this option only has an effect if the Include field on the Documents page of the Options dialog box is set to Topic Settings and the Include field on the Formats page of the Publishing Wizard is also set to Topic Settings. If they are set to any other option, changing the screenshot inclusion method at the frame level has no effect.

To change the automatic print setting for the current frame:

1. On the **Edit** menu, point to **Screenshot Publishing** and choose **Auto Select Screenshot to Print**, **Include Screenshot in Print**, or **Don’t Include Screenshot in Print**.

**Note:** There are also icons available on the Topic Editing toolbar for these options.

Use Alternative Actions and Paths

Often, the application for which you are recording content has multiple ways to complete a task. You can accommodate these ways in your content by using Alternative Actions and Paths.
Insert an Alternative Action

As you are recording a topic, you may have to choose one of several possible actions for completing a task. For example, you may need to decide between pressing the Tab key and clicking the mouse to move the insertion point to the next available field. If you want to document some of these alternative methods for your users, you can insert Alternative Actions within the topic. Alternative Actions are single actions that accomplish the same result as the primary action.

To insert an Alternative Action, you must determine on which frame the Alternative Action should appear. When you click the Insert Alternative Action command, the Topic Editor closes and the Recorder opens. After performing the action you want to record and pressing PRINTSCREEN, the Recorder closes and the Topic Editor reopens with the Alternative Action displayed.

Alternative Actions are not available in See It! mode. In the Player, a user can select the Show next Alternative action icon to display an action in Try It! and Do It! modes.

To insert an Alternative Action on the current frame:

2. Set up the application in which you want to record to display the screen on which the Alternative Action should be performed.
3. Perform the action you want to insert.
4. Press PRINTSCREEN.

Insert an Alternative Path

As you are recording a topic, you may have to choose one of several possible methods for completing a task. For example, you may need to decide between using a menu path and clicking a toolbar icon. If you want to document some of these alternative methods for your users, you can insert Alternative Paths within the topic. While Alternative Actions can display a single action only, Alternative Paths may include several steps. These paths may be shorter or longer than the primary path, or an equivalent number of steps. Alternative Paths guide the user through alternative steps to accomplish the same task as the primary steps.

To insert an Alternative Path, you must determine which frame is the starting point for the path. You also need to identify the frame that is the end point, which is where the path rejoins the main path of the topic. When you insert an Alternative Path, the current frame becomes the starting point for the path and the Frame Structure is automatically displayed if necessary to allow you to select the appropriate end frame. When positioned in the Frame Structure, the mouse pointer changes into a black arrow attached to a circle with the letter E. You can use the arrow to designate the end frame for the path.

You do not need to record a start screen for an Alternative Path. The screenshot for the frame already exists; you are simply recording a new action to associate with that screenshot. You press PRINTSCREEN after every action completed in the Alternative Path, and you must click the Finish button in the Recorder to end recording the Alternative Path when you reach the designated end frame.

Alternative Paths are not available in See It! mode. In the Player, a user can select the Show next Alternative action icon to follow a path in Try It! mode and Do It! mode.
To insert an Alternative Path beginning on the current frame:

1. On the Insert menu, choose Alternative Path.
2. Use the black arrow to click the circle representing the frame you want to use as the end frame of the Alternative Path.
3. Set up the application in which you want to record to display the starting screen of the first action of the Alternative Path.
4. Perform the first action you want to record.
5. Press PRINTSCREEN to capture the action.
6. Perform the next action you want to record.
7. Press PRINTSCREEN to capture the results of the step.
   Repeat as necessary to complete the Alternative Path.
8. Click Finish.

Display Alternative Actions/Paths

Just as you edit the frames of the primary path, you can edit the Alternative Action frame and the frames in an Alternative Path. To edit these frames, you must navigate to them. While you do not need to display the Frame Structure to edit Alternative Actions or Alternative Path frames, it is helpful to display the Frame Structure to verify that you are working with the appropriate frame.

To display an Alternative Action or Path for the current frame:

1. On the Go to menu, choose Next Action or Previous Action.

Set the Current Action as the Default Action

After inserting an Alternative Action or Path, you may decide to use the Alternative Action or Path as the primary action or path. This is especially useful as only the primary action or path displays in See It! mode. The original primary action becomes an Alternative Action or an Alternative Path.

To set the current action as the default action:

1. Display the Alternative Action or the first frame of the Alternative Path you want to use as the default action.
2. On the Edit menu, choose Set Action as Default.

Change the End Frame of an Alternative Path

When you create an Alternative Path, you must specify an end frame for the path. If you decide later that the path should reconnect at a different frame, or you chose the incorrect end point when you recorded the topic, you can change the end point of an Alternative Path. When you change the end point of the path, the rest of the frames in the path are not affected.

Changing the end point only affects the currently selected action. If the end frame in an Alternative Path has an Alternative Action, and you change the end point for one action, the Alternative Action will still connect to the original end point. Two paths will appear in the Topic Editor. You must select the Alternative Action and change its end point separately.
To change the end frame of an Alternative Path:

1. Click the final frame in the Alternative Path.
2. On the Edit menu, choose Modify End Point.
   You can also click the Modify end point button in the Frame toolpane.
3. Use the black arrow to click the circle representing the frame you want to use as the new end frame of the Alternative Path.

Delete an Action

You may want to remove a particular Alternative Action that is incorrect, or one that is no longer needed. You cannot delete the only action for a frame.

You cannot undo a deletion, so be sure to verify that you have selected the action you want to delete.

To delete an Alternative Action from the current frame:

1. Display the action you want to delete.
3. Click Yes.

Delete a Path

If an Alternative Path is no longer needed, you can remove it. You can delete all frames of an Alternative Path along with the first action of the path. You can also delete a portion of the path beginning at the currently displayed frame and including all subsequent frames.

You cannot remove a frame containing Alternative Paths. You must first delete all Alternative Paths that use that frame as their starting point before you can delete the frame itself.

If you remove an Alternative Path or a portion of the default path, you cannot undo the action. Therefore, you should verify that the first frame of the path you want to remove is displayed before you delete the path.

To delete an Alternative Path from the current frame:

1. Display the first action of the path you want to remove.
2. On the Delete menu, choose Path.
3. Click Yes.

Use Decision Frames

When you are recording topics, you may find that several tasks share common steps. Instead of recording separate topics, you can insert a Decision frame to allow your users to choose from two or more options. For example, from the Print dialog box in your application, you can print all pages in the document, the current page only, or a range of pages. For each task, you follow the same steps to open the Print dialog box and start the printing process. You could record the steps for printing all pages and then insert a Decision frame to record the other print options instead of creating individual Print topics. Decision frames provide a way to document multiple tasks rather than different methods of accomplishing the same task.
Use the Topic Editor

Note: Explanation, Decision, and No Context frames are informational and do not have Context IDs.

Insert a Decision Frame

When you insert a Decision frame, it is placed after the currently selected frame in the Topic Editor. The existing path becomes the first path on the Decision frame, so you will be asked to provide a name for the path. Decision frames are represented in the Frame Structure as a dark blue circle with the letter D. A Decision frame utilizes the screenshot from the following frame and lists the available paths as hyperlinks.

From a Decision frame, you can create an Alternative Path, which rejoins the existing path, or you can create a Branch Path, which has a different ending point. For example, you could create Alternative Paths for printing the current page and a range of pages. You could create a Branch Path for setting print options, which requires that the Print dialog box be open, but does not result in anything being printed.

Note: Explanation, Decision, and No Context frames are informational and do not have Context IDs.

To insert a Decision frame after the current frame:

1. On the Insert menu, choose Decision Frame.
2. Enter a name for the current path.
3. Click OK.

Record Paths in a Decision Frame

After you have inserted a Decision frame, you can record additional paths that your users can launch from the Decision frame. These paths allow users to choose from a variety of available tasks. When you record a Decision frame path, you must capture both the actions and screenshots needed to accomplish the task. You do not need to record an Introduction frame, however, as the path will be launched from the default Decision frame screenshot.

Before you create a new Decision frame path, you must decide whether the new path will rejoin the primary path. If the new path will rejoin the primary path, you will create a new Alternative Path. If the new path will not rejoin the primary path, you will create a new Branch Path.

Decision Alternative Paths can also rejoin the primary path at or before the Decision frame, thereby creating a "loop." If you create a looping Alternative Path, the path is represented by a line with an arrow that appears above the primary path in the Frame Structure window.

Note: You can change the end frame of a Decision Alternative Path. See Change the End Frame of an Alternative Path for more information.

Decision frames appear in See It!, Try It!, and Do It! modes (and not Know It? mode). When you play or preview a topic in See It!, Try It!, or Do It! mode, the available Decision frame paths are listed as links in the mode bubble. Clicking a link launches the appropriate Decision frame path.
To create an Alternative Path for a Decision frame:

1. In the Decision Properties dialog box, click \( \text{New Path} \).
2. Click \textbf{Alternative}.
3. Enter a name for the new path.
4. Click \textbf{OK}. The mouse pointer turns into an arrow with a circle containing the letter \( \text{E} \) when placed over the Frame Structure.
5. Click the frame where the Decision Alternative Path will rejoin the primary path.
6. Set up the application in which you want to record to display the starting screen of the first action of the Decision Alternative Path.
7. Perform the first action of the path.
8. Press \texttt{PRINTSCREEN}.
9. Continue to record the actions and screenshots needed to complete the path.
10. Click \textbf{Finish}.

To create a Branch Path for a Decision frame:

1. In the Decision Properties dialog box, click \( \text{New Path} \).
2. Click \textbf{Branch}.
3. Enter a name for the new path.
4. Click \textbf{OK}.
5. Set up the application in which you want to record to display the starting screen of the first action of the Decision Alternative Path.
6. Perform the first action of the path.
7. Press \texttt{PRINTSCREEN}.
8. Continue to record the actions and screenshots needed to complete the path.
9. Click \textbf{Finish}.

\textbf{Rename Paths in a Decision Frame}

When you insert a Decision frame, the existing path is identified by the text you enter in the Create New Decision Path dialog box or Create New Branch dialog box. You can, however, change the path name as this text is displayed in the Decision frame.

To rename a path in a Decision frame:

1. Click the entry in the \textbf{Path list} list box in the Decision Properties window.
2. Click \( \text{Rename path} \).
3. Enter the text you want to display in the Decision frame.
4. Click \textbf{OK}.

\textbf{Edit Header Text}

In addition to the text representing links to various paths, Decision frames display Header text that instructs users how to proceed. The Header text appears in the Header textbox in the Decision Properties window. By default, the Header text is "Please select from the
Use the Topic Editor

following choices.” You can edit the Header text to provide more descriptive information for your users.

To edit the header text in a Decision frame:

1. Drag to select the text in the **Header** textbox in the Decision Properties window.
2. Type the text you want to display in the Decision frame.

Reposition Paths

By default, the first path displayed in a Decision frame is the first path you recorded. If you have multiple paths available in a Decision frame, you may want to rearrange the order in which they are listed. You can change the position of the paths by using the Move path up and Move path down buttons.

**Warning:** The default path cannot be a loop that rejoins before the Decision frame.

To reposition paths in a Decision frame:

1. Click the path you want to move in the **Path list** list box in the Decision Properties window.
2. Click **Move path up** or **Move path down**, as appropriate.

Remove Paths

After you have created Decision frame paths, you may decide that you want to delete one or more of them. When you remove one path, the remaining paths are not affected.

To remove a path from a Decision frame:

1. Click the path you want to remove in the **Path list** list box in the Decision Properties window.
2. Click **Delete path**.
3. Click **Yes** to confirm the deletion.

Delete a Decision Frame

You must delete all paths other than the primary path before you can delete the Decision frame itself. If you attempt to delete the Decision frame without deleting the attached paths, you will receive an error message explaining that the frame contains alternatives and cannot be deleted.

To delete a Decision frame:

1. Open the Topic Editor and navigate to a Decision Frame.
2. On the **Delete** menu, choose **Delete Frame**.
3. Click **Yes**.

Edit Frame Properties

The Frame toolpane in the Topic Editor contains settings that allow you to change the appearance of the bubble and bubble text, as well as describe the action performed in the frame.
The Frame toolpane has two sections, separated by a divider bar. The section above the divider bar contains the options for the bubble and bubble text, and the section below the divider bar contains the settings for the action. You can drag the divider bar up or down as needed, for example, to see more of the bubble text in the upper section.

**Edit Bubble Properties**

The buttons in the upper section of the Frame Properties toolpane allow you to:

- change the text that appears in the bubble
- set text formatting (for example, bold, italics, and alignment)
- select the position of the bubble pointer
- change the background color of the bubble
- link an attachment to bubble text
- decide in which playback modes and output types the text appears

Any changes you make apply to the current frame only.

**Add Text to the Introduction and End Frames**

The Introduction frame appears in the lower right pane in the Player when a user selects a topic in the outline. You can also set it to appear as the first frame before the action frames during playback. It typically contains a short statement introducing the topic; however, you can add any text that you desire. The End frame appears during playback as the last frame of the topic after the action frames. It typically contains a short statement about the result of the actions performed in the topic. Like the Introduction frame, you can add any text you feel is necessary.

To enter text into the Introduction or End frame, you must display the Frame Properties toolpane, and then type the text in the text edit pane. As you type, the text appears in both the text edit pane and the bubble in the frame.

To add text to an Introduction or End frame:

1. Navigate to the Introduction or End frame.
2. Display the Frame Properties toolpane, if necessary.
3. Click the text edit pane and enter the text.

**Use Bubble Templates for a Frame**

The Developer generates default text for the bubble for each frame using the action settings to determine the correct template text to use.

If the template text is not the text you want for a particular frame, you can choose not to use it. If you deactivate the template text, it is cleared from the bubble and you must enter bubble text manually.

---

**Note:** This setting can be applied to all frames on the Bubble page of the Content Defaults section of the Options dialog box. You can change this setting, but it is not recommended.
To use or disable the bubble templates for the current frame:

1. Display the Frame Properties toolpane, if necessary.
2. Click **Use templates**.

**Change the Template Text Font**

When you record topics, the template text in the bubbles is formatted with the default font set on the Bubble page in the Content Defaults section of the Options dialog box. You can change this font for the current frame while you are in the Topic Editor.

*Note:* You cannot change the font color for template text. If you must change the color, you can insert the template text as custom text and then format it. Be aware that if you do this, it is no longer template text.

To change the font for the template text for the current frame:

1. Display the Frame Properties toolpane, if necessary.
2. Click **Template fonts** and choose the font and attributes.
3. Click **OK**.

**Add Custom Bubble Text**

You can add your own custom text to the bubble, in addition to the template text. You enter the text in the text edit pane of the Frame Properties toolpane. By default, the text you enter appears before the template text, so that users read it first before performing the action. It is good practice to separate custom text from template text with an extra blank line, to make it more readable.

You can change this default for all frames on the Bubble page of the Content Defaults section of the Options dialog box. For an individual frame, you can deselect the Show custom text first option to show the template text first.

To add custom bubble text to the current frame:

1. Display the Frame Properties toolpane, if necessary.
2. Click the text edit pane.
3. Enter the custom text.
4. Click **Show custom text first**, if desired.

**Insert Template Text as Custom Text**

When you disable template text, the bubble is empty and you must enter custom text. You can also convert template text into custom text and then edit it in the text edit pane. When you insert template text as user text, the default template text is imported into the text edit pane, disabling the template text from displaying in the bubble.

To insert template text as user text on the current frame:

1. Display the Frame Properties toolpane, if necessary.
2. Click **Insert template text as user text**.
3. Edit the text.

**Edit Custom Bubble Text**

You can edit any custom text you enter in the bubble. In the text edit pane, there are icons that enable you to cut, copy, paste, and delete text. You must select text in the text edit pane to enable these icons. You cannot use the text editing icons to edit the template text for a frame.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="cut.png" alt="Cut" /></td>
<td>Cut the selected text.</td>
</tr>
<tr>
<td><img src="copy.png" alt="Copy" /></td>
<td>Copy the selected text.</td>
</tr>
<tr>
<td><img src="paste.png" alt="Paste" /></td>
<td>Paste the contents of the Clipboard.</td>
</tr>
<tr>
<td><img src="delete.png" alt="Delete" /></td>
<td>Delete the selected text.</td>
</tr>
</tbody>
</table>

To edit custom bubble text for the current frame:

1. Display the Frame Properties toolpane, if necessary.
2. Select the text you want to edit in the text edit pane.
3. Edit the text as desired.

**Format Custom Bubble Text**

You can format any custom text you enter in the bubble. In the text edit pane there are icons that enable you to bold, italicize, underline, and change the color of text, as well as change the font for the custom text. In addition, you can choose how to align text horizontally within the bubble.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="font.png" alt="Font" /></td>
<td>Change the font for the selected text.</td>
</tr>
<tr>
<td><img src="line.png" alt="Line" /></td>
<td>Prevent selected text from wrapping to the next line. (Places a dotted green line under the text).</td>
</tr>
<tr>
<td><img src="align.png" alt="Align" /></td>
<td>Align the selected text to the left side of the bubble.</td>
</tr>
<tr>
<td><img src="center.png" alt="Center" /></td>
<td>Center the selected text horizontally.</td>
</tr>
<tr>
<td><img src="right.png" alt="Right" /></td>
<td>Align the selected text to the right side of the bubble.</td>
</tr>
<tr>
<td><img src="justify.png" alt="Justify" /></td>
<td>Justify the text.</td>
</tr>
<tr>
<td><img src="bold.png" alt="Bold" /></td>
<td>Bold the selected text.</td>
</tr>
<tr>
<td><img src="italic.png" alt="Italic" /></td>
<td>Italicize the selected text.</td>
</tr>
<tr>
<td><img src="underline.png" alt="Underline" /></td>
<td>Underline the selected text.</td>
</tr>
<tr>
<td><img src="color.png" alt="Color" /></td>
<td>Change the color of the selected text.</td>
</tr>
</tbody>
</table>

To format custom bubble text for the current frame:

1. Display the Frame Properties toolpane, if necessary.
2. Select the text you want to format in the text edit pane.
3. Apply the formatting as desired.
Specify the Playback Mode for Custom Text

By default, custom text is set to appear in See It!, Try It!, and Do It! modes. This applies to text for the Introduction and End frames as well. You can specify the playback modes in which the custom text appears. For example, for certain frames, you may find that the custom text is inappropriate for all playback modes, or you may also want to add custom text to a frame for specific use in Know It! mode to provide users with a hint. You can select the text in the text edit pane, and then deselect or select the Visible in See It!/Try It!, Visible in Do It!, and Visible in Know It? icons below the text edit pane to specify the particular mode.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![See It!/Try It! icon]</td>
<td>The text is visible in See It! and Try It! modes only.</td>
</tr>
<tr>
<td>![Know It? icon]</td>
<td>The text is visible in Know It? Mode only.</td>
</tr>
<tr>
<td>![Do It! icon]</td>
<td>The text is visible in Do It! mode only.</td>
</tr>
</tbody>
</table>

For certain actions, you may find that the custom text is inappropriate for all playback modes and can exclude it from a particular mode. If you do not want custom text to appear in See It!, Try It!, and/or Do It! modes, you need to select the text in the text edit pane, and then deselect the mode icon(s).

**Note:** Explanation frames provide a method for adding information to a topic. While Explanation frames automatically appear during playback in See It!, Try It!, and Do It! modes, they do not appear in Know It? mode. If you wish to include Explanation frame text in the Know It? playback, you can select the text and enable the Visible in Know It! icon. Be aware that deselecting all of the Explanation frame text for Do It! mode causes the playback to skip the Explanation frame entirely.

Intro/End Frames in Know It Mode

When a user plays a topic in Know It? mode, the Introduction bubble appears. This bubble typically includes instructions for completing the task, and in many situations it will differ from the Introduction text for the other modes. By default, Introduction/End frame text does not display in Know It? mode. For this reason, you should enter and designate text for the Introduction/End frames for Know It? mode only. For example, for a topic in Know It? mode, you want the Introduction text to be "Complete the steps for printing a document." or "Print a document." In this situation, you can enter the instruction text, select it, and then select the Visible in Know It! icon. Next, you would deselect the Visible in See It!/Try It! and Visible in Do It! icons to exclude the text from displaying in those modes.

When a user completes a task in Know It? mode, the End frame appears. Just as with the Introduction text, you may want to enter text that is appropriate for Know It? mode and designate it for Know It? mode only.

Display Template Text in Know It Mode

Template text appears in See It!, Try It! and Do It! modes by default for all frames. The Visible in See It!/Try It! and Visible in Do It! icons below the text edit pane are selected automatically. On frames where the user is required to enter text, the Template text visible in Know It? mode icon is also selected, as such actions may require the user to enter specific text to perform the step correctly.
Control Text for Player and Print Output

The playback mode for which custom text is marked determines in what playback or print output the text will appear. By default, custom text that is marked to be visible in See It! and Try It! modes will appear in the Player for those modes, in the Presentation output, and in the Business Process Document and Training Guide documentation; text that is marked to appear for playback in Do It! mode will appear in the Job Aid and Test Document. However, you may want custom text to appear during playback, but not appear in your training manual. Conversely, you may want text to appear in the printed documentation, but not in the Player.

Using the Visible in Player and Visible in Print icons, you can separately control whether your custom text appears for Player and Presentation output only, a Print output only, or for both.

**Note:** Selecting or deselecting the Visible in Player or Visible in Print icons affects the visibility of the selected text in all selected playback modes for Player or print output. If custom text is marked for both See It/Try It and Do It modes, deselecting the Visible in Print icon means that the text will not appear in any printed output.

To control the text for the Player and print outputs for the current frame:

1. Display the Frame Properties toolpane, if necessary.
2. In the text edit pane, select the text you want to include or remove from a particular output.
3. Select or deselect [Visible in Player](#) or [Visible in Print](#).

Preview Frame Text for Playback and Print Output

You can preview how your custom text for a frame will appear in the Player and Printed outputs in each playback mode using the Display list in the Topic Editing toolbar. By default, the bubble displays the template and custom text as they appear when you play the topic in See It! and Try It! modes. However, you can check how the text appears for each mode in the Player and print output. There are six display modes; Player - See It/Try It, Player - Know It, Player - Do It, Print - See It/Try It, Print - Know It, and Print - Do It.

**Note:** You can use the Print - See It/Try It view to see how the text will appear in the Business Process Document, Training Guide, and Instructor Manual. The Print - Do It views allows you to see how the text will appear in the Job Aid, Test Document, and HP Quality Center.

**Tip:** You can also access the display modes using the View menu and the Display submenu. A checkmark appears next to the selected display mode on the menu.

Hide the Bubble

You can prevent the bubble from appearing during playback in See It! and Try It! modes. This allows you to create the equivalent of a PowerPoint slide show, and then record sound to narrate it if desired. In this case, a bubble on each "slide" would not be appropriate.
This option allows you to hide the bubble on a frame-by-frame basis. You must turn off the action areas manually if you do not want them to show. If you turn the action area off, you may want to make sure that the Enable skipping in Try It! mode option is selected when you publish the content so that the frames can be advanced by pressing Enter in Try It!; if there are no action areas, there is no visual cue as what to do to advance the frame, and you may have difficulty advancing the frame.

If sound has been recorded for the topic or the frame, all frames display during See It! mode playback and advance automatically when the sound has finished playing. In Try It! mode, all frames are shown, but the frames must be advanced manually by either performing the correct action or pressing Enter. No remediation is shown if you perform the incorrect action.

If there is no sound with the topic, turning off the bubble has the following affect on the various frame types in See It! and Try It! modes:

<table>
<thead>
<tr>
<th>Frame type</th>
<th>See It!</th>
<th>Try It!</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction/End</td>
<td>skipped</td>
<td>skipped</td>
</tr>
<tr>
<td>Explanation</td>
<td>skipped</td>
<td>skipped</td>
</tr>
<tr>
<td>Decision</td>
<td>included; user must choose a path</td>
<td>included; user must choose a path</td>
</tr>
<tr>
<td>Action</td>
<td>bubble hidden; action area displayed unless it has been turned off</td>
<td>bubble hidden; action area displayed unless it has been turned off</td>
</tr>
<tr>
<td>No-context</td>
<td>bubble hidden; action area displayed unless it has been turned off</td>
<td>bubble hidden; action area displayed unless it has been turned off</td>
</tr>
<tr>
<td>Frames with infinite time delay</td>
<td>skipped</td>
<td>bubble hidden; action area displayed unless it has been turned off</td>
</tr>
</tbody>
</table>

**Note:** If there are alternative actions on a frame and you hide the bubble, the bubble is hidden for all actions.

To hide the bubble for the current frame:

1. Display the Frame Properties toolpane, if necessary.

2. Click 🎨 Display bubble for this frame.

**Select a Bubble Icon**

Each bubble can contain a default icon before the text. By default, no icon appears. You can choose an icon for the current frame by using the Bubble icon in the Frame Properties toolpane.

To select an icon for the bubble for the current frame:

1. Display the Frame Properties toolpane, if necessary.

2. Click 🎨 Bubble icon and choose a bubble icon.
Change the Bubble Pointer
The bubbles appear with a default shape and pointer location. You can choose from nine different pointer locations, which will effectively relocate the bubble on the screen. You cannot relocate a bubble if the bubble will not fit on the screen in the new position.

To change the bubble pointer for the current frame:
1. Display the Frame Properties toolpane, if necessary.
2. Click Pointer position and choose a pointer position.

Change the Bubble Background Color
The default background color for all bubbles is yellow. You can change this default for the current frame. This option is useful for calling attention to certain steps.

To change the background color of the bubble for the current frame:
1. Display the Frame Properties toolpane, if necessary.
2. Click Background color and choose a background color.
3. Click OK.

Edit Action Properties
The lower section of the Frame toolpane contains settings that describe the action performed in the frame. As you record a topic, the Developer automatically enters information for these settings, which vary according to the type of action performed. The Developer uses these settings to determine the appropriate bubble text based on the template assigned to the topic. You can change many of the settings as appropriate for your needs.

Action Types
The Action Type setting indicates the type of action taken for the current frame. There are three basic action types: keyboard, string input, and mouse. A keyboard action occurs when you press a key on the keyboard to accomplish a task. A string input action occurs when you enter text into a document, field, dialog box, and so on. A mouse action includes clicking, double-clicking, pointing, rolling the wheel, and dragging. While the Developer automatically determines the action, you can change this setting if necessary. The following table lists the possible actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
<td>Using the mouse to point to an object on the screen. Most often used when displaying a submenu.</td>
</tr>
<tr>
<td>Drag</td>
<td>Clicking and holding either mouse button while moving the mouse. This action includes dragging to select text or cells, or dragging an object (such as a graphic) across the screen.</td>
</tr>
<tr>
<td>Keyboard</td>
<td>Pressing any function key, cursor movement key, or any other single key, such as ENTER, TAB, ESC, INSERT, or DELETE. This action also includes key combinations, such as CTRL+A, SHIFT+ENTER, and ALT+TAB.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Left button down</td>
<td>Pressing and holding the primary mouse button (the left mouse button for a right-handed user); releasing the mouse button. These actions are used before and after drag events to indicate the start and end of the drag.</td>
</tr>
<tr>
<td>Left button up</td>
<td>Using the primary mouse button.</td>
</tr>
<tr>
<td>Left click</td>
<td>Using the primary mouse button.</td>
</tr>
<tr>
<td>Left double-click</td>
<td>Using the primary mouse button.</td>
</tr>
<tr>
<td>Left triple-click</td>
<td>Using the primary mouse button.</td>
</tr>
<tr>
<td>Left begin drag</td>
<td>Holding the primary mouse button down and moving the mouse.</td>
</tr>
<tr>
<td>Right button down</td>
<td>Pressing and holding the secondary mouse button (the right mouse button for a right-handed user); releasing the mouse button.</td>
</tr>
<tr>
<td>Right button up</td>
<td>Using the secondary mouse button.</td>
</tr>
<tr>
<td>Right click</td>
<td>Using the secondary mouse button.</td>
</tr>
<tr>
<td>Right double-click</td>
<td>Using the secondary mouse button.</td>
</tr>
<tr>
<td>Right triple-click</td>
<td>Using the secondary mouse button.</td>
</tr>
<tr>
<td>Right begin drag</td>
<td>Holding the secondary mouse button down and moving the mouse.</td>
</tr>
<tr>
<td>Middle button down</td>
<td>Pressing and holding the middle mouse button; releasing the mouse button.</td>
</tr>
<tr>
<td>Middle button up</td>
<td>Using the middle mouse button.</td>
</tr>
<tr>
<td>Middle click</td>
<td>Using the middle mouse button.</td>
</tr>
<tr>
<td>Middle double-click</td>
<td>Using the middle mouse button.</td>
</tr>
<tr>
<td>Middle triple-click</td>
<td>Using the middle mouse button.</td>
</tr>
<tr>
<td>Middle begin drag</td>
<td>Holding the middle mouse button down and moving the mouse.</td>
</tr>
<tr>
<td>Wheel</td>
<td>Rolling the middle mouse button.</td>
</tr>
<tr>
<td>String input</td>
<td>Entering text into a document or a field by typing on the keyboard.</td>
</tr>
</tbody>
</table>

**Note:** If you record an action that uses a keyboard combination involving the SHIFT, CTRL, or ALT keys, the Topic Editor records the action as a keyboard action and automatically selects the Alt, Control, or Shift option in the Frame toolpane, as appropriate.

**Object Type**

The Object type setting refers to the type of object on which you performed the action. The Developer determines the object type or class automatically, based on the Template Set selected. The Developer then determines which template text to use for the bubble text. Each Template Set may contain different text for the same object type.

The Object type list is divided into an upper and lower section, separated by a horizontal line. All object types appear in the lower section. The upper section contains a list of the most commonly used object types. As you change object types, the new entries are added to the upper section; older entries in the upper list are removed to make room for the new ones. The upper section then becomes a personalized list of the objects you frequently use, making object type changes faster and easier to manage.

**Object Type - Standard Template Set**

For your reference, the following table contains a listing of the types and classes of objects in the Standard template set, with their associated template text for a left click:
<table>
<thead>
<tr>
<th>Object Type</th>
<th>Description</th>
<th>Template Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActiveX</td>
<td>An ActiveX control, such as a navigation tree.</td>
<td>Click the desired object.</td>
</tr>
<tr>
<td>Alert</td>
<td>An alert or a condition that a user should be notified about. Should be used only for objects that embody an alert but are not associated with another user interface element such as a message box, graphic, text, or sound. A navigation tree is an example.</td>
<td>Click the <code>&lt;object name&gt;</code> alert.</td>
</tr>
<tr>
<td>Animation</td>
<td>An animation control, which contains content that is changing over time, such as a control that displays a series of bitmap frames. Usually displayed when files are being copied, or when some other time-consuming task is being performed.</td>
<td>Click the animation.</td>
</tr>
<tr>
<td>Application</td>
<td>The main window for an application.</td>
<td>Click the <code>&lt;object name&gt;</code> application.</td>
</tr>
<tr>
<td>Balloon</td>
<td>A tooltip or help bubble.</td>
<td>Click the help balloon.</td>
</tr>
<tr>
<td>Border</td>
<td>A window border. The entire border is represented by a single object, rather than by separate objects for each side.</td>
<td>Click the <code>&lt;object name&gt;</code> border.</td>
</tr>
<tr>
<td>Calendar</td>
<td>A calendar, usually displayed after clicking a dropdown arrow that allows the user to select a date to enter information.</td>
<td>Click the desired date.</td>
</tr>
<tr>
<td>Caret</td>
<td>The system caret.</td>
<td>Click the <code>&lt;object name&gt;</code> caret.</td>
</tr>
<tr>
<td>Cartoon graphic</td>
<td>A graphic object, typically displayed to provide help to users of an application.</td>
<td>Click the <code>&lt;object name&gt;</code> cartoon graphic.</td>
</tr>
<tr>
<td>Chart</td>
<td>A graphical image used to represent data, for example a chart.</td>
<td>Click the <code>&lt;object name&gt;</code> chart.</td>
</tr>
<tr>
<td>Checkbox</td>
<td>An option, usually in a dialog box, that has two states, selected or deselected.</td>
<td>Click the <code>&lt;object name&gt;</code> option.</td>
</tr>
<tr>
<td>CheckListBox</td>
<td>A special type of control in which the list items have a checkbox that the user can enable or disable.</td>
<td>Select the desired item(s) in the <code>&lt;object name&gt;</code> list</td>
</tr>
<tr>
<td>CheckListBox Item</td>
<td>An item in a checklist box control.</td>
<td>Click the <code>&lt;object name&gt;</code> list item.</td>
</tr>
<tr>
<td>CheckListBox Item - Checkbox</td>
<td>The checkbox of a checklist box object. Select the box before the <code>&lt;object name&gt;</code> item.</td>
<td></td>
</tr>
<tr>
<td>Clock</td>
<td>A control that displays time.</td>
<td>Click the <code>&lt;object name&gt;</code> clock.</td>
</tr>
<tr>
<td>Column</td>
<td>A vertical section of a table.</td>
<td>Click an entry in the <code>&lt;object name&gt;</code> column.</td>
</tr>
<tr>
<td>Column header</td>
<td>The first cell in a column, it displays a label to identify the contents of the column.</td>
<td>Click the <code>&lt;object name&gt;</code> column header.</td>
</tr>
<tr>
<td>Combobox</td>
<td>An option, usually in a dialog box, that displays a drop-down list from which a user can choose an option or in which the user can type.</td>
<td>Click the <code>&lt;object name&gt;</code> list.</td>
</tr>
<tr>
<td>Combobox - EditBox</td>
<td>The edit box of the ComboBox object.</td>
<td>Click in the edit field of the <code>&lt;object name&gt;</code> combobox.</td>
</tr>
<tr>
<td>Cursor</td>
<td>The system mouse pointer.</td>
<td>Click the <code>&lt;object name&gt;</code> cursor.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Description</td>
<td>Template Text</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Date/Time box</td>
<td>A control with a special edit box and a spin control that allows the user to</td>
<td>Click the &lt;object name&gt; date/time field.</td>
</tr>
<tr>
<td></td>
<td>choose a specific date or time value.</td>
<td></td>
</tr>
<tr>
<td>Date/Time box - Down SpinButton</td>
<td>The down button in the Date/Time spinbox control.</td>
<td>Click the &lt;object name&gt; date/time box.</td>
</tr>
<tr>
<td>Date/Time box - Editbox</td>
<td>The embedded edit control in the Date/Time box.</td>
<td>Click in the &lt;object name&gt; field.</td>
</tr>
<tr>
<td>Date/Time box - Spinbox</td>
<td>The embedded spin control in the Date/Time box.</td>
<td></td>
</tr>
<tr>
<td>Date/Time box - Up SpinButton</td>
<td>The up button in the Date/Time spinbox control.</td>
<td>Click the &lt;object name&gt; date/time box.</td>
</tr>
<tr>
<td>Diagram</td>
<td>A graphical image used to diagram data.</td>
<td>Click the &lt;object name&gt; diagram.</td>
</tr>
<tr>
<td>Dial box</td>
<td>A dial or knob, such as a volume control.</td>
<td>Click the &lt;object name&gt; dial box.</td>
</tr>
<tr>
<td>DragListBox</td>
<td>A special type of list control, where the user can drag items up and down</td>
<td>Click an entry in the list.</td>
</tr>
<tr>
<td></td>
<td>for changing the order.</td>
<td></td>
</tr>
<tr>
<td>DragListBox Item</td>
<td>An item in the DragList Box control.</td>
<td>Click the &lt;object name&gt; list item.</td>
</tr>
<tr>
<td>Drop-down button</td>
<td>The object represents a button that drops down a list of items.</td>
<td>Click the button to the right of the &lt;object name&gt; field.</td>
</tr>
<tr>
<td>DropDown Grid Button</td>
<td>A button that drops down a grid.</td>
<td>Click the &lt;object name&gt; button.</td>
</tr>
<tr>
<td>DropDown List</td>
<td>A drop-down list box that shows one item and allows the user to display and</td>
<td>Click an entry in the list.</td>
</tr>
<tr>
<td></td>
<td>select another from a list of alternative values.</td>
<td></td>
</tr>
<tr>
<td>DropDown Menu Button</td>
<td>A button that drops down a menu.</td>
<td>Click the &lt;object name&gt; dropdown button to activate the menu.</td>
</tr>
<tr>
<td>Editfield</td>
<td>An option in which a user must type to enter information.</td>
<td>Click in the &lt;object name&gt; field.</td>
</tr>
<tr>
<td>Equation</td>
<td>A mathematical equation.</td>
<td>Click the &lt;object name&gt; equation.</td>
</tr>
<tr>
<td>Graphics</td>
<td>A picture.</td>
<td>Click the &lt;object name&gt; graphic.</td>
</tr>
<tr>
<td>Grip Object</td>
<td>A special mouse pointer, which allows a user to manipulate user interface</td>
<td>Click the &lt;object name&gt; grip.</td>
</tr>
<tr>
<td></td>
<td>elements such as a window.</td>
<td></td>
</tr>
<tr>
<td>Hot key field</td>
<td>A hot-key field that allows the user to enter a combination or sequence of</td>
<td>Click the &lt;object name&gt; hotkey field.</td>
</tr>
<tr>
<td></td>
<td>keystrokes.</td>
<td></td>
</tr>
<tr>
<td>Hyperlink</td>
<td>A link to another object. This object might look like text or a graphic, but</td>
<td>Click the &lt;object name&gt; link.</td>
</tr>
<tr>
<td></td>
<td>it acts like a button.</td>
<td></td>
</tr>
<tr>
<td>IP Address box</td>
<td>A special edit control with 4 point-separated field in which the user can</td>
<td>Click in the &lt;object name&gt; ip address.</td>
</tr>
<tr>
<td></td>
<td>write an IP address.</td>
<td></td>
</tr>
<tr>
<td>IP Address box - Editbox</td>
<td>One field of the 4 fields of the IP Address control.</td>
<td>Click in the &lt;object name&gt; ip address field.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Description</td>
<td>Template Text</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>Listbox</td>
<td>An option in a dialog box that contains a list of items from which the user can choose an option to enter information.</td>
<td></td>
</tr>
<tr>
<td>Listbox item</td>
<td>An item in a list box or the list portion of a combo box, drop-down list box, or drop-down combo box.</td>
<td></td>
</tr>
<tr>
<td>Menu bar</td>
<td>The menu bar, usually following (beneath) the title bar of a window, from which menus can be selected by the user.</td>
<td></td>
</tr>
<tr>
<td>Menu entry</td>
<td>The choices that appear as the result of selecting a popup menu. This type includes a shortcut menu.</td>
<td></td>
</tr>
<tr>
<td>Object Group</td>
<td>An object that logically groups other objects.</td>
<td></td>
</tr>
<tr>
<td>Outline</td>
<td>An outline or tree structure, which displays a hierarchical list and usually allows the user to expand and collapse branches.</td>
<td></td>
</tr>
<tr>
<td>Outline item</td>
<td>An item in an outline or tree structure.</td>
<td></td>
</tr>
<tr>
<td>Outline item button</td>
<td>An expander button of an outline item.</td>
<td></td>
</tr>
<tr>
<td>Pager</td>
<td>Click the &lt;object name&gt; arrow.</td>
<td></td>
</tr>
<tr>
<td>Pager - Down Arrow</td>
<td>Click the &lt;object name&gt; arrow.</td>
<td></td>
</tr>
<tr>
<td>Pager - Horizontal</td>
<td>The horizontal type of Pager object.</td>
<td></td>
</tr>
<tr>
<td>Pager - Left Arrow</td>
<td>Click the &lt;object name&gt; arrow.</td>
<td></td>
</tr>
<tr>
<td>Pager - Right Arrow</td>
<td>Click the &lt;object name&gt; arrow.</td>
<td></td>
</tr>
<tr>
<td>Pager - Up Arrow</td>
<td>Click the &lt;object name&gt; arrow.</td>
<td></td>
</tr>
<tr>
<td>Pager - Vertical</td>
<td>The vertical type of Pager object.</td>
<td></td>
</tr>
<tr>
<td>Pane</td>
<td>A pane within a frame or document window.</td>
<td></td>
</tr>
<tr>
<td>Pointer</td>
<td>An indicator such as a pointer graphic that points to the current item.</td>
<td></td>
</tr>
<tr>
<td>Popup menu</td>
<td>The choices that appear in the menu bar of an application, below the title bar; in the Start menu on the taskbar; or on a shortcut menu. A list of menu commands appears when the popup menu is selected.</td>
<td></td>
</tr>
<tr>
<td>Progress bar</td>
<td>A progress bar that dynamically shows the user the percent complete of an operation in progress.</td>
<td></td>
</tr>
<tr>
<td>Property page</td>
<td>A property sheet.</td>
<td></td>
</tr>
<tr>
<td>Pushbutton</td>
<td>A command button that appears in a dialog box.</td>
<td></td>
</tr>
<tr>
<td>Object Type</td>
<td>Description</td>
<td>Template Text</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Radiobutton</td>
<td>An option, usually in a dialog box, that allows the user to choose only one setting from a group.</td>
<td>Click the &lt;object name&gt; option.</td>
</tr>
<tr>
<td>RichEdit</td>
<td>A special type of edit control in which the user can write text with formatting properties.</td>
<td>Click in the &lt;object name&gt; field.</td>
</tr>
<tr>
<td>Row</td>
<td>A row of cells within a table.</td>
<td>Click an entry in the &lt;object name&gt; row.</td>
</tr>
<tr>
<td>Row header</td>
<td>A row header with a label for a table row.</td>
<td>Click the &lt;object name&gt; row header.</td>
</tr>
<tr>
<td>Ruler</td>
<td>The horizontal or vertical bar that allows the user to measure dimensions of objects, or place objects in specific locations in a document.</td>
<td>Click the ruler.</td>
</tr>
<tr>
<td>Ruler - Horizontal</td>
<td>The horizontal type of ruler object.</td>
<td>Click the horizontal ruler.</td>
</tr>
<tr>
<td>Ruler - Vertical</td>
<td>The vertical type of ruler object.</td>
<td>Click the vertical ruler.</td>
</tr>
<tr>
<td>Scrollbar</td>
<td>A vertical or horizontal scroll bar, which can be either part of the client area or used in a control.</td>
<td>Click the &lt;object name&gt; scrollbar.</td>
</tr>
<tr>
<td>Scrollbar - Horizontal</td>
<td>The horizontal type of scrollbar object.</td>
<td>Click the &lt;object name&gt; scrollbar.</td>
</tr>
<tr>
<td>Scrollbar - Vertical</td>
<td>The vertical type of scrollbar object.</td>
<td>Click the &lt;object name&gt; scrollbar.</td>
</tr>
<tr>
<td>Scrollbar box</td>
<td>The box object of the scrollbar object that can be moved up-down or left-right.</td>
<td>Click the &lt;object name&gt; scrollbar box.</td>
</tr>
<tr>
<td>Scrollbar box - Horizontal</td>
<td>The box object of the vertical scrollbar object that can be moved up-down.</td>
<td>Click the &lt;object name&gt; scrollbar box.</td>
</tr>
<tr>
<td>Scrollbar box - Vertical</td>
<td>The box object of the horizontal scrollbar object that can be moved left-right.</td>
<td>Click the &lt;object name&gt; scrollbar box.</td>
</tr>
<tr>
<td>Scrollbar button</td>
<td>The sliding button on the horizontal or vertical bar that allows you to view another part of the workspace.</td>
<td>Click the &lt;object name&gt; button of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - Down</td>
<td>The down button of the vertical scrollbar object.</td>
<td>Click the &lt;object name&gt; button of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - Horizontal</td>
<td>The left or right or pageleft, or pageright button of the horizontal scrollbar object.</td>
<td>Click the &lt;object name&gt; button of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - Left</td>
<td>The left button of the horizontal scrollbar object.</td>
<td>Click the &lt;object name&gt; button of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - PageDown</td>
<td>The pagedown button of the vertical scrollbar object.</td>
<td>Click the &lt;object name&gt; button of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - PageLeft</td>
<td>The pageleft button of the horizontal scrollbar object.</td>
<td>Click the &lt;object name&gt; button of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - PageRight</td>
<td>The pageright button of the horizontal scrollbar object.</td>
<td>Click the &lt;object name&gt; button of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - PageUp</td>
<td>The pageup button of the vertical scrollbar object.</td>
<td>Click the &lt;object name&gt; button of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - Right</td>
<td>The right button of the horizontal scrollbar object.</td>
<td>Click the &lt;object name&gt; button of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - Up</td>
<td>The up button of the vertical scrollbar object.</td>
<td>Click the &lt;object name&gt; button of the scrollbar.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Description</td>
<td>Template Text</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Scrollbar button -</td>
<td>The up or down or pageup, or pagedown button of the vertical scrollbar object.</td>
<td>Click the &lt;object name&gt; button of the scrollbar.</td>
</tr>
<tr>
<td>Vertical</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Separator</td>
<td>An object used to visually divide a space into two regions, such as a separator menu item or a bar dividing split panes within a window.</td>
<td>Click the &lt;object name&gt; separator.</td>
</tr>
<tr>
<td>Slider</td>
<td>An object that you drag to change the level of a setting.</td>
<td>Click the &lt;object name&gt; slider, and drag it to the desired level.</td>
</tr>
<tr>
<td>Slider - Track</td>
<td>The slider object's trackbar.</td>
<td>Click the &lt;object name&gt; slider.</td>
</tr>
<tr>
<td>Sound</td>
<td>A system sound which is associated with various system events.</td>
<td>Click the &lt;object name&gt; sound.</td>
</tr>
<tr>
<td>Spin box</td>
<td>A field in which you can enter numeric information. Up and down arrows allow you to increase or decrease the number in the field.</td>
<td>Click the up or down arrow next to the &lt;object name&gt; field.</td>
</tr>
<tr>
<td>Spin box - Down</td>
<td>The spinbox's down button</td>
<td>Click the down arrow next to the &lt;object name&gt; field.</td>
</tr>
<tr>
<td>button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spin box - Up</td>
<td>The spinbox's up button.</td>
<td>Click the up arrow next to the &lt;object name&gt; field.</td>
</tr>
<tr>
<td>button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Static Text</td>
<td>Read-only text such as labels for other controls or instructions in a dialog box.</td>
<td>Click in the &lt;object name&gt; field.</td>
</tr>
<tr>
<td>Statusbar</td>
<td>The area at the bottom of the screen that displays messages and other information.</td>
<td>Click the statusbar.</td>
</tr>
<tr>
<td>Statusbar button</td>
<td>An embedded button in the status bar.</td>
<td>Click the &lt;object name&gt; button in the statusbar.</td>
</tr>
<tr>
<td>Tab</td>
<td>An object that appears at the top of each page in a dialog box containing more than one page.</td>
<td>Click the &lt;object name&gt; tab.</td>
</tr>
<tr>
<td>Tab - Horizontal</td>
<td></td>
<td>Click the &lt;object name&gt; horizontal tab.</td>
</tr>
<tr>
<td>Tab - Vertical</td>
<td></td>
<td>Click the &lt;object name&gt; vertical tab.</td>
</tr>
<tr>
<td>Tab List</td>
<td></td>
<td>Click the &lt;object name&gt; tab list.</td>
</tr>
<tr>
<td>Table</td>
<td>A table containing rows and columns of cells, and optionally, row headers and column headers.</td>
<td>Click the &lt;object name&gt; table.</td>
</tr>
<tr>
<td>Table Cell</td>
<td>A cell within a table.</td>
<td>Click the &lt;object name&gt; cell.</td>
</tr>
<tr>
<td>Titlebar</td>
<td>A title or caption bar for a window.</td>
<td>Click the titlebar.</td>
</tr>
<tr>
<td>Titlebar button</td>
<td>A button in the titlebar object.</td>
<td>Click the &lt;object name&gt; button in the titlebar.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>A toolbar, which is a grouping of controls that provide easy access to frequently used commands.</td>
<td>Click the &lt;object name&gt; toolbar.</td>
</tr>
<tr>
<td>Toolbar button</td>
<td>An object that contains graphics or text, usually grouped with other similar objects in a bar at the top of the application workspace.</td>
<td>Click the &lt;object name&gt; button.</td>
</tr>
</tbody>
</table>
## Use the Topic Editor

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Description</th>
<th>Template Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tooltip</td>
<td>An object that appears when you point to a toolbar button. This object contains the name of the button and may include a brief description of it.</td>
<td>Click the &lt;object name&gt; tooltip.</td>
</tr>
<tr>
<td>Universal Object</td>
<td>This type is used when another appropriate object type does not exist.</td>
<td>Click the &lt;object name&gt; object.</td>
</tr>
<tr>
<td>Whitespace</td>
<td>Blank space between other objects.</td>
<td>Click the &lt;object name&gt; whitespace.</td>
</tr>
<tr>
<td>Window</td>
<td>The area that the application occupies on the screen. Usually, this area has a title bar in which the name of the product appears. The name of this object cannot be edited.</td>
<td>Click the &lt;Window name&gt;.</td>
</tr>
<tr>
<td>Workspace</td>
<td>An open document, presentation, spreadsheet, or database file.</td>
<td>Click the desired object.</td>
</tr>
</tbody>
</table>

### Object Type - Microsoft Template Set

For your reference, the following table contains a listing of the types and classes of objects in the Microsoft Template set, with their associated template text for a left click:

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Description</th>
<th>Template Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActiveX</td>
<td>An ActiveX control, such as a navigation tree.</td>
<td>Click the desired object.</td>
</tr>
<tr>
<td>Alert</td>
<td>An alert or a condition that a user should be notified about. Should be used only for objects that embody an alert but are not associated with another user interface element such as a message box, graphic, text, or sound. A navigation tree is an example.</td>
<td>Click the &lt;object name&gt; alert.</td>
</tr>
<tr>
<td>Animation</td>
<td>An animation control, which contains content that is changing over time, such as a control that displays a series of bitmap frames. Usually displayed when files are being copied, or when some other time-consuming task is being performed.</td>
<td>Click the animation.</td>
</tr>
<tr>
<td>Application</td>
<td>The main window for an application.</td>
<td>Click the &lt;object name&gt; application.</td>
</tr>
<tr>
<td>Balloon</td>
<td>A tooltip or help bubble.</td>
<td>Click the help balloon.</td>
</tr>
<tr>
<td>Border</td>
<td>A window border. The entire border is represented by a single object, rather than by separate objects for each side.</td>
<td>Click the &lt;object name&gt; border.</td>
</tr>
<tr>
<td>Calendar</td>
<td>A calendar, usually displayed after clicking a dropdown arrow that allows the user to select a date to enter information.</td>
<td>Click the desired date.</td>
</tr>
<tr>
<td>Caret</td>
<td>The system caret.</td>
<td>Click the &lt;object name&gt; caret.</td>
</tr>
<tr>
<td>Cartoon graphic</td>
<td>A graphic object, typically displayed to provide help to users of an application.</td>
<td>Click the &lt;object name&gt; cartoon graphic.</td>
</tr>
<tr>
<td>Chart</td>
<td>A graphical image used to represent data, for example a chart.</td>
<td>Click the &lt;object name&gt; chart.</td>
</tr>
<tr>
<td><strong>Object Type</strong></td>
<td><strong>Description</strong></td>
<td><strong>Template Text</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Checkbox</td>
<td>An option, usually in a dialog box, that has two states, selected or deselected.</td>
<td>Select the <code>&lt;object name&gt;</code> option.</td>
</tr>
<tr>
<td>CheckList Box</td>
<td>A special type of control in which the list items have a checkbox that the user can enable or disable.</td>
<td>Select the desired item(s) in the <code>&lt;object name&gt;</code> list.</td>
</tr>
<tr>
<td>CheckList Box Item</td>
<td>An item in a checklist box control.</td>
<td>Click the <code>&lt;object name&gt;</code> list item.</td>
</tr>
<tr>
<td>CheckList Box Item - Check Box</td>
<td>The checkbox of a checklist box object.</td>
<td>Select the check box before the <code>&lt;object name&gt;</code> item.</td>
</tr>
<tr>
<td>Clock</td>
<td>A control that displays time.</td>
<td>Click the <code>&lt;object name&gt;</code> clock.</td>
</tr>
<tr>
<td>Column</td>
<td>A vertical section of a table.</td>
<td>Click an entry in the <code>&lt;object name&gt;</code> column.</td>
</tr>
<tr>
<td>Column header</td>
<td>The first cell in a column, it displays a label to identify the contents of the column.</td>
<td>Click the <code>&lt;object name&gt;</code> column header.</td>
</tr>
<tr>
<td>Combo box</td>
<td>An option, usually in a dialog box, that displays a drop-down list from which a user can choose an option or in which the user can type.</td>
<td>Click the <code>&lt;object name&gt;</code> box.</td>
</tr>
<tr>
<td>Combo box - EditBox</td>
<td>The edit box of the ComboBox object.</td>
<td>Click the <code>&lt;object name&gt;</code> box.</td>
</tr>
<tr>
<td>Cursor</td>
<td>The system mouse pointer.</td>
<td>Click the <code>&lt;object name&gt;</code> cursor.</td>
</tr>
<tr>
<td>Date/Time box</td>
<td>A control with a special edit box and a spin control that allows the user to choose a specific date or time value.</td>
<td>Click the <code>&lt;object name&gt;</code> date/time box.</td>
</tr>
<tr>
<td>Date/Time box - Down SpinBox</td>
<td>The down button in the Date/Time spinbox control.</td>
<td>Click the <code>&lt;object name&gt;</code> date/time box.</td>
</tr>
<tr>
<td>Date/Time box - EditBox</td>
<td>The embedded edit control in the Date/Time box.</td>
<td>Click in the <code>&lt;object name&gt;</code> box.</td>
</tr>
<tr>
<td>Date/Time box - SpinBox</td>
<td>The embedded spin control in the Date/Time box.</td>
<td>Click the up or down arrow next to the <code>&lt;object name&gt;</code> box.</td>
</tr>
<tr>
<td>Date/Time box - Up SpinBox</td>
<td>The up button in the Date/Time spinbox control.</td>
<td>Click the <code>&lt;object name&gt;</code> date/time box.</td>
</tr>
<tr>
<td>Diagram</td>
<td>A graphical image used to diagram data.</td>
<td>Click the <code>&lt;object name&gt;</code> diagram.</td>
</tr>
<tr>
<td>Dial box</td>
<td>A dial or knob, such as a volume control.</td>
<td>Click the <code>&lt;object name&gt;</code> dial box.</td>
</tr>
<tr>
<td>DragList Box</td>
<td>A special type of list control, where the user can drag items up and down for changing the order.</td>
<td>Select an entry in the list.</td>
</tr>
<tr>
<td>DragList Box Item</td>
<td>An item in the DragList Box control.</td>
<td>Select the <code>&lt;object name&gt;</code> list item.</td>
</tr>
<tr>
<td>Drop-down button</td>
<td>The object represents a button that drops down a list of items.</td>
<td>Click the dropdown arrow to the right of the <code>&lt;object name&gt;</code> box.</td>
</tr>
<tr>
<td>DropDownList Button</td>
<td>A button that drops down a grid.</td>
<td>Click the <code>&lt;object name&gt;</code> button.</td>
</tr>
<tr>
<td>DropDown List</td>
<td>A drop-down list box that shows one item and allows the user to display and select another from a list of alternative values.</td>
<td>Select an entry in the list.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Description</td>
<td>Template Text</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DropDown Menu Button</td>
<td>A button that drops down a menu.</td>
<td>Click the &lt;object name&gt; dropdown arrow to access the menu.</td>
</tr>
<tr>
<td>Editfield</td>
<td>An option in which a user must type to enter information.</td>
<td>Click the &lt;object name&gt; box.</td>
</tr>
<tr>
<td>Equation</td>
<td>A mathematical equation.</td>
<td>Click the &lt;object name&gt; equation.</td>
</tr>
<tr>
<td>Graphics</td>
<td>A picture.</td>
<td>Click the &lt;object name&gt; graphic.</td>
</tr>
<tr>
<td>Grip Object</td>
<td>A special mouse pointer, which allows a user to manipulate user interface elements such as a window.</td>
<td>Click the &lt;object name&gt; grip.</td>
</tr>
<tr>
<td>Hot key field</td>
<td>A hot-key field that allows the user to enter a combination or sequence of keystrokes.</td>
<td>Click the &lt;object name&gt; keyboard shortcut box.</td>
</tr>
<tr>
<td>Hyperlink</td>
<td>A link to another object. This object might look like text or a graphic, but it acts like a button.</td>
<td>Click the &lt;object name&gt; link.</td>
</tr>
<tr>
<td>IP Address box</td>
<td>A special edit control with 4 point-separated field in which the user can write an IP address.</td>
<td>Click in the &lt;object name&gt; Internet Protocol address.</td>
</tr>
<tr>
<td>IP Address box - Editbox</td>
<td>One field of the 4 fields of the IP Address control.</td>
<td>Click in the &lt;object name&gt; Internet Protocol address box.</td>
</tr>
<tr>
<td>Listbox</td>
<td>An option in a dialog box that contains a list of items from which the user can choose an option to enter information.</td>
<td>Select an entry in the list.</td>
</tr>
<tr>
<td>Listbox item</td>
<td>An item in a list box or the list portion of a combo box, drop-down list box, or drop-down combo box.</td>
<td>Select the &lt;object name&gt; list item.</td>
</tr>
<tr>
<td>Menu</td>
<td>The choices that appear in the menu bar of an application, below the title bar; in the Start menu on the taskbar; or on a shortcut menu. A list of menu commands appears when the popup menu is selected.</td>
<td>Click the &lt;object name&gt; menu.</td>
</tr>
<tr>
<td>Menu bar</td>
<td>The menu bar, usually following (beneath) the title bar of a window, from which menus can be selected by the user.</td>
<td>Click the &lt;object name&gt; menu bar.</td>
</tr>
<tr>
<td>Menu entry</td>
<td>The choices that appear as the result of selecting a popup menu. This type includes a shortcut menu.</td>
<td>Click the &lt;object name&gt; command.</td>
</tr>
<tr>
<td>Object Group</td>
<td>An object that logically groups other objects.</td>
<td>Click the &lt;object name&gt; object group.</td>
</tr>
<tr>
<td>Outline</td>
<td>An outline or tree structure, which displays a hierarchical list and usually allows the user to expand and collapse branches.</td>
<td>Click an entry in the &lt;object name&gt; tree control.</td>
</tr>
<tr>
<td>Outline item</td>
<td>An item in an outline or tree structure.</td>
<td>Click the &lt;object name&gt; tree item.</td>
</tr>
<tr>
<td>Outline item button</td>
<td>An expander button of an outline item.</td>
<td>Click the plus sign button before the &lt;object name&gt; tree item.</td>
</tr>
<tr>
<td><strong>Object Type</strong></td>
<td><strong>Description</strong></td>
<td><strong>Template Text</strong></td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>Pager</td>
<td></td>
<td>Click the &lt;object name&gt; arrow.</td>
</tr>
<tr>
<td>Pager - Down Arrow</td>
<td></td>
<td>Click the &lt;object name&gt; arrow.</td>
</tr>
<tr>
<td>Pager - Horizontal</td>
<td>The horizontal type of Pager object.</td>
<td>Click the &lt;object name&gt; arrow.</td>
</tr>
<tr>
<td>Pager - Left Arrow</td>
<td></td>
<td>Click the &lt;object name&gt; arrow.</td>
</tr>
<tr>
<td>Pager - Right Arrow</td>
<td></td>
<td>Click the &lt;object name&gt; arrow.</td>
</tr>
<tr>
<td>Pager - Up Arrow</td>
<td></td>
<td>Click the &lt;object name&gt; arrow.</td>
</tr>
<tr>
<td>Pager - Vertical</td>
<td>The vertical type of Pager object.</td>
<td>Click the &lt;object name&gt; arrow.</td>
</tr>
<tr>
<td>Pane</td>
<td>A pane within a frame or document window.</td>
<td>Click the &lt;object name&gt; pane.</td>
</tr>
<tr>
<td>Pointer</td>
<td>An indicator such as a pointer graphic that points to the current item.</td>
<td>Click the &lt;object name&gt; pointer.</td>
</tr>
<tr>
<td>Progress bar</td>
<td>A progress bar that dynamically shows the user the percent complete of an operation in progress.</td>
<td>Click the &lt;object name&gt; progress bar.</td>
</tr>
<tr>
<td>Property page</td>
<td>A property sheet.</td>
<td>Click the &lt;object name&gt; property page.</td>
</tr>
<tr>
<td>Pushbutton</td>
<td>A command button that appears in a dialog box.</td>
<td>Click the &lt;object name&gt; button.</td>
</tr>
<tr>
<td>Radiobutton</td>
<td>An option, usually in a dialog box, that allows the user to choose only one setting from a group.</td>
<td>Select the &lt;object name&gt; option.</td>
</tr>
<tr>
<td>RichEdit</td>
<td>A special type of edit control in which the user can write text with formatting properties.</td>
<td>Click the &lt;object name&gt; box.</td>
</tr>
<tr>
<td>Row</td>
<td>A row of cells within a table.</td>
<td>Click an entry in the &lt;object name&gt; row.</td>
</tr>
<tr>
<td>Row header</td>
<td>A row header with a label for a table row.</td>
<td>Click the &lt;object name&gt; row header.</td>
</tr>
<tr>
<td>Ruler</td>
<td>The horizontal or vertical bar that allows the user to measure dimensions of objects, or place objects in specific locations in a document.</td>
<td>Click the ruler.</td>
</tr>
<tr>
<td>Ruler - Horizontal</td>
<td>The horizontal type of ruler object.</td>
<td>Click the horizontal ruler.</td>
</tr>
<tr>
<td>Ruler - Vertical</td>
<td>The vertical type of ruler object.</td>
<td>Click the vertical ruler.</td>
</tr>
<tr>
<td>Scrollbar</td>
<td>A vertical or horizontal scroll bar, which can be either part of the client area or used in a control.</td>
<td>Click the &lt;object name&gt; scrollbar.</td>
</tr>
<tr>
<td>Scrollbar - Horizontal</td>
<td>The horizontal type of scrollbar object.</td>
<td>Click the &lt;object name&gt; scrollbar.</td>
</tr>
<tr>
<td>Scrollbar - Vertical</td>
<td>The vertical type of scrollbar object.</td>
<td>Click the &lt;object name&gt; scrollbar.</td>
</tr>
<tr>
<td>Scrollbar box</td>
<td>The box object of the scrollbar object that can be moved up-down or left-right.</td>
<td>Click the &lt;object name&gt; scrollbar box.</td>
</tr>
<tr>
<td>Scrollbar box - Horizontal</td>
<td>The box object of the vertical scrollbar object that can be moved up-down.</td>
<td>Click the &lt;object name&gt; scrollbar box.</td>
</tr>
</tbody>
</table>

*Use the Topic Editor*
<table>
<thead>
<tr>
<th><strong>Object Type</strong></th>
<th><strong>Description</strong></th>
<th><strong>Template Text</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Scrollbar box - Vertical</td>
<td>The box object of the horizontal scrollbar object that can be moved left-right.</td>
<td>Click the &lt;object name&gt; scrollbar box.</td>
</tr>
<tr>
<td>Scrollbar button</td>
<td>The sliding button on the horizontal or vertical bar that allows you to view another part of the workspace.</td>
<td>Click the &lt;object name&gt; scroll arrow of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - Down</td>
<td>The down button of the vertical scrollbar object.</td>
<td>Click the &lt;object name&gt; button of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - Horizontal</td>
<td>The left or right or pageleft, or pageright button of the horizontal scrollbar object.</td>
<td>Click the &lt;object name&gt; scroll arrow of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - Left</td>
<td>The left button of the horizontal scrollbar object.</td>
<td>Click the &lt;object name&gt; scroll arrow of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - PageDown</td>
<td>The pagedown button of the vertical scrollbar object.</td>
<td>Click the &lt;object name&gt; scroll arrow of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - PageLeft</td>
<td>The pageleft button of the horizontal scrollbar object.</td>
<td>Click the &lt;object name&gt; scroll arrow of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - PageRight</td>
<td>The pageright button of the horizontal scrollbar object.</td>
<td>Click the &lt;object name&gt; scroll arrow of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - PageUp</td>
<td>The pageup button of the vertical scrollbar object.</td>
<td>Click the &lt;object name&gt; scroll arrow of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - Right</td>
<td>The right button of the horizontal scrollbar object.</td>
<td>Click the &lt;object name&gt; scroll arrow of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - Up</td>
<td>The up button of the vertical scrollbar object.</td>
<td>Click the &lt;object name&gt; scroll arrow of the scrollbar.</td>
</tr>
<tr>
<td>Scrollbar button - Vertical</td>
<td>The up or down or pageup, or pagedown button of the vertical scrollbar object.</td>
<td>Click the &lt;object name&gt; scroll arrow of the scrollbar.</td>
</tr>
<tr>
<td>Separator</td>
<td>An object used to visually divide a space into two regions, such as a separator menu item or a bar dividing split panes within a window.</td>
<td>Click the &lt;object name&gt; separator.</td>
</tr>
<tr>
<td>Slider</td>
<td>An object that you drag to change the level of a setting.</td>
<td>Move the &lt;object name&gt; slider to the desired level.</td>
</tr>
<tr>
<td>Slider - Track</td>
<td>The slider object's trackbar.</td>
<td>Click the &lt;object name&gt; slider.</td>
</tr>
<tr>
<td>Sound</td>
<td>A system sound which is associated with various system events.</td>
<td>Click the &lt;object name&gt; sound.</td>
</tr>
<tr>
<td>Spin box</td>
<td>A field in which you can enter numeric information. Up and down arrows allow you to increase or decrease the number in the field.</td>
<td>Click the up or down arrow next to the &lt;object name&gt; box.</td>
</tr>
<tr>
<td>Spin box - Down button</td>
<td>The spinbox's down button</td>
<td>Click the down arrow next to the &lt;object name&gt; box.</td>
</tr>
<tr>
<td>Spin box - Up button</td>
<td>The spinbox's up button.</td>
<td>Click the up arrow next to the &lt;object name&gt; box.</td>
</tr>
<tr>
<td>Static Text</td>
<td>Read-only text such as labels for other controls or instructions in a dialog box.</td>
<td>Click the &lt;object name&gt; box.</td>
</tr>
<tr>
<td>Statusbar</td>
<td>The area at the bottom of the screen that displays messages and other information.</td>
<td>Click the status bar.</td>
</tr>
<tr>
<td>Statusbar button</td>
<td>An embedded button in the status bar.</td>
<td>Click the &lt;object name&gt; button on the statusbar.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Description</td>
<td>Template Text</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Tab</td>
<td>An object that appears at the top of each page in a dialog box containing more than one page.</td>
<td>Click the &lt;object name&gt; tab.</td>
</tr>
<tr>
<td>Tab - Horizontal</td>
<td></td>
<td>Click the &lt;object name&gt; horizontal tab.</td>
</tr>
<tr>
<td>Tab - Vertical</td>
<td></td>
<td>Click the &lt;object name&gt; vertical tab.</td>
</tr>
<tr>
<td>Tab List</td>
<td></td>
<td>Click the &lt;object name&gt; tab list.</td>
</tr>
<tr>
<td>Table</td>
<td>A table containing rows and columns of cells, and optionally, row headers and column headers.</td>
<td>Click the &lt;object name&gt; table.</td>
</tr>
<tr>
<td>Table Cell</td>
<td>A cell within a table.</td>
<td>Click the &lt;object name&gt; cell.</td>
</tr>
<tr>
<td>Titlebar</td>
<td>A title or caption bar for a window.</td>
<td>Click the title bar.</td>
</tr>
<tr>
<td>Titlebar button</td>
<td>A button in the titlebar object.</td>
<td>Click the &lt;object name&gt; button on the titlebar.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>A toolbar, which is a grouping of controls that provide easy access to frequently used commands.</td>
<td>Click the &lt;object name&gt; toolbar.</td>
</tr>
<tr>
<td>Toolbar button</td>
<td>An object that contains graphics or text, usually grouped with other similar objects in a bar at the top of the application workspace.</td>
<td>Click the &lt;object name&gt; button.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>An object that appears when you point to a toolbar button. This object contains the name of the button and may include a brief description of it.</td>
<td>Click the &lt;object name&gt; tooltip.</td>
</tr>
<tr>
<td>Universal Object</td>
<td>This type is used when another appropriate object type does not exist.</td>
<td>Click the &lt;object name&gt; object.</td>
</tr>
<tr>
<td>Whitespace</td>
<td>Blank space between other objects.</td>
<td>Click the &lt;object name&gt; whitespace.</td>
</tr>
<tr>
<td>Window</td>
<td>The area that the application occupies on the screen. Usually, this area has a title bar in which the name of the product appears. The name of this object cannot be edited.</td>
<td>Click the &lt;Window name&gt;.</td>
</tr>
<tr>
<td>Workspace</td>
<td>An open document, presentation, spreadsheet, or database file.</td>
<td>Click the desired object.</td>
</tr>
</tbody>
</table>

To change the object type for the current frame:

1. Display the Frame Properties toolpane, if necessary.
2. Click the **Object type** list.
3. Scroll as necessary and click the desired object type.

**Object Name**

The Object name setting refers to the name of the object on which you performed the action. This name is entered in the appropriate place in the bubble template to tell the user which icon to click, which menu item to click, or which option to select. The Developer determines the name of the object from the programming of the application itself. If you
want to alter the object name, you can use the Object name field in the Frame toolpane to do so.

To edit the object name for the current frame:
1. Display the Frame Properties toolpane, if necessary.
2. Click the Object name list.
3. Edit the object name as desired.

Ignore Context Information
You can choose to ignore the context information for a particular frame. This action clears all the context information settings (SmartMatch or ExactMatch type) except for the action in the Action type list box. The context information determines the template text in the bubble; when context information is removed, the bubble is empty. You must then manually enter the text that you want to display in the frame's bubble.

Ignore Context provides the opportunity to document actions and objects that are not normally recognized. For example, you can use Ignore Context to document a non-recognized scrolling action. You can move and resize the action area to reference the scroll bar and then enter text in the Frame toolpane instructing the user to scroll as necessary.

To ignore context information for the current frame:
1. Display the Frame Properties toolpane, if necessary.
2. Click Ignore context.
3. Click Yes to confirm the action, if applicable.
4. Move and resize the action area.
5. Click the text edit pane in the Frame Properties toolpane and enter bubble text.

Create a New Action Area
The action area indicates where the action takes place in a frame. In the Topic Editor, it is designated by a red rectangle overlaying the frame's screenshot.

You may find that you need more than one action area to accommodate an action on a particular frame. For example, if you are recording the action of clicking the Home button in a browser and two screen elements (tool bar and navigation bar) contain the Home button, you could have an action area for each button.

To create a new action area for the current frame:
1. Display the Frame Properties toolpane, if necessary.
2. Click Modify action areas and choose the Create new action area command.
3. Resize and reshape the new action area.

Delete an Action Area
After creating new action areas on a frame, you may decide that you do not want to use all the action areas. You must have at least one action area on a frame unless the frame is a Decision frame or the action for the frame is a keyboard action.
To delete an action area from the current frame:

1. Display the Frame Properties toolpane, if necessary.
2. Click the action area you want to delete.
3. Click Modify action areas and choose the Delete action area command.
4. Click Yes.

Copy an Action Area

If you have edited action areas on a frame and the subsequent frame uses the same action areas, you can copy the action area from the previous frame instead of repeating your work. All action areas from the previous frame are copied to the current frame, simultaneously replacing any existing action areas on the current frame.

To copy action areas from the previous frame to the current frame:

1. Display the Frame Properties toolpane, if necessary.
2. Click Modify action areas and choose the Copy action area command.

Resize an Action Area

Most often, the Developer is able to determine the correct menu, menu entry, icon, or other object, and the action area is sized and positioned automatically. At times, however, you may need to resize the action area to select the correct location or to indicate a specific choice in a list. The Developer includes three methods to resize the action area.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection handles</td>
<td>Drag a selection handle to resize in a specific direction. Drag a corner selection handle to resize both horizontally and vertically.</td>
</tr>
<tr>
<td>Redraw mode</td>
<td>Resize using a combination of the left mouse button and the CTRL key. Hold CTRL and press the left mouse button to position the upper left corner of the action area. Then drag the mouse to redefine the size of the area. The mouse pointer changes into a crosshair as you drag. When you release the left mouse button and the CTRL key, you position the lower right corner of the action area. Using CTRL in conjunction with the right mouse button will not activate redraw mode.</td>
</tr>
<tr>
<td>Double-clicking the mouse</td>
<td>Double-click the left mouse button within the existing action area to indicate the upper left corner. Hold the SHIFT key and double-click the left mouse button within the existing action to indicate the lower right corner.</td>
</tr>
</tbody>
</table>

Note: While recording, the action area defaults to the size specified in the Area Size field on the Recorder tab in the Options dialog box if the Recorder recognizes the object as a Universal Object, Workspace, Window or Active X object.

To resize the action area using the selection handles:

1. Point to a selection handle on the action area.
2. Drag the selection handle in a direction and release the mouse button.

To resize the action area using redraw mode:

1. Hold the CTRL key and click the left mouse button within the existing action area in the location where you want the upper left corner of the action area to appear.
2. Drag to extend the action area over the area of the screen you want to reference.
3. Release the mouse button and the CTRL key where you want the lower right corner of the action area to appear.

To resize the action area by double-clicking the mouse:

1. Double-click the left mouse button within the existing action area in the location where you want the upper left corner of the action area to appear.
2. Hold the SHIFT key and double-click the left mouse button within the existing action area in the location where you want the lower right corner of the action area to appear.

Move an Action Area

You can move an action area easily by dragging it or by using redraw mode. Be aware that double-clicking on the screen will resize the action area.

To move the action area by dragging:

1. Point to any area within the action area. The mouse pointer changes into a four-headed arrow.
2. Drag the action area to any location and release the mouse button.

To move an action area using redraw mode:

1. Hold the CTRL key and click the left mouse button outside of the existing action area in the location where you want the upper left corner of the action area to appear. The mouse pointer changes into a crosshair and the upper left corner of the action area is positioned in the new location.
2. Drag to extend the action area over the area of the screen you want to reference.
3. Release the mouse button and the CTRL key where you want the lower right corner of the action area to appear.

Disable the Action Area

When you play a topic in Try It! mode, a rectangle appears around the area in which you must click or type to move to the next frame. You can disable the action area in Try It! mode to prevent the rectangle from appearing. The Action area on/off option affects the current frame only.

To disable the action area for the current frame:

1. Display the Frame Properties toolpane, if necessary.
2. Click Action area on/off.

Use Keep with Next

The Keep with Next option displays the steps for the current frame and the following frame together during the topic playback in Do It! mode. When the topic is played back, the
steps are presented together, separated by the word “then.” For some actions, such as selecting a menu and then selecting the menu command, this option is enabled by default.

To display the current frame with the next frame in Do It mode:
1. Display the Frame Properties toolpane, if necessary.
2. Click ![Keep this action with next action in Do It!]

**Set Frame Delay**

The delay refers to the amount of time a frame is visible before the action takes place during See It! mode. The default value of 5.0 is five seconds. You can create as much of a delay as you feel necessary for the user to understand or read the information on the screen. There is a predefined list of delay options from which you can choose, or you can enter the delay time in the Delay time(s) list box. The following table describes the predefined options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skip</td>
<td>The step does not display at all. This option is only available for Introduction, End, Decision and Explanation frames.</td>
</tr>
<tr>
<td>0</td>
<td>There is no delay before the animated mouse pointer begins to move for an action frame. This option is not available for Introduction, End, Decision and Explanation frames.</td>
</tr>
<tr>
<td>5.0</td>
<td>There is a 5-second delay before the animated mouse pointer begins to move for an action frame.</td>
</tr>
<tr>
<td>10.0</td>
<td>There is a 10-second delay before the animated mouse pointer begins to move for an action frame.</td>
</tr>
<tr>
<td>Infinite</td>
<td>The demonstration of the step will not proceed automatically. The user must press the ENTER key to advance to the next step of the topic. When you set the delay to Infinite, the text “Press Enter to continue.” appears automatically in the bubble in See It! mode.</td>
</tr>
</tbody>
</table>

If sound files are available for a frame and sound is activated, the Delay time is ignored.

This setting can be applied to all frames on the General page of the Content Defaults section of the Options dialog box. The time set here is the default for all newly recorded and inserted frames, with the exception of Decision frames, which automatically default to Infinite. Changing the setting here does not change the delay time for existing content.

**Create a Jump-in Point**

Jump-in Points are available to users in the Player. An arrow icon appears on the See It!, Try It!, and Do It! buttons in the Player window. Clicking the icon opens a window containing a list of Jump-in point links to various frames within a topic. This allows a user viewing content in the Player to start a topic at a point other than at the beginning. For example, if you have a topic that covers many screens, you can create Jump-in Points to allow users to move directly to the screen with which they need help, instead of navigating the entire topic.

The Frame Properties toolpane in the Topic Editor includes a Jump-in point textbox at the bottom. You can enter a descriptive name for a frame in this textbox to create a Jump-in point. You cannot create Jump-in points for Introduction/End or Explanation frames.
To create a Jump-in point for the current frame:

1. Display the Frame Properties toolpane, if necessary.
2. Click the Jump-in point field.
3. Type the text you want to appear as the link to the Jump-in point.

**Keyboard Action Options**

If the action is a keyboard action, two extra options appear in the Frame toolpane. These options enable you to specify what key was pressed. The Key field contains a list of the keys on a keyboard, including: Backspace, Delete, Down, End, Enter, Escape, F1, F2, F3, F4, F5, F6, F7, F8, F9, F10, F11, F12, Home, Insert, Left, Page Down, Page Up, PrintScreen, Right, Space, Tab, Up, and so on. If any other key is pressed, you need to select the <Character> option and then type the specific key in the Char key (character key) field.

You can change these settings if necessary, but it is not recommended.

**Note:** If the keyboard action involves the ALT, SHIFT, or CTRL key, the appropriate checkbox is selected automatically in the Frame toolpane.

**String Input Formatting Options**

If the action is a string input action, these settings are available.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implicit text</td>
<td>The text in this textbox appears as selected text before the input text is entered in the simulation modes. It is the default text that appears in an edit field, the text that is replaced by a string input.</td>
</tr>
<tr>
<td>Input text</td>
<td>The text in this list box appears when the topic is played in See It! mode. It is also the text that the user must type when the topic is played in Try It! and Know It? modes. Depending upon the options set, this text may also appear to users in Do It! mode.</td>
</tr>
<tr>
<td>String input font</td>
<td>Clicking this icon opens the Font dialog box and allows you to change the font attributes of the input text.</td>
</tr>
<tr>
<td>String input background color</td>
<td>Clicking this icon opens the Color dialog box and allows you to choose the color for the background of the input text.</td>
</tr>
<tr>
<td>String input case sensitivity</td>
<td>Clicking this icon activates case sensitivity in Try It! and Know It? modes. The user must enter text in the proper case to advance to the next step automatically.</td>
</tr>
<tr>
<td>Set as password field</td>
<td>Clicking this icon displays string input text as asterisks instead of characters as it is typed during playback in See It!, Try It!, and Know It? modes. This option is useful for recording password screens.</td>
</tr>
</tbody>
</table>

If you want to edit the input text or add other possible entries, you must use the String input options icon. See Input Text Options for further information.
**Note:** By default, string input text is set to appear in Know It? mode as it may be critical for users to enter specific text. However, you can turn off the display of this text by de-selecting the Template text visible in Know It mode icon in the Frame toolpane.

**Input Text Options**

You have several options available to modify input text. You can add additional entries to be displayed in Know It? and Do It! modes, replace input text in all three modes, delete entries, change the default entry, or clear the string input list. In addition, the available options allow you to have multiple “concrete” entries, which are specific text that can be entered, and several “meta” entries, which allow for a range of non-specified text in Know It? and Do It! modes. You must have at least one concrete entry in the Input text list for every string input action.

**Replace Input Text**

After recording a string input action in a topic, you may decide that you would prefer other text to be displayed in the action. You can change the text that is entered in See It!, Try It!, Do It! and Know It? modes.

**Warning:** If you replace the text for a string input action, be sure to recapture the affected screenshots. Otherwise, the bubble text and screenshot will not match for See It! and Try It! mode. For example, if you recorded a topic in which “Peter” is entered into a Name field and later, you replace “Peter” with ”John,” the screenshot in the next frame will still display “Peter.”

1. Display the Frame Properties toolpane, if necessary.
2. Click 📊 String input options and choose 🗼 Replace text.
3. Enter the desired text.
4. Click OK.

**Delete Input Text**

By default, every string input action has two entries listed in the Input text list; the text you entered and < Something >. These entries restrict what users can enter in Try It! mode to exactly the text you entered, while still allowing users to enter any text in Know It? and Do It! modes. If you want to add additional possible entries for Try It! mode, or use the < Anything > or < Blank > entries, you can delete the < Something > entry and then add option(s). You can also delete concrete entries or other meta entries if you decide not to use them.

**Note:** You must have at least one concrete entry in the Input text list. If there is only one concrete entry in the list, the Delete entry option is unavailable for that entry.

1. Display the Frame Properties toolpane, if necessary.
2. Click the **Input text** list box.
3. Click the entry you want to delete.
4. Click 📊 String input options and choose 🗼 Delete entry.
Add New Text to the Input Text List

After deleting the default `<Something>` entry from the Input text list, you can add other concrete entries to the list. If you add concrete entries to the list, those entries appear in Know It? and Do It! modes and will satisfy the string input action; additional concrete entries do not affect See It! and Try It! modes. You cannot add text to the Input text list if the list includes the `<Something>` or `<Anything>` entry.

To add new text to the input text list for the current frame:

1. Display the Frame Properties toolpane, if necessary.
2. Delete any existing meta entry.
3. Click String input options and choose Add new text.
4. Enter text.
5. Click OK.
6. Repeat as necessary.

Add Meta Entries to the Input Text

After deleting the default `<Something>` entry from the Input text list, you can add other meta entries to the list. The following table lists the possible meta entries and their impact:

<table>
<thead>
<tr>
<th>Entry</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anything</td>
<td>When a string input action using the <code>&lt;Anything&gt;</code> entry is played in Know It? mode, a user can enter any text or leave the field blank and move to the next step. For example, a user may see the following instructions for completing a field: Enter information into the Subject field. Enter a valid value; e.g., “Meeting on Tuesday” or leave blank.</td>
</tr>
</tbody>
</table>
| Something | When a string input action using the `<Something>` entry is played in Know It? mode, a user must enter some text to satisfy the step. The text entered may or may not be the concrete entry created by the content author. For example, a user may see the following instructions for completing a field: Enter information into the Subject field. Enter a valid value, e.g., “Meeting on Tuesday”.
| Blank     | When a string input action using the `<Blank>` entry is played in Know It? mode, a user must enter the same concrete entry created by the content author or leave the field blank and move to the next step. For example, a user may see the following instructions for completing a field: Enter information into the Subject field. Enter “Meeting on Tuesday” or leave blank. |
| No meta entry | If no meta entry is included in the Input text list, a user must enter one of the concrete entries to satisfy the string input action in Know It? mode. For example, a user may see the following instructions for completing a field: Enter information into the Subject field. Enter “Meeting on Tuesday” or “Tuesday's Meeting”.

Note: You cannot add the `<Something>` or `<Anything>` entries if the Input text list includes more than one concrete entry.

Note: You can only include one meta entry in the Input text list for a string input action.
In the Player, the string input text appears as described in the preceding table. In Do It! and Try It!, users can move to the next step using the Next Step button in the Player.

To add meta entries to the input text list for the current frame:
1. Display the Frame Properties toolpane, if necessary.
2. Delete any existing meta entry or any multiple concrete entries.
3. Click String input options and choose Add 'anything', Add 'something', or Add 'blank'.

Set the Default Text Entry

The default input text entry will be used in both See It! mode and Try It! mode, and it will be the first entry listed in Do It! mode. After recording a string input action in a topic and adding new text, you may decide that you prefer to use one of the new concrete entries as the default. You cannot use a meta entry as the default entry, however.

Warning: If you set a new default for the string input action, be sure to recapture or edit the affected screenshots. Otherwise, the bubble text and screenshot will not match for See It! and Try It! mode. For example, if you recorded a topic in which "Peter" is entered into a Name field and later, add "John" and set "John" as the default, the screenshot in the next frame will still display "Peter."

To set the default input text entry for the current frame:
1. Display the Frame Properties toolpane, if necessary.
2. Click the Input text list box.
3. Click an entry.
4. Click String input options and choose Set to default.

Clear the Input Text Entry List

If you want to remove all of the entries from the Input text list, except for the default entry, you can clear the list. You can then add new entries or simply leave the default entry as the only entry for the action.

To clear the input text entry list for the current frame:
1. Display the Frame Properties toolpane, if necessary.
2. Click String input options and choose Clear list.

String Input Scoring in Know It Mode

There are two ways that string inputs are scored in Know It? mode. If the step uses a validated string input, the user must enter the string input exactly as indicated by the content author in the bubble for the step to be scored as correct. Therefore, if the bubble prompts the user to enter "AB31S" into an Account field, the step will be counted as incorrect if the user mistypes the entry as AB33S.

If you use an unvalidated string input, any entry typed in the field will be scored as a correct entry. Users will not be penalized for incorrectly typing an entry.
When a user types an entry that matches the text that appears in the bubble, Know It? mode scores the step as correct and automatically advances to the next step. This action occurs for both validated and unvalidated string inputs. Know It? mode does not automatically advance to the next step if the user types an entry that is different from the entry in the bubble. If the step does not automatically advance, the user has a choice of either editing the entry to match the example, or clicking the Typing Complete button in the Know It? mode bubble to submit the current entry. The entry will then be scored as correct or incorrect depending on its validation status.

**Note:** For content created with the Japanese or Chinese versions of the Developer, a string input step will not automatically advance when the end user types a correct entry. The user needs to click the Typing Complete button to submit their entry.

**Note:** A user can use normal editing functions to correct a string input entry. Mouse actions such as dragging and keyboard actions such as the BACKSPACE and DELETE keys are allowed.

The meta entry used for the input step controls whether a string input will be a validated or an unvalidated one. The possible meta entries and their impact are listed below:

<table>
<thead>
<tr>
<th>Entry</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Something</td>
<td>Creates an unvalidated string input. When a string input action using the &lt;Something&gt; entry is played in Know It? mode, the user must enter some text to be scored as correct. The text entered may or may not be the concrete entry created by the content author. For example, if a user is prompted to enter “Tuesday”, the step will be counted as correct if the user enters “Monday” or “123”. However, leaving the field blank will be scored as a mistake.</td>
</tr>
<tr>
<td>Anything</td>
<td>Creates an unvalidated string input. When a string input action using the &lt;Anything&gt; entry is played in Know It? mode, the user can enter any text or leave the field blank, to be scored as correct.</td>
</tr>
<tr>
<td>Blank</td>
<td>Creates a validated string input. When a string input action using the &lt;Blank&gt; entry is played in Know It? mode, the user must enter the same concrete entry created by the content author or leave the field blank, to be scored as correct. Any other entry, including a typing mistake, is scored as incorrect.</td>
</tr>
<tr>
<td>No meta entry</td>
<td>Creates a validated string input. If no meta entry is included in the Input text list, the user must enter one of the concrete entries to be scored as correct. Any other entry, including a typing mistake, is scored as incorrect.</td>
</tr>
</tbody>
</table>

**Edit External Content**

In the Topic Editor, you can link attachments to a specific frame. This allows you to include explanatory information for a specific step in the topic.

**Link an Attachment as a Concept: Topic Editor**

You can manage the concept of a topic directly from the Topic Editor. This allows greater efficiency in editing topics and their concepts and also provides a clearer representation of the overall organization of the topic. You can perform the same concept-related tasks from the Topic Editor as are available from the Outline Editor. The Concept toolpane also provides a preview of the linked concept attachment.
To link a package file or web page as a concept from the Topic Editor:

1. Display the Concept toolpane, if necessary.
2. Click Create link.
3. In the Link to pane, select Document in Library.
   If desired, you can select Packages or Web pages in the Type field to further filter your selection.
4. Navigate the Library to the folder containing the package file or web page to which you want to link.
5. Select the desired package file or web page document.
6. Click OK or press ENTER.

Note: At step 2, you can also click Create new web page to create a new web page and link to it in one step. When you do so, you first specify the name of the web page and the Library folder in which it should be saved. The Concept toolpane then closes, and an empty web page opens in a new tab. After you complete the web page, you can preview its contents in the topic by reactivating the Topic Editor tab.

To link a URL as a concept from the Topic Editor:

1. Display the Concept toolpane, if necessary.
2. Click Create link.
3. In the Link to pane, select URL.
4. In the Address field, type or paste the target URL.
5. Click Go or press ENTER.
   While selecting a URL, you can also enter a base URL and then follow links in the preview displayed in the results pane to reach your desired target.
6. Click OK or press ENTER.

Link to an Attachment from a Topic Frame

Within a topic, you can link from any frame to one or more attachments. Attachments linked at this level provide information to your users as they view a topic. For example, you might link from a frame to a spreadsheet listing department codes or other reference information that users need at a particular step in a procedure. Like concept and bubble text links, links to attachments from topic frames become part of the parent document. If you then move the topic or reuse it elsewhere in your content, the linked attachment remains associated with that frame of the topic. Conversely, deleting the link to an attachment from a topic frame in one location removes the link in all places where the topic is used.

The Frame Link toolpane of the Topic Editor provides the tools for linking to and managing the links to attachments from topic frames. When linking to a package file or web page, you can filter the display to include packages or web pages only and navigate through the Library folders to the specific file you want to link. When linking to a URL, you can type or paste a base URL and then follow links in the preview displayed in the results pane of the Insert Hyperlink dialog box to reach your desired target.
The procedure for linking to an attachment from a topic frame differs slightly from that for concepts and bubble text. When you link to an attachment from a topic frame, you can select an icon for the link and add a tooltip. The icon appears in the frame bubble when the user views the topic in the Player, and the tooltip appears when the user rests the mouse pointer over the link icon. The icon and tooltip are stored with the link itself, rather than with the attachment. Therefore, when you link to the attachment from another location in your content, you can choose to add a different icon and/or tooltip, if desired.

Unlike concepts and bubble text, which can link to only one attachment, a single topic frame can link to multiple attachments. You manage all of the attachments linked at the frame level from the same dialog box, but you can assign a different icon and/or tooltip to each of the links. You can also change the order in which multiple attachments are linked to a single topic frame. As you navigate among the frames in a topic with the Frame Link toolpane open, the display updates dynamically to show the links for each frame. This provides a simple means of managing all frame links in a topic and analyzing the overall topic layout.

**Link to an Attachment from Bubble Text**

As you enter custom text in bubbles and Introduction/End frames, you can link to an attachment from this text. For example, you could use a web page linked at this level to provide a definition of a term. Linked text appears in the frame bubble in color and underlined. When a user clicks linked text while viewing a topic in the Player, the attachment is displayed. If the attachment is a package file, the file opens in its parent application. If the attachment is a web page or URL, it opens in a new, independent browser window.

*Note:* When a glossary term is used in a manually created bubble text link, no glossary link is created during glossary markup. That is, text used in manually created bubble text links is excluded from glossary markup.

The Bubble Text Link Properties dialog box of the Topic Editor provides the tools for linking to and managing the links to attachments from bubble text. When linking to a package file or web page, you can filter the display to include packages or web pages only and navigate through the Library folders to the specific file you want to link. When linking to a URL, you can type or paste a base URL and then follow links in the preview displayed in the results pane of the Insert Hyperlink dialog box to reach your desired target. The Bubble Text Link Properties dialog box also provides a preview of the linked attachment.

Like concept and frame links, a link to an attachment from bubble text becomes part of the parent document. If you then move or reuse the topic, the linked attachment remains associated with that text in the topic. Conversely, deleting the link to an attachment from bubble text in one location removes the link in all places where the topic is used.

To link to a package file or web page from bubble text:

1. With the topic open in the Topic Editor, navigate to the frame from which you want to link to a package file or web page.
2. Select the bubble text to be linked.
3. In the Frame Properties toolpane, click **Bubble text link.**
4. Click **Create link.**
5. In the Link to pane, select **Document in Library.**
If desired, you can select Packages or Web pages in the Type field to further filter your selection.

6. Navigate the Library to the folder containing the package file or web page to which you want to link.

7. Select the desired package file or web page document.

8. Click OK or press ENTER.

**Note:** At step 4, you can also click Create new web page to create a new web page and link to it in one step. When you do so, you first specify the name of the web page and the Library folder in which it should be saved. The Bubble Text Link Properties dialog box then closes, and an empty web page opens in a new tab. After you complete the web page, you can preview its contents in the topic by reactivating the Topic Editor tab, selecting the appropriate bubble text, and again displaying the Bubble Text Link Properties dialog box as in step 3 above.

To link to a URL from bubble text:

1. With the topic open in the Topic Editor, navigate to the frame from which you want to link to a URL.

2. Select the bubble text to be linked.

3. In the Frame Properties toolpane, click Bubble text link.

4. Click Create link.

5. In the Link to pane, select URL.

6. In the Address field, type or paste the target URL.

7. Click Go or press ENTER.

While selecting a URL, you can also enter a base URL and then follow links in the preview displayed in the results pane to reach your desired target.

8. Click OK or press ENTER.

**Change the Tooltip of a Frame Link**

When you link to attachments at the frame level, you can provide tooltips for the links. These tooltips appear when a user rests the mouse pointer over the link icon while viewing the topic in the Player. By default, the word "Link" is added as the tooltip when the link is created; however, you can change the link tooltip at any time. For example, you might want to use a tooltip that identifies the attachment contents, to provide users with information about the attachment before they launch it.

If you plan to deploy content to one or more Player outputs, use of tooltips is particularly important, especially for links to package files. For example, if a link launches a Flash animation that is several megabytes in size, you might use a tooltip such as "Flash animation of business process (4.65 MB)" to alert users before they click the link. Without such tooltips, users do not have a good indication of the type of content they will be launching or its purpose.

**Tip:** Although there is no limit to the length of a tooltip, concise, descriptive tooltips are most useful.
To change the tooltip of a frame link:

1. Display the Frame Link toolpane, if necessary.
2. Select the row listing the link for which you want to change the tooltip.
3. In the **Tooltip** field, delete the current text and type the desired tooltip.

**Change the Icon of a Frame Link**

When you create a link to an attachment from a topic frame, an icon is added to the link by default; however, you can change the link icon at any time. This icon appears in the frame bubble when a user views the topic in the Player, indicating that additional information is available. Users can then click the icon to launch the linked material. By standardizing your use of link icons, you can provide your users with a consistent visual cue as to the type of information available through each link. You can also add a tooltip for each link to provide a brief text description of the linked attachment.

The Developer comes with a standard set of link icons. You can also create your own custom icons, if desired.

To change the icon of a frame link:

1. Display the Frame Link toolpane, if necessary.
2. Select the row listing the link to which you want to change the icon.
3. In the icon column, click the down arrow to display the list of available icons.
4. Select the desired icon.
7. Enhance Content with Attachments

In an outline, module and section documents supply the headings for organizing the content, and topics supply the recorded steps and sounds (if applicable) for completing each task.

You can supplement your content with additional conceptual and explanatory information by linking to attachments from the documents in the outlines. Attachments can include files developed in external applications, custom web pages with descriptive text and graphics, and Internet and intranet web sites.

Types of Attachments
There are three types of attachments to which you can link documents in an outline. They include:

- Package files
- Web pages
- URLs

Packages are containers in your Library that hold one or more files. Any type of file can be stored in a package, including word processing documents, graphics, computer animations, and so on. You can link from any document in your outlines to any individual file in a package. The package file appears in the Concept pane or is launched in its native application when a user selects the link in the Player.

Note: The precise appearance and behavior of package files depends on the setup and Windows Explorer settings of the computer on which they are viewed.

Web pages are documents that you create in the Developer for displaying additional text and graphics in the Player or document output. You can create a simple web page to define a term or a more complex one that includes graphics and links to other web pages, package files, sound and external URLs.

You can also link from your content to an Internet or intranet web site through its URL address. The web site appears in the Concept pane of the Player or is launched in a new browser window when a user clicks the link, provided that the user is online and has access to the target site.

Link Attachments
You can link from your content to an attachment at the following three levels:

- The concept of a module, section, or topic
- A frame of a topic
- Bubble text in a topic frame, including Introduction and End frames

An attachment linked as the concept of a module, section, or topic appears in the Concept pane when the user selects the document to which it is linked from the table of contents in the Player.

Note: Some types of package files might launch in their native applications rather than appearing in the Concept pane.
When a frame of a topic is linked to an attachment, an icon representing the attachment appears in the bubble in Try It! mode or in the window in Do It! mode for that frame. The user can point to the icon to read a tooltip describing the attachment and click the icon to open the attachment. Bubble text linked to an attachment appears in the frame as a hyperlink. Users can click the hyperlinked text in the Try It! bubble or Do It! window to view the attachment. An attachment linked at the frame or bubble text level always opens in a new window.

**Note:** Attachments linked to frames or bubble text are not available in See It! or Know It? playback mode.

Attachments can also be included in some document outputs, namely, the Business Process Document, Instructor Manual, and Training Guide. The actual outcome depends on the type of attachment and the level at which it is linked. In general, package graphics, web pages, and the addresses of URLs linked at the concept and frame levels appear in document outputs; all other types of package files and the contents of URL link targets do not. See Package Behavior in Publishing, Web Page Behavior in Publishing, and URL Behavior in Publishing for more detail.

**Note:** The Job Aid, Test, and HP Quality Center document outputs do not include attachments.

You can link to attachments while working in the Outline Editor (concepts only) or Topic Editor.

Once you have created a link from a document to an attachment, the link essentially becomes part of the parent document. As a result, you do not need to re-create or repair these links every time you move or reuse the parent document in your outlines. Links are also maintained if you move or copy the parent document in the Library.

**Attachment Considerations**

One question you must consider when using attachments is the type of attachment you want to use in each case. The three general types of attachments you can use, namely, package files, web pages, and URLs, have different characteristics that affect which might be more appropriate in a given situation. The following discussion provides a comparison of several aspects of the different types of attachments and a summary of their relative capabilities.

**Purpose/Complexity**

A primary consideration is the purpose of the attachment and the level of complexity of the information it must convey. For example, if an attachment provides the definition of a term, a simple, text-only web page is probably the easiest, most straightforward option. Web pages are also appropriate for presenting more complex arrangements of text and graphics, as well as for providing access to a collection of different resources from a single location through hyperlinks.

Packages allow great flexibility, because they can contain essentially any type of file. Thus, packages are the preferred option for information that is best presented in its native format, such as tabular data contained in an Excel spreadsheet or a multimedia presentation.

Finally, URL links can be used to send users directly to an Internet or intranet site or to provide such Internet-based functionality as email contact.
Attachment Location
Another consideration is the location in which the attachment is saved, specifically, whether it is included in the Library or not. Both packages and web pages are saved as Library documents, whereas Internet or intranet sites linked as URL attachments are external to the Library. This difference can be important when you publish to Player outputs. In particular, packages and web pages are incorporated directly in your output during publishing, whereas URL attachments are always accessed from their external locations, which might be updated or removed over time. As a result, users might find a URL attachment to be missing or unavailable if, for example, the Internet address of a URL link target is changed after you create the link in your content.

Note that, for package and web page attachments, location within the Library is not important. That is, you can link from any module, section, or topic document to any package file or web page stored anywhere in the Library; the package/web page and the parent document do not need to be in the same folder. This provides great flexibility in how you organize your Library, while also allowing you to reuse your package files and web pages by linking to each one as many times as needed throughout your content.

User System Setup and Connectivity
When you publish to Player outputs, the setup and connectivity of your users' computer systems also impact your choice of attachments, especially for packages and URLs.

For packages, you should avoid any file types that your users are unlikely to be able to view directly. For example, if you link to a flowchart saved as a package file in native Microsoft Visio format but your users have neither Microsoft Visio nor the Microsoft Visio Viewer installed on their computers, they are unable to access the flowchart. A more effective approach to using the same flowchart as a package file would be to export it from Microsoft Visio in a more common format, such as a standard graphics format, for which your users are more likely to have an appropriate application. In addition to the application itself, you should also consider the version supported in your users' workplace, to ensure that it is compatible with the version in which you create the file(s).

Note: The precise appearance and behavior of package files depends on the user's computer operating system, its settings, and the settings for the Web browser on that system.

For URL attachments, the primary considerations involve connectivity, as with any other use of Internet or intranet sites. In particular, your users must be online when viewing your content to access linked URLs, and their connection speed should be sufficient for the contents of the target sites. They should also have any necessary plug-ins installed. Finally, if you plan to link to any limited-access or otherwise restricted Internet or intranet sites, you should ensure that your users have appropriate permissions or user accounts to access these sites.

In contrast to package files and URLs, web page attachments present minimal system issues. Because they are constructed in standard HTML and because they are incorporated in your published output, you can consider web pages as a reliable choice for attachments if you are uncertain of your users' setups.

File Creation and Maintenance
You create and maintain web pages entirely within the Developer using the Web Page Editor. Whenever you make and save changes to a web page, the changes are immediately reflected throughout your content wherever the web page is linked.

You also create and maintain packages in the Developer. Packages provide the advantage of allowing you to incorporate a variety of documents, in a variety of formats, into the
Library. You can copy documents into a package from an external location and then edit them directly from the package.

Finally, you create and maintain URLs entirely outside the Library. This allows you to use preexisting Internet and intranet content, as well as functionality such as email, but also requires that the content be maintained separately. For example, you must ensure that the URL address of the link target does not change, in which case the site would no longer be accessible from your content. In addition, when a target site is updated, you should ensure that it remains relevant as a link from your content.

**Player Outputs**
In general, users can access all attachment types in all Player outputs. See *User System Setup and Connectivity* above for certain limitations.

For each frame link, web page hyperlink, or bubble text link, users access the attachment by clicking on the link icon or hyperlinked text, respectively; the attachment always launches in a new, independent window. For each concept link, the attachment generally appears directly in the Concept pane of the Player.

You should especially consider the behavior of concept attachments in relation to package files, such as external documents and multimedia files, which you might not want to launch directly in the Concept pane. For example, you might prefer that a large graphic or detailed spreadsheet appear in its own window, rather than in the limited region of the Player's Concept pane. Alternatively, your users might prefer that a Flash animation play only when they specifically click on a link to activate it, rather than having it launch automatically in the Player when they select the document to which it is linked as the concept. In such cases, a better alternative is to use a concept link to a web page that, in turn, contains some explanatory text and a hyperlink to the desired package file. This approach provides greater control over how and when package files used as concepts are displayed.

**Document Outputs**
Only three types of document outputs ever include linked attachments: the Business Process Document, Training Guide, and Instructor Manual. For these three document formats, the behavior differs depending on the type of attachment and the level at which it is linked.

- Web pages that are directly linked at the concept and frame levels are included in document outputs.
- Package files that are graphics appear in document outputs, whether they are directly linked at the concept and frame levels or inserted in web pages. All other types of package files are excluded from document outputs.
- The addresses of URL attachments linked at the concept and frame levels are included in document outputs, in the format "Please refer to:" followed by the address. When text in a web page or bubble text links to a URL attachment, the address of the link target is included in parentheses after the link text.

Therefore, if you wish to include an attachment in your document outputs, use a web page or a package graphic.

**Summary**
The following table summarizes various factors that you should consider in determining which type of attachment best meets your needs in a particular situation:
### Enhance Content with Packages

You can enhance your content by linking it to images, web sites, multimedia presentations, Microsoft Word documents, PowerPoint presentations, and so on. To use such resources in the Developer, you create package documents, which are essentially containers that allow you to add externally created material to the Library. For example, you can create a package that contains either a collection of related folders and files in the case of a web site or multimedia presentation or a single file such as a Word document. You can then link to a single file in the package as the concept of a module, section, or topic document or as explanatory information for a specific frame or bubble text in a frame of a topic.

When you publish your content to a Player output, your users can view the linked package material in Try It! and Do It! modes. In general, package files linked at the concept level appear in the Concept pane of the Player window or launch in their native application when a user selects the document to which they are linked. The specific behavior depends on the type of package file and the user’s system setup. When linked at the frame or bubble text level or when linked in a web page, the package file launches in its native application when a user clicks on the link icon or hyperlinked text or graphic.

**Note:** Package files that are linked to frames or bubble text are not available in See It! or Know It? playback modes in the Player.

With one exception, linked package files do not appear in document outputs; the exception is graphic files. Graphics linked at the concept and frame levels are included when you publish document types that include attachments, namely, the Business Process Document, Training Guide, and Instructor Manual. In addition, package graphic files inserted as images in web pages also appear in these document outputs. See *Package Behavior in Publishing* for more detail.

---

<table>
<thead>
<tr>
<th>Type</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Package file</td>
<td>Flexible, allows use of virtually any type of file</td>
<td>User setup/access issues for Player outputs, depending on file type</td>
</tr>
<tr>
<td></td>
<td>Saved in Library so incorporated directly in published Player outputs</td>
<td>Excluded from document outputs if anything other than a graphic</td>
</tr>
<tr>
<td></td>
<td>Graphic files included in document outputs when linked at the concept and frame levels or inserted as images in web pages</td>
<td>For concept links, consider launching from a hyperlink in a web page, rather than linking directly</td>
</tr>
<tr>
<td>Web page</td>
<td>Saved in Library so incorporated directly in published Player outputs</td>
<td>Limited web functionality (for example, no tables, no scripting)</td>
</tr>
<tr>
<td></td>
<td>Always compatible with users’ systems because created in standard HTML</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Can include links to other attachments</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Included in document outputs when linked at the concept and frame levels</td>
<td></td>
</tr>
<tr>
<td>URL</td>
<td>Can use existing, independently maintained content</td>
<td>Users must be online to access (also consider speed of connection)</td>
</tr>
<tr>
<td></td>
<td>Can use email, ftp, and other URL-based links</td>
<td>Users must have appropriate permissions for access</td>
</tr>
<tr>
<td></td>
<td>Address included in document outputs when linked at the concept, frame, and bubble text levels</td>
<td>Site (URL address and content) must be maintained separately from Library content</td>
</tr>
</tbody>
</table>

---

Copyright © 1998, 2010, Oracle. All rights reserved.
To use a package in the Developer, you must complete two basic steps. First, you create and add files to the package, and then you link to a file in the package from the appropriate module, section, topic, or frame. Once you have created a package in a Library, you can use it multiple times by linking to its files from various locations throughout your content.

User System Setup
It is important that you understand your users' system setup before you link to package files from your content. When you link to a file that was developed in an external application, such as a Microsoft Excel workbook, a Microsoft Project file, or a Flash video, you need to consider whether your users have the appropriate applications and plug-ins to launch this content from their desktops. If a user's browser or system is not configured so that it can open a particular type of package file, the Player displays an error. Therefore, you should plan carefully to anticipate and avoid such situations.

Note: The precise appearance and behavior of package files depends on the setup and Internet Explorer settings of the computer on which they are viewed.

Package Graphic Files
Package graphic files display at their actual size in the Player. When published to document outputs, directly linked package graphics appear at actual size or are resized in Microsoft Word to be ½ pages, whichever is smaller. When inserted in a web page, the package image is sized appropriately according to web page behavior in document outputs.

Note that the formats for package graphics that are supported by the Developer are those that are supported natively by Microsoft Word XP, 2003, and 2007. These include

- Graphics Interchange Format (GIF)
- Joint Photographic Experts Group (JPEG/JPG)
- Macintosh (PICT)
- Portable Network Graphics (PNG)
- Windows bitmap (BMP)
- Run-length encoded (RLE)
- Device-independent bitmap (DIB)
- Windows Enhanced Metafile (EMF)
- Windows Metafile (WMF)

All non-native graphics formats are not exported to Word.

In using package graphic files, however, you must also consider whether you intend to publish to Player outputs in addition to document outputs, as not all of the formats supported by Microsoft Word work well in online, browser-based formats.

Package Considerations
Although packages can contain multiple files of different types and even an internal folder structure, the Developer regards each package as a single document. The file(s) and/or folder(s) within a package are components of the package, rather than Developer documents as such. These facts have implications for how packages function in the Developer and how best to use them. The main considerations for packages are how many
items a package should contain, what the items in the package should be named, and whether the package should have an internal folder structure.

**Number of Package Items**

When creating packages, you need to decide whether each package document should hold a single file or multiple files. Although there is no limit to the number of files and folders you can add to a package, it is generally a good idea to create packages with a single file or a few related files rather than to add all of your external files to one package.

Because the Developer regards each package as a single document, tasks such as publishing and exporting affect an entire package, even if only part of it is needed. For example, when you publish a document that is linked to a file in a package, all of the files in the package are included in the published output, even those files that are not linked to the document being published. This is undesirable, as publishing unused files takes longer and increases the size of the published output.

Nevertheless, there are situations in which you must keep multiple files in a single package. For example, suppose that you want to use a package to link to a custom web site that consists of several linked pages containing graphics (rather than making the site available on a server and linking to it as a URL attachment). To do so, you must copy the entire file and folder structure of the web site into one package for the hyperlinks in the web site to work and the graphics to appear properly.

**Naming of Package Items**

Each package is a Developer document and, as such, is identified by its Document ID, rather than its name. In contrast, package items are NOT Developer documents and do not have Document IDs. Rather, each package item is identified by the Document ID of the package in which it is stored and its name, as well as its relative path within the folder structure of the package, if relevant (see below). This difference has a number of consequences:

First, if a package contains multiple files and/or folders, the name of each item at a given level of the package must be unique. This is identical to the requirement for folder names (but not document names) in the Library.

Second, when you link to a package attachment, you actually link to a single file within the package, not the overall package document. To uniquely identify the target of such a link, the link path must include the name of the package file, as well as its relative path within the folder structure of the package, if relevant (see below). As a result, if you change either the name or the relative path of the package file, you break the link to it. Therefore, it is recommended that you establish final names for all package items before linking to them.

**Warning!** The Broken Links tool does not penetrate packages and cannot detect when links to package files are broken.

In contrast, because Developer documents are uniquely identified solely on the basis of Document IDs, a package can be renamed and/or moved within the folder structure of the Library without breaking any links to the files it contains. This is identical to the behavior of all other Developer documents, such as modules, topics, glossaries, and so on.

**Internal Structure of a Package**

If you do choose to store multiple files in a single package, you might want to organize them using a folder structure within the package. For example, in the case of a custom web site such as that mentioned in Number of Package Items, the package must have an internal folder structure identical to that of the source.
As stated above, when you link to a package file, the link path includes the relative path of the file within the package. It is therefore recommended that you keep the internal package folder structure relatively simple so as to avoid creating excessively long link paths (>255 characters). In addition, if you change the relative path of a package file after linking to it, you break the link. Therefore, it is recommended that you establish the final internal structure of a package before linking to any items it contains.

**Warning!** The Broken Links tool does not penetrate packages and cannot detect when links to package files are broken.

In summary, when using packages, you should consider the following recommendations:

- Store one or a few related files in each package.
- Use unique package file and folder names.
- Use relatively simple internal folder structures, if possible.
- Establish the file names and internal folder structure, if any, before linking to any items in a package.

### Create a New Package

Before you create a package, you need to identify the folders/files on your local computer or network server that will comprise the package. Package content is always created from material outside the Developer Library. Once you identify the material to include in a package, you use the Package Editor to create a new package and add the file(s) and/or folder(s) that you want into the new package. Then, you can save the package with a name of your choice, store it anywhere in the Developer Library, and link to the file(s) in the package from your content.

You can create a package from the main File menu available in the Library or any other document editor. When you create a new package, the Package Editor launches in a new tab and displays an empty package where you can add files and folders. After creating a new package, you can name it and save it to any folder in the Library. The name of the package appears in the Package Editor tab.

If you save a package to the wrong folder in the Library, you always have the option to move the package document to another folder. You can also rename a package just as you would any other document. If you rename a package containing items to which you have linked from other documents, topic frames, or bubble text, the links remain unaffected. That is, renaming a package does not break any links to the items it contains; however, renaming a package item does break the links to that item.

**Warning!** The Undo command is not available in the Package Editor. You cannot undo the actions of adding, deleting, renaming, moving, or copying package items.

### Multi-user Considerations

Any new document that you create or link is automatically checked out to you. If you want to make a new document available to multiple authors and place the document under the Developer's version control system, you must check it in.

See Check In and Check Out Documents in Use the Developer in a Multi-user Environment for more information.
To create a new package:

1. On the File menu, point to New and choose Package.
2. Add items to the package.
3. Save the new package document.

You can also close the tab and click Yes in response to the Save Document message.

When you save a package for the first time, you are prompted to provide a name for it. Enter a name for the package by typing over the default name. Although the package name does not have to be unique, it is recommended that you provide a meaningful name so you can easily find the package later.

Edit a Package

You can open a package at any time in the Package Editor to modify its contents. For each package that you open to edit, an independent instance of the Package Editor opens in a separate tab, allowing you to edit multiple packages at one time. When you edit a package, you can add, move/copy, rename, delete, and/or edit the files and folders in the package. As you make such changes, the name of each item at a given level of the package must remain unique.

Warning! Moving, renaming, or deleting a package item that is linked to a document creates broken links in your content. Because the Broken Links tool does not penetrate packages, it cannot detect when links to items within packages are broken. Therefore, if you plan to perform any of these actions on a package item, you should first remove any links to it from your content.

Folders

You can store package items at the root of a package, or you can create a folder structure in the package to organize the items. Folders in a package behave similarly to folders in the Library; they can be named, renamed, deleted, moved, and copied. When naming folders in a package, duplicate names and blank names, as well as certain reserved characters, are not permitted. Once you have created folders, you can move or copy items into the folders in the current package using cut/copy and paste or drag-and-drop.

Warning! Adding folders to a package increases the Library path to the files in those folders. If you choose to create folders in your packages, it is best to keep the folder names short and to create only a simple folder hierarchy. Long folder names and/or a complex folder structure with multiple levels can create problems if the paths to the package files exceed the maximum Windows file system length.

The Package Editor does not save empty folders. If you save a package that contains a folder with no content, the folder will not be there the next time you open the package.

Folders can also be added to a package from a file system. When you copy an existing folder from a local or network drive, the folder and its entire contents are copied to the package.

You can navigate the folders in a package by double-clicking the folder icon to drill down through the folder structure. The Location field at the top of the Package Editor tab displays the folder path. To move back through the folders, use the Up One Level icon to the right of the Location field until you reach the root of the package.
Changes to a package are not automatically saved. You can save a package as you are working with it or save it as prompted when you close the package.

## Multi-user Considerations

Before you can perform this action, you must check out the document. After you save any changes, you should check in the document to make it available to other authors and add the changes to the Developer's version control system. Note that you check out and in the overall package document; you cannot check out/in individual package items.

A new version of a package document is created upon check in whenever you add, delete, rename, or edit an item in the package. Only the overall package is versioned; the items themselves are not versioned. Therefore, if you decide to undo changes to a package by rolling back to an earlier version, you return ALL items in the package to that version.

### To edit a package:

1. Open the package in the Package Editor.
2. Edit the package as necessary.
   
   You can add, move/copy, rename, delete, and/or edit the files and folders contained in the package.
3. Save and close the package.

**Tip:** To create a new folder in the Package Editor, on the File menu, point to New and select Folder. You can also right-click in a blank area in the Package Editor and choose New Folder from the context menu. A new folder icon appears in the Package Editor window with the folder name in edit mode. Type a name for the folder and press ENTER.

## Add Items to a Package

You can add one or more files and/or folders to a package document from any drive on your computer or local network. The files/folders that you add to packages are not removed from your local computer/server unless you specifically choose to remove them, rather than copying them.

The ![Add Files] Add Files command allows you to browse your computer or network to select files to add to the package. You can also add both files and folders to a package by copying or moving them from their location on your computer or network to an open package using one of the following procedures:

- Drag-and-drop from a window on your computer to an open package to create new copies of the files/folders
- Copy from a window on your computer and paste in an open package to create new copies of the files/folders
- Hold SHIFT and drag-and-drop from a window on your computer to an open package to move the files/folders from your computer to the package
- Cut from a window on your computer and paste in an open package to move the files/folders from your computer to the package
Warning! When copying files and folders with very long, complicated names from your computer to a package, the Package Editor might truncate some file and folder names to an 8.3 (MS-DOS compatible) file format. After copying such files and folders, check the copies in the package.

When adding items to a package, file and folder names at the same level within a package must be unique. Therefore, if you attempt to add a file with a duplicate name to the same folder in a package, you are prompted to replace the original with the new file. If two distinct package files must keep the same name, you can either create a new package for the additional file or create a separate folder for it in the same package.

Tip: If you plan to localize your content, you should consider a language-neutral naming convention for package items. This will help you avoid having to re-create links to package files in the translated content.

To add files only to a package:

1. On the Edit menu, select Add Files.
2. In the Open dialog box, browse your computer or network to select the file(s) you want to add to the package.
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click). In this case, the files must be located in the same source directory to be added to the package at the same time.
3. Save the package.

To add files and folders to a package:

1. Organize your desktop so that you can simultaneously view both the package open in the Developer window and a Windows Explorer window.
2. In Windows Explorer, navigate to a source directory on your computer or server and select the files/folders that you want to include in the package.
3. Copy and paste or drag-and-drop the selected files/folders into the Package Editor tab.
4. Save the package.

Move/Copy Items in a Package

After creating packages and adding items to them, you might find that you want to move items from one package to another. For example, you might want to keep all of the files used in one section in a single package rather than creating a separate package for each file.

Items in a package can be moved or copied to another package using cut/copy and paste. You can also drag-and-drop items between packages by splitting the work area and viewing different packages in the two panes of the layout. When you drag-and-drop an item between packages, a new copy of the item is created in the destination package. To move an item between packages using drag-and-drop, hold the SHIFT key while dragging.

Note: If the source and destination are different folders within the same package tab, drag-and-drop moves the item rather than copying it.
When moving and/or copying items in a package, file and folder names at the same level within a package must be unique. Therefore, if you attempt to copy or move a file with a duplicate name to the same folder in a package, you are prompted to replace the original with the new file. If two distinct package files must keep the same name, you can either create a new package for the additional file or create a separate folder for it in the same package.

**Warning!** Moving a package item that is linked to a document creates broken links in your content. Because the Broken Links tool does not penetrate packages, it cannot detect when links to items within packages are broken. Therefore, if you plan to move a package item, you should first remove any links to it from your content.

### Multi-user Considerations

Note that if you want to move items between two packages, you must check out both packages. If you want to copy items between two packages, you need to check out only the destination package.

To move or copy items in a package:

1. Open the source package containing the items you want to move or copy.
2. Open the destination package into which you want to move or copy the package items.
3. Split the layout of the work area.
4. Display the source package in one layout pane and the destination package in the other layout pane.
5. Use drag-and-drop or cut/copy and paste to move or copy the items between the packages.
   
   To move items, hold the SHIFT key and drag the items from the source package to the destination package. You can also use the ‣ Cut and ‣ Paste commands to move items between packages.
   
   To copy items, drag the items (or hold the CTRL key and drag the items) from the source package to the destination package. You can also use the ‣ Copy and ‣ Paste commands to copy items between packages.
   
   The Cut, Copy, and Paste commands are also available on the Edit menu.
6. Save the packages.

### Rename an Item in a Package

You can rename any file or folder that is contained in a package. Long document names are supported for package items, but special reserved characters are not allowed.

When renaming items in a package, file and folder names at the same level within a package must be unique. Therefore, if you attempt to assign a duplicate name to a package item, you receive an error. If two distinct package files must keep the same name, you can either create a new package for the additional file or create a separate folder for it in the same package.
**Warning!** Renaming a package item that is linked to a document creates broken links in your content. Because the Broken Links tool does not penetrate packages, it cannot detect when links to package files are broken. If you need to rename a package item, you should do so before linking to it from your content.

**Tip:** If you plan to localize your content, you should consider a language-neutral naming convention for package items. This will help you avoid having to re-create links to package files in the translated content.

To rename an item in a package:

1. Open the package in the Package Editor.
2. Select the package item.
3. Click the document name or press the F2 key to start edit mode.
   You can also right-click a document and choose Rename.
4. Type the document name.
5. Press ENTER to save your changes.
   You can also click anywhere outside the document name to save your changes.

**Delete Items in a Package**

You can delete any folder or file in a package. Deleted package items are sent from the package in the Developer to the Windows Recycle Bin.

**Warning!** Deleting a package item that is linked to a document creates broken links in your content. Because the Broken Links tool does not analyze packages, it cannot detect when links to items within packages are broken. Therefore, if you plan to delete a package item, you should first remove any links to it from your content.

If you later discover that you improperly deleted a package item, you can restore the deleted item from the Windows Recycle Bin to its original package, as long as you have not emptied the Recycle Bin. To do so, you must first open the package in the Package Editor.

**Multi-user Considerations**

You must check out the package both to delete items from the package and to restore deleted package items from the Windows Recycle Bin.

To delete items in a package:

1. Open a package and select the folder(s) and/or file(s) that you want to delete.
2. On the **Edit** menu, choose **Delete.**
   You can also press DELETE or right-click the folder or file and choose Delete from the context menu.
3. Click **Yes** to confirm the deletion and move the items to the Windows Recycle Bin.
You can restore a deleted item from the Windows Recycle Bin to its original package, as long as the Recycle Bin has not been emptied. However, before you restore the item, you must first open the package in the Package Editor.

4. Save the package.

**Edit Files in a Package**

You can edit the content of any file in a package by opening it directly from the Package Editor. The file opens in its native application so you can make your changes.

You can use any one of the following methods to open a file from the Package Editor:

- Double-click the file name.
- Right-click the file name and choose Open.
- Right-click the file name and choose Open with.
- Drag the file into an open instance of the native application.

Before you save or close the package, be sure to save and close any open documents. Depending on the native application you are using to edit the file, you will receive different messages if you try to close the Package Editor while the file is still open. For example, with applications such as Microsoft Word or Excel, you will be prevented from saving or closing the package until the files are closed. If you are using other applications such as Notepad, you are warned that the file may be open and should be closed, but you can force the Package Editor to save or close anyway.

The messages could also vary depending on the method you used to open the file from the Package Editor. If you used either of the first two, the scenarios as described in the previous paragraph apply. If you used either of the last two methods, the Package Editor cannot determine reliably if the file is open, so you will receive a warning that the files may be open.

If the file you want to edit is also being maintained outside the Library, you can move or copy it from the Package Editor to your computer or a local server.

You can move or copy an item from a package to your desktop using standard Windows controls as follows:

- To move an item, drag the item (or hold the SHIFT key and drag the item) from the package to your desktop. You can also use the Cut and Paste commands.
- To copy an item, hold the CTRL key and drag the item from the package to your desktop. You can also use the Copy and Paste commands.

**Warning!** Dragging a package item from the Package Editor to your desktop or a local network removes the file from the package. Press CTRL while dragging to copy the file and leave the original in place in the package.

**Delete a Package**

Deleting a package deletes the package document from the Library, along with all of the items it contains. You can delete a package only from the Library, just as you would delete a document of any other type.
Deleting a package that contains items linked to your content creates broken links. Therefore, if you plan to delete a package, you should first remove any links from your content to the files it contains.

Tip: You can use the Broken Links tool to identify any broken links in your content that result from deleting a package. However, you cannot use this tool to identify broken links resulting from deleting, moving, or renaming items within packages.

The situation might also arise in which you attempt to delete a package as a related document. For example, if a package file is the concept of a module and you delete the module with related documents, the package is deleted as a related document. Note that the entire package is deleted, not just the file linked as the concept of the module. However, you cannot delete a package as a related document if any file it contains is linked to any other document that is not selected for deletion.

Consider the following two examples involving a package named Package AB that contains the files File A and File B:

- First, suppose that File A is linked as the concept of Module A but File B is not linked to any other document. If you delete Module A with related documents, Package AB, including both File A and File B, is deleted. The entire package is deleted, even though only one of the files it contained was linked to the document being deleted,

- Now suppose that File A is linked as the concept of Module A and File B is linked as the concept of Module B. If you now attempt to delete Module A with related documents, Package AB is NOT deleted, because of the link between File B and Module B. Further, File A is also not deleted, even though it was directly linked to the document being deleted and is not linked to any other document. In this case, the selected document is successfully deleted, but the related package document is left intact.

Therefore, you cannot create any broken links in your content by deleting a package as a related document.

Multi-user Considerations

Documents under version control must be checked in and you must be working online to delete a document from the Library. You can delete new documents that have never been checked in (are not under version control) while working online or offline.

Deleted documents that have been checked in to the Library can be restored if they have not been purged by your Administrator. New documents that have never been checked in cannot be restored.

Change the Package View

Just as you can change how you view files and folders in Windows Explorer, you can change the view for items in a package. The four views for packages are Large Icons, Small Icons, List, and Details. The Large Icons view is the default. The Large Icons, Small Icons, and List views display only the names of the package items. To see additional properties for each item in the package, such as file size, file type, and date modified, use the Details View.
If you split the work area using the horizontal or vertical layout, you can choose a separate view for the package in each pane of the layout.

By default, the package items in a view are arranged alphabetically by the Name property. If you view the package items in the Details View, which displays the properties for each item, you can use the column headings to rearrange the items by sorting the view on the different properties. The other views, which do not contain column headings, can be arranged by the Name, Type, and Date Modified properties.

**Note:** The icon representing each file in the package views is the standard Windows icon for the associated file type.

To change the package view:
1. Open a package.
2. Right-click in a blank area in the Package Editor window.
3. Point to **View** and choose a view.

To arrange the icons in the package view:
1. Open a package.
2. Right-click in a blank area in the Package Editor window.
3. Point to **Arrange Icons** and choose a property.

**Package Behavior in Publishing**

The behavior of package files in publishing depends on the type of published output, the type of package file, and the level at which the package file is linked, as described below.

**Player Outputs**

Package files linked at all levels are included in all Player outputs in Try It! and Do It! modes. When linked at the concept level, most package files appear directly in the Concept pane when the user selects the parent document. Depending on the type of file, some concept package files open in a new window instead. When linked at the frame or bubble text level or when linked from a web page, users access the package file by clicking on the link icon or hyperlinked text/image. In these cases, all package files open in a new window, although the precise appearance and behavior of package files depends on the setup and browser settings of the computer on which they are viewed (see Package Considerations).

**Warning!** If a user's browser/system does not support a specific type of package file, the browser displays an error when the user attempts to access the linked package file, whether in the Concept pane or through a link. Therefore, you should consider your users' system setup when determining which types of package files to use.

**Note:** Package files linked to frames or bubble text are not available in See It! or Know It? playback modes in the Player.

**Document Outputs**

With one exception, package files do not appear in document outputs. The exception is graphic files, which can be included when you publish a Business Process Document, Training Guide, or Instructor Manual. Specifically, package graphic files linked directly at
the concept and frame levels are included in these document outputs. Package graphic files linked to bubble text are excluded from all document outputs.

When linked at the concept level, the package graphic appears immediately after the name of the parent document to which it is linked. When linked at the topic frame level, the package graphic immediately follows the screen shot and steps for the frame to which it is linked. It appears in a lightly shaded box that is indented slightly to set it off from the surrounding content, with the link icon to its left. Although the graphic appears within the borders of the shaded box, it does not have a shaded background. When the same frame links to multiple package graphics or other attachments that are included in document outputs, each attachment is displayed as a separate item, in the order in which it is linked. If desired, you can use publishing format options to exclude directly linked package graphic files from all document outputs.

In addition, package graphics inserted as images in web pages can also be included in the above document outputs. In this case, the images appear as part of the web page, for web pages linked at the concept and frame levels. If desired, however, you can use publishing format options to exclude web page images, including those linked through packages, from all document outputs.

Finally, if a glossary term links to a graphic in a package as its definition link, the graphic appears in the Glossary section of a published Training Guide or Instructor Manual.

The maximum size for package graphics in document outputs is ½ page, so graphics that are larger than this are scaled accordingly and those that are smaller appear at full size.

**Note:** The Job Aid, Test, and HP Quality Center document outputs do not include linked package files.

**Enhance Content with Web Pages**

You can enhance your content by creating web pages and linking to them from any module, section, or topic document as a concept or from any frame in a topic as explanatory information. In a web page, you can create flexible arrangements of text, sound, images, and hyperlinks, just as you would with a standard web authoring tool. One exception is that the Web Page Editor provides only a controlled subset of HTML functionality, to ensure that your web pages can be both displayed online and transferred properly to print documentation. In addition, the web pages that you create in the Developer are saved in the Library, so they are incorporated directly in your published output, thus minimizing the possibility of broken links, access problems, or other browser issues.

**Note:** The Web Page Editor does not provide access to the page HTML for direct editing. Rather, you make all changes to the content and formatting of your web pages using the tools available in the Web Page Editor interface.

When you link to a web page as the concept of a module, section, or topic, users can access the web page from the Concept pane in the Player window. When you link to a web page from a frame in a topic, an icon representing the link appears in the bubble in Try It! mode or in the bubble or window in Do It! mode for that frame. If the web page is linked to the Introduction frame of a topic, its icon appears in the Introduction pane of the Player window. In each case, a user can click the icon to view the contents of the web page.
In addition, you can link to web pages from bubble text in a topic frame or from text or graphics in another web page. Users can view the linked web pages by clicking the hyperlinked text or graphic appearing when they view your content in the Player window.

You can also add sound to a web page and link the web page to a Module, Section or Topic and have the sound play back thru the Concept pane. See Add Sound on a Web Page for details.

Web pages linked at the concept and frame levels are also included in selected document outputs, namely, the Business Process Document, Training Guide, and Instructor Manual. See Web Page Behavior in Publishing for more detail.

To use a web page in the Developer, you must complete two basic steps. First, you create the web page, and then you link it to the appropriate module, section, topic, or frame. Once you have created a web page in a Library, you can use it multiple times by linking to it from each location in your outlines where you want the users to be able to access it.

**Note:** Web pages linked to frames or bubble text are not available in See It! or Know It? playback modes in the Player.

### Create a New Web Page

You can create a web page from the main File menu available in the Library or any other document editor EXCEPT the Topic Editor. When you create a new web page or open an existing web page, the Web Page Editor launches in a new tab and displays an empty web page (or the selected web page) where you can add and format text, sound, insert images and hyperlinks, and so on. You can save the web page to any folder in the Library and then link to it from one or more documents anywhere in the Library.

If you save a web page to the wrong folder in the Library, you always have the option to move the web page document to another folder. You can also rename a web page at any time without breaking any links from your content to the web page.

**Note:** The Web Page Editor does not support split views. In a split view, a tab appears for the web page in each pane, with the contents of the web page displayed in the active pane and a Click here to make this Web Page Editor active link appearing in the other. Clicking the link switches the active display of the web page to the other pane.

### Multi-user Considerations

Any new document that you create or link is automatically checked out to you. If you want to make a new document available to multiple authors and place the document under the Developer's version control system, you must check it in.

See Check In and Check Out Documents in Use the Developer in a Multi-user Environment for more information.

To create a new web page:

1. On the File menu, point to New and choose Web Page.
2. Edit the empty web page to include the content that you want.
You can both create new content directly using the Web Page Editor and copy and paste material from other sources, such as word processing documents and Internet sites.

3. Save the new web page.

You can also close the tab and click Yes in response to the Save Document message.

When you save a web page for the first time, you are prompted to provide a name for it. Enter a name for the web page by typing over the default name. Although the web page name does not have to be unique, it is recommended that you provide a meaningful name so you can easily find the web page later.

**Note:** Web pages are not saved automatically, so you should save your work periodically as you add content to your web page.

### Edit a Web Page

You can open a web page at any time in the Web Page Editor to modify its contents. For each web page that you open to edit, an independent instance of the Web Page Editor opens in a separate tab, allowing you to edit multiple web pages at one time. When you edit a web page, you can add any combination of text, hyperlinks, sound, and images and also copy and paste external content.

**Note:** Web pages are not saved automatically, so you should save your work periodically as you edit the content of your web page.

**Tip:** You can undo any change you make in a web page by selecting Undo from the Edit menu before saving the web page. Once you save the web page, you can no longer undo earlier changes.

### Multi-user Considerations

Before you can perform this action, you must check out the document. After you save any changes, you should check in the document to make it available to other authors and add the changes to the Developer’s version control system.

To edit a web page:

1. Open the web page in the Web Page Editor.

   You can open a web page for editing from the Library, Outline Editor (Concept pane), or Topic Editor (Concept, Frame Link, and Hyperlink Properties toolpanes).

2. Add text, hyperlinks, sound and/or images as desired.

3. Save and close the web page.

### Add and Format Text

You can type text in the Web Page Editor window just as you would in any word processing or web authoring tool. As you type the text, it reflects the default formatting, but you can use the toolbar icons and controls above the main window to change the formatting as desired. Alternatively, you can set up the desired formatting options before adding any text so that the specified formatting is applied as you type. The formatting options
supported by the Web Page Editor provide flexibility but also ensure that your published content will be presented well in both Player and document outputs.

**Note:** You can preset the default font settings and background color for the Web Page Editor using Tools, Options. These defaults apply to all newly created web pages, but not those that already exist. This feature is useful in helping to set consistent standards for the appearance of your web pages.

<table>
<thead>
<tr>
<th>Control</th>
<th>Type</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Character</td>
<td>Changes the font family/style of the selected text.</td>
</tr>
<tr>
<td>Font size</td>
<td>Character</td>
<td>Changes the font size of the selected text.</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>Character</td>
<td>Bolds the selected text.</td>
</tr>
<tr>
<td><strong>Italic</strong></td>
<td>Character</td>
<td>Italicizes the selected text.</td>
</tr>
<tr>
<td><strong>Underline</strong></td>
<td>Character</td>
<td>Underlines the selected text.</td>
</tr>
<tr>
<td>Paragraph</td>
<td>Paragraph</td>
<td>Aligns the paragraph to the left of the web page.</td>
</tr>
<tr>
<td>Paragraph</td>
<td>Paragraph</td>
<td>Aligns the paragraph in the center of the web page.</td>
</tr>
<tr>
<td>Paragraph</td>
<td>Paragraph</td>
<td>Aligns the paragraph to the right of the web page.</td>
</tr>
<tr>
<td>Paragraph</td>
<td>Paragraph</td>
<td>Justifies the paragraph.</td>
</tr>
<tr>
<td>Paragraph</td>
<td>Paragraph</td>
<td>Formats the text as a bulleted list.</td>
</tr>
<tr>
<td>Paragraph</td>
<td>Paragraph</td>
<td>Formats the text as a numbered list.</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>Character</td>
<td>Changes the color of the selected text.</td>
</tr>
<tr>
<td>Background</td>
<td>Background</td>
<td>Changes the background color of the web page.</td>
</tr>
</tbody>
</table>

The background color setting always applies to the entire web page, regardless of its contents (text and/or graphics).

**Note:** In new web pages, numbered lists take the font style and size set in the web page default options (in new web pages) or in immediately preceding text if different from the default settings. However, you can change the numbering style and size by applying formatting to the text in the list paragraphs (that is, applying text formatting after applying the numbered list paragraph format). In addition, you can change the color of the numbers or bullets in lists by applying a text color to the text in the list paragraphs. You cannot change the size or style of the bullets, however.

Several of the formatting controls are toggle commands, namely, bold, italic, underline, numbered list, and bulleted list. This means that clicking the toolbar button once applies the format and clicking a second time removes the format.

The Web Page Editor also supports both paragraph returns (ENTER or CTRL+M) and line breaks (SHIFT+ENTER or CTRL+SHIFT+M), as well as nonbreaking spaces (CTRL+SHIFT+space). These elements are useful in controlling the layout of your web pages. For example, you can use a line break in a bulleted paragraph to create the type of layout.

- This is a bulleted paragraph.
  - This is an indented line created using a line break.
- This is another bulleted paragraph created with a paragraph return.
You can use nonbreaking spaces to keep two or more adjacent words in the same line of text. For example, you can use nonbreaking spaces between the parts of a multiword product name to ensure that the name always appears as a unit and is never broken across lines by text wrapping. This provides some control over how your web pages are displayed in the user’s browser, even if the browser window is resized.

In addition to typing text directly in the Web Page Editor, you can also add text (and graphics) created in an external application using copy and paste. However, the pasted selection might appear somewhat different than the original depending on the formatting used. Any formatting not supported by the Web Page Editor, such as tables and sub- and superscripts, is removed when the web page is saved.

To add and format text in a web page:

1. Position your cursor at the location on the web page where you want to add text.
2. Type the text.
3. To apply a character format, select the text you want to format and use the appropriate toolbar buttons and controls.
   - To apply a paragraph format, position your cursor in the paragraph you want to format and use the appropriate toolbar buttons.
   - To apply a background color to the entire web page, use the appropriate toolbar button.

### Insert a Hyperlink

Within a web page, you can create a hyperlink from specific text or from an image to additional information, such as another web page, a detailed flow diagram, or a web animation. When the user activates a web page hyperlink in the Player, the target opens in a new, independent browser window.

When inserting a hyperlink, you can choose from two types of targets as follows:

<table>
<thead>
<tr>
<th>Select...</th>
<th>To link to...</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document in Library</td>
<td>Another web page or a file saved in a package</td>
<td>Allows you to link to another attachment contained in the Library. For example, you could link from a word in a web page to another web page containing its definition.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This option can be particularly appropriate for package files used as concepts. Rather than linking directly to the package file, you can link to a web page that, in turn, contains a hyperlink to the package file. This approach provides greater control over how and when package files used as concepts are displayed.</td>
</tr>
<tr>
<td>URL</td>
<td>An intranet or Internet site</td>
<td>Allows you to link to web content that is maintained outside the Library. You can use this option for any valid URL, such as mailto and ftp links, provided that your users have appropriate access when they view the content. Examples: Corporate web site, web-based feedback form, help desk email</td>
</tr>
</tbody>
</table>

To test the targets of your hyperlinks from the Web Page Editor, right-click the link and select Open Hyperlink. You can also use SHIFT+click to open the targets of your hyperlinks.
from the Web Page Editor. For web pages and package files, this command opens the target in a new Developer tab. For URLs, the target opens in a new, independent browser window.

When viewing your web page from outside the Web Page Editor (for example, in the Concept pane of the Outline Editor), you can test your hyperlinks simply by clicking on them. In this case, the target of each hyperlink opens in a new, independent window. However, if you need to edit a hyperlink, you must open the web page containing it in the Web Page Editor.

**Note:** When a glossary term is used in a manually created web page hyperlink, no glossary link is created during glossary markup. That is, text used in manually created hyperlinks is excluded from glossary markup.

To insert a hyperlink in a web page:

1. Select the text or graphic you want to use as the hyperlink hotspot.
2. On the **Insert** menu, select **Hyperlink**.
3. On the Link to pane, select the type of hyperlink target as **Document in Library** or **URL**.
4. Depending on your selection in step 3, navigate to the target document or file or type or paste the target URL in the **Address** field.
   - When selecting a URL, you can also enter a base URL and then follow links in the preview displayed in the results pane to reach your desired target.
5. Click **OK** or press ENTER.
   - The presence of the hyperlink is indicated by underlining of the selected text or outlining of the selected image.

**Edit Hyperlink Properties**

After you have inserted a hyperlink in a web page, you might need to change its properties. In addition to changing the target URL or file, you can add text to display as a tooltip. For example, you might use the tooltip "terminology" for a hyperlink to a web page providing a detailed definition of a term.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Path to the hyperlink target. You can change the hyperlink target by clicking the Browse button in the Hyperlink Properties dialog box to select a new target file or URL.</td>
</tr>
<tr>
<td>Tooltip</td>
<td>Text used as a tooltip for the hyperlink. The tooltip appears when a user points to the hyperlink when viewing the web page in the Player. Tooltips display the same behavior in the Developer when you view your web page from the Outline Editor or the Topic Editor (for example, in the Concept pane of the Outline Editor). If the target of a hyperlink in a web page is a URL, its tooltip also appears in document outputs that include the web page. (See <em>Web Page Behavior in Publishing</em> for more detail.) If this field is left blank, no tooltip appears.</td>
</tr>
</tbody>
</table>

7-22  Copyright © 1998, 2010, Oracle. All rights reserved.
To edit hyperlink properties:

1. Right-click the hyperlink and select **Hyperlink Properties** from the context menu.
2. Edit the target location and/or tooltip as needed.
3. Click **OK**.

**Remove a Hyperlink**

If you decide that you no longer need a hyperlink from your web page to a particular target, you can easily remove the link. The contents of the web page remain otherwise unaffected, and the target is simply unlinked; it is not deleted from the Library or other source location.

To remove a hyperlink:

1. Right-click the hyperlink.
2. Select **Remove Hyperlink** from the context menu.

**Insert an Image**

You can add images to your web page from files stored in packages in the Library, saved on your computer or a local intranet, or available on the Internet. The Web Page Editor supports png, jpg/jpeg, and gif image file formats.

When inserting an image, you can choose from three types of sources as follows:

<table>
<thead>
<tr>
<th>Select...</th>
<th>To insert...</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image in Library</td>
<td>Image saved in a package in the Library</td>
<td>The image displayed on the web page is linked to the package graphic file. Therefore, if you update the package file, the image displayed on the web page is automatically updated as well. However, if you move, delete, or rename the package file, you create a broken link, and a “file not available” indicator replaces the image on the web page. Because this option allows for easy image reuse and maintenance, it is preferable for images used many times throughout your content.</td>
</tr>
<tr>
<td>Image on My Computer</td>
<td>Image saved elsewhere on your computer or a network</td>
<td>The image is embedded in the web page; that is, it becomes part of the web page document and is not available in the Library as a separate file. This option is preferable for images used only once or a few times.</td>
</tr>
</tbody>
</table>
Select... | To insert... | Comments
---|---|---
URL | Image located on an Internet or intranet site | For images obtained from Internet or intranet sites, you must enter (type or copy/paste) the complete URL of the image file itself. The complete URL includes the URL of the site on which it is located, plus the path to the image file within the site structure. When you insert a URL image in a web page, the image is linked to its source and is updated whenever the source file changes. However, if the source file is moved, deleted, or renamed, the link is broken, and a "file not available" indicator replaces the image on the web page. Therefore, you must be sure to use exactly the same file name and path within the site structure each time you change the source image for the link to be maintained.

Note: You can also add images to web pages using copy and paste. For images copied from Internet or intranet sites, you can choose to link or embed the pasted images.

To insert an image:
1. Position your cursor at the location on the web page where you want to insert the image.
2. On the Insert menu, select Image.
3. On the Link to pane, select the type of image source as Image in Library, Image on My Computer, or URL.
4. Depending on your selection in step 3, navigate to the desired image in the Library or on your computer/server or type/paste the target URL in the Address field.
5. Click OK.
If you later decide that the image is not needed on the web page, you can delete it by simply selecting it and pressing DELETE.

Edit Image Properties
You can set the following properties for any image inserted in a web page:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Path to the image source file. You can change the image displayed by clicking the Browse button in the Image Properties dialog box to select a new source file or URL. All other image properties except size remain unchanged for the new image.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Alternative text</td>
<td>Text used as a tooltip (mouse-over text) for the image. The tooltip appears when a user points to the image when viewing the web page in the Player. Tooltips display the same behavior in the Developer when you view your web page from the Outline Editor or the Topic Editor (for example, in the Concept pane of the Outline Editor). If this field is left blank, no tooltip appears.</td>
</tr>
<tr>
<td>Use actual image size</td>
<td>Displays the image at its full size in the source file. The values in the Height and Width fields reflect the actual image dimensions and cannot be edited when this option is selected. You can change the image size by deselecting this option and typing new values in the Height and Width fields. Alternatively, you can adjust the size of the image by dragging its anchors directly on the web page. If you later choose to undo any changes made to the size of the image, simply select this checkbox again to revert to the original size.</td>
</tr>
<tr>
<td>Height</td>
<td>Image height, in pixels. When the Use actual image size option is deselected, you can modify the image height by typing the desired value in the Height field.</td>
</tr>
<tr>
<td>Width</td>
<td>Image width, in pixels. When the Use actual image size option is deselected, you can modify the image width by typing the desired value in the Width field.</td>
</tr>
<tr>
<td>Preserve aspect ratio</td>
<td>Maintains the ratio between the height and width of the image, to prevent distortion as you resize the image from the Image Properties dialog box. With this option selected, you can type a new value in the Height or Width field, and the value of the other dimension is updated automatically when you tab or click off your entry. Note that this option applies ONLY when you resize an image from the Image Properties dialog box; it does not affect changes made by dragging the image anchors directly on the web page.</td>
</tr>
<tr>
<td>Border</td>
<td>Width of the image border, in pixels. For images that are not hyperlinks, the border is black. If an image with a border functions as a hyperlink, its border appears in the default link color. If an image without a border functions as a hyperlink, a 2-pixel colored border is automatically added to indicate the presence of the hyperlink, although you can also increase the width of this border, if desired.</td>
</tr>
<tr>
<td>Alignment</td>
<td>Vertical or horizontal alignment of the image relative to the line containing it. The vertical alignment options are Top, Middle, and Bottom. Top aligns the top of the image with the top of the tallest item in the line, Middle aligns the center of the image with the baseline, and Bottom aligns the bottom of the image with the baseline. In each case, the line wraps to the bottom of the image. These options have no visual effect if the image is on a line by itself. The remaining options concern horizontal alignment. Left places the image at the left margin and wraps subsequent text along the right side of the image. Similarly, Right places the image at the right margin and wraps subsequent text along the left side of the image. If the image is on a line by itself (that is, if text wrapping is not important), you can use the paragraph alignment controls instead to obtain the same effect.</td>
</tr>
</tbody>
</table>
To edit image properties:

1. Double-click the image to display the Image Properties dialog box.
   You can also right-click the image and select Image Properties from the context menu.
2. Change the image properties as needed.
3. Click OK or press ENTER.
   You can also click Apply to see the effects of your changes without closing the dialog box and then make further changes to the image properties if needed.

Edit an Image in a Web Page

You cannot edit images directly from the Web Page Editor. Instead, you must edit the original image file in an appropriate application and then update the image in the web page as follows:

<table>
<thead>
<tr>
<th>Image Type</th>
<th>Update Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image in Library</td>
<td>Replace the image file in the package, using exactly the same file name. Because the image in the web page is linked to the package file, it updates automatically.</td>
</tr>
<tr>
<td>Image on My Computer</td>
<td>Edit the image properties, replacing the Source entry with the path to the edited image file. All other image properties except size remain unchanged.</td>
</tr>
<tr>
<td>URL, embedded</td>
<td>Edit the image properties, replacing the Source entry with the path to the edited image file. All other image properties except size remain unchanged.</td>
</tr>
<tr>
<td>URL, linked</td>
<td>Replace the image on the source Internet or intranet site, using exactly the same file name and path to the image file within the site structure. Because the image in the web page is linked to the source file, it updates automatically.</td>
</tr>
</tbody>
</table>

Copy and Paste Web Page Content

In addition to creating new web page content directly in the Web Page Editor, you can also copy and paste content developed in another application, such as a word processing document or Internet site. You can then modify the pasted content using the formatting controls available in the Web Page Editor. For example, you could paste a column of data from a spreadsheet and then format the resulting paragraphs as a bulleted list. Note, however, that the Web Page Editor supports only the formatting options available through its toolbar. These formatting options provide flexibility but also ensure that your published content is presented well in both Player and document outputs. As a result, your pasted content might not look identical to the selection copied from the external source, and you should always use the Web Page Editor controls after pasting content to ensure that it is formatted as intended.

**Tip:** Always save your web page after pasting content from external applications and before applying Web Page Editor formatting. Because saving a web page removes any unsupported formatting, this allows you to see a valid starting point for the pasted content and ensures that any subsequent formatting you apply is preserved.

The following are some points to consider when pasting content into your web pages.
Text

- Fonts that are not supported are converted to the default font style and size.
- Tabs are converted into nonbreaking spaces.
- Numbered and bulleted lists are converted to standard, left-aligned paragraphs. The number or bullet in each list item is pasted as a character or graphic, respectively, and the tab separating the number/bullet from the item text is converted into nonbreaking spaces. That is, the appearance of the lists is maintained but not the functionality.

To obtain list functionality, you should delete the pasted numbers/bullets and apply the desired list format using the Web Page Editor controls.

- Tables are converted into paragraphs, one paragraph for each cell. The cells are converted in order across rows from left to right and then from top to bottom. If you need a table presentation, a better alternative is to create the table in an external file, save the file in a package, and then link to the package file. You can also save the table in a graphical format and insert it as an image.

Images

- Images from Internet or intranet sites can be copied using copy and paste or drag-and-drop. In both cases, you can choose to embed or link the image. If you embed the URL image, the image becomes part of the web page document. The result is exactly the same as for an image inserted from your computer.

In contrast, a linked image is updated whenever the source file changes. However, if the source file is moved, deleted, or renamed, the link is broken, and a "file not available" indicator replaces the image on the web page.

The linked URL option is preferable for images that are maintained on an Internet or intranet site, especially if they are updated frequently. You must be sure, however, to use exactly the same file name and path within the site structure each time you change the source image for the link to be maintained.

- Images from external documents can be copied using copy and paste or CTRL+drag-and-drop. These images are always embedded; that is, they are treated exactly the same as images inserted using the Images on My Computer option.

- Inserted images can be duplicated or moved within a web page using copy/paste or cut/paste, respectively. The pasted image retains all of the properties (alternative text, size, and border) of the original.

Rename a Web Page

You can rename a web page just as you would any other document. If you rename a web page to which you have linked from other documents, topic frames, or bubble text, the links remain unaffected. That is, renaming a linked web page does not break any links in your content.

Note: You can rename a web page only from the Library.

Delete a Web Page

You can delete a web page only from the Library, just as you would delete a document of any other type.
Deleting a web page that is linked to your content creates broken links. Therefore, if you plan to delete a web page, you should first remove any links to it from your content.

**Tip:** You can use the Broken Links tool to identify any broken links in your content that result from deleting a web page.

### Multi-user Considerations

Documents under version control must be checked in and you must be working online to delete a document from the Library. You can delete new documents that have never been checked in (are not under version control) while working online or offline.

Deleted documents that are used in any outline will continue to appear in the outline. You can either remove these links from the outline or restore the deleted documents as long as the administrator has not purged them.

Deleted documents that have been checked in to the Library can be restored if they have not been purged by your Administrator. New documents that have never been checked in cannot be restored.

### Web Page Behavior in Publishing

The behavior of web pages in publishing depends on the type of published output, the level at which the web page is linked, and the content of the web page, as described in this section.

**Player Outputs**

Web pages linked at all levels are included in all Player outputs in Try It! and Do It! modes, and all hyperlinks within the web pages are active. When linked at the concept level, the web page appears directly in the Concept pane when the user selects its parent document. When linked at the frame or bubble text level, users access the web page by clicking on the link icon or hyperlinked text, respectively. In these cases, the web page opens in a new browser window. Similarly, for hyperlinks within web pages, the link target always opens in a new window.

**Warning!** If the target of a web page hyperlink is a package file or URL, you must ensure that your users have the appropriate setup and access to view the target of the link. Otherwise, the browser displays an error when the user attempts to access the linked attachment through the web page hyperlink.

**Note:** Web pages linked to frames or bubble text are not available in See It! or Know It? playback modes in the Player.

**Document Outputs**

Only three types of document outputs ever include linked attachments such as web pages: the Business Process Document, Training Guide, and Instructor Manual. For these three documents, the outcome depends on the level at which the web page is linked and its contents. Specifically, web pages linked at the concept and frame levels are included in document outputs. Web pages linked to bubble text are excluded from all document outputs.
When linked at the concept level, the web page appears immediately after the name of the parent document to which it is linked. When linked at the topic level, the web page immediately follows the screen shot and steps for the frame to which it is linked. It appears in a lightly shaded box that is indented slightly to set it off from the surrounding content, with the link icon to its left. When the same frame links to multiple web pages or other attachments that are included in document outputs, each attachment is displayed as a separate item, in the order in which it is linked.

Further details on the appearance of a web page depend on the combination of text, images, and/or hyperlinks it contains.

- Web page background color is not preserved.
- If a web page contains formatted text, the bold, italic, underline, text color, and numbered and bulleted list formatting is preserved, but the font style and font size are not. The default font style and size, as specified in the publishing styles, are used instead.
- All images inserted in web pages (as embedded images, linked package graphics, and linked URLs) are also included in document outputs. Although the images appear within the borders of the shaded box, the images themselves do not have a shaded background. The maximum image size is 1/2 page; graphics larger than this are scaled accordingly and those smaller appear at full size. If the image is also hyperlinked, the image is included in the document, but the hyperlink is ignored.

If desired, you can use the publishing format options to exclude web page images from all document outputs.

- Web page hyperlinks are included in document outputs only when the target is a URL (not another web page or a package file) and the hyperlink is from text, not an image. In this case, the hyperlink tooltip appears in place of the linked text, followed by the target URL in parentheses. The target URL functions as an active link in the document output.

Consider the following example:

A web page linked as a topic concept contains the text "You can find more information at the Microsoft web site." with a hyperlink from the words "Microsoft web site" to the target URL "www.microsoft.com". Further, the tooltip of the hyperlink is "Microsoft Corporation web site". Upon publication to the Business Process Document, for example, the result for this URL hyperlink is "You can find more information at the Microsoft Corporation web site (www.microsoft.com)."

Note: The Job Aid, Test, and HP Quality Center document outputs do not include linked attachments.

Enhance Content with URLs

In addition to package files and web pages, you can also enhance your content by linking it to URLs. This allows you to link to information that is created and maintained outside the Library and is accessed directly on the Internet or a local intranet. You can use this option for any valid URL, including mailto and ftp links. For example, you can use a URL attachment to link from the Introduction frame of a topic to your corporate web site. Alternatively, you can use a mailto URL link to your help desk to allow users to easily submit questions or comments while they are viewing your content in the Player.
Note: Clicking a mailto link in the Developer or Player launches the default e-mail program specified on the user's computer and opens a new mail message with the mailto address included in the To field. You can also include a default subject and/or message text by using the "subject" and/or "body" attributes of the mailto tag.

When you use links to URL attachments, you must take three issues into consideration:

- First, your users must be online when viewing content in the Player to access URL links. In addition, you should take into account the speed of their Internet connection, especially if the target sites contain many graphics and/or multimedia components.

- Second, you must ensure that the path to the target of the link always remains valid; that is, you must not move the target of the link from its current location on the Internet or intranet. If the path to the target does change, you must update the link in the Developer and republish your content. Otherwise, your users will encounter a "page not available" browser error when they try to access the URL by clicking the link.

- Third, you must ensure that your users have appropriate access and an appropriate setup to view the target of the link. For example, if the target of the link is located on a secure server, your users must be authorized to access the server. Likewise, if the target of the link employs plug-ins, you should ensure that your users have the appropriate plug-ins installed before they attempt to view the linked content.

When you link to a URL as the concept of a module, section, or topic, users can access the target Internet or intranet site from the Concept pane in the Player window. When you link to a URL from a frame in a topic, an icon representing the link appears in the bubble in Try It! mode or in the bubble or window in Do It! mode for that frame. If the URL is linked to the Introduction frame of a topic, its icon appears in the Introduction pane of the Player window. In each case, a user can click the icon to view the contents of the target Internet or intranet site.

In addition, you can link to URLs from bubble text in a topic frame or from text or an image in a web page. Users can view the target Internet or intranet site by clicking the hyperlinked text or graphic appearing when they view your content in the Player window.

URLs linked at the concept and frame levels and in web pages are also included in selected document outputs, namely, the Business Process Document, Training Guide, and Instructor Manual. See URL Behavior in Publishing for more detail.

Note: URL attachments that are linked to frames or bubble text are not available in See It! or Know It? playback modes in the Player.

URL Behavior in Publishing
The behavior of URLs in publishing depends on the type of output and the level at which the URL is linked.

Player Outputs
Like links to package files and web pages, links to URLs are included in all Player outputs in Try It! and Do It! modes. For URLs linked at the concept level, the target of the link appears in the Concept pane. For example, if your corporate web site is the concept of a module, the Concept pane displays the home page of the web site when the user selects the module document. The display is fully functional, so that users can explore the site
using its navigation buttons and links. For URLs linked at the frame or bubble text level, users access the link target by clicking on the link icon or hyperlinked text, respectively; in both cases, the link target opens in a new browser window. The same is true for hyperlinks to URLs within web pages.

**Note:** Users must be online when viewing your content to access linked URLs. They should also have a sufficient connection speed, any necessary plug-ins, and all appropriate permissions or user accounts to access the target sites.

**Note:** URL attachments linked to frames or bubble text are not available in See It! or Know It? playback modes in the Player.

### Document Outputs

Only three types of document outputs ever include linked attachments such as URLs: the Business Process Document, Training Guide, and Instructor Manual. For these three documents, the outcome depends on the level at which the URL is linked.

Direct links to URLs at the concept and frame levels appear in the same format: the text "Please refer to:" is followed by the address of the target. For example, a concept link to the Microsoft web site appears as "Please refer to: www.microsoft.com". The URL address functions as an active text hyperlink in the document output that your users can use to directly access the target of the link.

When linked at the concept level, this text appears immediately after the name of the parent document to which it is linked. When linked at the topic level, this text immediately follows the screenshot and steps for the frame to which the URL attachment is linked. It appears in a lightly shaded box that is indented slightly to set it off from the surrounding content, with the link icon to its left. When the same frame links to multiple URLs or other attachments that are included in document outputs, each attachment is displayed as a separate item, in the order in which it is linked.

Unlike package and web page attachments, URLs linked to custom bubble text in action frames are also included in document outputs. In this case, the address of the target appears in parentheses immediately after the linked text and again functions as an active text hyperlink. For example, the bubble text "You can find more information at the Microsoft web site." with a link from the text "Microsoft web site" would appear as "You can find more information at the Microsoft web site (www.microsoft.com)."

Web pages can also contain hyperlinks to URLs. Such hyperlinks are included in document outputs as part of the web pages to which they belong under the following conditions:

- The web page is linked at the concept or frame level.
- The hyperlink is from text in the web page, not an image.

In this case, the hyperlink tooltip (if defined) appears in place of the link text, followed by the address of the target URL in parentheses. The URL address functions as an active text hyperlink in the document output. Consider the following example:

A web page linked as a topic concept contains the text "You can find more information at the Microsoft web site." with a hyperlink from the words "Microsoft web site" to the same target as above (www.microsoft.com). Further, the tooltip of the hyperlink is "Microsoft Corporation web site". Upon publication to the above document outputs, the result for this URL hyperlink is "You can find more information at the Microsoft Corporation web site (www.microsoft.com)." with an active link from the text "www.microsoft.com" to the web site.
Link Attachments

To supplement the basic structure and step-by-step procedures provided by your module, section, and topic documents, you link from these documents to attachments. Attachments can be package files, web pages, or URLs.

You can link from your outlines to an attachment at the following three levels:

- The concept of a module, section, or topic
- A frame of a topic
- Bubble text in a topic frame, including Introduction and End frames

You can link to attachments while working in the Outline Editor (concepts only) or Topic Editor.

Once you have created a link from a document to an attachment, the link essentially becomes part of the parent document. As a result, you do not need to re-create or repair these links every time you move or reuse the parent document in your outlines. Links are also maintained if you move or copy the parent document in the Library.

The procedure for linking to an attachment at a given level is the same, regardless of the type of attachment. When you link to an attachment from a topic frame, you also select an icon that appears during topic playback in the Player to alert the user to the presence of a link and provide access to the linked information. You can also assign a tooltip to the link, for example, to provide a brief description of the linked attachment.

Multi-user Considerations

Before you can perform this action, you must check out the parent document. After you save any changes, you should check in the parent document to make it available to other authors and add the changes to the Developer's version control system.

You do not need to check out the attachment, only the parent document. In addition, you can link to an attachment even if it is checked out to another user.

When you are working offline, you can link to an attachment only if it is available in your local cache. Therefore, if you plan to work offline, you should ensure that you have a local copy of any attachment to which you want to link. To do this, you can either check out or get the attachment(s), depending on whether you plan to edit them or to have access to read-only copies. If you go offline and do not have copies of some attachments in your local cache, those attachments will be unavailable to you as you work offline. To remedy this, you need to go back online and get the documents that you need.

Link an Attachment as a Concept: Outline Editor

You can use the Player View in the Outline Editor to link a package file, web page, or URL as the concept of a module, section, or topic document. The linked attachment then appears in the Concept pane of the Outline Editor, resembling the display in the Player window. To assist in the maintenance of concept links in the Developer, the linked attachment is also identified at the top of the pane. If the attachment is a package file or
web page, the file name and location in the Library are shown; if the attachment is a URL, its absolute path is shown instead. For module and section documents, the concept expands to fill the entire right side of the Developer window, whereas for topic documents, both the concept and the introduction frame appear. If the size of the linked attachment is greater than the size of the concept pane, scroll bars allow you to view all areas of the concept.

**Note:** Depending on your computer system setup and browser settings, some types of package documents might not appear in the Concept pane.

The Concept pane in the Outline Editor provides the tools for linking to and managing the links to concept attachments. When linking to a package file or web page, you can filter the display to include packages or web pages only and navigate through the Library folders to the specific file you want to link. When linking to a URL, you can type or paste a base URL in the Address field and then follow links in the preview displayed in the Insert Hyperlink dialog box to reach your desired target.

The link to the concept of a parent document is saved with the document. Therefore, the concept link is maintained when the parent document is copied or moved to another outline. Conversely, deleting the link to an attachment from a parent document in one outline removes the link in all outlines where the parent document is used. The concept link to an attachment is also maintained when you copy or move a parent document in the Library or Outline Editor.

If a linked web page contains sound, controls for sound playback display in the Concept pane.

**Note:** You can control the display of linked content using the Preview category in Options (on the Tools menu). By default, linked content automatically appears in the Concept pane when you select a document in the outline. However, you can turn this off for all documents or selectively turn off the display by document type. If you turn off the display of linked content, you can click ![Linked Content Button](image) for any document in the outline to display the linked content.

**Note:** From the Concept pane, you can also click ![Create New Web Page Button](image) Create new web page to create a new web page and link to it in one step. When you do so, you first specify the name of the web page and the Library folder in which it should be saved. The Web Page Editor then launches in a new tab, displaying an empty web page. After you complete the web page, you can preview its contents directly in the Outline Editor tab.

To link a package file or web page as a concept from the Outline Editor:

1. With the outline open in the Outline Editor, display the Player View.
2. Select the document from which you want to link to a package file or web page.
3. In the Concept pane, click ![Create Link Button](image) Create link.
4. In the Link to pane, select ![Document in Library](image) Document in Library.
   - If desired, you can select Packages or Web pages in the Type field to further filter your selection.
5. Navigate the Library to the folder containing the package file or web page to which you want to link.
6. Select the desired package file or web page document.
7. Click OK or press ENTER.

To link a URL as a concept from the Outline Editor:

1. With the outline open in the Outline Editor, display the Player View.
2. Select the document from which you want to link to a package file or web page.
3. In the Concept pane, click Create link.
4. In the Link to pane, select URL.
5. In the Address field, type or paste the target URL.
6. Click Go or press ENTER.

While selecting a URL, you can also enter a base URL and then follow links in the preview displayed in the results pane to reach your desired target.
7. Click OK or press ENTER.

Link an Attachment as a Concept: Topic Editor

You can manage the concept of a topic directly from the Topic Editor. This allows greater efficiency in editing topics and their concepts and also provides a clearer representation of the overall organization of the topic. You can perform the same concept-related tasks from the Topic Editor as are available from the Outline Editor. The Concept toolpane also provides a preview of the linked concept attachment.

To link a package file or web page as a concept from the Topic Editor:

1. Display the Concept toolpane, if necessary.
2. Click Create link.
3. In the Link to pane, select Document in Library.
   If desired, you can select Packages or Web pages in the Type field to further filter your selection.
4. Navigate the Library to the folder containing the package file or web page to which you want to link.
5. Select the desired package file or web page document.
6. Click OK or press ENTER.

Note: At step 2, you can also click Create new web page to create a new web page and link to it in one step. When you do so, you first specify the name of the web page and the Library folder in which it should be saved. The Concept toolpane then closes, and an empty web page opens in a new tab. After you complete the web page, you can preview its contents in the topic by reactivating the Topic Editor tab.

To link a URL as a concept from the Topic Editor:

1. Display the Concept toolpane, if necessary.
2. Click Create link.
3. In the Link to pane, select 🌐 URL.

4. In the **Address** field, type or paste the target URL.

5. Click ➡️ Go or press ENTER.

   While selecting a URL, you can also enter a base URL and then follow links in the preview displayed in the results pane to reach your desired target.

6. Click **OK** or press ENTER.

### Link to an Attachment from a Topic Frame

Within a topic, you can link from any frame to one or more attachments. Attachments linked at this level provide information to your users as they view a topic. For example, you might link from a frame to a spreadsheet listing department codes or other reference information that users need at a particular step in a procedure. Like concept and bubble text links, links to attachments from topic frames become part of the parent document. If you then move the topic or reuse it elsewhere in your content, the linked attachment remains associated with that frame of the topic. Conversely, deleting the link to an attachment from a topic frame in one location removes the link in all places where the topic is used.

The Frame Link toolpane of the Topic Editor provides the tools for linking to and managing the links to attachments from topic frames. When linking to a package file or web page, you can filter the display to include packages or web pages only and navigate through the Library folders to the specific file you want to link. When linking to a URL, you can type or paste a base URL and then follow links in the preview displayed in the results pane of the Insert Hyperlink dialog box to reach your desired target.

The procedure for linking to an attachment from a topic frame differs slightly from that for concepts and bubble text. When you link to an attachment from a topic frame, you can select an icon for the link and add a tooltip. The icon appears in the frame bubble when the user views the topic in the Player, and the tooltip appears when the user rests the mouse pointer over the link icon. The icon and tooltip are stored with the link itself, rather than with the attachment. Therefore, when you link to the attachment from another location in your content, you can choose to add a different icon and/or tooltip, if desired.

Unlike concepts and bubble text, which can link to only one attachment, a single topic frame can link to multiple attachments. You manage all of the attachments linked at the frame level from the same dialog box, but you can assign a different icon and/or tooltip to each of the links. You can also change the order in which multiple attachments are linked to a single topic frame. As you navigate among the frames in a topic with the Frame Link toolpane open, the display updates dynamically to show the links for each frame. This provides a simple means of managing all frame links in a topic and analyzing the overall topic layout.

To link to a package file or web page from a topic frame:

1. With the topic open in the Topic Editor, navigate to the frame from which you want to link to a package file or web page.

2. Display the Frame Link toolpane, if necessary.

3. In the empty row in the Frame Link toolpane, click the **Name** field to activate it.

4. Click 📂 Create/modify link.

5. In the Link to pane, select 📄 Document in Library.
If desired, you can select **Packages** or **Web pages** in the **Type** field to further filter your selection.

6. Navigate the Library to the folder containing the package file or web page to which you want to link.
7. Select the desired package file or web page document.
8. Click **OK** or press ENTER.
9. An icon is added to the link by default. If desired, change the link icon.
10. The word "Link" is added as the default tooltip. If desired, change the link tooltip.

**Note:** You can repeat steps 3-10 to link to additional package files or web pages from the same frame or click `×` to close the Frame Link Properties toolpane.

**Note:** At step 4, you can also click ![Create new web page](image) Create new web page to create a new web page and link to it in one step. When you do so, you first specify the name of the web page and the Library folder in which it should be saved. The main Developer window then becomes the active window, displaying an empty web page in a new tab. After you complete the web page, you can continue managing frame links in the topic by reactivating the Topic Editor window; the Frame Link Properties window remains open throughout the process.

To link to a URL from a topic frame:
1. With the topic open in the Topic Editor, navigate to the frame from which you want to link to a URL.
2. Display the Frame Link toolpane, if necessary.
3. In the empty row in the Frame Link toolpane, click the **Name** field to activate it.
4. Click ![Create/modify link](image) **Create/modify link**.
5. In the **Address** field, type or paste the target URL.
6. Click ![Go](image) **Go** or press ENTER.
   While selecting a URL, you can also enter a base URL and then follow links in the preview displayed in the results pane to reach your desired target.
7. Click **OK** or press ENTER.
8. An icon is added to the link by default. If desired, change the link icon.
9. The word "Link" is added as the default tooltip. If desired, change the link tooltip.

**Note:** You can repeat steps 3-10 to link to additional URLs from the same frame or click `×` to close the Frame Link Properties toolpane.

**Link to an Attachment from Bubble Text**

As you enter custom text in bubbles and Introduction/End frames, you can link to an attachment from this text. For example, you could use a web page linked at this level to provide a definition of a term. Linked text appears in the frame bubble in color and underlined. When a user clicks linked text while viewing a topic in the Player, the attachment is displayed. If the attachment is a package file, the file opens in its parent
application. If the attachment is a web page or URL, it opens in a new, independent browser window.

**Note:** When a glossary term is used in a manually created bubble text link, no glossary link is created during glossary markup. That is, text used in manually created bubble text links is excluded from glossary markup.

The Bubble Text Link Properties dialog box of the Topic Editor provides the tools for linking to and managing the links to attachments from bubble text. When linking to a package file or web page, you can filter the display to include packages or web pages only and navigate through the Library folders to the specific file you want to link. When linking to a URL, you can type or paste a base URL and then follow links in the preview displayed in the results pane of the Insert Hyperlink dialog box to reach your desired target. The Bubble Text Link Properties dialog box also provides a preview of the linked attachment.

Like concept and frame links, a link to an attachment from bubble text becomes part of the parent document. If you then move or reuse the topic, the linked attachment remains associated with that text in the topic. Conversely, deleting the link to an attachment from bubble text in one location removes the link in all places where the topic is used.

To link to a package file or web page from bubble text:

1. With the topic open in the Topic Editor, navigate to the frame from which you want to link to a package file or web page.
2. Select the bubble text to be linked.
3. In the Frame Properties toolpane, click `Bubble text link`.
4. Click `Create link`.
5. In the Link to pane, select `Document in Library`.
   If desired, you can select Packages or Web pages in the Type field to further filter your selection.
6. Navigate the Library to the folder containing the package file or web page to which you want to link.
7. Select the desired package file or web page document.
8. Click OK or press ENTER.

**Note:** At step 4, you can also click `Create new web page` to create a new web page and link to it in one step. When you do so, you first specify the name of the web page and the Library folder in which it should be saved. The Bubble Text Link Properties dialog box then closes, and an empty web page opens in a new tab. After you complete the web page, you can preview its contents in the topic by reactivating the Topic Editor tab, selecting the appropriate bubble text, and again displaying the Bubble Text Link Properties dialog box as in step 3 above.

To link to a URL from bubble text:

1. With the topic open in the Topic Editor, navigate to the frame from which you want to link to a URL.
2. Select the bubble text to be linked.
3. In the Frame Properties toolpane, click `Bubble text link`. 


4. Click **Create link**.

5. In the Link to pane, select ![URL](image)

6. In the **Address** field, type or paste the target URL.

7. Click **Go** or press ENTER.

   While selecting a URL, you can also enter a base URL and then follow links in the preview displayed in the results pane to reach your desired target.

8. Click **OK** or press ENTER.

### Change the Tooltip of a Frame Link

When you link to attachments at the frame level, you can provide tooltips for the links. These tooltips appear when a user rests the mouse pointer over the link icon while viewing the topic in the Player. By default, the word "Link" is added as the tooltip when the link is created; however, you can change the link tooltip at any time. For example, you might want to use a tooltip that identifies the attachment contents, to provide users with information about the attachment before they launch it.

If you plan to deploy content to one or more Player outputs, use of tooltips is particularly important, especially for links to package files. For example, if a link launches a Flash animation that is several megabytes in size, you might use a tooltip such as "Flash animation of business process (4.65 MB)" to alert users before they click the link. Without such tooltips, users do not have a good indication of the type of content they will be launching or its purpose.

---

**Tip:** Although there is no limit to the length of a tooltip, concise, descriptive tooltips are most useful.

---

To change the tooltip of a frame link:

1. Display the Frame Link toolpane, if necessary.
2. Select the row listing the link for which you want to change the tooltip.
3. In the **Tooltip** field, delete the current text and type the desired tooltip.

### Change the Icon of a Frame Link

When you create a link to an attachment from a topic frame, an icon is added to the link by default; however, you can change the link icon at any time. This icon appears in the frame bubble when a user views the topic in the Player, indicating that additional information is available. Users can then click the icon to launch the linked material. By standardizing your use of link icons, you can provide your users with a consistent visual cue as to the type of information available through each link. You can also add a tooltip for each link to provide a brief text description of the linked attachment.

The Developer comes with a standard set of link icons. You can also create your own custom icons, if desired.

To change the icon of a frame link:

1. Display the Frame Link toolpane, if necessary.
2. Select the row listing the link to which you want to change the icon.
3. In the icon column, click the down arrow to display the list of available icons.
4. Select the desired icon.

Manage Linked Attachments

After you create links from your content to attachments, you might need to change the properties of one or more of the links. For example, you might choose to link from a particular document to a different attachment or to not link from that document to any attachment at all. If the link is from a topic frame, you might also choose to change the link icon or tooltip or to change the order of multiple attachments linked to the same frame.

You can perform any of these actions using the same controls as you used to create the initial links. Specifically, the Concept pane in the Outline Editor and the Concept Properties dialog box provide the tools for managing the links to concept attachments. The Frame Link Properties toolpane in the Topic Editor provides the tools for managing the links to frame attachments. Finally, the Bubble Text Link Properties dialog box provides the tools for managing the links from bubble text.

Change a Link Target

Once you have created a link from your content to an attachment, you might need to change the target of the link. You do not need to delete the link to the current attachment first; you can simply redirect the link to the new target.

To change the attachment linked as a concept from the Outline Editor:

1. With the outline open in the Outline Editor, display the Player View.
2. Select the document for which you want to change the linked concept attachment.
3. In the Concept pane, click Create link.
4. On the Link to pane, select the type of link target as Document in Library or URL.
5. Depending on your selection in the preceding step, navigate to the target document or file or type or paste the target URL in the Address field.
   When selecting a URL, you can also enter a base URL and then follow links in the preview displayed in the results pane to reach your desired target.
6. Click OK or press ENTER.

To change the attachment linked as a concept from the Topic Editor:

1. Display the Concept toolpane, if necessary.
2. Click Create link.
3. On the Link to pane, select the type of link target as Document in Library or URL.
4. Depending on your selection in the preceding step, navigate to the target document or file or type or paste the target URL in the Address field.
When selecting a URL, you can also enter a base URL and then follow links in the preview displayed in the results pane to reach your desired target.

5. Click OK or press ENTER.

To change an attachment linked at the frame level:

1. With the topic open in the Topic Editor, navigate to the frame for which you want to change a linked attachment.
2. Display the Frame Link toolpane, if necessary.
3. In the list of linked attachments, select the row of the linked attachment to be changed.
4. Click Create link.

5. On the Link to pane, select the type of link target as Document in Library or URL.
6. Depending on your selection in the preceding step, navigate to the target document or file or type or paste the target URL in the Address field.

When selecting a URL, you can also enter a base URL and then follow links in the preview displayed in the results pane to reach your desired target.

7. Click OK or press ENTER.
8. Click to close the Frame Link Properties toolpane.

To change an attachment linked to bubble text:

1. With the topic open in the Topic Editor, navigate to the frame containing the bubble text for which you want to change the linked attachment.
2. In the Frame toolpane, click Bubble text link.
3. Click Create Link.

4. On the Link to pane, select the type of link target as Document in Library or URL.
5. Depending on your selection in the preceding step, navigate to the target document or file or type or paste the target URL in the Address field.

When selecting a URL, you can also enter a base URL and then follow links in the preview displayed in the results pane to reach your desired target.

6. Click OK or press ENTER.

**Edit a Linked Package File**

If you need to edit a package file that is linked to your content, you can access the package that contains the file directly from the parent document to which it is linked. This saves you the step of having to navigate through the Library to locate the package and open it directly.
Multi-user Considerations

Before you can perform this action, you must check out the document. After you save any changes, you should check in the document to make it available to other authors and add the changes to the Developer's version control system. You need to check out only the package, not the parent document to which the package file is linked.

If the package is not checked out, you will be prompted to check it out before proceeding. Click Yes to continue and edit the package. Click No to cancel the process and return to your starting point; the package does not open in read-only mode.

To edit a package file linked as a concept from the Outline Editor:

1. With the outline open in the Outline Editor, display the Player View.
2. Select the document for which you want to edit the linked concept package file.
3. In the Concept toolpane, click Edit package.
   The package containing the linked file opens in a new tab for editing.
4. Double-click the file to open it in its native application, and edit the file as necessary.
5. Save the file and close the application.
6. Save and close the package.
   In the Outline Editor, the Concept pane refreshes, showing the changes to the concept package file.

To edit a package file linked as a concept from the Topic Editor:

1. With the topic open in the Topic Editor, on the View menu, point to Panes and choose Concept, if necessary.
2. Click Edit package.
   When you do so, the Concept Properties dialog box closes, and the main Developer window becomes the active window, displaying the package containing the linked file in a new tab for editing.
3. Double-click the file to open it in its native application, and edit the file as necessary.
4. Save the file and close the application.
5. Save and close the package.
   You can preview the changes from the topic by reactivating the Topic Editor window and again displaying the Concept Properties dialog box as in step 2 above.

To edit a package file linked at the frame level:

1. With the topic open in the Topic Editor, navigate to the frame for which you want to edit the linked package file.
2. On the View menu, point to Panes and choose Frame Link, if necessary.
3. In the list of linked attachments, select the row of the package file to be edited.
4. Click **Edit package**.
   When you do so, the main Developer window becomes the active window, displaying the package containing the linked file in a new tab for editing.
5. Double-click the file to open it in its native application, and edit the file as necessary.
6. Save the file and close the application.
7. Save and close the package.

To edit a package file linked to bubble text:

1. With the topic open in the Topic Editor, navigate to the frame containing the bubble text for which you want to edit the linked package file.
2. In the Frame toolpane, click **Bubble text link**.
3. Click **Edit package**.
   When you do so, the Bubble Text Link Properties dialog box closes, and the main Developer window becomes the active window, displaying the package containing the linked file in a new tab for editing.
4. Double-click the file to open it in its native application, and edit the file as necessary.
5. Save the file and close the application.
6. Save and close the package.

   You can preview the changes from the topic by reactivating the Topic Editor window, selecting the appropriate bubble text, and again displaying the Bubble Text Link Properties dialog box as in step 3 above.

**Edit a Linked Web Page**

If you need to edit a web page that is linked to your content, you can access the web page for editing directly from the parent document to which it is linked. This saves you the step of having to navigate through the Library to locate the web page and open it directly.

**Multi-user Considerations**

Before you can perform this action, you must check out the document. After you save any changes, you should check in the document to make it available to other authors and add the changes to the Developer's version control system. You need to check out only the web page, not the parent document to which it is linked.

If the web page is not checked out, you will be prompted to check it out before proceeding. Click Yes to continue and edit the web page. Click No to cancel the process and return to your starting point; the web page does not open in read-only mode.

To edit a web page linked as a concept from the Outline Editor:

1. With the outline open in the Outline Editor, display the Player View.
2. Select the document for which you want to edit the linked concept web page.
3. In the Concept toolpane, click **Edit web page**.
The web page opens in a new tab for editing.

4. Edit the web page as necessary.

5. Save and close the web page.

In the Outline Editor, the Concept pane refreshes, showing the changes to the concept web page.

To edit a web page linked as a concept from the Topic Editor:

1. With the topic open in the Topic Editor, display the Concept toolpane, if necessary.

2. Click **Edit web page**.

   When you do so, the Concept Properties dialog box closes, and the main Developer window becomes the active window, displaying the web page in a new tab for editing.

3. Edit the web page as necessary.

4. Save and close the web page.

   You can preview the changes from the topic by reactivating the Topic Editor window and again displaying the Concept Properties dialog box as in step 2 above.

To edit a web page linked at the frame level:

1. With the topic open in the Topic Editor, navigate to the frame for which you want to edit the linked web page.

2. Display the Frame Link toolpane, if necessary.

3. In the list of linked attachments, select the row of the web page to be edited.

4. Click **Edit web page**.

   When you do so, the main Developer window becomes the active window, displaying the web page in a new tab for editing.

5. Edit the web page as necessary.

6. Save and close the web page.

To edit a web page linked to bubble text:

1. With the topic open in the Topic Editor, navigate to the frame containing the bubble text for which you want to edit the linked web page.

2. In the Frame Properties toolpane, click **Bubble text link**.

3. Click **Edit web page**.

   When you do so, the Bubble Text Link Properties dialog box closes, and the main Developer window becomes the active window, displaying the web page in a new tab for editing.

4. Edit the web page as necessary.

5. Save and close the web page.

   You can preview the changes from the topic by reactivating the Topic Editor window, selecting the appropriate bubble text, and again displaying the Bubble Text Link Properties dialog box as in step 3 above.
Delete an Attachment Link

You can delete the link to an attachment from a document, topic frame, or bubble text at any time. For example, you might decide that an attachment linked at the fourth frame of a topic should be linked at the sixth frame instead. In this case, you cannot just change the link target; you need to completely remove the link from the fourth frame. When you delete the link to an attachment, you are not deleting it; you are simply removing the link. The attachment is still in the Library and available for use.

You can delete links to attachments from the Outline Editor (concepts only) or from the Topic Editor (topic concepts and frame and bubble text links).

To delete the link to a concept attachment from the Outline Editor:

1. With the outline open in the Outline Editor, display the Player View.
2. Select the document from which you want to delete the attachment link.
3. In the Concept toolpane, click Delete link.

To delete the link to a concept attachment from the Topic Editor:

1. With the topic open in the Topic Editor, display the Concept toolpane, if necessary.
2. Click Delete link.
3. Click OK.

To delete the link to a frame attachment:

1. With the topic open in the Topic Editor, navigate to the frame from which you want to delete the link to an attachment.
2. Display the Frame Link toolpane, if necessary.
3. In the list of attached documents, select the row of the attachment link to be deleted.
4. Click Delete link.
5. Click X to close the Frame Link toolpane.

To delete the link to a bubble text attachment:

1. With the topic open in the Topic Editor, navigate to the frame from which you want to delete the link to a bubble text attachment.
2. In the Frame Properties toolpane, click Hyperlink Properties.
3. Click Delete link.
4. Click OK.

Change the Icon of a Frame Link

When you create a link to an attachment from a topic frame, an icon is added to the link by default; however, you can change the link icon at any time. This icon appears in the frame bubble when a user views the topic in the Player, indicating that additional information is available. Users can then click the icon to launch the linked material. By standardizing your use of link icons, you can provide your users with a consistent visual cue as to the type of information available through each link. You can also add a tooltip for each link to provide a brief text description of the linked attachment.
The Developer comes with a standard set of link icons. You can also create your own custom icons, if desired.

To change the icon of a frame link:
1. Display the Frame Link toolpane, if necessary.
2. Select the row listing the link to which you want to change the icon.
3. In the icon column, click the down arrow to display the list of available icons.
4. Select the desired icon.

**Change the Tooltip of a Frame Link**

When you link to attachments at the frame level, you can provide tooltips for the links. These tooltips appear when a user rests the mouse pointer over the link icon while viewing the topic in the Player. By default, the word "Link" is added as the tooltip when the link is created; however, you can change the link tooltip at any time. For example, you might want to use a tooltip that identifies the attachment contents, to provide users with information about the attachment before they launch it.

If you plan to deploy content to one or more Player outputs, use of tooltips is particularly important, especially for links to package files. For example, if a link launches a Flash animation that is several megabytes in size, you might use a tooltip such as "Flash animation of business process (4.65 MB)" to alert users before they click the link. Without such tooltips, users do not have a good indication of the type of content they will be launching or its purpose.

**Tip:** Although there is no limit to the length of a tooltip, concise, descriptive tooltips are most useful.

To change the tooltip of a frame link:
1. Display the Frame Link toolpane, if necessary.
2. Select the row listing the link for which you want to change the tooltip.
3. In the **Tooltip** field, delete the current text and type the desired tooltip.

**Change the Order of Multiple Frame Links**

More than one web page can be linked to a topic frame. By default, the attachments appear in the order in which they were linked. However, you can easily change the order of the linked attachments.

To change the order of multiple frame links:
1. Open the topic in the Topic Editor.
2. Navigate to the frame for which you want to change the link order.
3. Display the Frame Link toolpane, if necessary.
4. In the list of linked attachments, select the row of an attachment whose order you want to change.
5. Use the **Move Up** and **Move Down** arrows to move the attachment to the desired position in the list.
6. Repeat steps 4 and 5 as needed to obtain the desired order of linked attachments.
7. Click ✗ to close the Frame Link toolpane.

**Create a Custom Icon**

In addition to using the standard icons, you can create your own custom icons. You might want to create a custom icon that is consistent with those used in existing documentation, for example, or one that is based on your company logo. You can also make a new icon by starting with an existing icon, editing it as necessary, and saving it with a new name.

To be used as a custom icon, a graphic file must satisfy the following constraints:

- It must be 22 pixels x 22 pixels in size.
- It must be saved in .png, .jpg, or .gif format.
- It must be saved in a package in the Library folder System/Icons/Custom.

An empty Custom folder is present in your Library by default, even if your content does not currently include custom icons.

**Note:** The color depth for icons is unrestricted, although 8- or 16-bit color is typically sufficient.

When you change the icon of a frame link, you see a preview of each icon file saved in the folders System/Icons/Standard and System/Icons/Custom. You cannot browse to any other Library location to select an icon saved elsewhere. Also, if any file saved in a package in either of these folders does not satisfy the requirements for use as an icon (22 pixels x 22 pixels; .png, .jpg, or .gif format), you will not be able to select it as an icon. In this case, you must edit the file in the package in order to use it as an icon.

You can simplify icon management by taking the following approach:

- Save only one icon per package.
- Use the same name for the package and the icon file it contains.
- Ensure that only valid icon files, contained in packages, are saved in the Library folders System/Icons/Standard and System/Icons/Custom.

**Multi-user Considerations**

Any new document that you create or link is automatically checked out to you. If you want to make a new document available to multiple authors and place the document under the Developer’s version control system, you must check it in.

See *Check In and Check Out Documents* in *Use the Developer in a Multi-user Environment* for more information.

To create a custom icon:

1. In your image editing software, create a graphic appropriate for use as a link icon. You can also make a new icon by starting with an existing icon and editing it as necessary.
   
   An icon graphic must be 22 pixels x 22 pixels and must be of .png, .jpg, or .gif format.

2. Create a new package.
3. Add the image file to the package.
4. Save the package in the folder System/Icons/Custom.

**Tip:** To simplify icon management, use the same name for the custom icon file and the package in which it is saved.

**Warning!** No size or format validation is performed when you add a custom icon to the Library. Therefore, you should verify that the file satisfies the requirements for use as an icon before adding it to the Library.
8. Enhance Content with Sound

The Developer provides the tools that you need to create and edit sound to deploy in your content without any specialized audio applications. You can add sound during topic recording using the Recorder (with sound enabled) or to an existing topic using the Topic Sound Recorder.

Once recorded, you can use the Sound Editor to make adjustments to recordings.

Sound can be created on frame by frame basis but when you edit a frame, the sound file for the previous and next frames (if they exist) are combined with the current sound file. This allows for a seamless adjustment of sound with the neighboring frames. Once saved, the files are split back out to the associated frames but are stored together with the sounds that make up the topic.

Sound Recording Best Practices

Audio recording is a noise-sensitive process that requires a quiet space, free from typical ambient office sounds such as voices, phones, air-conditioning, street noise, and so on. Choose an office space to record in that has minimal evident street noises. Listen for air-conditioning hum, voices, and other obvious noise in the space. If there are blinds in the windows, lower them to further reduce outside noise. If you are recording in more than one session, be sure to record in the same space each time. This reduces obvious changes in sound quality.

Selecting a Microphone

There are many microphones available to use with your computer. DO NOT use the internal microphone on your computer; it is not appropriate to record narration, as it will pick up hard-drive and cooling-fan noise. USB microphones are primarily made for low budget applications and are not recommended for professional recording. These microphones tend to add background noise and have limited dynamic range.

Noise cancellation or rejection microphones are recommended. These microphones only pick up the sound from directly in front of the microphone. A windscreen helps cut the sound of the speakers breathing. Some microphones listen for sound from all directions and are not recommended because they will pickup extraneous sounds during recording.

Microphones designed for the telephone are not a good choice because they usually use only mid range frequencies to reduce bandwidth requirements. Choose a microphone with a wide frequency range (100Hz to 15kHz). Analog microphones are preferable because they plug directly into the audio card microphone input and can take advantage of the computer's pre-amp instead of the lesser quality pre-amp typically found in a USB cable.

When using an external microphone, always turn off the Line In and Internal Mic controls to prevent interference in the recording quality. Close any extraneous applications on your computer, particularly those with alerts and sounds, such as email that has new mail notification. These sounds will record with the audio if not turned off.

For additional microphone information, go to http://www.microphones.com.

Position Microphone

Choose a microphone with a headset mount or a stand. If you are using a free-standing microphone, always place the microphone in the same location to help ensure recording levels are the same for each recording session. With free standing microphones, you often have to turn up the gain to increase the signal enough to get a good recording. Turning up the gain also turns up the background noise. Moving closer to the microphone can eliminate the need to turn up the gain but often creates an uncomfortable position and is
not ideal for long recording sessions. If you are using a headset, position the microphone several inches away and below your mouth so that when you speak, you are speaking over the microphone. This reduces the risk of distorting the signal into the computer. A headset with a flexible boom microphone that moves with the speaker is ideal for long recording sessions.

Create a script for your narration
Scripts are helpful when you record audio. They ensure that the final presentation flows coherently and incorporates the appropriate level of detail, ensuring that the audio portion delivers easily and the message is clear and succinct.

Create a test recording to determine the proper levels
Record the narration for the first page of your presentation using the Sound Recorder's VU meter to monitor the modulation, then review the audio for quality.

Record in one session
It is very clear when a narrator has recorded audio at different times and on different equipment. This can distract learners. If possible, plan enough time to record your presentation, play it back, and edit the audio in a single session.

Set Sound Playback and Record Options
Do not mute the speaker on your computer while you are recording because sounds are used to indicate Record and Pause states.

To prevent feedback, set your Windows audio to mute the Playback microphone. These instructions are specific to Windows XP. If you are running a different version of Windows, they will be similar, but not exact.

To set sound playback and record options:

1. Open the Control Panel.
2. Double-click Sounds and Audio Devices.
3. Click the Audio tab to display the sound playback and recording options.
4. In the Sound Playback section, click Volume to display the Volume Control window.
5. For Microphone, choose Mute to disable the device and prevent feedback during recording.
6. Close the Volume Control window.
7. In the Sound Recording section, click the Volume to display the Recording Control window.
8. For Microphone, choose Select to enable the device to record.
9. If using an external microphone, turn the volume all the way down on the Line In and Internal Mic to prevent interference in the recording quality.
10. Close the Recording Control window to return to the Sounds and Audio Devices Properties window.
11. Click the Apply to save changes.
12. Click the OK exit the Sounds and Audio Devices Properties window.

Record Sound
You can record sound at:
• Content creation - when the content is created via the Recorder (for example, when recording a topic) or via the Sound Editor toolpane (for example, when recording sound on a new web page).

• Post content creation - using the Sound Editor toolpane (for example, replacing the sound on an existing web page).

Enable Sound

You enable sound in the Developer by selecting a few settings on the Options dialog box accessed from the Tools menu.

Sound settings are located in the Recorder and Content Default (Recorder) categories:

Recorder category

• Sound Recording: Use these options to control how sound is recorded with a topic.
  
  Record sound with topic: By default, the recorder is not set to record sound with a topic. Click this option to enable sound recording on the Recorder. The display of the Recorder depends on the state of this option and the Screenshot capture mode (Automatic or Manual). See Recorder Logic for more on Screenshot capture mode.

  Sound pause key: By default, the Recorder uses the PAUSE key to pause sound recording for a topic. If the PAUSE key is difficult or inconvenient for you to use, you can change the Recorder sound pause key. You can use any of the function keys, or a combination of any of the function keys (F1 thru F12) and the ALT key, CTRL key, and/or SHIFT key.

  If you change the Sound pause key, you should select a key or key combination that is not used in the target application for another purpose. For example, pressing the F1 key in some applications opens a Help window. Therefore, for those applications you would not want to use the F1 key to capture the screenshots.

Content Default (Recorder)

Automatically ensure consistent sound recording levels: When recording sound, signal levels and noise can vary widely. Use this option to ensure a consistent recording level, from start to finish, by automatically raising or lowering the signal. The signal level adjustment is performed at the moment a recording is created from the Recorder or Sound Editor.

Configure the Recorder for Sound

The Recorder behavior varies based on how the Screenshot capture mode (Manual or Automatic) and Sound Recording (Record sound with topic) are set.

The Recorder behavior is summarized in the following table.
Option settings | Behavior when Recorder opens | Behavior after user interaction | Behavior after first PrintScreen
--- | --- | --- | ---
Record sound with topic is On | Sound icon is On | If user toggles Sound button Off, the "Next screenshot records: Start Screen Sound" displays in message area. | Start screenshot sound is recorded.
Screenshot capture is Manual | Microphone and VU meter are On in recorder and deskband. "Next screenshot records: Start Screen Sound" displays in message area. | "Next screenshot records: Start Screen" displays in message area.

Record sound with topic is On | Sound icon is On | If user toggles Sound button Off, "Next screenshot records: Start Screen" displays in message area. | Start screenshot sound is recorded.
Screenshot capture is Automatic | Microphone and VU meter are On in recorder and deskband. | Record button replaces sound button.

Record sound with topic is Off | Sound icon is muted. Microphone and VU meter are disabled for recorder and deskband. "Next screenshot records: Start Screen Sound" displays in message area. | If user toggles Sound button On, Microphone and deskband are enabled. "Next screenshot records: Start Screen Sound" displays in message area. | Start screen is recorded. Microphone and VU meter are disabled for recorder and deskband.
Screenshot capture is Manual

Record sound with topic is Off | Sound icon is muted. | If user toggles Sound button On, Microphone and deskband are enabled. | Start screen is recorded.
Screenshot capture is Automatic

Record Sound When Recording a Topic
If sound is enabled in Tools, Options, the icons for recording sound appear at the bottom of the Recorder.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔴</td>
<td>Starts recording sound on the current screen.</td>
</tr>
<tr>
<td>🔴</td>
<td>Opens the Microsoft Windows Recording Control allowing you to choose an input device or adjust the volume.</td>
</tr>
<tr>
<td>🔴</td>
<td>Visual indicator of the amplitude of the speaker's voice.</td>
</tr>
</tbody>
</table>

How these icons function depends on the Screenshot capture mode (Manual or Automatic).

Use the Recorder Deskband in Automatic Record Mode
A deskband is a dockable window on your desktop that is designed to minimize programs you want to keep running but only use on occasion. These programs do not take up space on the Taskbar and only display when necessary.
If the Recorder is configured to record sound and is in automatically record screenshot mode, the camera sound that occurs when recording a frame is disabled so it is not part of the recording. When you press PRINTSCREEN during the recording process, the Recorder deskband appears in the taskbar providing a visual camera cue that a screenshot is being taken. The Recorder deskband also contains other icons to make adjustments to sound recordings.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Pause button]</td>
<td>When sound is being recorded, the Pause button displays. When sound recording is paused, the Record button displays. Activate recording by clicking the Record button.</td>
</tr>
<tr>
<td>![Recording Control]</td>
<td>Opens the Recording Control window for adjusting input device and microphone volume. This icon is only active in Pause mode.</td>
</tr>
<tr>
<td>![Recording level]</td>
<td>This is a visual scale depicting the recording level. Levels range from no color (no recording level), through Green, Dark Green, Yellow and Red (Very High recording level).</td>
</tr>
<tr>
<td>![Screenshot indicator]</td>
<td>This visual indicator appears when a screenshot is taken if the Recorder is configured to automatically record screenshots. This space on the deskband is blank when a screenshot is not being recorded.</td>
</tr>
</tbody>
</table>

**Record Sound in a Topic using the Sound Editor**

Record Sound on the Sound Editor toolpane of the Topic Editor lets you record sound on a frame or series for frames of an existing topic.

The mode of the Sound Recorder depends on the selection when the Record Sound button is pressed. If a sound segment is selected, the Sound Recorder opens in Record Selection mode and the new sound replaces the selected segment. If nothing is selected, the Sound Recorder opens in Record Frame mode and the new sound replaces the sound on the frame.

The Sound Recorder displays the Windows default recording device and input channel detected at the time the Developer launched. You can change the default recording device or input channel on the Properties window of the Recording Controls dialog box while the Developer is running.

If a USB recording device is added as the Windows default device while the Developer is running, the device is not recognized and the Sound Recorder continues to use the device set when the Developer launched. If the Sound Recorder is using a USB recording device and the device is disconnected, an error message displays in the status area.

---

**Note:** Record Sound is inactive on selections that cross frames.

To record sound on a existing topic or web page:

1. Click the location in the waveform where you want to record sound.
2. Click **Record Sound**.
   
   The Sound Recorder opens in Record Sound mode and recording begins.
3. Record the desired sound using the or to navigate the frame structure if recording over multiple frames.
4. Click **OK**.
Record Sound in a Web Page using the Sound Editor

Record Sound on the Sound Editor toolpane of the Web Page Editor lets you record sound on a web page.

The mode of the Sound Recorder depends on the selection set when the Record Sound button is pressed. If a sound segment is selected in the waveform, the Sound Recorder opens in Record Selection mode and the new sound replaces the selected segment. If no selection set is made in the waveform, the Sound Recorder opens in Record Sound mode and the new sound replaces sound previously recorded on the web page.

The Sound Recorder displays the Windows default recording device and input channel detected at the time the Developer launched. You can change the default recording device or input channel on the Properties window of the Recording Controls dialog box while the Developer is running.

If a USB recording device is added as the Windows default device while the Developer is running, the device is not recognized and the Sound Recorder continues to use the device set when the Developer launched. If the Sound Recorder is using a USB recording device and the device is disconnected, an error message displays in the status area.

To record sound on a web page:

1. Display the Sound Editor toolpane in the Web Page Editor.
2. Click Record Sound.
3. Record the desired sound.
4. Click OK.
   The newly recorded sound covers the entire waveform and replaces any exiting sound on the web page.

To record over a selected sound segment on a web page:

1. Display the Sound Editor toolpane in the Web Page Editor.
2. Left click and drag in the waveform to select the sound segment to be recorded over.
3. Click Record Sound.
   The Sound Recorder opens in Record Sound mode and recording begins.
4. Record the desired sound.
5. Click OK.
   The newly recorded sound replaces the selected sound.

Insert Sound

Insert Sound allows you to insert a new segment of sound into the waveform. For example, if you need to insert a new sentence or paragraph into your recording, you can insert the sound instead of rerecording the entire sound file. Clicking Insert Sound opens the Sound Recorder in Insert Sound mode. The toolbar is identical to Sound Recorder in Record Frame mode but the new sound is inserted at the selection point without overwriting the existing sound in the waveform.
Note: Insert Sound is inactive if a segment is selected in the waveform. Sound can only be inserted at a marker in a waveform

To insert sound:

1. Click the location in the waveform to insert a new recording.
2. Click 🎧 Insert Sound.
   The Sound Recorder opens in Insert Sound mode and begins recording.
3. Record the desired audio or use the Sound Recorder toolbar to make adjustments.
4. Click OK.
   The new sound is added to the waveform without overwriting the existing sound.

Import a Sound File

If you have access to a prerecorded sound file that you want to use in your content, you can import the sound file. Supported file formats include .aiff, .aif, .au, .mp3, .snd, .wav or .wma. The sound file is embedded into the topic.

Note: You can not import an .mp3 file into a web page.

Importing .mp3 files into topics

You can import an .mp3 file into a topic but you can not edit it in the Sound Editor. To edit an .mp3 file, export it, edit it using a valid MP3 editor and import the file back into the Sound Editor.

Note: You can bulk import sound files to a Library. This allows you to use a central folder for your sound files. See Import Sound Files in Bulk for more information.

To import a sound file:

1. Display the Sound Editor toolpane and select the frame or webpage where you want to import a sound file.
2. Click 🎧 Import Sound.
3. In the Import Audio dialog box, click the Look in list box and choose the drive where the file is located.
4. Open the folder where the file is located and choose a file.
5. Click Open.
   The sound file is imported into the selected frame.

Export a Sound File

After you have recorded sound for your content, you can edit it or use it in another application by exporting the sound file.

Note: You can bulk export sound files from your outline. This allows you to use a central folder for your sound files. See Export Sound Files in Bulk for more information.
To export a sound file:

1. Display the Sound Editor toolpane and select the frame or webpage with the sound to export and click Export.
2. Navigate to the destination export location and select (or enter) a file name.
3. Click the Save.

Edit Sound

The Developer has a fully functional Sound Editor built in to the Topic Editor. You can edit sound frame by frame or across frames on a topic or edit the sound on a web page using the Sound Editor toolpane.

Sound Editor Toolpane

The Sound Editor toolpane is used to manipulate the sounds associated with each frame of a topic or a webpage. The Sound Editor toolpane is made up of a waveform and a toolbar.

The waveform is a visual representation of the shape and form of the sound signal. You can use the Sound Editor controls to locate, select and edit all or parts of the sound in the waveform.

Note: When you edit sound for a topic, the Sound Editor toolpane displays a temporary sound file made up of the current frame and the sound from the previous and next frames (if they exist). When the file is saved, the sound file is stored as three separate sound files.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Audio Import" /></td>
<td>Opens the Audio Import dialog box for importing sound into the current frame or webpage.</td>
</tr>
<tr>
<td><img src="image" alt="Audio Export" /></td>
<td>Opens the Audio Export dialog box for exporting sound from the current frame or webpage.</td>
</tr>
<tr>
<td><img src="image" alt="Sound Recorder" /></td>
<td>Launches the Sound Recorder to record sound on a frame or frames or on a webpage.</td>
</tr>
<tr>
<td><img src="image" alt="Insert Mode" /></td>
<td>Opens the Sound Recorder in an insert mode so a new piece of sound can be added at the insertion point without overwriting any existing sound.</td>
</tr>
<tr>
<td><img src="image" alt="Play" /></td>
<td>Plays the sound from the beginning or from a selection point if one is selected.</td>
</tr>
<tr>
<td><img src="image" alt="Pause" /></td>
<td>Pauses the playback of a sound file. Once the Play or Play frame buttons are pressed, they are replaced by the Pause button.</td>
</tr>
<tr>
<td><img src="image" alt="Stop" /></td>
<td>Plays the sound from the beginning to the end of the current frame. This icon does not display when editing sound on a webpage.</td>
</tr>
<tr>
<td><img src="image" alt="Stop" /></td>
<td>Stops the playback of the sound file.</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copies the selection to the clipboard and removes it from the waveform.</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copies the selection to the clipboard and retains it in the waveform.</td>
</tr>
<tr>
<td><img src="image" alt="Paste" /></td>
<td>Inserts the copied or cut selection and inserts it at the cursor or replaces the selection.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Deletes the selection in the waveform. Delete selection reduces the timeline of the waveform. This is grayed out if nothing is selected.</td>
</tr>
</tbody>
</table>
Cut, Copy and Paste Sound

The Topic Sound Editor contains tools for copying, cutting and pasting pieces of sound in the waveform.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Copies the selected portion of the waveform in to the clipboard. The waveform updates and removes the cut selection. Cut is disabled until a selection is made in the waveform.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Copies the selected portion of the waveform to the clipboard. The waveform is left unchanged. Copy is disabled until a selection is made in the waveform.</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Inserts sound from the clipboard to the waveform. The pasted sound is added to the waveform at the insertion point. Paste is disabled unless something has been copied or cut to the clipboard.</td>
</tr>
</tbody>
</table>

To copy and paste a piece of sound:

1. Click and drag in the waveform to select the piece of the sound you want to copy.
2. Choose **Copy**.
   You can also right-click your selection and choose Copy.
3. Select the destination location where you want to paste your selection.
The destination location can be within the current waveform or a waveform in another topic.

4. Choose 

To cut a piece of sound:

1. Left click and drag in the waveform to select the piece of the sound you want to cut.

2. Choose 

You can also right-click your selection and choose Cut.

To cut and paste a piece of sound:

1. Left click and drag in the waveform to select the piece of the sound you want to cut.

2. Choose 

You can also right-click your selection and choose Cut.

3. Select the destination location where you want to paste your selection.

The destination location can be within the current waveform or a waveform in another topic.

4. Choose 

You can also right-click the document where you want to paste your selection and choose Paste.

Delete a Sound

If you do not want a segment of existing sound, you can delete it and compress the waveform by the size of the deletion. Delete is only active if a piece of sound is selected in the waveform.

To delete a piece of sound:

1. Left click and drag in the waveform to select the piece of the sound you want to delete.

2. Click

Select a Frame

When working with sound across frames, the sound displaying in the Sound Editor is often over more than just the current frame. If you want to work with only the sound on a frame, you can use Select Frame to highlight the piece of sound associated with the current frame.

To select the current frame in the waveform:

1. Choose 

The sound associated with the current frame is highlighted in the waveform.
Deselect a Sound

Many Sound Editor functions are applied against a selection that you make in the waveform. When a piece of sound is selected, either by Select Frame or by clicking and dragging in the waveform, the Deselect button becomes active. Use Deselect to cancel the selection displayed in the waveform.

To deselect a sound in the waveform:

1. Choose Deselect All.

   Any selected piece of sound in the waveform is deselected.

Adjust the Start and Stop Point of Sound in a Frame

When working with sound recorded over a series of frames, you may need to adjust where the sound begins and/or ends on a specific frame. You can make these adjustments with Set Frame Sound Start and Set Frame Sound End. Any pieces of sound excluded from the frame by the adjustment become part of the sound for the previous or next frame. For example, if the start marker is moved 3 seconds to the right, those three seconds that where part of the current frame become part of the previous frame. If no previous or next frame is available, the buttons are disabled.

To set the start of frame sound:

1. Click the location in the waveform of a frame where you want the current frame sound to start.

2. Click Set start of frame sound.

   The solid yellow vertical line marks where the frame sound starts. Any sound to the left of this marker that was previously in the frame becomes part of the previous frame sound. Any sound to the right of this marker that was previously in the frame become part of the sound for the next frame.

To set the end of frame sound:

1. Click the location in the waveform of a frame where you want the sound to end.

2. Click Set end of frame sound.

   The solid yellow vertical line marks where the frame sound ends. Any sound to the right of this marker that was previously in the frame becomes part of the next frame sound. Any sound to the left of this marker that was previously in the frame become part of the sound for the previous frame.

Crop Sound to Selection

When editing sound, you may need to remove the sound before and after the sound. For example, you made final edits and you want to discard some extraneous sound before and after your edited sound. You can make these adjustments by cropping sound with Crop Sound to Selection by selecting the sound you want to keep. All sound in the waveform that is not selected is replaced with the selection. Your selection set can be across frames and the frame markers will be preserved.

If no sound is selected, the button is disabled.
To crop the sound in a frame:

1. Click and drag in the waveform to select the piece of the sound you want to crop to.

2. Click **Crop to selection**
   
   All frame sound in the waveform that is outside the selection set is replaced with the selection.

### Zooming to a Sound

When working with sound in the Sound Editor, the waveform often displays sound across more than one frame. The ability to zoom makes it easier to keep track of the frame sound on which you are working.

The Sound Editor provides the following zoom modes:

<table>
<thead>
<tr>
<th>Zoom Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom to current frame</td>
<td>Centers the current frame in the waveform with portions of the previous and next frames on either side. The gray slider bar shows the duration of the current frame with respect to the entire sound file.</td>
</tr>
<tr>
<td>Zoom to previous and next frame</td>
<td>Displays the entire waveform (previous, current and next frames). The gray slider bar spans the entire waveform.</td>
</tr>
<tr>
<td>Zoom to selection</td>
<td>Displays the selected piece of sound in the waveform. The gray slider bar shows the duration of the selected sound with respect to the entire sound file.</td>
</tr>
</tbody>
</table>

Once a zoom mode is selected, it remains the mode until a different mode is selected. The active mode is indicated with a checkmark in the Zoom menu. Dragging the gray slider changes the zoom and removes the checkmark next to the selected predefined zoom mode.

**Note:** The Sound Editor toolpane in the Web Page Editor only contains the Zoom to selection mode.

To zoom to the current frame:

1. From the **Zoom** menu, click **Zoom to current frame**.
   
   The current frame displays in the middle of the waveform with portions of the previous and next frame on either side.

To zoom to the previous and next frames:

1. From the **Zoom** menu, click **Zoom to previous and next frame**.
   
   The entire previous, current, and next frames display in the waveform.

To zoom to a selected piece of sound:

1. Left click and drag in the waveform to select the piece of the sound you want zoom.

2. From the **Zoom** menu, click **Zoom to selection**.
The selected sound only displays in the waveform.

**Adjust Volume Controls**

You can adjust the volume of a sound using the standard Windows Volume Control dialog box. These are the same controls accessed by double-clicking the sound icon on the taskbar.

Refer to the Windows Volume Control help for more information on these controls.

![To adjust sound volume:](image)

1. Choose **Playback volume** and make the necessary volume adjustments.

**Extend Timeline**

You can add silence to the end of the waveform to extend the timeline. The time added is always at the end of the waveform regardless of what is selected. The silence added is designated in minutes and seconds.

![To add silence to the end of a frame:](image)

1. On the **Options** drop-down list, choose **Extend Timeline**.
2. Select the amount of silence to be added using the spinbox control.
3. Click **OK**.

**Add Silence**

Add silence allows you to add a user specified amount of silence at the point selected in the waveform. Add Silence is disabled unless something is selected in the waveform. If a selection point is made in the waveform, the Add Silence dialog opens allowing you to specify the amount of time (in minutes and seconds) of silence to be added at that point. If a piece of sound is selected in the waveform, silence replaces that piece of sound.

![To add silence at a selected point:](image)

1. Select an insertion point in the waveform.
2. On the **Options** drop-down list, choose **Add Silence**.
3. Select the amount of silence to be added using the spinbox control.
4. Click **OK**.

![To add silence over a selected piece of sound:](image)

1. Left click and drag to select a piece of sound in the waveform.
2. On the **Options** drop-down list, choose **Add Silence**.
   The selected sound is replaced with silence.

**Amplify Sound**

Amplify allows you to increase or decrease the audio signal of the selected sound resulting in a louder or softer sound.
Enhance Content with Sound

Amplify is disabled if no sound is selected in the waveform. Once a selection is made in the waveform, the Amplify menu item is enabled. Use the slider control or spinbox to increase amplification by up to 400% or decrease amplification to as low as 1%.

ıdır To amplify a sound:

1. Left click and drag in the waveform to select the sound to amplify.
2. On the Options drop-down list, choose Amplify.
3. Increase or decrease the amplification using the slider or spinbox control.
4. Click OK.

Play Sound

After you have recorded or imported sound, you can play it back to verify the audio. You can playback sound over a single frame, a series of 3 consecutive frames or a selection of the waveform.

Note: You need Flash 9.0 or later to play content with sound through the Player or when previewing topics from the Outline Editor. Flash is not necessary to play sound that is embedded as a concept from the Outline Editor.

<table>
<thead>
<tr>
<th>Situation</th>
<th>Icon</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>No selection is made in the waveform</td>
<td></td>
<td>Sound plays from the beginning of the frame to the end of the next frame. For a web page, the entire sound file plays from beginning to end.</td>
</tr>
<tr>
<td>Selection point is made in the waveform</td>
<td></td>
<td>The sound file plays from that point until the end of the sound file.</td>
</tr>
<tr>
<td>A portion of sound is selected in the waveform</td>
<td></td>
<td>The portion of the sound file associated with that selection plays.</td>
</tr>
<tr>
<td>Any of the above</td>
<td></td>
<td>The sound file associated with the current frame only plays.</td>
</tr>
</tbody>
</table>

Stop and Volume Control are the only active icons on the Sound Editor toolbar during Playback.

Note: Since sound can be recorded over a series of frames, the sound playback may cover more than one frame. The sound that displays in the waveform is one temporary sound file that maybe made up of the current, previous, and next frames. This sound file is one file in the Sound Editor but is stored as three separate files.

To play the entire sound file on a web page:

1. Click Play without making a selection in the waveform.
   The entire sound file plays.

To play the entire sound file on a topic:

1. Place the cursor at the beginning of the previous frame or do not make a selection in the waveform, then click Play.
The entire sound file plays.

To play the sound file from a selection point:
1. Click a selection point in the waveform.
2. Click 🎧 Play.
   The sound from the selection point to the end of the waveform plays.

To play a selection of a sound file:
1. Select beginning point and drag to select end point in the waveform.
2. Click 🎧 Play.
   The sound associated with the selected portion of the waveform plays.

To play the sound associated with a frame:
1. Click 🎧 Play Frame.
   The sound file for the current frame plays regardless of any selection made in the waveform.

To pause the sound file:
1. Click 🎧 Play or 🎧 Play Frame.
   The playback begins and the button changes to the Pause button.
2. Click 🎧 Pause.
   The playback pauses.
3. Click 🎧 Pause to resume playback.

Stop Sound File Playback
You can stop a sound file at any point during the playback. Stopping the playback sets the sound file back to the starting point; it does not pause the sound file at the point at which you stopped playback.

**Note:** The starting point of playback can be the beginning of the sound file, the selection point in the wavefile or the beginning of a selected section of the waveform.

To stop the playback of the sound file:
1. Click 🎧 Play or 🎧 Play Frame.
2. Click 🎧 Stop.
As you build your content and link various documents, you may need to review the relationships between documents and repair broken links that resulted from deleted or unavailable documents, for example.

The Developer provides toolpanes that allow you to:

- View Related Documents
- View Broken Links

You can display these toolpanes from the Library or any document editor. When you use these toolpanes from the Library or Outline Editor, you must select one document to view its related documents or broken links. When you display these toolpanes and open a document in a document editor, these panes automatically display the results for the open document.

**Note:** The Related Documents and Broken Links toolpanes are empty if you select multiple documents from either the Library or Outline Editor. Select only ONE document to display the appropriate results.

You can open any document listed in either the Related Documents or Broken Links toolpane by double-clicking the document name.

**Publishing Note:** Broken links are automatically removed from any published output.

**Multi-user Considerations**

If you open a document that is not checked out to you, it opens in Read-Only mode. If you decide to make any changes to a Read-Only document, upon exit you are given the option to save the document (check out and save the changes), save it as a new document, or discard the changes.

**View Related Documents**

Any document can have links to other documents as well documents that link to it. For example, a section can have one or more modules that link to it as well links to topic, web page, or package documents. You can view both incoming and outgoing links for a document using the Related Documents toolpane.

The top section of the toolpane displays the name of the selected document and a list of documents that it links to. The bottom section of the toolpane displays the documents that link to the selected document (parent documents). The Library Details View displays a Link Count and Links To column that calculates the total number of document links from the top and bottom sections of the Related Documents toolpane, respectively.

**Note:** You can resize either section of the pane by dragging the horizontal split bar up or down.

Broken links are also displayed in this pane; however, you can also display the Broken Links toolpane to show only broken links and not related documents.
Multi-user Considerations

If you perform this operation while you are working offline, only the documents in your local cache are considered.

To view related documents:

1. Display the Related Links toolpane.
2. Select ONE document that you want to review from the Library or Outline Editor.
3. Review the document links.
4. Double-click the name of any document in either section of the toolpane to open a related document.
5. Continue selecting other documents to review their related links.

View and Repair Broken Links

As you develop content, you will want to ensure that there are no broken links between documents. In most cases, broken links result when linked documents are deleted and not available.

To help you track the state of links between documents, you can display the Broken Links toolpane from the Library or any document editor and report broken links for selected documents. For example:

- If you are working in the Library, select one document to report its broken links.
- If you open a document in an editor (other than the Outline Editor) such as a web page or glossary, broken links are reported for the open document.
- If you are working in the Outline Editor, the results are based on the selected document. For example, if you select the root document in the Outline Editor, broken links are reported for all documents that appear in the outline as well as any related documents. As you select other documents in the outline, broken links are reported for the selected document and child documents as well as their related documents.

The top of the Broken Links toolpane displays the document you have selected or open in an editor. If there are broken links for the selected document they will automatically appear in the toolpane once a document is selected or open. The Name column shows the related documents that have broken links and the Broken Link column identifies the document to which the link is broken.

If the broken link is the result of a deleted document, you will see Missing Document in the Broken Link column. You can repair a broken link by removing the link to the missing document. For example, if a section has a broken link because a linked topic was deleted, you can open the section in the Outline Editor and remove the missing topic from the section. If a broken link results because a glossary document was deleted, you can open the Properties toolpane for the document and either remove the linked glossary or assign a different glossary.

Note: Broken link documents also appear in left pane of the Outline Editor so you see where they are in the context of the outline.
Link to Package File
A broken link cannot be detected when you have a document that links to file in a Package and the file is then deleted from the Package.

Multi-user Considerations
Broken links can happen for several reasons, and, in most cases, can result from working offline. For this reason, it is recommended that if you do work offline and establish links between documents, you should periodically go back online and check in your work.

A broken link can be created the following ways:

- You create a link to a document that was deleted by another author.
- You create a link to a new document that exists in your local cache but has not been checked in to the server. This will appear as a broken link to other authors who view the source document until you check in the new document.
- You create a link to an external document on your computer that is not visible to the other users.
- A link target URL existed at the time the link was created but it was deleted or renamed.
- A link can be broken because you are offline and you do not have a document in your local cache that a document is linked to. You should go online and get the appropriate documents that you need.

Broken links are represented in two ways. The Missing Document label appears for a broken link document that was new (not under version control) and deleted. A document that is under version control and deleted is identified by its name and a red X on top of the standard document icon. To repair this type of broken link you can either restore the deleted document or remove the link to the document.

To view broken links:

1. Display the Broken Links toolpane.
2. Select ONE document that you want to review from the Library or Outline Editor.

If the Broken Links toolpane remains empty when you select a document, there are no broken links. If broken links exist for the selected document, each document with a broken link appears. You should take the appropriate steps to fix any broken links that are reported.

Broken Links in Published Content
Most broken links (links to a document in the Library such as module, section, topic documents, package files, or web pages) are automatically detected and removed during publishing from any Player or document format. However, links to external content such as URL links or graphic links to external files cannot be verified at time of publishing. If these links are broken, they may appear in published content.

In online formats such as the Player, the browser will handle a missing URL or graphic file with a standard "content not found" message. In document formats, the Developer will
include the bad URL in the document and let Microsoft Word display the standard "content not found" message when the author launches the link.

If attachment icon links are broken (but the attachment itself exists), the Developer inserts a stock graphic icon so the online users will have something to click, rather than displaying a broken image link.

**Note:** Although broken links are removed in publishing, the source content is unaffected and will still have broken links that should be fixed.
10. Define Glossary Terms

As you create content, you might use specialized terms unique to your company or terms that require further clarification for your users. You can use glossaries to provide definitions for these terms.

Use of glossaries involves three steps:

First, you create a glossary document using the Glossary Editor. Each glossary document contains a list of terms and definitions, where the definitions are attachments to which the terms link. You can also specify a tooltip for each definition link, along with conditions describing markup of each term (match whole word and match case). Using the Glossary Editor, you can add, edit, and delete terms. You can also create multiple glossary documents and use them for different parts of your content.

You next assign one or more glossaries to your content using the Properties toolpane. You can assign glossaries in this way from the Library, Outline Editor, and Web Page Editor. In addition, in the Outline Editor and Topic Editor, you can use property inheritance to ensure that the appropriate glossary is automatically assigned to children created under a parent document to which a glossary has been assigned. Glossaries can be assigned only to modules, sections, topics, and web pages.

The final step in using glossaries is glossary markup, or updating glossary links, which can be done from the Glossary Editor, Library, and Outline Editor. When you update glossary links, the Developer searches the text in your content for occurrences of glossary terms. When it finds a term that matches the selected markup conditions (match whole word and match case), it creates a link to the attachment specified as the definition link. By default, when a glossary term appears multiple times in one location, only the first instance of the term is marked as a glossary link. You can also change the glossary default settings to have all occurrences of all terms marked as glossary links.

If you later make any changes to a glossary, to glossary assignments, or to text containing glossary terms, you must update the links again.

Glossary markup affects text in frame bubbles in topics, including Introduction and End frames, and text in web pages. However, if a glossary term is included in the text of a manually created bubble text link or web page hyperlink, no additional glossary link is created during glossary markup. That is, text used in manually created links is skipped during glossary markup. For example, suppose that a frame bubble in a topic contains the text "Save this file to your local disk." and you create a link from the phrase "local disk" to a web page attachment. Further suppose that the glossary assigned to this topic contains the term "disk" with a different attachment as its definition link. If you then update the glossary links for the topic, the original link to the web page is left intact, and no glossary link is created from the word "disk" to the definition link attachment.

Note that document names, package files, and templates are all excluded from glossary markup.

When you publish your content to Player outputs, glossary terms appearing in bubble text in topic frames or web page text are linked to their definitions as in the Developer. Users can click glossary links to display the attachments containing the definitions of the glossary terms. When you publish content that contains glossary markup to a Training Guide and Instructor Manual, a glossary is included as a list of terms and definitions at the end of the document. If you publish content containing more than one glossary to one of these document outputs, the glossaries are merged and presented as one alphabetical list. If a term appears in more than one of the merged glossaries, it is listed multiple times, once for each glossary in which it appears. However, only those terms with definition link
Define Glossary Terms

Attachments that typically appear in document outputs are included in the glossary. Specifically, the types of definition links included in the glossary sections of document outputs are package files (graphics only), web pages, and URLs (addresses only). Therefore, if a definition link is a non-graphic package file, such as an Excel spreadsheet, the corresponding term is not included in the document glossary.

Create a Glossary

You create and manage glossaries using the Glossary Editor. You can create a glossary from the main File menu available in the Library or any other document editor EXCEPT the Topic Editor. When you create a new glossary or open an existing glossary, the Glossary Editor launches in a new tab and displays an empty glossary (or the selected glossary) where you can add, edit, and delete terms and change their properties (such as tooltip). You can save the glossary to any folder in the Library and then assign it to one or more documents anywhere in the Library.

If you save a glossary to the wrong folder in the Library, you always have the option to move the glossary document to another folder. You can also rename a glossary at any time without breaking any links from your content to the glossary.

Note: You can open multiple glossaries at the same time. Each glossary appears in its own tab.

In addition to its name, each glossary document has a language assigned to it. The default language of a new glossary document is the language of the Developer. However, you can change the language of the glossary in the Properties toolpane.

Multi-user Considerations

Any new document that you create or link is automatically checked out to you. If you want to make a new document available to multiple authors and place the document under the Developer’s version control system, you must check it in.

See Check In and Check Out Documents in Use the Developer in a Multi-user Environment for more information.

To create a new glossary:

1. On the File menu, point to New and choose Glossary.
2. Add terms to the glossary.
3. Save the new glossary.

You can also close the tab and click Yes in response to the Save Document message.

When you save a glossary for the first time, you are prompted to provide a name for it. Enter a name for the glossary by typing over the default name. Although the glossary name does not have to be unique, it is recommended that you provide a meaningful name so you can easily manage multiple glossaries.

Long document names are supported.

Edit a Glossary

You can open a glossary at any time in the Glossary Editor to modify its contents. For each glossary that you open to edit, an independent instance of the Glossary Editor opens in a
Define Glossary Terms

A separate tab, allowing you to edit multiple glossaries at one time. When you edit a glossary, you can add, edit, or delete glossary terms, where each glossary entry consists of a term (the text to be matched for markup), a link to an attachment that provides its definition, a tooltip (optional), and markup conditions (match whole word and/or match case).

After making any changes to a glossary, you should update glossary links to apply your changes.

Multi-user Considerations

Before you can perform this action, you must check out the document. After you save any changes, you should check in the document to make it available to other authors and add the changes to the Developer's version control system.

When you add, edit, or delete glossary terms, you are editing the glossary document, so you must check the glossary out. When you assign a glossary to a document or update glossary links, you are not editing the glossary document itself, so you do not need to check the glossary out. In these cases, you are editing the parent documents to which the glossary is assigned, so you must instead check out the parent documents.

To edit a glossary:

1. From the Library, open the glossary document that you want to edit.
2. Add, edit, and/or delete glossary terms as needed.
3. Save and close the glossary document.

When you close a glossary document to which you have made and saved changes, you are prompted to update glossary links. Click Yes to update links for all documents to which the glossary is assigned, or click No to close the glossary without updating links.

If you have not saved the changes before closing the glossary, you are prompted to save the glossary and update links, to save the glossary without updating links, or not to save the glossary. Select the appropriate option and click OK, or click Cancel to keep the glossary open without saving changes.

Add a Glossary Term

Each glossary entry consists of a term (the text to be matched for markup), a link to an attachment that provides its definition, a tooltip (optional), and markup conditions (match whole word and/or match case). Glossary terms can include both spaces and special characters, and there is no limit to the length of a term. However, each term must include at least one non-space character and cannot begin or end with one or more spaces. In addition, glossary terms must be unique, on a case-insensitive basis, within a glossary document. Therefore, for example, one glossary cannot include both the terms "document" and "Document". You must enter a valid term before you can set any of the properties of the glossary entry (definition link, tooltip, markup conditions).

You can use any type of attachment (package file, web page, or URL) as a definition link. In the Developer and in published Player outputs, glossary terms appearing in bubble text in topic frames or web page text are linked to their definition attachments. Users can click glossary links to display the attachments containing the definitions of the glossary terms. Glossaries are also included in the Training Guide and Instructor Manual as a list of terms and definitions at the end of the document. If you publish content containing more than
Define Glossary Terms

one glossary to one of these document outputs, the glossaries are merged and presented as one alphabetical list. If a term appears in more than one of the merged glossaries, it is listed multiple times, once for each glossary in which it appears. However, only those terms with definition link attachments that typically appear in document outputs are included in the glossary. Specifically, the types of definition links included in the glossary sections of document outputs are package files (graphics only), web pages, and URLs (addresses only). Therefore, if a definition link is a non-graphic package file, such as an Excel spreadsheet, the corresponding term is not included in the document glossary.

You also have the option to enter text for a tooltip that identifies the link contents. These tooltips appear in the Player when a user rests the mouse pointer over the link text. For example, because these links apply to glossary terms, you might use the tooltip "definition". However, the length of the tooltip is not limited, and you can use a different tooltip for each term, if desired.

**Tip:** Although there is no limit to the length of a tooltip, concise, descriptive tooltips are most useful.

In addition, you can specify that the glossary term must match the whole word only, preventing words containing the glossary term from being marked as glossary links. For example, if the Match Whole Word option is selected for the glossary term "test", the word "testing" is not marked as a glossary link. You also have the option to require glossary terms to match the specified case, so that words that are not typed in uppercase and lowercase letters exactly as the term in the glossary document are not marked as glossary links.

After adding glossary terms, you should update glossary links to apply your changes.

![To add a glossary term to a glossary document:](image)

1. In the empty **Glossary Term** cell in the bottom row of the table, type the term.
2. In the **Definition Link** cell in the same row, select an attachment for the definition link.
3. In the **Tooltip** cell in the same row, type a tooltip, if desired.
4. Set the markup conditions.
   - By default, **Match Whole Word** is selected, and **Match Case** is not selected. Change a setting by checking or clearing the appropriate checkbox.
5. Continue adding terms or save and close the glossary document.

When you close a glossary that is assigned to one or more documents after making changes to it, you are prompted to update the glossary links. Select Save the glossary and update the links and click OK to close the glossary and update links. Otherwise, you can select Save the glossary and click OK to close the glossary without updating links. Click Cancel to close the glossary document without saving changes.

**Tip:** To navigate in the glossary, you can click in the desired cell or press TAB to move one cell to the right or SHIFT+TAB to move one cell to the left.

Select a Definition Link Attachment

When you create a new glossary term, you must also select a corresponding definition link, which is an attachment containing the definition for the term. If you do not select a
A definition link attachment for a term, no glossary links are created in your content for that term. A definition link can be any type of attachment: package item, web page, or URL. When you publish your content to Player outputs, glossary terms appearing in bubble text in topic frames or web page text are linked to their definitions as in the Developer. Users can click glossary links to display the attachments containing the definitions of the glossary terms. Glossaries are also included in the Training Guide and Instructor Manual as a list of terms and definitions at the end of the document. If you publish content containing more than one glossary to one of these document outputs, the glossaries are merged and presented as one alphabetical list. If a term appears in more than one of the merged glossaries, it is listed multiple times, once for each glossary in which it appears. However, only those terms with definition link attachments that typically appear in document outputs are included in the glossary. Specifically, the types of definition links included in the glossary sections of document outputs are package files (graphics only), web pages, and URLs (addresses only). Therefore, if a definition link is a non-graphic package file, such as an Excel spreadsheet, the corresponding term is not included in the document glossary.

To select a package file or web page as a definition link for a glossary term:

1. In the **Definition Link** cell for the term, click ![Create link].
2. In the Edit Definition Link dialog box, click ![Create link].
3. In the Link to pane, select ![Document in Library].
   - If desired, you can select **Packages** or **Web pages** in the **Type** field to further filter your selection.
4. Navigate the Library to the folder containing the package file or web page to which you want to link.
5. Select the desired package file or web page document.
6. Click **OK** or press ENTER.

**Note:** At step 3, you can also click ![Create new web page] to create a new web page and link to it in one step. When you do so, you first specify the name of the web page and the Library folder in which it should be saved. The Web Page Editor then launches in a new tab, displaying an empty web page.

To select a URL as a definition link for a glossary term:

1. In the **Definition Link** cell for the term, click ![Create link].
2. In the Edit Definition Link dialog box, click ![Create link].
3. In the Link to pane, select ![URL].
4. In the **Address** field, type or paste the target URL.
5. Click ![Go] or press ENTER.
   - While selecting a URL, you can also enter a base URL and then follow links in the preview displayed in the results pane to reach your desired target.
6. Click **OK** or press ENTER.
Edit a Glossary Term

You can edit a glossary term, if necessary, from the Glossary Editor. In addition to changing the text of the term itself, you can change the tooltip, select a different attachment for the definition link, or change the markup conditions (match whole word, match case). You make these changes in the same way as when you add a new glossary term.

**Note:** Glossary terms can include both spaces and special characters, and there is no limit to the length of a term. However, each term must include at least one non-space character and cannot begin or end with one or more spaces. In addition, glossary terms must be unique, on a case-insensitive basis, within a glossary document. Therefore, for example, one glossary cannot include both the terms "document" and "Document". You must enter a valid term before you can set any of the properties of the glossary entry (definition link, tooltip, markup conditions).

After editing one or more glossary terms, you should update glossary links to apply your changes.

Delete a Glossary Term

If a glossary term is no longer needed or appropriate, you can delete it by deleting the entire entry from the glossary document. Deleting the glossary term and updating links for the glossary from which it was deleted removes the glossary links from affected text; however, the link text itself is not deleted. The attachment (web page or package) used as the definition link is also not deleted. (URL attachments used as definition links are obviously not affected, as they are external to the Developer.)

Assign a Glossary to a Document

Once you create a glossary, you can assign it to one or more documents in the Library. A glossary can be assigned to a document in two ways: through manual assignment and through inheritance from the document's parent.

You can manually assign a glossary while working in the Library, Outline Editor, or Web Page Editor, using the Properties toolpane. A glossary can be assigned only to modules, sections, topics, and web pages. Although no module or section text is marked up when glossary links are updated, assigning glossaries to modules and sections is useful for inheritance purposes, as described.

**Tip:** You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click). However, you must select only document types that support glossaries. If a multi-document selection in the Library includes a document type that does not support glossaries, such as a package, the Glossary property does not appear in the Properties toolpane.

**Warning!** Be careful when changing a property for multiple documents that already contain values for the same property. The new values you enter for the property overwrite any existing values for all selected documents.

Glossaries can be assigned through property inheritance only in the Outline and Topic Editors. If you assign a glossary to a module or section, all new module, section, and topic documents that you link as children of this document while working in the Outline Editor inherit the parent's glossary setting. Similarly, any new web page that you create from the Concept pane of the Outline Editor inherits the glossary of its parent. Likewise, if you assign a glossary to a topic, any new web pages that you create while working in the Topic

10-6 Copyright © 1998, 2010, Oracle. All rights reserved.
Define Glossary Terms

Editor, for example, as new frame attachments, inherit the topic's glossary setting. However, new documents that are not linked (documents that are created using the File, New command) and existing documents that are linked as children of the document do NOT inherit any property settings.

Once you have assigned a glossary to a document, you still must update glossary links to create glossary links in that document.

If a glossary is no longer appropriate for a document, you can change or remove the assigned glossary using the Properties toolpane. Changing or removing the glossary assigned to a parent does not automatically change the glossary for any child documents, even those that inherited their glossary from the parent. You must change the glossary for each child document manually.

In addition, changing or removing the glossary assigned to a document does not automatically update glossary links. Therefore, after making any changes in glossary assignments, you must update glossary links to apply the new glossary to the affected documents.

**Note:** You can view the glossaries assigned to selected documents in the Related Links toolpane. However, you cannot use the Related Links toolpane to change glossary assignments.

---

**Multi-user Considerations**

Before you can perform this action, you must check out the document. After you save any changes, you should check in the document to make it available to other authors and add the changes to the Developer's version control system. If you are changing the glossaries of multiple documents at the same time, all selected documents must be checked out. The Glossary property is not available for editing if one or more documents in a multi-document selection are not checked out.

You do not need to check out the glossary, only the parent document(s). In addition, you can link to a glossary even if it is checked out to another user.

When you are working offline, you can link to a glossary only if it is available in your local cache. Therefore, if you plan to work offline, you should ensure that you have a local copy of any glossary to which you want to link. To do this, you can either check out or get the glossary, depending on whether you plan to edit it or to have access to a read-only copy. If you go offline and do not have a copy of a glossary in your local cache, that glossary will be unavailable to you as you work offline. To remedy this, you need to go back online and get the documents that you need.

To assign a glossary to a document:

1. Display the Properties toolpane.
2. From the Library or Outline Editor, select the document(s) to which you want to assign a glossary.
   
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click). However, glossaries can be assigned only to modules, sections, topics, and web pages.
3. In the Properties toolpane, click the **Glossary** property.
4. Click .

---

Copyright © 1998, 2010, Oracle. All rights reserved.
Define Glossary Terms

5. Navigate the Library to the folder containing the desired glossary.
6. Click Open or press ENTER.

After assigning a glossary to a document, be sure to update glossary links.

To remove a glossary assigned to a document:

1. Display the Properties toolpane.
2. From the Library or Outline Editor, select the document(s) from which you want to remove an assigned glossary.
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click). However, you must select only module, section, topic, and/or web page documents to which the same glossary has been assigned.
3. In the Properties toolpane, click the Glossary property cell.
4. Press DELETE to clear the glossary field.

After removing an assigned glossary from a document, be sure to update glossary links.

Update Glossary Links

The final step in using glossaries is glossary markup, or updating glossary links. You can update glossary links from the Glossary Editor, the Library, or the Outline Editor.

When you update glossary links from the Glossary Editor, all documents to which the open glossary is assigned are updated.

When you update glossary links from the Library or Outline Editor, the selection and its related documents are included by default. Clicking the View related documents link displays a list of the related documents. For this process, related documents are defined as all searchable documents that are directly or indirectly linked as children of the selection. For example, if you select a section that has topics and each of the topics has a web page linked as its concept, choosing to search related documents searches the section, the topics, and the web pages linked to the topics. Templates and package contents are not included in this operation.

From the Library, you must have at least one document selected or the tool is disabled. If nothing is selected in the Outline Editor, the entire outline is searched; this is equivalent to selecting the root of the outline.

The documents that are included in glossary markup from the Library and Outline Editor do not all have to have the same assigned glossary, but each one must have an assigned glossary to be updated. The appropriate glossary is applied to each document, regardless of the glossary used to update any document to which it is related.

During glossary markup, the Developer searches the text in your content for occurrences of glossary terms. When it finds a term that matches the selected markup conditions (match whole word and match case), it creates a link to the attachment specified as the definition link. By default, when a glossary term appears multiple times in one location, only the first instance of the term is marked as a glossary link. You can also change the glossary default settings to have all occurrences of all terms marked as glossary links.

If you later make any changes to a glossary, to glossary assignments, or to text containing glossary terms, you must update the links again.
Glossary markup affects text in frame bubbles in topics, including Introduction and End frames, and text in web pages. However, if a glossary term is included in the text of a manually created bubble text link or web page hyperlink, no additional glossary link is created during glossary markup. That is, text used in manually created links is skipped during glossary markup. For example, suppose that a frame bubble in a topic contains the text "Save this file to your local disk." and you create a link from the phrase "local disk" to a web page attachment. Further suppose that the glossary assigned to this topic contains the term "disk" with a different attachment as its definition link. If you then update the glossary links for the topic, the original link to the web page is left intact, and no glossary link is created from the word "disk" to the definition link attachment.

Note that document names, package files, and templates are all excluded from glossary markup.

Note also that glossary markup does not create recursive links. Therefore, if a web page that is used as the definition link for a term includes text containing the same term, no glossary link is created, so that the web page is not linked to itself by glossary markup.

Once created, a glossary link functions just like any other link to an attachment, such as a hyperlink inserted in a web page. Therefore, you can edit or remove the link, if desired. However, any changes that you make to a glossary link apply only to that link and do not affect the entry for the glossary term in the glossary document. In addition, if you later update glossary links again, the text used in a manually edited glossary link is excluded from glossary markup and is not overwritten with a new glossary link.

---

**Multi-user Considerations**

For changes to be made to a document using this tool, the document must be checked out. If you plan to use this tool offline, you should check out all affected documents before going offline.

When you execute this process, the Developer searches through all of the documents in the selection, regardless of their check in/out state. If a change is necessary and the document is not checked out and if you are working online, the Developer automatically checks the document out to you and makes the change. If the document cannot be checked out, for example, if it is open in another editor or checked out to another user or you are working offline, it is skipped. At the end of the process, a summary message appears with a link to an activity log. Clicking the View activity log link in the message displays a list of the documents that were checked out to you during the process and those that could not be checked out. After you save any changes, you should check in the documents to make them available to other authors and add the changes to the Developer's version control system.

To update glossary links, you do not need to check out the glossary, only the parent document(s). In addition, you can update links with a glossary even if it is checked out to another user. However, the glossary markup in this case will not reflect any changes made to the glossary after it was checked out.

When you are working offline, you can update glossary links only if the glossary is available in your local cache. Therefore, if you plan to work offline, you should ensure that you have an up-to-date local copy of any glossary you plan to use. To do this, you can either check out or get the glossary, depending on whether you plan to edit it or to have access to a read-only copy. If you go offline and do not have a copy of a glossary in your local cache, you will be unable to update glossary links for any documents to which it is assigned as you work offline. To remedy this, you need to go back online and get the documents that you need.
To update glossary links from the Glossary Editor:

1. Open the glossary document, if necessary.
2. On the Edit menu, choose Update Glossary Links.
   - If you have unsaved changes in the glossary, you can also choose Save and Update from the File menu to save your changes and update glossary links in one step.
   - The Developer searches all documents to which the glossary is assigned and updates links for glossary terms found in those documents.

To update glossary links from the Library or Outline Editor:

1. Select the document(s) for which you want to update glossary links.
   - You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click). If you do not select a document in the Outline Editor, the entire outline is updated.
2. On the Edit menu, choose Update Glossary Links.
   - The Developer searches all selected documents and their directly related children and updates links for glossary terms found in those documents to which a glossary is assigned.

Delete a Glossary

If a glossary is no longer needed or appropriate, you can delete it just as you would delete a document of any other type. You can delete a glossary only from the Library.

Deleting a glossary removes the glossary document from the Library, but does not delete the package files and web pages used as definition links unless you explicitly choose to delete related documents as well. The links created using the glossary are also not removed when the glossary is deleted. Therefore, if you delete the glossary with related documents, you break these links. Moreover, deleting a glossary does not remove the glossary from the documents to which it was assigned. Therefore, if you delete a glossary that is assigned to one or more documents, you break the glossary assignment links. You can use the Broken Links tool to identify any broken links in your content that result from deleting a glossary.

To avoid breaking links when you delete a glossary document, you should first ensure that it is not assigned to any documents. To do this, you can use the Related Documents tool to find all of the documents to which the glossary is assigned (parent documents). Then, select the parent documents in the Library or Outline Editor and use the Properties toolpane to remove the glossary from these documents or to assign a different glossary. If you plan to delete the glossary's related documents as well (child documents used as definition links), you should also update glossary links for the parent documents, to remove any links created using the glossary to be deleted. After completing these steps, you can select the glossary document from the Library and delete it without creating any broken links.
Multi-user Considerations

Documents under version control must be checked in and you must be working online to delete a document from the Library. You can delete new documents that have never been checked in (are not under version control) while working online or offline.

Deleted documents that have been checked in to the Library can be restored if they have not been purged by your Administrator. New documents that have never been checked in cannot be restored.
11. Create Roles for Content Filtering

Role-based filtering allows users to quickly locate modules, sections, or topics based on their job function or department. While developing content, you can create a list of roles corresponding to your intended users and assign the roles to the appropriate documents. During publishing, you can tailor your output by publishing selectively to one, several, or all roles. In the Player, users can then choose from a list of available roles to display only the content that is relevant to their job function; they can also toggle to display the entire outline if necessary. You can also create document outputs, such as Training Guides, that contain information relevant to only specific roles. In addition, the assigned roles populate the Roles/Responsibility field when you publish a Business Process Document.

Working with roles in the Developer requires two basic steps: First, you create the roles, and then you assign these roles to the appropriate documents. You use the Role Editor to create and manage roles in master role list documents. You assign roles and view role assignments at the document level through the Properties toolpane in the Library or Outline Editor. Once you assign one or more roles to a document, the role assignment is saved as a property of the document and travels with it on operations such as export and import.

By default, the Developer comes with one empty master role list for each language installed. These role lists are stored in the System/Roles folder and are named according to language. The default name of a role list document is Roles, followed by the two-letter abbreviation of the language of the document. For example, the Roles.en document is the master role list for the English language. Additional roles that are not included in any role list can also exist in your content, for example, when you convert or import content with new roles. To simplify role assignment, however, it is recommended that you always update the master role list to include these additional roles whenever they exist.

When you assign roles to modules, sections, or topics, the Developer determines the language of the selected document(s) and displays a list of all roles in the master role list for that language, as well as any additional roles that are in use in the selected documents. You can assign roles only to modules, sections, or topics, and all of the documents selected for role assignment at one time must be of the same language.

**Warning!** Do not delete the role list for any language. Doing so will disable role assignment for that language.

Once you assign one or more roles to a document, the role assignment is saved as a property of the document. If you later make changes to these roles in a master role list, the document assignment is not updated. Therefore, it is recommended that you define and finalize your role lists before assigning roles to documents. Otherwise, you must manually update each document to which obsolete roles are assigned to reflect the changes in the master role list.

### Edit a Master Role List

By default, the Developer comes with one empty master role list for each language installed. If needed, you can also create role lists for additional languages. You use the Role Editor to add, rename, and/or delete roles in these master role lists.

In addition, content that you convert or import might be assigned to roles that are not included in the master role list for the appropriate language. From the Role Editor, you can easily update the master role list to include such additional roles whenever they exist.
Tip: It is recommended that you define and finalize your role lists before assigning roles to documents. If you later rename or delete a role that has been assigned to one or more topics, you should update the role assignments automatically when you save the changes to the role list.

You can access the Role Editor from the Library or Outline using the Manage Roles item on the Edit Menu. The Role Editor can also be opened using the Manage button on the Assign Roles dialog box. Using these methods, the Developer determines the appropriate language master role list to open based on the following:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No document selected</td>
<td>Master role list opens in the default language specified on the General Tab of the Content Defaults category on the Options dialog box.</td>
</tr>
<tr>
<td>Document selected</td>
<td>Master role list opens in the language associated to the document.</td>
</tr>
<tr>
<td>Document selected in a language where no Master Role List exists</td>
<td>New master role list is created and opens in that language.</td>
</tr>
<tr>
<td>Multiple documents of different languages are selected</td>
<td>The master role list for each selected language opens in a separate tab.</td>
</tr>
</tbody>
</table>

You can open the master role list in a specific language by opening the associated Role file from the System/Roles folder in the Library.

Multi-user Considerations

Before you can perform this action, you must check out the document. After you save any changes, you should check in the document to make it available to other authors and add the changes to the Developer's version control system.

If you rename or delete a role that is assigned to one or more documents, you will be prompted to update the role assignments automatically when you save your changes to the master role list. If you choose to do this, the Developer searches through all of the documents with the same language as the master role list, regardless of their check in/out state. If a change is necessary and the document is not checked out and if you are working online, the Developer automatically checks the document out to you and makes the change. If the document cannot be checked out, for example, if it is open in another editor or checked out to another user or if you are working offline, it is skipped. At the end of the process, a summary message appears with a link to an activity log. Clicking the View activity log link in the message displays a list of the documents that were checked out to you during the process and those that could not be checked out. After you save any changes, you should check in the documents to make them available to other authors and add the changes to the Developer's version control system.

If a document cannot be checked out to update a renamed or deleted role, you will need to update the role assignment for that document manually.

Automatic updating of assignments for a role that is renamed or deleted is available only at the time the change is made. If you choose not to update role assignments automatically at that time, you will need to update them manually for all documents to which the renamed or deleted role was assigned.
To edit a master role list:

1. Navigate in the Library to the System/Roles folder.
2. Open the role list to which you want to add the role.
   
   If the Add Roles In Use message box appears, click Yes to add these roles to the role list or No to proceed without adding the roles. See Update a Master Role List for further detail.
3. Add, rename, and/or delete roles as necessary.
4. Save and close the master role list.

   If you renamed or deleted any roles that are assigned to one or more documents, you are prompted to update these role assignments when saving your changes. Click Yes to save the master role list and update role assignments or No to save the master role list without updating role assignments.

   If you have not saved the changes before closing the master role list, you are prompted to save the master role list and update role assignments, to save the master role list without updating role assignments, or not to save the master role list. Select the appropriate option and click OK, or click Cancel to keep the master role list open without saving changes.

   If you choose not to update role assignments automatically when saving your changes, you will need to update them manually for all documents to which the renamed or deleted role was assigned.

Add a Role

You can add one or more roles to a role list using the Role Editor.

Each role consists of a text description of a group of users, such as a department name or job function. Roles can include both spaces and special characters, and there is no limit to the length of a role name. Each role must include at least one non-space character and cannot begin or end with one or more spaces. In addition, roles are not case sensitive and must be unique within a role list document. Therefore, for example, one role list cannot include both the roles "author" and "Author".

To add a role to a role list:

1. In the role list to which you want to add a role, click the empty Role cell in the bottom row of the table.
2. Type the name of the role.
3. Continue adding roles or save and close the role list document.

Tip: To navigate in the role editor, you can click in the desired cell or press TAB to move one row down the list or SHIFT+TAB to move one row up the list.

Rename a Role

After you have created roles, you might need to rename them. For example, you might have inadvertently misspelled a role and need to correct it. Roles can include both spaces and special characters, and there is no limit to the length of a role name. Each role must include at least one non-space character and cannot begin or end with one or more spaces. In addition, roles are not case sensitive and must be unique within a role list.
Create Roles for Content Filtering

document. Therefore, for example, one role list cannot include both the roles "author" and "Author".

If you rename a role that is assigned to one or more documents, you must also update the role assignments of the document(s). It is recommended that you update role assignments automatically when prompted to do so after saving changes to the master role list. If the role assignment for a document cannot be updated automatically at that time, for example, if the topic is open in the Topic Editor, or if you choose not to update role assignments automatically, you must manually update each topic to which obsolete roles are assigned to reflect the changes in the master role list.

Tip: You can use find and replace to update role assignments.

Warning! If you rename a role in the master role list but do not update role assignments to remove the original role from all documents, the original role remains in the Library as an additional role in use and will be added back to the role list if you automatically update the role list before it is removed from all document(s). To completely rename a role, you must both rename it in the role list and update all documents to which the original role was assigned.

To rename a role:

1. In the role list, select the role you want to rename.
2. Type the changes.
   Note that this renames the role in the role list only and does not update any documents that might have been assigned to this role.
3. Save and close the role list document.
   It is recommended that you update role assignments automatically when prompted to do so after saving changes to the master role list. If you choose not to update role assignments automatically at this time, you will need to update them manually for all topics to which the renamed role was assigned.

Delete a Role

In addition to removing roles from documents, you can delete them from a role list.

If you delete a role that is assigned to one or more documents, you must also update the role assignments of the document(s). It is recommended that you update role assignments automatically when prompted to do so after saving changes to the master role list. If the role assignment for a document cannot be updated automatically at that time, for example, if a topic is open in the Topic Editor, or if you choose not to update role assignments automatically, you must manually update each document to which obsolete roles are assigned to reflect the changes in the master role list.

Tip: You can use find and replace to update role assignments.

Warning! If you delete a role from the master role list but do not update role assignments to remove this role from all documents, the role remains in the Library as an additional role in use and will be added back to the role list if you automatically update the role list before it is removed from all document(s). To completely delete a role from the Library, you must both delete it from the role list and remove it from all documents to which it is assigned.
To delete a role from a role list:

1. In the role list, select the row of the role you want to delete.
   Note that you must select the entire row; you cannot simply delete the text name of the role.

2. Click Delete or press DELETE.

3. Save and close the role list document.

   It is recommended that you update role assignments automatically when prompted to do so after saving changes to the master role list. If you choose not to update role assignments automatically at this time, you will need to update them manually for all documents to which the deleted role was assigned.

Update a Master Role List

Although you create and manage roles using role lists, additional roles can exist in your Library that are assigned to one or more documents but are not included in any role list. Such roles can arise as a result of conversion or import, as described later in this section.

During conversion and import, the Developer identifies all roles used in the converted/imported content. It then compares these roles to the master role list of the same language. If any of these roles is not included in the appropriate master role list, the Developer attempts to add the role to the role list. If the role cannot be added to the list, for example, if the master role list is open in an editor, the role is still kept in the content but is not included in any role list.

When you open a role list for which such roles exist, you are prompted to add these roles to the role list. Clicking Yes adds these roles to the role list; clicking No opens the role list without adding the roles. In the latter case, you can still update the master role list to include such roles from within the Role Editor.

Although you can allow roles to continue to exist in your Library as additional roles in use that are not included in any role list, this is not recommended, as such roles are available for role assignment only in certain cases. (See Assign Roles to Modules, Sections, or Topics for further detail.) Rather, it is recommended that you include all roles in use in your content in the appropriate master role list, thus making them available for assignment to all documents of the same language.

To update a master role list from the Role Editor:

1. On the Edit menu, choose Update Master Role List.
   The Developer searches documents of the same language as the role list and adds any roles that are not currently in the document.

2. Save and close the role list document.

Create a New Role List

By default, the Developer comes with one empty master role list for each language installed. Each master role list can be used to assign roles to all documents of the same language. Therefore, you need to create a new role list only if your content includes a language for which no role list currently exists.
Note: Only one role list can be used to assign roles to documents of a given language. If multiple role lists exist for the same language, only the oldest (the first one created) is used to populate the role assignment selection list. For example, if you make a copy of the Roles.en document and add roles to it, those new roles do not appear as assignment choices for any English documents. Therefore, you should not create more than one role list for any language.

Warning! Do not delete the role list for any language. Doing so will disable role assignment for that language.

To create a new role list, you must start with an existing role list. For example, you can set up all necessary roles in an existing role list and then create new role lists for other languages using this initial list as a model.

Tip: You can change the language of a role list from the Properties toolpane.

You can create a new role list from the Library or the Role Editor. From the Library, you simply copy and paste the entire role list document. From the Role Editor, you save the original role list as a new document.

The original master role lists in the Library are named according to language. For example, the Roles.en document is the master role list for the English language. Although you do not have to follow this convention in naming new role lists, it is recommended that you provide a meaningful name so you can easily find the new role list later.

All role list documents must be saved in the System/Roles folder to be used for role assignment.

Multi-user Considerations

Any new document that you create or link is automatically checked out to you. If you want to make a new document available to multiple authors and place the document under the Developer's version control system, you must check it in.

See Check In and Check Out Documents in Use the Developer in a Multi-user Environment for more information.

To create a new role list from the Role Editor:

1. Open the master role list you want use as the basis for the new role list.
2. On the File menu, choose Save As.
3. In the Save As dialog box, type a name for the new role list.
   Although there are no restrictions on the name of a role list, it is recommended that you provide a meaningful name so you can easily find the new role list later.
   Both the Type field and the Save in field should read "Roles".
4. Click Save or press ENTER.
5. Use the Properties toolpane to set the language of the new role list.
To create a new role list from the Library:

1. Navigate to the System/Roles folder.
2. Select the master role list you want to use as the basis for the new role list.
3. On the Edit menu, choose Copy. You can also right-click your selection and choose Copy.
4. Point to a blank area in the Contents pane.
5. On the Edit menu, choose Paste to paste a new copy of the original role list.
   For steps 4 and 5, you can also right-click in a blank area in the Contents pane or right-click a folder in the Folders pane and choose Paste from the context menu. You can paste the new role list document in any Library folder, but it cannot be used for role assignment unless it is saved in the System/Roles folder.
6. If desired, rename the new role list document. Although this step is optional, it is highly recommended. There are no restrictions on the name of a role list, but it is recommended that you provide a meaningful name so you can easily find the new role list later.
7. Use the Properties toolpane to set the language of the new role list.

Assign Roles to Modules, Sections, or Topics

Once you have created roles using role lists, you can assign the roles to one or more modules, sections, or topics. This step is necessary to allow both role-selective publishing in the Developer and role-based filtering in the Player.

You can assign roles while working in the Library or Outline Editor, using the Properties toolpane. Roles can be assigned to module, section, or topic documents, and all of the documents selected for role assignment at one time must be of the same language.

Tip: You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click). However, you must select only modules, sections or topics, as no other document types support roles. If a multi-document selection in the Library includes a document type that does not support roles, such as a package, the Role property does not appear in the Properties toolpane.

When you select documents for role assignment, the Developer determines the language of the selected document(s) and displays a list of all roles in the master role list for that language. If any additional roles are in use in the selected documents but are not on the role list, they are also shown. Note that inclusion of these additional roles depends on the specific document(s) selected for role assignment, rather than just language. Consequently, such roles are available for role assignment only if the document(s) to which they are assigned are included in the selection. It is therefore recommended that you always update the master role list to include these additional roles whenever they exist.

If no role list exists for the language of the selected document(s), role assignment is not enabled.

Warning! Do not delete the role list for any language. Doing so will disable role assignment for that language.
Create Roles for Content Filtering

To assign a role to a document, you simply select the checkbox next to the desired role in the Assign Roles dialog box. To remove the role from the document, clear the checkbox. Note, however, that, if you remove a document from all roles, the document will appear in the Player only if role-selective filtering is turned off.

If you select multiple documents for property assignment, the checkboxes for the property values can have any of three initial states:

- **Unselected (clear)** - The value is not assigned to any of the selected documents.
- **Selected (checked)** - The value is assigned to all of the selected documents.
- **Partially selected (gray with gray checkmark)** - The value is assigned to some, but not all, of the selected documents.

You can check or clear any checkbox, regardless of its initial state, to assign the value to or remove it from **ALL** of the selected documents. If you do not change the state of a partially selected checkbox, the assignment of the corresponding value remains unchanged (assigned to some, but not all, of the selected documents). However, once you click a partially selected checkbox, you cannot restore it to its initial state. Therefore, when assigning property values to documents, you should select only those documents to/from which you want to add/remove the same value(s).

Once you assign one or more roles to a topic, the role assignment is saved as a property of the topic document. If you later make changes to these roles in a master role list, the topic assignment must also be updated. It is recommended that you update role assignments automatically when prompted to do so after saving changes to the master role list. If the role assignment for a topic cannot be updated automatically at that time, for example, if the topic is open in the Topic Editor, or if you choose not to update role assignments automatically, you must manually update each topic to which obsolete roles are assigned to reflect the changes in the master role list. Therefore, it is recommended that you define and finalize your role lists before assigning roles to topics.

**Tip:** You can use find and replace to update role assignments.

---

**Multi-user Considerations**

Before you can perform this action, you must check out the document. After you save any changes, you should check in the document to make it available to other authors and add the changes to the Developer's version control system. If you are assigning roles to multiple documents at the same time, **all** selected documents must be checked out. The Roles property is not available for editing if one or more documents in a multi-document selection are not checked out.

You do not need to check out the role document, only the document(s) to which roles are being assigned. In addition, you can assign roles even if the appropriate master role list is checked out to another user, although only the roles in the latest checked in version of the role list will be available for assignment.

To assign roles while working offline, you should ensure that you have the latest version of the appropriate master role list(s) available in your local cache. To do this, you can either check out or get the role list, depending on whether you plan to edit it or to have access to a read-only copy. If you go offline and do not have a current copy of a role list in your local cache, some of the roles on the role list might be unavailable to you as you work offline. To remedy this, you need to go back online and get the documents that you need.
To assign roles to one or more documents:

1. Display the Properties toolpane.

2. From the Library or Outline Editor, select the document(s) to which you want to assign roles.

   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click). However, all documents included in your selection must have the same language.

3. In the **General** category, click in the **Roles** cell.

4. In the Assign Roles dialog box, select the role(s) to which you want to assign the selected document(s).

   To include a role, click the checkbox next to its name. To remove a role, clear the checkbox next to its name.

   You can also use the Select All button to include all roles or the Clear All button to remove all roles from the selection. These buttons apply to all roles listed in the Assign Roles dialog box, whether they are included in the master role list or are available as additional roles for the selected documents.

5. Click **OK** or press ENTER.
12. View Document Properties

Documents contain two types of properties; those that are calculated and those that you can manually edit. Modules, sections, topics, web pages, and packages have editable properties that you can set and change at any time. The properties you set are saved with the document and travel with it on operations such as export and import.

Initial Values
Some editable document properties start with an initial value. The initial value assigned depends on how the document was created. New documents that are created by linking them to an outline inherit the same value as the parent. New documents created in the Library as stand-alone documents not linked to a parent, adopt the system setting in the Options dialog box as the initial value. As with any editable property, you can change document's initial value at any time.

Use the Properties Toolpane
Editable document properties are viewed and modified in the Properties toolpane, which can be opened from the Library and all document editors except the Topic Editor. By default, the Properties toolpane opens docked on the right side of the Developer window. However, you can undock, move, and resize the Properties toolpane as needed.

Properties are grouped under categories in the Properties toolpane. Depending on the selected document type, different categories and properties appear. When you select a document, categories such as General, Topic, and Business Process Document may appear. You can expand and collapse categories to show or hide the related properties. The expand/collapse state of any category is saved as you navigate to other documents.

When you select a property, its description appears at the bottom of the toolpane. The bottom of the toolpane also displays warning messages when you cannot change the properties for a document.

The Properties toolpane is divided into two columns, with the name of the property in the left column and the value assigned to the property in the right column. You can resize the columns by dragging the vertical border between them. In addition, you can resize the height of the description pane at the bottom of the toolpane to view more or less of the text. When the descriptive pane or a property column is not large enough to display the full contents, pointing to the truncated text displays the full text in a tooltip.

Toolpane Views
The Categorized and Alphabetical buttons that appear at the top of the Properties toolpane control how you view the properties. The Categorized view, which is the default, displays the properties organized by category names. The Alphabetical view removes the category names and sorts all properties in alphabetical order.

Note: The Properties toolpane does not split when you enable a split layout. The properties in the toolpane refer to the document selected in the active layout.
Multi-user Considerations

To change general, topic, and document output properties, you must check out the document. A message appears at the bottom of the toolpane if any of the documents in a selection are read-only. You can change general, topic and document output properties while working online or offline.

To change workflow properties, you must be working online and the document must be either checked in or checked out to you. Properties in this category include Assigned to and State.

Change Document Properties

You can leave the Properties toolpane open as you modify properties. The contents of the toolpane change as you move from document to document. If you select multiple documents and change a property, the change is applied to all selected documents. When the selection includes multiple documents of mixed document types, the only properties that are available for editing are the properties that the document types have in common. Only editable properties appear in the Properties toolpane.

You can open the Properties toolpane from the Library or any document editor, except the Topic Editor. Property changes made from the Library or Outline Editor are automatically saved to the document. If you change a property from another editor, such as the Web Page editor, you will be prompted to save your changes when you close the editor. You cannot change properties for a document open in another editor. For example, if you open a web page or topic, you cannot change properties for the open documents from the Library. A warning message appears at the bottom of the Properties toolpane indicating that the document is open and that you must close it to modify the document properties.

Undo Document Properties

Most document editors (for example, Outline, Glossary, and Role editors) have an Undo command that will allow you to undo a property change. You can not undo property changes from the Web Page or Package editors or from the Library. There is no limit to number of actions you can undo/redo in the Outline Editor.

If you are changing properties from an editor that does not allow undo, and you are still in the property cell, you can press CTRL+Z or right-click in the cell and choose Undo from the context menu to undo a property change. Once you click outside a cell, you cannot undo your changes.

Multi-user Considerations

Before you can perform this action, you must check out the document. After you save any changes, you should check in the document to make it available to other authors and add the changes to the Developer's version control system. When you select a checked in document, a Read-Only message appears at the top of the Properties toolpane. If you are changing the properties of multiple documents at the same time, all selected documents must be checked out. Properties are not available for editing if one or more documents in a multiple document selection are not checked out.

You can change workflow properties for documents that are checked in or checked out to you.
To change properties for a document:

1. Display the Properties toolpane.
   You can also right-click any document and choose Properties or press F4.
2. Select the document(s) whose properties you want to change.
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
   You can also edit the properties for a web page or package open in a document editor.
3. Click the property cell in the Properties toolpane and make the necessary changes.

**Note:** The Developer automatically saves property changes made while you are working in the Library or Outline Editor. For properties that you type directly in a cell, you can press ENTER or click outside of the property cell to finalize your entry.

**Ways to Assign Properties**

How you enter or change the value for a property depends on the type of property. The methods for assigning property values include:

- **Text entry** - For properties such as keywords and document output fields, you type a value for the property directly into the corresponding cell in the Properties toolpane. For properties that may contain a large amount of text, such as an instructor note or a table, a browse button appears in the cell. Clicking the browse button opens a window where you can enter text or create the table.

- **Selection of a single value from a list** - A drop-down arrow appears in the property cell for properties where you select a single value from a preset list of values. These properties include language and screen resolution.

- **Selection of multiple values from a list** - A drop-down arrow or browse button appears in the property cell for properties where you can select multiple values from a preset list of values and checkboxes. You can select or clear one or more checkboxes.

**Assign a Property to Multiple Documents**

You can select multiple documents and change one or more properties at the same time. If the selected documents have different values for the same property, the property value appears blank in the property cell or dialog box. Entering new text or selecting a new value applies the property value to all the selected documents.

**Warning!** Be careful when changing a property for multiple documents that already contain values for the same property. The new values you enter for the property overwrite any existing values for all selected documents.

**Assign Checkbox Properties**

Properties such as roles, play modes, and remediation levels allow you to assign multiple values. The available values for these properties appear in a checkbox list. You assign property value(s) by selecting one or more checkboxes.

If you select multiple documents for property assignment, the checkboxes for the property values can have any of three initial states:
• Unselected (clear) - The value is not assigned to any of the selected documents.
• Selected (checked) - The value is assigned to all of the selected documents.
• Partially selected (gray with gray checkmark) - The value is assigned to some, but not all, of the selected documents.

You can check or clear any checkbox, regardless of its initial state, to assign the value to or remove it from ALL of the selected documents. If you do not change the state of a partially selected checkbox, the assignment of the corresponding value remains unchanged (assigned to some, but not all, of the selected documents). However, once you click a partially selected checkbox, you cannot restore it to its initial state. Therefore, when assigning property values to documents, you should select only those documents to/from which you want to add/remove the same value(s).

**General Properties**

The General Properties category appears for all document types. Depending on how a document was created, the initial property values for a document either default to the settings in Tools, Options or are inherited from the parent document.

When you create a new module or section document from the Library, you have the opportunity to change the default settings for the Language, Template, and Screen Resolution properties. These defaults are then passed to any new module, section or topic documents that are linked to the parent in the Outline Editor. For example, if you create a new Purchasing module with a screen resolution of 800 x 600, and then link a new Purchase Orders section and Reviewing a Purchase Order topic, the new documents inherit the same screen resolution as the parent module.

Existing documents inserted into an outline retain their original properties, even if they do not match the property settings of the parent. For example, if you link the Working with Vendors section with a screen resolution of 1024 x 768 to the Accounts Payable module, the linked section retains its original screen resolution settings. However, if you now create/link new documents to the Working with Vendors section, the new documents inherit the new screen resolution.

You can change the properties in the General category for a single document or several documents at the same time.

**Warning!** Be careful when changing a property for multiple documents that already contain values for the same property. The new values you enter for the property overwrite any existing values for all selected documents.

The General Properties category includes the following properties:

• Context
• Glossary
• Keywords
• Language
• Name
• Resolution
• Roles
Multi-user Considerations

To change properties, you must check out the document.

Context Property

The Context Property allows you to define a relationship between a topic(s) and a non-topic document such as sections and modules. This relationship allows for better search results because searching and finding the non-topic document also finds the related topics.

The Context button opens the Context dialog box which is used add relationships from existing topics to non-topic documents and/or create Context IDs for new topics that are related to non-topic documents.

Context for Topics verses Non-Topic documents

Context, that allows for better search results, can be applied to individual frames that make up a topic or associated, in a broader sense, to non-topic documents that can be related to one or more topics.

Topic documents

Context is added to a topic (on a frame by frame basis) during the recording process. You can view the context ID for any frame in the Context ID dialog box.

Context can also be manually added to a topic, on a frame by frame basis, if the match type is ExactMatch or NoMatch. You cannot add context to frames with context type SmartMatch because they are fuzzy matches, not specific Context IDs.

The Context ID dialog box opens from within a topic by clicking on the toolbar or by choosing Context ID from the Edit menu.

Non-topic documents

Context can be assigned to a non-topic document such as a section or module. This allows you to define relationships between topics and non-topic documents ensuring that related documents appear in a topic. For example, each time a user works through the process of filling out a purchase order form (i.e., a series of topics), a link to the actual purchase order form (i.e., a non-topic document) can be provided. In the Developer, the author can associate each frame of the process with the non-topic document. They can also associate the entire topic with a section or module.

Note: Frames added to a process after the context association was made to a non-topic document are not automatically associated to the non-topic document. The author must manually make the association to the new frames. However, if a topic is associated directly with a topic or section, any new frames added to the topic automatically inherit the association to the topic or section.

Context relationships for non-topic documents are set up from the Context field in the General category of the Properties toolpane. The Context field displays the name of each topic associated with the non-topic document. The Context button opens the Context dialog box which is used add relationships from existing topics to non-topic documents and/or create Context IDs for new topics that are related to non-topic documents. The Context dialog box contains two tabs: Topic Context and Context Names.
The Topic Context tab is where you create Context IDs for non-topic documents by selecting existing topics with context. This relationship insures that when you look at the section, the associated topics also appear. The Add Topic Context button opens the Add Existing Topic Contents dialog box where you can select existing topics with context to relate to the non-topic document.

**Note:** Context can also be added to non-topic by copying context from an existing topic and pasting it to a non-topic document or by capturing the context by recording screen(s) of the relevant application.

The Context Names tab is where you create additional Context IDs or edit the existing Context IDs of supported application screens associated with a non-topic document. The Create New Context button opens the Recorder in order to record an application screen. Once recorded, the Context Name field is filled with a context name and the Screen View show a snapshot of the captured screen. The Edit Context button opens the Context ID dialog box. You can add additional context names or edit the captured context name Context ID. This allows you to find specific context via a user-friendly name without having to understand all of the parts that make up the context ID.

To add context to a section/module:

1. Select a section or module document in the outline.
2. Click in the **Context** field in the Properties toolpane then click to open the Context dialog box.
3. With the Topic Contexts tab active, click **Add topic contexts** to open the Add Existing Topic Contexts dialog box.
4. Select the existing topic(s) to be associated with the document and click **OK**. The selected topics display on the Topic Contexts tab.
5. Click **OK**.

### Copy Context

Context can be copied from a frame within a topic and pasted to a non-topic asset such as a section or module. This copies all rows of the context ID into the section or module. Context IDs can not be pasted from one frame into other frames.

Context can also be copied from a section or module to another section or module. Since multiple contexts can be associated to a section/module, you can copy single Context IDs or all Context IDs associated with a section to another section.

To copy context from a topic frame to a section/module:

1. Open a topic in the Topic Editor.
2. Select a frame with context that you want to copy.
3. On the **Edit** menu, choose **Copy Frames**.
4. In the outline, select the section or module to which you want to paste the context.
5. If necessary, open the Properties toolpane of the section or module.
6. Click in the **Context** field to open the Context dialog box.
7. From the Context Name tab, click the **Paste Context** button.
8. Click **OK** to save the context.

To copy context between sections/modules:

1. If necessary, open the Properties toolpane of the section or module.
2. Click **Context** in the **Context** field to open the Context dialog box.
3. From the Topic Context tab, select the topic(s) within the section to be copied and click the **Copy Context** button.
4. Click **OK**.
5. Navigate to the Context dialog box of the destination section.
6. From the Topic Context tab, click **Paste Context**.
7. Click **OK**.

**Glossary Property**

Once you create a glossary, you can assign it to one or more documents in the Library. A glossary can be assigned to a document in two ways: through manual assignment and through inheritance from the document's parent.

You can manually assign a glossary while working in the Library, Outline Editor, or Web Page Editor, using the Properties toolpane. A glossary can be assigned only to modules, sections, topics, and web pages. Although no module or section text is marked up when glossary links are updated, assigning glossaries to modules and sections is useful for inheritance purposes, as described.

---

**Tip:** You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click). However, you must select only document types that support glossaries. If a multi-document selection in the Library includes a document type that does not support glossaries, such as a package, the Glossary property does not appear in the Properties toolpane.

---

**Warning!** Be careful when changing a property for multiple documents that already contain values for the same property. The new values you enter for the property overwrite any existing values for all selected documents.

---

Glossaries can be assigned through property inheritance only in the Outline and Topic Editors. If you assign a glossary to a module or section, all new module, section, and topic documents that you link as children of this document while working in the Outline Editor inherit the parent's glossary setting. Similarly, any new web page that you create from the Concept pane of the Outline Editor inherits the glossary of its parent. Likewise, if you assign a glossary to a topic, any new web pages that you create while working in the Topic Editor, for example, as new frame attachments, inherit the topic's glossary setting. However, new documents that are not linked (documents that are created using the File, New command) and existing documents that are linked as children of the document do NOT inherit any property settings.

Once you have assigned a glossary to a document, you still must update glossary links to create glossary links in that document.

If a glossary is no longer appropriate for a document, you can change or remove the assigned glossary using the Properties toolpane. Changing or removing the glossary assigned to a parent does not automatically change the glossary for any child documents,
even those that inherited their glossary from the parent. You must change the glossary for each child document manually.

In addition, changing or removing the glossary assigned to a document does not automatically update glossary links. Therefore, after making any changes in glossary assignments, you must update glossary links to apply the new glossary to the affected documents.

**Note:** You can view the glossaries assigned to selected documents in the Related Links toolpane. However, you cannot use the Related Links toolpane to change glossary assignments.

### Keywords Property

When a user performs a search in the Player, the Player performs a full text search of the text in the content you have created. You may, however, want to link text not used in the content to specific documents. The Keyword property allows you to attach words or text that relate specifically to your organization that might not occur in the content.

**Note:** Keywords can be assigned to module, section, or topic documents.

Keywords act like an index for locating documents and allow users to quickly find relevant content. For example, if members of your organization are required to use special formatting features to create end of month reports, you might want to attach the name of the monthly report as a keyword to all documents that could assist users with format features needed for report creation. It is very important for content authors to develop good keywords that enable users to quickly find the information they need.

**Note:** Document text is not indexed for Far Eastern languages. The only way for Search to work in the Player for such languages is for authors to attach keywords.

Keywords travel with the document, so that each time you reuse or export/import the document, the keywords are also reused or exported/imported.

### Assign Keywords

Keywords are assigned to module, section, or topic documents from the Library or Outline Editor. You can select a single or multiple documents assign one or more keywords to the selection.

There is no limit on the number of characters in a keyword, nor is there a limit to the number of keywords a document may contain. However, the Keywords field is limited to a total of 1024 characters. Multiple keywords in the same document are separated by a comma (,), for example, "order, payment, vendor". Spaces added before or after a keyword are ignored.

**Note:** You can copy a comma delimited list of words from Microsoft Word or Notepad and paste it into the Keywords field. The copied text cannot include paragraph marks.

Keywords are not case sensitive, you can type them in upper or lower case. If the keyword for topic A is "print" and the keyword for topic B is "Print", both topics A and B are indexed under the same keyword "print". The Developer automatically reorders the keywords for a document in alphabetical order and removes any duplicate keyword entries.
**Note:** Although you can enter a phrase (multiple words separated by spaces) for a single keyword entry, the Developer treats each word in the phrase as a single keyword. The Developer will not remove a duplicate word if it is part of a phrase.

**Warning!** Be careful when changing a property for multiple documents that already contain values for the same property. The new values you enter for the property overwrite any existing values for all selected documents. To assign additional keywords to multiple documents, see *Rules for Assigning and Deleting Keywords*.

### Multi-user Considerations

Before you can perform this action, you must check out the document. After you save any changes, you should check in the document to make it available to other authors and add the changes to the Developer’s version control system.

In a multiple selection, you cannot add, edit or delete keywords unless all documents are checked out.

To assign a keyword:

1. Display the Properties toolpane.
2. In the Library or Outline Editor, select the topics(s) to which you want to assign a keyword.
   
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
3. In the **General** category, click the **Keywords** cell.
4. Type the first keyword.
5. To assign additional keywords, type a comma (,) and then type the next keyword.

**Note:** To append a keyword to existing keywords, click at the end of the keywords, type a comma and the new keyword.

**Note:** You can move or copy keywords from one topic to another. You can right-click in the Keywords cell and use the commands on the context menu to cut, copy, and paste selected keywords. You can also use the Select All command to select all the keywords in the cell.

### Delete Keywords

You can remove a keyword from a document by deleting the keyword in the Keywords field. You can also edit an assigned keyword to correct it.

**Note:** To delete or edit keywords for multiple documents, see *Rules for Assigning and Deleting Keywords*.
Multi-user Considerations

Before you can perform this action, you must check out the document. After you save any changes, you should check in the document to make it available to other authors and add the changes to the Developer's version control system.

In a multiple selection, you cannot add, edit or delete keywords unless all documents are checked out.

To delete a keyword:

1. Display the Properties toolpane.
2. In the Library or Outline Editor, select the document(s) for which you want to delete a keyword.
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
3. For a single document or multiple documents with identical keywords, select the text in the Keywords cell and press DELETE.
4. To delete all keywords for multiple documents with different keywords assigned, type any text in the blank Keywords cell, then select the text and press DELETE.

Rules for Assigning and Deleting Keywords

The results of assigning keywords depend on whether you are assigning keywords to one document or multiple documents and if those documents already contain existing keywords. The following table describes the rules for assigning keywords:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Display in Toolpane</th>
<th>Actions Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>One document with no keyword assigned</td>
<td>Keywords cell appears blank</td>
<td>You can add a new keyword.</td>
</tr>
<tr>
<td>One document with an existing keyword</td>
<td>Keyword appears in Keywords cell</td>
<td>You can edit, delete, or append to existing keywords.</td>
</tr>
<tr>
<td>Two or more documents that contain no existing keywords</td>
<td>Keywords cell appears blank</td>
<td>You can add a new keyword. The keyword is assigned to all selected topics.</td>
</tr>
<tr>
<td>Two or more documents that contain identical existing keywords</td>
<td>Keywords appear in Keywords cell</td>
<td>You can edit, delete, or append to existing keywords.</td>
</tr>
<tr>
<td>Two or more documents that contain different existing keywords</td>
<td>Keywords are NOT displayed. The Keywords cell appears blank.</td>
<td>You can enter a new keyword. The new keyword will overwrite any existing keywords in the selected documents. You cannot append keywords if different keywords are assigned.</td>
</tr>
</tbody>
</table>

Language Property

The Language property indicates the default language of the content and determines the language dictionary that is used to check the spelling of the document. If you assign a language to a document for which no Developer dictionary exists, the spelling checker skips checking the document.
New documents created from the Library inherit the default language setting. New module, section, and topic documents created in the Outline Editor automatically inherit the language of their parent.

You can also view the Language property for documents in the Details View in the Library or Outline Editor.

**Note:** The Language property for a topic also determines the publishing styles that are available for preview and the master role list that is used for assigning roles.

**Name Property**

The Name property is the name the author gave to the document when it was created/saved. You can use this property to rename a document.

**Note:** The Name property is not available for a multiple document selection.

**Resolution Property**

The Resolution property determines the screen resolution in which the content is recorded. The resolution is determined by the dimensions in the Width and Height properties.

To set the resolution, you can select a setting for the width or height from a list. Selecting a setting for one dimension automatically adjusts the other dimension to the correct setting. When you select a width of 1024 pixels, the Developer automatically sets the height to the matching dimension of 768 pixels.

If authors attempt to record in a screen resolution other than the assigned resolution, a message box informs them that their resolution does not match the setting for the topic and indicates in what resolution they should record. While authors are not prevented from recording in a different resolution if they choose, this property does help to create greater consistency in the title's content.

The Resolution property for recorded topics is read-only; you cannot change the resolution for a topic that has already been recorded.

**Roles Property**

Role-based filtering allows users to quickly locate documents based on their job function or department.

For each language, there is a separate master role document to which you can add the roles that correspond to your company roles. You can then use this master role list to assign roles to modules, sections, or topics.

Roles are assigned to one or more document from either the Library or the Outline Editor using the Roles property. The Roles property opens the Assign Roles dialog box, from which you can select a single role or multiple roles to assign to the selected document(s).

**Note:** If roles assigned to a document appear truncated in the toolpane, you can point to the Roles property to display a tooltip showing the assigned roles.

Roles travel with the document so that each time you reuse or export/import the document, the roles are also reused or exported/imported.
You can view the roles assigned to documents in the Properties toolpane or in the Roles column that appears in the Details View in the Library or Outline Editor.

**Removing Roles from Documents**
You can choose to remove one or more roles from one or more documents by clearing the appropriate checkbox in the Assign Roles dialog box.

**Warning!** Be careful when changing a property for multiple documents that already contain values for the same property. The new values you enter for the property overwrite any existing values for all selected documents. If some of the documents in a multiple document selection already contain roles, adding or removing roles overrides the original role assignments for all selected documents. See Assign Roles to Modules, Sections, or Topics for more information about changing roles for multiple topics.

To assign roles to one or more documents:

1. Display the Properties toolpane.
2. From the Library or Outline Editor, select the document(s) to which you want to assign roles.
   
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click). However, all documents included in your selection must have the same language.

3. In the **General** category, click in the **Roles** cell.
4. In the Assign Roles dialog box, select the role(s) to which you want to assign the selected document(s).
   
   To include a role, click the checkbox next to its name. To remove a role, clear the checkbox next to its name.

   You can also use the Select All button to include all roles or the Clear All button to remove all roles from the selection. These buttons apply to all roles listed in the Assign Roles dialog box, whether they are included in the master role list or are available as additional roles for the selected documents.

5. Click **OK** or press ENTER.

**Template Property**

The document template determines the text used for bubble text and action properties. The Template property allows you to browse the Library and select another template set. The template sets included with the program are the Standard and Microsoft templates. The Microsoft template conforms to the standards as stated in the Microsoft Manual of Style for Technical Publications. In addition to these templates, other template sets may be available to you.

You can use the template to modify the text used in bubbles for action and object types. For example, you can change the template text for a Left click action to display the bubble text "Click on" instead of "Click the". Templates are read-only, but you can create a copy of the template with a new name, edit the text in the new template and use the Template property to assign the new template to your content.

If you are creating content for a language other than the default Developer language, you can select the template for that language. However, you can set only one language per document. If you need to produce the same content in multiple languages, you can follow the localization process to create a copy of your outline based on another language template.
Note: Templates are stored in the Library by language in the System/Templates folder.

Topic Properties

The properties in the Topic category apply specifically to topic documents. New topics inherit certain topic defaults from the Options dialog box, such as the default play modes and Know It? options. After you create topics, you can change the properties for a single topic or several topics at the same time. Topic properties only appear in the Properties toolpane for a multiple selection if all the selected documents are topics.

The Topic Properties category includes the following properties:

- Know It? Remediation
- Know It? Required %
- Play Modes

Warning! Be careful when changing a property for multiple documents that already contain values for the same property. The new values you enter for the property overwrite any existing values for all selected documents.

Multi-user Considerations

To change properties, you must check out the document.

Know It? Options

The Know It? options are available if Know It? play mode is selected for a topic. Know It? options for new topics are set in the Options dialog box, but you can change them on a per topic basis. Know It? options include the Know It Required % and Know It Remediation properties.

Warning! Be careful when changing a property for multiple documents that already contain values for the same property. The new values you enter for the property overwrite any existing values for all selected documents.

Know It? Required %

When you create a new topic, it inherits the required percentage for Know It? mode from the defaults set in the Options dialog box. This percentage is the score a user needs to achieve in order to pass the assessment for the current topic. You can enter any value between 0 and 100.

There may be some specific topics for which you want to change the passing percentage. You may want to lower it for certain difficult tasks or raise it for common tasks. You can change the required percentage for Know It? mode for one or more topics using the Know It Required % property in the Properties toolpane. You can type any value between 0 and 100 and it is not necessary to type a % sign.
**Note:** If all of the topics in a multiple selection are assigned the same required percentage, the value appears in the Know It Required % property cell. If the topics have different percentages assigned, the Know It Required % property cell appears blank.

**Warning!** Be careful when changing a property for multiple documents that already contain values for the same property. The new values you enter for the property overwrite any existing values for all selected documents.

**Note:** Changing default Know It? options in the Options dialog box affects new topics only.

To change the Know It? Required % for a topic:

1. Display the Properties toolpane.
2. In the Library or Outline Editor, select the topic(s) whose required percentage you want to change.
   - You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
3. In the **Topic** category, click the **Know It Required %** cell.
4. Type a value between 0 and 100.

**Note:** To change this property, the Know It? play mode must be enabled for the selected topic(s).

**Know It? Remediation Levels**

When you create a new topic, it inherits the remediation levels for Know It? mode from the defaults set in the Options dialog box. Remediation provides feedback for users when they perform an incorrect action in Know It? mode.

When a user fails to complete a step in Know It? mode, they can see up to four levels of remediation. Of the four levels, you can configure whether any combination of the first three listed in the following table are active for a topic. The fourth level is always active. When users fail to complete a step on the first attempt, they are marked incorrect for that particular step. The following table lists the four levels of remediation that are available, although you can only configure the first three for a specific topic or set global defaults for all new topics.

<table>
<thead>
<tr>
<th>Remediation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 1: Try Again</td>
<td>The bubble informs you that your action was incorrect and to try again.</td>
</tr>
<tr>
<td>Level 2: Instructions Provided</td>
<td>The bubble informs you that the action was incorrect and provides instructions for completing the step.</td>
</tr>
<tr>
<td>Level 3: Instructions and Highlight Provided</td>
<td>The bubble informs you that the action was incorrect and provides instructions for completing the step and a highlighted area indicating where the action should take place.</td>
</tr>
<tr>
<td>Level 4: The Step is Completed for You</td>
<td>The bubble informs you that the action was incorrect and states that the action will now be completed for you.</td>
</tr>
</tbody>
</table>
You can view and change the remediation levels assigned to a topic in the Know It Remediation property cell in the Properties toolpane. When activated, the Know It Remediation property cell displays a drop-down list from which you can select and deselect remediation levels. A short description of each level appears at the bottom of the list. You can change remediation levels for one or more topics.

**Note:** If all of the topics in a multiple selection are assigned the same remediation levels, the levels appear in the Know It Remediation property cell. If the selected topics have different remediation levels assigned, the Know It Remediation property cell appears blank. Levels common to all selected topics appear active in the Remediation drop-down list, and the levels that differ appear grayed out. You can make changes to active or grayed out levels. See *Assign a Property to Multiple Documents* for more information about changing remediation levels for multiple topics.

**Warning!** Be careful when changing a property for multiple documents that already contain values for the same property. The new values you enter for the property overwrite any existing values for all selected documents.

**Note:** Changing default Know It? options in the Options dialog box affects new topics only.

To change the Know It? remediation levels for a topic:

1. Display the Properties toolpane.
2. In the Library or Outline Editor, select the topic(s) whose required percentage you want to change.
   
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
3. In the **Topic** category, click in the **Know It Remediation** cell.
   
   A list of remediation levels appears.
4. Select a checkbox to include a remediation level or clear a checkbox to remove a remediation level.

**Note:** To change this property, the Know It? play mode must be enabled for the selected topic(s).

### Play Modes Property

The playback modes assigned to a topic determines which play modes will be available when a user plays the topic in the Player. New topics automatically have all playback modes enabled, but you can change the playback mode for a topic after it is created.

You can view the playback modes assigned to a topic in the Play Mode property cell in the Properties toolpane. You change the playback modes for one or more topics by selecting or deselecting play modes from the Play Mode drop-down list. A short description of each play mode appears at the bottom of the list.

If you select multiple topics, the play mode settings you select apply to the entire selection, and overwrite any previous settings for that property. See *Assign a Property to Multiple Documents* for more information about changing play modes for multiple topics.
To change the play mode for a topic:

1. Display the Properties toolpane.
2. In the Library or Outline Editor, select the topic(s) for which you want to change play modes.
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
3. In the Topic category, click in the Play Modes cell.
   A list of play modes appears.
4. Select a checkbox to include a play mode or clear a checkbox to disable a play mode.

Show Bubbles Property

You can prevent the bubble from appearing during playback in See It! and Try It! modes. This allows you to create the equivalent of a PowerPoint slide show, and then record sound to narrate it if desired. In this case, a bubble on each "slide" would not be appropriate.

The Show Bubbles topic property allows you to turn on or off all bubbles in a topic. There are three options:

- Always - All bubbles show for the topic.
- Never - No bubbles show for the topic.
- Use frame settings - Uses the settings on each frame to determine if the bubble appears. This is the default value.

Using this option does not update the settings on the individual frames. It acts as an override and ignores the settings. This option does, however, turn off all of the action areas for the topic. Since the action areas are not present, you may want to make sure that the Enable skipping in Try It! mode option is selected when you publish the content so that the frames can be advanced by pressing Enter in Try It!; if there are no action areas, there is no visual cue as what to do to advance the frame, and you may have difficulty advancing the frame.

If sound has been recorded for the topic or the frame, all frames display during See It! mode playback and advance automatically when the sound has finished playing. In Try It! mode, all frames are shown, but the frames must be advanced manually by either performing the correct action or pressing Enter. No remediation is shown if you perform the incorrect action.

If there is no sound with the topic, turning off the bubble has the following affect on the various frame types in See It! and Try It! modes:

<table>
<thead>
<tr>
<th>Frame type</th>
<th>See It!</th>
<th>Try It!</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction/End</td>
<td>skipped</td>
<td>skipped</td>
</tr>
<tr>
<td>Explanation</td>
<td>skipped</td>
<td>skipped</td>
</tr>
<tr>
<td>Frame type</td>
<td>See It!</td>
<td>Try It!</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Decision</td>
<td>included; user must choose a path</td>
<td>included; user must choose a path</td>
</tr>
<tr>
<td>Action</td>
<td>bubble hidden; action area displayed unless it has been turned off</td>
<td>bubble hidden; action area displayed unless it has been turned off</td>
</tr>
<tr>
<td>No-context</td>
<td>bubble hidden; action area displayed unless it has been turned off</td>
<td>bubble hidden; action area displayed unless it has been turned off</td>
</tr>
<tr>
<td>Frames with infinite time delay</td>
<td>skipped</td>
<td>bubble hidden; action area displayed unless it has been turned off</td>
</tr>
</tbody>
</table>

**Note:** If there are alternative actions on a frame and you hide the bubble, the bubble is hidden for all actions.

To show or hide bubbles for a topic:

1. Display the Properties toolpane.
2. In the Library or Outline Editor, select the topic(s) for which you want to change bubble settings.
   
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
3. In the **Topic** category, click ✔️ in the **Show Bubbles** cell.
4. Select **Always**, **Never**, or **Use frame settings**.

**Document Output Properties**


Some of the document field values in the published output are generated by the Developer from information taken from the topic. Developer-generated field data includes the name of the document, the roles assigned to the topic, and the date the document was generated. Fields that are not generated by the Developer are left blank for you to enter the appropriate topic information.

For a Business Process Document, user-defined fields may include the department, revision number, the name of the person who last changed the document, and the status of the document. For a Test Document, these fields include the purpose of the test being performed (note that the text in this field will also appear on the HP Quality Center format), the estimated time, and the required test setup. For an Instructor Manual, you can add instructor notes that relate to a topic.

You enter document output text directly in the Properties toolpane or in a text entry dialog box for those properties that appear in tables or allow multi-line entries, such as Instructor Notes.

You can enter and edit document field values for a single topic or multiple topics.
Warning! Be careful when changing a property for multiple documents that already contain values for the same property. The new values you enter for the property overwrite any existing values for all selected documents.

Multi-user Considerations
To change properties, you must check out the document.

To add text to document output fields:
1. Display the Properties toolpane.
2. In the Library or Outline Editor, select the topics(s) to which you want to add document output text.
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
   If you try to edit the properties for a topic open in the Topic Editor, a message appears prompting you to close the topic.
3. In the Properties toolpane, expand the heading for the document output category (for example, Business Process Document, Test Document, and so on).
4. Type the text directly in the property cell or click and enter the text in the text entry dialog box.

Required fields and Output results for the Business Process Document
The Business Process Document includes property tables for Required fields and Output results. These property tables are blank and do not contain prepopulated field names. They can be used to enter custom field names and comments.

When creating entries for either the Required Fields or Output property, you can add more rows to the table, delete rows, and move rows up and down to rearrange the order. The text in the first cell of the table appears in the Properties toolpane when you select a document that contains text for either property.

If a multiple topic selection contains existing table text, the table dialog box displays the common table rows that appear in ALL of the selected topics. The common table row can appear in different row positions in the selected topics as long as the text in the row is identical. If the selected topics contain no common table rows, the table appears blank. The changes made to a table for a multiple topic selection affect all of the selected topics, and overwrite any existing values. Therefore, the table rows that do not appear in a multiple selection because they are not common to the entire selection are deleted.

To add a Required field or Output result:
1. Display the Properties toolpane.
2. In the Library or Outline Editor, select the topic to which you want to add property values.
3. In the Business Process Document category, click in the Required fields or Output cell.
4. The Required Fields or Output dialog box opens with a blank row ready for text entry.
5. Type the text in the appropriate cell. Press Tab to move from one cell to the next. A new row is automatically added.
6. Click OK to save the changes.
   You can also click Cancel if you do not want to save your changes.

**Tip:** All cells allow multi-line entries. You can create multiple lines in a cell by letting the text word-wrap or by pressing Shift+ENTER to insert new lines. Scroll arrows appear in multi-line cells for navigating through the text.

To insert a new row:

1. Select a row and click to add a new row below the selected row.
2. Type the text in the appropriate cell.
3. Click OK to save the changes.
   You can also click Cancel if you do not want to save your changes.

To delete a row:

1. Select the row you want to delete and click ✗.
2. Click OK to save the changes.
   You can also click Cancel if you do not want to save your changes.

To sequence a row:

1. Select a row and click ▲ or ▼ to move the row to a new position in this list.
2. Click OK to save the changes.
   You can also click Cancel if you do not want to save your changes.

**Add Document Revision Text**

The Business Process Document, Test Document, and Job Aid publishing formats allow you to assign revision text that is appended to the topic filename (after the Document Type) when you publish these formats.

Revision text is appended to the topic file name as follows:

**Syntax:** Topic Name_Document Type_Revision.file extension
13. Preview a Topic

You can preview a selected topic only from the Outline Editor in any of the Player modes such as See It!, Try It!, Do It!, and Know It?; document formats such as the Business Process Document, Job Aid, Test Document, Training Guide, and Instructor Manual; and the Presentation format.

Note: You can only preview one topic at a time and the topic must have been recorded. You can also only preview a topic in a Player mode if that mode has been enabled on the Properties toolpane of the topic.

When you preview a topic in any format, the Developer uses the settings configured in the Documents, Player, and Presentation options (Tools menu). The Developer also uses the Category setting in the Preview Defaults option to determine which category of publishing styles should be used for previewing content. You should review these settings in Tools, Options before you preview a topic.

Set the Default Preview
You can choose any of the publishing styles as the default preview using the Preview list box on the toolbar. The Preview list box indicates the current preview default. Click to preview the topic using the current default or click the down arrow in the Preview list box and select a different format. Your selection becomes the new default.

Multi-user Considerations
You can preview a topic while working online and offline; however, you should note that the only local content is used in the preview. For example, you can not choose to preview sever vs. local content; however, you do have this option when publishing content. A message appears when you try to preview a topic that you do not have in your local cache. If this happens, you should go online to preview the document or use the Get command to download the topic and return to working offline.

Also note that you can not preview deleted, but restorable documents. You must first restore the document to preview it.

To preview a topic:

1. From the Outline Editor only, select one recorded topic that you want to preview.
2. On the File menu, point to Preview and choose one of the formats listed. The Player modes are listed first followed by the document formats. You can also click the down arrow to the right of the Preview list box on the Standard toolbar and choose one of the formats listed. Then click to preview the topic.
3. Review the topic and close it when you are finished.

Preview Player Modes

While the Player preview gives you a good idea of how the topic will appear in the Player, some differences do exist. For example, when you preview in Player mode you do not see the entire Player interface such as the outline and other controls for searching, filtering by role, and so on. However, this option allows you to test a recorded topic to verify that all the frames and bubble text are correct.
See It! and Try It! modes both use simulated environments, while Do It! mode uses a live environment where you interact with the live application. In See It! mode, you watch while the simulation progresses. In Try It! mode, you click in the location indicated or type the specified text to advance to the next frame. In Know It? mode, you are required to complete a particular task and are scored on how well you complete the task.

**Note:** The appropriate Play Modes property must be set on the topic to preview it in a particular mode.

### Play See It! Mode

See It! mode enables you to learn by watching an animated demonstration of tasks being performed in a simulated environment. As tasks are performed, information is provided explaining the steps being performed.

You can pause the playback at any time by clicking the Pause link in the bubble. Then, when you are ready, you can click the Resume link to continue the playback. You can stop the playback at any time by clicking the Close button in the bubble, or manually advance by pressing the ENTER key. You can also press ESC to exit.

Control the topic playback using the Actions link that appears in the bubble.

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resume</td>
<td>Close the Action menu and resume the topic playback.</td>
</tr>
<tr>
<td>Print It!</td>
<td>Displays a document that was provided for the topic by your content provider.</td>
</tr>
<tr>
<td>Preferences</td>
<td>Display the current preference settings for the Player. If this link does not</td>
</tr>
<tr>
<td></td>
<td>appear, your administrator has preset all of the preferences and has</td>
</tr>
<tr>
<td></td>
<td>prevented them from being changed.</td>
</tr>
<tr>
<td>Help</td>
<td>Display the Player help system.</td>
</tr>
<tr>
<td>Close Topic</td>
<td>Close the topic in current playback mode and return to the topic launch</td>
</tr>
<tr>
<td></td>
<td>point.</td>
</tr>
</tbody>
</table>

### Play Try It! Mode

Try It! mode enables you to learn a task by practicing in a simulated environment with step-by-step instructions and guidance throughout the task. If you make a mistake, you are prompted to try again. Whenever text input is required, the text must be entered EXACTLY as suggested to advance to the next step. If the step does not automatically advance after you enter the requested input, you may need to modify your entry. If you feel that your entry is also an acceptable one, you can click the Typing Complete button to submit it. If your entry is also considered a correct response, the step will advance. Otherwise, you will be prompted to enter the requested text. Because you are using a simulated environment, your actions will have no impact on actual system data or settings.

Control the topic playback using the Actions link that appears in the bubble.

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Step</td>
<td>Advance to the next step.</td>
</tr>
<tr>
<td>Previous Step</td>
<td>Return to the previous step.</td>
</tr>
</tbody>
</table>
Play Know It? Mode

Know It? mode enables you to test your knowledge of a task in a simulated environment. When you click the Know It? icon, you are presented with the score needed to pass, and you may also receive instructions for completing the assessment or other pertinent information. You can then start to perform the required steps for completing the current task. Once you start the task, you may not see any further instructions for completing it, depending on how the task was structured by the content author. Since Know It? mode is a simulated assessment, you must perform the steps of the topic exactly as they were recorded during content creation. If Try It! mode includes alternative methods of performing a step, either method will be scored properly in Know It? mode.

If you are unable to complete a step, you can click the Show Step link in the Know It? bubble. When you click this link, a window opens, informing you that you will be graded as incorrect if the Player completes the step for you. You can then confirm the action by clicking Yes or cancel the action by clicking No. If you cancel the action, you can attempt to complete the step. If you confirm the action, the step is completed for you and you are marked incorrect for that particular step. Once the step is complete, you can then complete the remaining steps in the task.

If you fail to complete a step, you will see up to four levels of remediation. Following are the four levels of remediation:

<table>
<thead>
<tr>
<th>Remediation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 1: Try Again</td>
<td>The bubble informs you that your action was incorrect and to try again.</td>
</tr>
<tr>
<td>Level 2: Instructions Provided</td>
<td>The bubble informs you that the action was incorrect and provides instructions for completing the step.</td>
</tr>
</tbody>
</table>
Remediation | Description
---|---
Level 3: Instructions and Highlight Provided | The bubble informs you that the action was incorrect and provides instructions for completing the step and a highlighted area indicating where the action should take place.
Level 4: The Step is Completed for You | The bubble informs you that the action was incorrect and states that the action will now be completed for you.

Although you cannot control the playback in Know It? mode, you can use the Actions link that appears in the bubble to access the following links:

| Link | Description |
---|---|
Preferences | Display the current preference settings for the Player. If this link does not appear, your administrator has preset all of the preferences and has prevented them from being changed. |
Help | Display the Player help system. |
Close Topic | Close the topic in current playback mode and return to the topic launch point. |

You can exit Know It? mode at any time by clicking the Close button in the Know It? bubble or by pressing ESC. When you attempt to exit Know It? mode, you are presented with two options that enable you to: 1) exit the assessment without being scored; or 2) return to the assessment and complete the task.

When you complete the assessment, you are presented with your score as a percentage of steps completed properly without assistance. Therefore, you are scored correct only when you complete a step right the first time. The passing score and a Pass field also appear in the assessment results. The Pass field displays “Yes” or “No” to indicate if you passed or failed the assessment.

**Play Do It! Mode**

With Do It! mode, you are guided through a task while you perform it in the live application. This unique mode makes it possible for you to accomplish real work while you learn.

When a topic is played in Do It! mode, the Do It! window opens on top of the target application. The top section of the window includes step-by-step instructions for completing the task. When you complete a step, you click the Next Step button to display instructions for the next step or to skip a step. The Previous Step button appears after you perform the first step in the topic, allowing you to move back to a previous step. If a key combination was set in the Preferences window, you can use that combination to advance to the next step in Do It! mode. A key combination is not available to navigate back to the previous step, however.

The bottom section of the Do It! window displays a graphic that illustrates how the screen should appear in the live application for the step. On the graphic, a marquee surrounds the area in which you should perform the action in the live application. You can drag the graphic to reposition it within the Do It! window, if necessary. You can also drag the lower right corner of the Do It! window to resize it and display more of the graphic or you can use the Show/Hide Graphic button to toggle the display of the graphic in the Do It!
window. You can also move the Do It! window to another area of the screen by dragging the title bar to the desired location on the screen.

Control the topic playback using the Actions link that appears in the bubble.

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show next Alternative action</td>
<td>Display other ways to perform the current step. This link only appears when other ways to perform the current step are defined in the authoring process.</td>
</tr>
<tr>
<td>Next Step</td>
<td>Advance to the next step.</td>
</tr>
<tr>
<td>Previous Step</td>
<td>Return to the previous step.</td>
</tr>
<tr>
<td>Restart Playback</td>
<td>Return to the first step in the topic and restart the task.</td>
</tr>
<tr>
<td>Display Concept</td>
<td>Display the conceptual information for the task. This link only appears if conceptual task information exists.</td>
</tr>
<tr>
<td>Attachments</td>
<td>Display individual links that launch additional information related to the current screen. This link only appears if additional information exists for the current screen.</td>
</tr>
<tr>
<td>Play</td>
<td>Display links to launch the topic in See It!, Try It!, or Print It! mode (if Print It! mode is enabled). After viewing the step in See It! or Try It! mode, you can continue in that mode or press ESC to return to Do It! mode.</td>
</tr>
<tr>
<td>Preferences</td>
<td>Display the current preference settings for the Player. If this link does not appear, your administrator has preset all of the preferences and has prevented them from being changed.</td>
</tr>
<tr>
<td>Help</td>
<td>Display the Player help system.</td>
</tr>
<tr>
<td>View Outline</td>
<td>This link only appears if the topic was launched in a context-sensitive manner from a target or web-based application. Close the topic and return to outline in the Player.</td>
</tr>
<tr>
<td>Close Topic</td>
<td>Close the topic in current playback mode and return to the topic launch point.</td>
</tr>
</tbody>
</table>

Preview Documents

In addition to previewing topics in the various Player modes, you can also preview a topic in any of the following Document formats:

- Business Process Document
- Job Aid
- Training Guide
- Instructor Manual
- Test Document

Each of these preview options appears below the Player modes on the Preview list box. When you choose one of these options, the document appears as read-only in Microsoft Word or Adobe Acrobat, depending on the options you selected for the format you are previewing.
System Process
This format is useful for creating documents that not only include the procedures and conceptual information for business processes, but also contain information relating to intended audience, roles and responsibilities, document status, versions, and dates. Each topic is published to a separate document which includes a concept page, with information about the document and task, and the procedures for completing the task.

Job Aid
This format results in a quick reference guide, enabling users to view only the procedures for completing a task, without conceptual information. Each topic is published in a separate document which includes only the procedures for completing the task.

Training Guide
This format allows instructors to create manuals quickly for Instructor-led training. The document includes a title page, copyright information, table of contents, conceptual information, and procedures for completing all tasks included in the published outline. In addition, if the content you publish contains glossary markups, then a glossary is included at the end of the document.

Warning! Be aware that when you publish a Training Guide, your entire selection is published as one document. If you publish a large amount of content at one time, you may encounter memory problems with Microsoft Word. Consider publishing your content in smaller chunks and then merge the contents of each Microsoft Word file after publishing from the Developer.

Instructor Manual
This format allows instructors to publish the Training Guide including instructor notes. The instructor notes are inserted in the document per topic, after the Concept, and before the Procedure. An Instructor Note heading appears in the output in the same style as Procedure text. The instructor notes are formatted like web page attachments (indented 1/2 inch from the margin in a box with a rule and shading). This is designed to make the notes stand out from the other text. The outside margin is adjusted to 2.5 inches. This allows instructors room to write their own notes.

Warning! Be aware that when you publish an Instructor Manual, the entire selection is published as one document. If you publish an entire outline, the document could be very large, and you might experience problems with Microsoft Word.

Test Document
This format allows you to create documents for testing software applications. Each topic is published to a separate document. The document includes the purpose of the test, test history, time to test, test setup, and test procedure. The test procedure contains the steps for completing the task.

Preview a Presentation
You can preview a topic in the Presentation format. This preview option appears at the bottom of the Preview list box. When you choose this option, the document appears as read-only in Microsoft PowerPoint.
14. Publish Content

The publishing process copies content out of the development environment, restructures it, and creates one of two types of outputs: content that you can deploy to end users through a Player or a series of document files. You can customize both the Player and the documents, as well as create your own custom publishing styles.

Note: If you create custom publishing styles, they may not be compatible with newer versions. You may need to re-apply the customizations; therefore it is a good idea to document any customizations so that you can easily re-apply them, if necessary.

Deployment Formats

When you publish to any one of the Deployment formats, the Developer creates a content source. The source can then be placed on a web server for users to view the content and play the topics. The content can also be distributed to end users to play offline on their local computers.

All types of content are included in the Player format: web pages, URLs, and files from packages. Sections which have no topics but do have a concept attachment are also included in the Player and Web Plug-in formats.

Player

This publishing format creates a content source for the Player. The Player interface includes a customizable header (showing a default image or custom image/html page), Outline/Search pane, and a Concept pane (showing a concept if available or an introduction if no concept is available). Users can play topics in See It!, Try It!, Do It!, and Know It? modes. They can also select Print It! mode to view and print a document of the process covered in the topic.

Note: Sound playback is available in See It!, Try It!, and Do It! modes. Sound is disabled in Know It? mode because it is designed to test the user's knowledge.

You can launch the Player when the publishing process is complete. If you publish just the Player format, the option to launch the content automatically is selected and you can launch it directly from the Publishing Wizard. If you want to launch it later, navigate to the location where you published and open the Publishing content folder. Within that folder, open the PlayerPackage folder and double-click the Play.exe file to launch the Player.

For complete information on using the Player, see the Content Player manual or online help.

The following publishing options are available for the Player:

- Convert screenshots to 256 colors: By default, screenshots are converted to 256 colors. This option allows for screenshots in more than 256 colors. This is especially useful for the Player formats so that the screenshots in the simulated playback modes are clearer.

- Create links for backward compatibility: You also can choose to create links for backward compatibility. This is an important option if you have created web pages or HTML links to content from a previous version that you have converted into the current version. If you choose this option during publishing, a folder structure is generated that will allow you to keep the existing links without needing to update
them. After you publish, open the folder in which you published the content and rename the Linked_folders directory to match the name of the application folder from the previous version. For example, in a previous version, you published a Player package for the WordPad application. Within that Player package, there is a folder called WordPad, in which all the content is located. If you convert that title to the current version and republish it to a Player package using the backward compatibility option, you would rename the Linked_folders folder to WordPad. The pages within this folder will redirect your existing links appropriately into the new content structure.

**Note:** If you want to use this option, the module names in the content you publish MUST be unique, as the module name is used to determine the folder name.

- Include HTML Web Site: You can choose to include the HTML Web Site format when you publish to the Player. The HTML format is contained in a folder called html within the PlayerPackage folder. If this folder is present, the HTML Web Site format will launch if a user has a browser that is not supported by the Browser.

- Sound: By default (None), sound files are not included in any of the Player formats. To include sound with the Player, select the quality for sound playback; Low (5.5 kHz), Medium (11 kHz), or High (22 kHz). Medium produces sound files (.FLV) in the published output roughly double that of the Low setting. High produces published sound files (.FLV) roughly double that of the Medium setting.

**Format for Print It! mode:** If you enable Print It! mode for topics using the Play Modes property, you can use this option to determine which document style is included when you publish formats that support Print It! mode. Choose "none" if you do not want publish Print It! mode (even when topics are assigned this mode). By default, Job Aid and System Process are the only options for Print It! mode. However, other styles can appear as choices by copying the PrintItStyle setting XML from Style.xml file of the Job Aid or System Process document styles and pasting the XML into the document style that you want included in the Print It list.

- Also, if you are using a custom category to store the styles, you must make sure you choose it in Publishing Preview on the Tools, Options dialog box. If you select a document style for Print It! mode, click Document Settings to set the publishing options for the document style you have selected. These settings do not impact the settings for the document style when published outside of Print It! mode.

**Presentation Options**

With the Player output, you also have the following presentation options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marquee color</td>
<td>Set the color for the marquee (or highlight) that appears in See It!, Try It! and Do It! modes. The default marquee color is red.</td>
</tr>
<tr>
<td>Play audio</td>
<td>• All available sound option (default) - Play any available sound files during playback.</td>
</tr>
<tr>
<td></td>
<td>• Keyboard and mouse clicks - Play only keyboard and mouse clicks during playback in See It! mode. These sounds are FLV files, delivered in the Audio folder of published content, that play automatically when keyboard and mouse clicks occur in See It! mode playback.</td>
</tr>
<tr>
<td></td>
<td>• No Sound - Disables sound during playback. <strong>Note:</strong> The user must have Flash 9.0 or greater installed to play sound in the Player.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show introduction text</td>
<td>This option controls whether the Introduction frame appears when a topic is played in the Player. Select this option to show the Introduction frame as the first frame during playback and deselect it to suppress the frame.</td>
</tr>
<tr>
<td>Enable users to change their Player preferences</td>
<td>If you enable this option, the Player will include a Preferences link that enables any user to change the settings. If you disable this option, the Preferences link does not appear in the Player.</td>
</tr>
<tr>
<td>Enable skipping in Try It! mode</td>
<td>Select this option to enable the user to advance to the next step in Try It! mode by pressing Enter instead of performing the action in the bubble.</td>
</tr>
<tr>
<td>Enable Direct Do It!</td>
<td>When a user launches Player content in a context-sensitive manner from a target or web application and only one topic is returned, the topic is automatically launched in Do It! mode when this option is on. This option is off by default. Note that the topic must also be configured for Do It mode using the Play modes property.</td>
</tr>
<tr>
<td>Key combination for advancing in Do It! mode</td>
<td>Configure a key combination for advancing to the next step in Do It! mode, if you do not want to use the default combination.</td>
</tr>
<tr>
<td>Default playback mode</td>
<td>This option controls the default mode launched when double clicking on a topic in the outline. The default is Try It! mode.</td>
</tr>
</tbody>
</table>

**HTML Web Site**

If you publish content for an HTML Web Site, the result is a tree of hyperlinked HTML files. Users can view the content via a browser. Exported content appears in a static version of Try It! mode suitable for posting to an Intranet or Internet site. With this method, users can view content without downloading a Web plug-in or installing content.

*Note:* The HTML Web Site is designed to conform to Section 508c requirements for accessibility. The site meets the following requirements: it can be read by a screen reader such as JAWS; it is not color dependent; the font size can be changed by the user; it is fully functional without using a mouse; and it does not depend on an audio track for functionality.

Users access the content by launching the index.html page in the HTMLPages folder in the Publishing Content folder in the location where you published. This page displays a table of contents page showing the outline. Each topic has a link. If there is an attachment, a Concept link appears next to the topic name.

After clicking a topic link, users can navigate the static version of Try It! mode using the available navigation links. Each frame is a separate HTML page. The frame pages contain a graphic showing the recorded target application screen with the action listed below the image. One action appears in each page, and a red border indicates the action area for the frame. To navigate through the topic, users can either click in the action area or click the navigation hyperlinks that appear below the graphic. Hyperlinked text appears below the frame to view any attachments as appropriate. The text used for the links is the tooltip as defined by the content author. Alternative Actions, Alternative Paths, and Decision frames are included as well. In addition, a Keyword Index link appears on the Table of Contents page. After clicking this link, users see each keyword followed by a list of the topics in which it appears. The topic names on this page are hyperlinked to the appropriate topic.
The graphics are in .png format and are linked to each HTML document as appropriate.

The following areas do not appear in the HTML Web Site output:

- Jump-in points
- Roles
- Unrecorded topics

The following publishing options are available for the HTML Web Site:

- Convert screenshots to 256 colors: By default, screenshots are converted to 256 colors. This option allows for screenshots in more than 256 colors. This is especially useful for the Player formats so that the screenshots in the simulated playback modes are clearer.

**LMS Package**

This publishing option creates learning specification compliant course material. It performs all the tasks required to generate content files that are ready to be integrated with your Learning Management System without any JavaScript programming or HTML manipulation. The output is AICC and SCORM compliant.

*Note:* AICC does not recognize double-byte character sets, such as Japanese or Chinese. If your content uses double-byte characters, the published LMS Package will only support a SCORM compliant Learning Management System.

The following publishing options are available for an LMS Package:

- Convert screenshots to 256 colors: By default, screenshots are converted to 256 colors. This option allows for screenshots in more than 256 colors. This is especially useful for the Player formats so that the screenshots in the simulated playback modes are clearer.

- Playback modes: Allows you to specify which of the enabled modes will be available when the topic is played through the LMS. It also functions as a filter based on the modes that are enabled on the topic. For example, if a topic has See It!, Try It!, and Know It modes enabled and you select the Try It! and Know It? option, only Try It! and Know It? modes are available in the LMS Package. In addition, if you select a topic that only has Try It! mode enabled, and then choose the See It! and Know It? option, the topic will not be published. Do It! mode is not available for an LMS Package.

- Sound: By default (None), sound files are not included in any of the Player formats. To include sound with the Player, select the quality for sound playback; Low (5.5 kHz), Medium (11 kHz), or High (22 kHz). Medium produces sound files (.FLV) in the published output roughly double that of the Low setting. High produces published sound files (.FLV) roughly double that of the Medium setting.

Format for Print It! mode: If you enable Print It! mode for topics using the Play Modes property, you can use this option to determine which document style is included when you publish formats that support Print It! mode. Choose "none" if you do not want publish Print It! mode (even when topics are assigned this mode). By default, Job Aid and System Process are the only options for Print It! mode. However, other styles can appear as choices by copying the PrintItStyle setting XML from Style.xml file of the Job Aid or System Process document styles and pasting the XML into the document style that you want included in the Print It list.
Also, if you are using a custom category to store the styles, you must make sure you choose it in Publishing Preview on the Tools, Options dialog box. If you select a document style for Print It! mode, click Document Settings to set the publishing options for the document style you have selected. These settings do not impact the settings for the document style when published outside of Print It! mode.

SCORM version: The content is compliant with the specifications for SCORM 1.2 and 1.3 (SCORM 2004). This allows you to select the SCORM version for publication. Regardless of the SCORM version you publish, the published content includes the files necessary for the other version. You do not have to republish to use the content for the other version.

Prefix URL: Allows you to enter the URL prefix that points to the location where the package will be placed on the LMS server. Each URL in the appropriate AICC and SCORM file is prefixed with this text. The path should include http://, followed by the name of the server and the folder name.

Standalone Topic Files

This option creates a content source with a file (.odtpc) for each topic. Each standalone topic file contains everything needed for playback in See It!, Try It!, Know It? or Do It! modes without having to be associated with a content source.

To play standalone topic files, you must install the Topic Player. When you publish a standalone topic, you can choose to publish the setup files for the Topic Player. Once this Player is installed, a user can then double-click the topic (.odtpc) file and play it in any mode. If you have the Developer installed on your computer, you can double-click on a standalone topic file to launch it without installing the Topic Player.

The following publishing options are available for Standalone Topic Files:

- Convert screenshots to 256 colors: By default, screenshots are converted to 256 colors. This option allows for screenshots in more than 256 colors. This is especially useful for the Player formats so that the screenshots in the simulated playback modes are clearer.

- Use encoded folder and file names: Publishes the content using hexadecimal names instead of actual module, section, and topic names. Encoding ensures that path names are not too long to publish.

- Include setup for topic player: Includes the setup executable file for the Topic Player, which must be installed in order to play the topic files.

- Sound: By default (None), sound files are not included in any of the Player formats. To include sound with the Player, select the quality for sound playback; Low (5.5 kHz), Medium (11 kHz), or High (22 kHz). Medium produces sound files (.FLV) in the published output roughly double that of the Low setting. High produces published sound files (.FLV) roughly double that of the Medium setting.

Format for Print It! mode: If you enable Print It! mode for topics using the Play Modes property, you can use this option to determine which document style is included when you publish formats that support Print It! mode. Choose "none" if you do not want publish Print It! mode (even when topics are assigned this mode). By default, Job Aid and System Process are the only options for Print It! mode. However, other styles can appear as choices by copying the PrintItStyle setting XML from Style.xml file of the Job Aid or System Process document styles and pasting the XML into the document style that you want included in the Print It list.

- Also, if you are using a custom category to store the styles, you must make sure you choose it in Publishing Preview on the Tools, Options dialog box. If you select a
document style for Print It! mode, click Document Settings to set the publishing options for the document style you have selected. These settings do not impact the settings for the document style when published outside of Print It! mode.

**Document Formats**

Document formats allow you to publish recorded content in various predefined documents that can appear in Microsoft Word (.doc) and/or Adobe Acrobat (.pdf) format. To publish document formats, Word XP or greater or Adobe Acrobat 7.0 or greater is required; earlier versions are not supported.

**Important Publishing Note:** If you are using Microsoft Office 2003 or Microsoft Office XP SP3 and you want to publish or customize document formats, the HP Quality Center output, or the Presentation output, you must install the *Microsoft Office Compatibility Pack for Word, Excel, and PowerPoint 2007 File Formats*. You can download this compatibility pack from the Microsoft Office Download Center. In addition, all Microsoft Office Products must have the latest updates and security fixes.

**Note:** All document formats are designed to conform to the following Section 508c requirements for accessibility: the document can be read by a screen reader such as JAWS, except for headers, footers, and image alternative text; and the text background shading is formatted to meet legibility standards for the visually impaired.

**Document Type and Version**

When you publish any of the Document formats, the document type is appended to the filename of each document published. The following table lists the document types.

<table>
<thead>
<tr>
<th>Document Format</th>
<th>Document Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Process Document</td>
<td>BPD</td>
</tr>
<tr>
<td>Job Aid</td>
<td>JOBAID</td>
</tr>
<tr>
<td>Instructor Manual</td>
<td>INSTMAN</td>
</tr>
<tr>
<td>Training Guide</td>
<td>TRAIN</td>
</tr>
<tr>
<td>Test Document</td>
<td>TEST</td>
</tr>
<tr>
<td>HP Quality Center</td>
<td>TESTDIR</td>
</tr>
</tbody>
</table>

If a revision number has been assigned to a topic, the revision number is also appended. This allows you to maintain multiple versions of different published output.

The document name is separated from the document type and revision number by an underscore. For example, a topic file name for a Business Process Document is TopicA, the resulting published document is TopicA_BPD.doc. If the assigned revision value is 2, the published document name is TopicA_BPD_2.doc.

**Attachments in Document Formats**

Sections which have no topics but do have a concept attachment are included in the Training Guide and Instructor Manual styles. Attachments are also included in the document formats as follows:
### Options for Document Outputs

The following options are available for each document format except HP Quality Center and Presentation.

- **Output format:** By default, published output is in Microsoft Word, but you can choose Adobe Acrobat PDF format or both. You must have Adobe Acrobat 7.0 (or greater) Standard or Professional edition installed to create PDF output.

  After Adobe Acrobat is installed, make the following changes to the PDF conversion settings in Microsoft Word: From the Adobe PDF menu, choose Change Conversion Settings, and deselect the View Adobe PDF result and Prompt for Adobe PDF file name options.

  **Note about PDF Publishing with Microsoft Office 2007:** Adobe Acrobat is not required for PDF output if you are using Microsoft Office 2007. However, you will need the 2007 Microsoft Office Add-in: *Microsoft Save as PDF*. You can obtain this add-in from the Microsoft Office Download Center.

- **Microsoft file type:** If you choose the Microsoft Word output format, you can use this option to indicate whether you want the documents to be in .doc (Word 2003) or .docx (Word 2007) format.

- **Include:** By default, screenshots are included in a document based on the settings for the topic in the Topic Editor. This option allows you to override those settings and choose to include one screenshot per topic, one screenshot for each frame, or no screenshots. You can choose a different setting for each document format you print.

- **Convert screenshots to 256 colors:** By default, screenshots are converted to 256 colors. This option allows for screenshots in more than 256 colors. This is
especially useful for the Player formats so that the screenshots in the simulated playback modes are clearer.

- **Paper size:** By default, the paper size is set based on the Location setting in the Regional & Language options for your operating system locale. You can override this setting by choosing a different paper size. If you customize the print template to have a special paper size (for example, to print Job Aids on smaller cards), choose the option to use the print template setting; otherwise, it will be overridden during publishing. You can choose a different setting for each document format you print.

- **Text mode:** By default, each document output uses the text from a specific mode. Some document outputs default to the See It/Try It mode text, and the others default to the Do It mode text. With this option, you can specify the mode text to use.

- **Use encoded folder and file names:** Publishes the content using hexadecimal names instead of actual module, section, and topic names. Encoding ensures that path names are not too long to publish.

- **Include alternatives:** By default, Alternative Actions and Paths are set to appear in document and Presentation outputs. This option is useful if you want to make the output simpler, with only one set of steps.

- **Include images from packages:** By default, images will appear if they are attached to a frame or to the concept pane. Images larger than ½ page will be scaled to fit the page. This option is not available for the Job Aid, Test Document, or Presentation outputs.

- **Include images in web pages:** By default, images appear if they are attached to a frame or to the concept pane. Images larger than ½ page will be scaled to fit the page. This option is not available for the Job Aid, Test Document, or Presentation outputs.

### System Process

This format is useful for creating documents that not only include the procedures and conceptual information for business processes, but also contain information relating to intended audience, roles and responsibilities, document status, versions, and dates. Each topic is published to a separate document which includes a concept page, with information about the document and task, and the procedures for completing the task.

### Job Aid

This format results in a quick reference guide, enabling users to view only the procedures for completing a task, without conceptual information. Each topic is published in a separate document which includes only the procedures for completing the task.

### Training Guide

This format allows instructors to create manuals quickly for Instructor-led training. The document includes a title page, copyright information, table of contents, conceptual information, and procedures for completing all tasks included in the published outline. In addition, if the content you publish contains glossary markups, then a glossary is included at the end of the document.
Warning! Be aware that when you publish a Training Guide, your entire selection is published as one document. If you publish a large amount of content at one time, you may encounter memory problems with Microsoft Word. Consider publishing your content in smaller chunks and then merge the contents of each Microsoft Word file after publishing from the Developer.

Instructor Manual

This format allows instructors to publish the Training Guide including instructor notes. The instructor notes are inserted in the document per topic, after the Concept, and before the Procedure. An Instructor Note heading appears in the output in the same style as Procedure text. The instructor notes are formatted like web page attachments (indented 1/2 inch from the margin in a box with a rule and shading). This is designed to make the notes stand out from the other text. The outside margin is adjusted to 2.5 inches. This allows instructors room to write their own notes.

Warning! Be aware that when you publish an Instructor Manual, the entire selection is published as one document. If you publish an entire outline, the document could be very large, and you might experience problems with Microsoft Word.

Test Document

This format allows you to create documents for testing software applications. Each topic is published to a separate document. The document includes the purpose of the test, test history, time to test, test setup, and test procedure. The test procedure contains the steps for completing the task.

Presentation

If you publish content for a Presentation, a separate PowerPoint file is created for each topic, each of which can be launched from a main page. This page displays a table of contents page showing the outline. If a concept exists for a module, section, or topic, a Concept link appears next to the name. The names of the modules and sections are not links; however each topic has a link.

When you click a topic link, a PowerPoint presentation launches. You can then view the PowerPoint slideshow to navigate the topic in a static version of Try It! mode. Each frame is a separate slide in the presentation. The slide contains a graphic showing the screenshot, with the bubble text next to it. A box on the screenshot indicates the action area or areas for the frame. To navigate through the topic, use standard PowerPoint methods. If a frame has attachments, the attachment icons will appear above the bubble text. You can click the icons to access the attachments, if the presentation is being viewed online. If the presentation is printed, hyperlinked content is not included. Alternative Actions, Alternative Paths, and Decision frames are included as well, and links are provided to choose paths.

The following areas do not appear in the Presentation output:

- Jump-in points
- Roles
- Keywords
- Unrecorded topics

You can launch the Presentation when the publishing process is complete. If you publish just the Presentation format, the option to launch the content automatically is selected.
and you can launch it directly from the Publishing Wizard. If you want to launch it later, navigate to the location where you published and open the Publishing content folder. Within that folder, open the Presentation folder. You can then choose to launch the index.html file or play.exe to display the table of contents, or open any of the PowerPoint files for a specific topic.

**Important Publishing Note:** If you are using Microsoft Office 2003 or Microsoft Office XP SP3 and you want to publish or customize document formats, the HP Quality Center output, or the Presentation output, you must install the Microsoft Office Compatibility Pack for Word, Excel, and PowerPoint 2007 File Formats. You can download this compatibility pack from the Microsoft Office Download Center. In addition, all Microsoft Office Products must have the latest updates and security fixes.

The following publishing options are available for the Presentation:

- **Convert screenshots to 256 colors:** By default, screenshots are converted to 256 colors. This option allows for screenshots in more than 256 colors. This is especially useful for the Player formats so that the screenshots in the simulated playback modes are clearer.

- **Include action areas:** In the Player outputs, a marquee - or highlight - appears around the action area for each frame. You can choose to include this marquee in the Presentation. You can also change the color of the marquee. Changing the color for the Presentation output does not affect the marquee color for the Player outputs.

- **Use encoded folder and file names:** Publishes the content using hexadecimal names instead of actual module, section, and topic names. Encoding ensures that path names are not too long to publish.

- **Include alternatives:** By default, Alternative Actions and Paths are set to appear in document and Presentation outputs. This option is useful if you want to make the output simpler, with only one set of steps.

- **Microsoft file type:** You can use this option to indicate whether you want the documents to be in .ppt (PowerPoint 2003) or .pptx (PowerPoint 2007) format.

- **Text mode:** By default, each document output uses the text from a specific mode. Some document outputs default to the See It/Try It mode text, and the others default to the Do It mode text. With this option, you can specify the mode text to use.

**HP Quality Center**

This format allows you to create documents for testing software applications that can be imported into HP Quality Center. If you select multiple items in the outline, the published output is combined into a single Excel file with each topic separated by a blank row. This file can then be exported into HP Quality Center in a single operation.

**Note:** To export this output from Microsoft Excel and into HP Quality Center, you need the TestDirector Microsoft Excel Connectivity add-in installed. See the HP Quality Center documentation for more information or go to http://update.merc-int.com/testdirector/td80/.

Only topics with content are included in the output; empty topics do not appear. In addition, modules and sections are not included in the output.
By default, Alternative paths and actions are not included in this format but you can change the publishing option to include them. Decision Frames are automatically included and cannot be suppressed. You need to edit the output in Microsoft Excel or in HP TestDirector to remove any unwanted Decision Frame material. Explanation Frames are not included.

If context ID information is available for a frame, it is included at the end of the Action cell. The type of information will differ or may not appear, depending on the target application of the topic.

The following publishing options are available for HP Quality Center:

- **Text mode**: By default, each document output uses the text from a specific mode. Some document outputs default to the See It/Try It mode text, and the others default to the Do It mode text. With this option, you can specify the mode text to use.
- **Include alternatives**: By default, Alternative Actions and Paths are set to appear in document and Presentation outputs. This option is useful if you want to make the output simpler, with only one set of steps.
- **Use encoded folder and file names**: Publishes the content using hexadecimal names instead of actual module, section, and topic names. Encoding ensures that path names are not too long to publish.
- **Group actions by context ID**: By default, each action appears in a separate row in the Test Procedure table. When you select this option, the actions when the same context ID are grouped together into one test step.

**Use the Publishing Wizard**

The Publishing Wizard steps you through the publishing process. There are several screens of options, each of which is described in more detail in the following sections.

When the publishing process is finished, you have three options on the final screen:

- **Launch the content automatically** - For Player packages, launches the Player window and displays the content. For document output, launches Microsoft Word or Adobe Acrobat and displays the document.
- **Open the folder where the content was published** - Opens a Windows Explorer browser window and displays the contents of the folder where the content was published.
- **Close the Publishing Wizard** - Closes the Publishing Wizard without opening any windows or displaying content.

**Note**: If you publish to multiple formats, or if you publish to document formats only, the first option is disabled.

If an error occurs during publishing, the first option becomes View activity log. The log helps you to determine what caused the error.

**Publishing Destination**

The first time you publish, the default destination location is set to the My Documents folder on your local computer. You can change this either by browsing to a new location or
typing a path, if you know it. If you change the location, it becomes the new default location for the next time you publish.

It is essential to understand the importance of the destination location when you publish content.

**Publishing settings**
The first time you publish to a specific destination location, the Developer saves the publishing settings you used to that location. These settings include the output formats that were published and the options for each individual format. Each time you publish to that same location, the settings in the publishing wizard will reflect the ones specified for that location. You can change the options as necessary each time you publish to that location, and the changes are saved for the next time you publish.

**Incremental publishing**
Incremental publishing allows you to update published content quickly. When you publish content to a destination location, the Developer records the publishing data. When you publish the same content to the same location, the Developer accesses the publishing data and only the changes are published, including new content, changes to the existing content, and deletions. Because only the changes are published, the publishing process is much faster. Therefore, if you want to publish the changes to an outline, you publish the entire outline without having to select individual items in the outline structure.

**Keep/Delete files**
If you choose to publish a different content selection to a destination in which you have already published, the Developer will warn you and ask you whether you want to replace the old content. If you continue, the result depends on the type of format to which you are publishing:

- Player formats: Old content is deleted for the same format. If you select fewer formats to publish, the published content for other formats is kept.
- Document formats: Old content is kept.

**General Publishing Options**
There are options for selective publishing, publishing by role, and skipping advanced options.

**Selective Publishing**
You can choose to publish the entire outline or just the items you selected in the outline. If you are publishing to a format which has a table of contents, such as a Player package, a training guide, or an instructor manual, your results may differ depending on what you have selected and what you have open in the Outline Editor. Note the following:

- The entire hierarchy of sections and modules above the selection is included, in a direct line up to the highest level of the outline.
- The name of the highest level in the hierarchy, that is, the name that appears on the tab of the document window you are publishing from, will appear in the title bar of the Player, and on the title page for the Training and Instructor Manuals.

For example, you have Topic 1 and Topic 2, both of which are contained in Section A. Section A is in turn contained in Module 1. You open the Module 1 document in the Outline Editor, select Topic 1, and choose to publish only that topic to a Player package. After publishing, in the Player window, Module A will appear in the title bar of the window, Section A appears as the highest level in the outline pane on the left, and Topic 1 appears below Section A. If, however, you open the Section A document in the Outline Editor and
publish only Topic 1 to a Player Package, Section A appears in the title bar of the resulting Player Package and the outline pane contains only Topic 1.

**Publish by Role**
You can choose to publish by roles to filter content. If you have roles assigned to the content you are publishing, the Publish by roles option is available. When you select it, the Select Roles button becomes available, which opens the Select Roles dialog box. The list of roles includes only the roles available for the content you are publishing. You can select as many roles as desired. Only the items in the selected content that are associated with the specified roles will be included in the published output.

---

**Multi-user Considerations**

**Publish by States**
In a multi-user environment, when you are online, you also have the option to publish by states. This allows you to filter the content to publish only those items that are indicated as ready. When you select the Publish by states option, the Select States button becomes available. In the Select States dialog box, you can select the states to publish as desired. Only the items in the selected content that are associated with the specified states will be published. If you specify roles as well as states, only items that meet all the specified criteria will be published. Items with no state assigned will always be excluded. If you select the Publish by state option and then do not choose any states, you will be notified that you have made an invalid selection.

**Skip Advanced Options**
There is an option to skip the Advanced Options page which is selected by default. If you deselect it, the Advanced Options page appears next in the Publishing Wizard. In addition, your choice for this setting becomes the default until you change it again.

**Advanced Options**
On the Advanced Publishing Options page, you can choose the category and language in which you want the published output to appear. The category defines which logos and formatting will be used for player and print outputs. The language changes the language of the Player and help files as well as the default headings in the print outputs. It does not affect the bubble text or the template text.

You can use the publishing settings from another location. This allows you to easily reuse settings from other published content to help ensure consistency. The settings are stored in the Publishing.Project.xml file, located at the root of the publishing destination folder. When you want to import settings, you do not need to select the .xml file; you only need to navigate to the publishing destination folder where it is located.

---

**Multi-user Considerations**

In a multi-user environment, when you are online, you also have the option to choose local or server content. Local content includes the locally edited copies of all selected documents that you have checked out and the server versions of those not checked out to you. Use this option for documents in progress for review. Server content includes only the checked in versions of the selected documents. Any local changes to checked out documents are ignored. Use this option for final versions of documents.
Publish Content

### Publishing Formats
Deployment formats allow you to publish content for users to play topics in the various playback modes, or to create a PowerPoint presentation.

Document formats allow you to publish recorded content in various predefined documents that can appear in Microsoft Word (.doc or .docx) and/or Adobe Acrobat (.pdf) format.

The first time you publish, the options for the format or formats you choose to publish will default to the ones that are set in the Options dialog box. You can change the options each time you publish, if desired. You can also reset them back to the settings on the Options page.

---

**Important Publishing Note:** If you are using Microsoft Office 2003 or Microsoft Office XP SP3 and you want to publish or customize document formats, the HP Quality Center output, or the Presentation output, you must install the *Microsoft Office Compatibility Pack for Word, Excel, and PowerPoint 2007 File Formats*. You can download this compatibility pack from the Microsoft Office Download Center. In addition, all Microsoft Office Products must have the latest updates and security fixes.

---

To publish content:

1. On the **File** menu, choose 📄 Publish.
2. Enter the location to which you want to publish, or click **Browse** to navigate to the location or create a new folder.
3. Click **Next** to display the Select Publishing Options page of the Publishing Wizard.
4. Choose to publish the entire outline or the selected documents only.
5. If desired, specify to publish by roles, and select the roles from the list.
6. Click **Next** to display the Formats and Options page of the Publishing Wizard, or deselect **Skip Advanced Options Page** and click **Next** to display the Advanced Publishing Options page of the Publishing Wizard.
7. Select the format(s) to which you want to publish.
8. For each format that you choose to publish, select the desired options.
9. Click **Publish**. When the publishing process finishes, the Publishing Complete page of the Publishing Wizard appears.
10. Click **View activity log**, if desired.
11. Select the desired launch option.
12. Click **Finish** to launch the content, open the folder, or close the Publishing Wizard.

### Customize Publishing Styles
Publishing styles are Publishing Project documents that are stored in the System/Publishing/Styles folder in the Library. Within the Styles folder, each category has a folder. Each output format has its own Project document, such as Job Aid and Player.

You can use categories to create customized styles to change the branding, that is, the logo, or format the appearance of the published output. You can also create categories with only certain published outputs, such as Job Aid and Training Guide, to limit the publishing outputs available to the content authors.
**Note:** If you create custom publishing styles, you should document your customizations so you can easily re-apply them, if necessary, after a software upgrade.

## Create Styles

You can create custom styles as needed for any publishing format. To customize the appearance of any style, you should first make a copy of the publishing project document that you want to modify. It is not recommended that you customize the standard styles that ship with the Developer.

When you copy a publishing style in the Library, you can place the copy within the same folder in the Library, or you can create a new folder and subfolder structure to contain the customized styles. If you place the copy in the same folder, the style name will be listed twice on the Formats and Options screen of the Publishing Wizard. See Rename a Publishing Style for information on how to change the name. If you create a new folder structure, the name of the folder appears as a category on the Advanced Publishing Options page of the Publishing Wizard.

Follow these basic steps to create a custom style or styles:

- Copy the style or styles that you want to customize. Be sure to use the Paste command to create a new document with no links to the original style.
- Customize the style documents as desired. The style documents are packages, and you can edit the files as you would files in any other package.

### Help Menu Integration Warning

In the Publishing folder in the Library, there is a folder, named according to the installed brand, in both the Styles and the Help Menu Integration folders. These matching folder names are necessary so that the required files for help menu integration are published with the content.

If you create a custom publishing category folder in the Styles folder in the Library, and you use the custom category to publish your content, be aware of the following. You MUST create a copy of the User Productivity Kit folder under the Help Menu Integration folder, paste it back to the Help Menu Integration folder, and rename the copy to the exact name that you used for your custom category folder in the Styles folder. If you do not do these steps, the files necessary for help menu integration will not be published with the content.

### Rename a Publishing Style

If you make a copy of a publishing style in the same subfolder as the original, the style name will be listed twice on the Formats and Options page in the Publishing Wizard. In order to rename the publishing style, you must modify a line in the style.resources.xml file for the appropriate language in the Lang folder for the publishing style.

In the package, open the lang folder and then the folder for the appropriate language. Copy the style.resources.xml to your local computer. Open the style.resources.xml in any text editor, such as Notepad. The third line of this file should have the name of the style in between `<Resource ID>` and `</Resource>` codes. For example, for the Business Process style, the line looks like this:

```xml
<Resource Id="StyleName">Business Process</Resource>
```
To change the name of the style, edit the text between the codes. Save and close the file and copy it back into the style package.

**Customize the Player**

There are numerous ways you can customize the Player interface and the topic playback, including changing the logo, changing the search, preferences and help icons, changing the "For Example" text in string inputs, and suppressing the scores in Know It? mode. Additionally, you can change style sheet elements such as dividers, background colors or text colors. You can also localize the Player resources.

For all Player formats, you can modify the files in the published output or the Player publishing project in the Library. If you modify the files in the published content, only that published content will be affected. If you modify the files in the publishing project in the Library, the changes apply to all content you publish after making the change. After making the changes, you must republish any existing content to apply the changes.

To make global changes, you change the Player publishing style. The Player publishing style is located in the System/Publishing/Styles/<category> folder in the Library. Images are stored in the /img folder within the Player publishing style.

To make one time changes to published output, you change the images in the player published output folders. Images are stored in the \Publishing Content\PlayerPackage\img folder in the location where you published your output.

See Customize Publishing Styles for more information about copying, renaming and editing publishing styles.

---

**Note:** If you create custom publishing styles, you should document your customizations so you can easily re-apply them, if necessary, after a software upgrade.

---

**Customize the Player Interface Graphics**

You can customize many of the graphics in the Player interface to fit your corporate look and feel.

There are two basic steps. First, create a graphic file that is the correct size and save it with the correct name (from the table below). Then, insert the graphic in the style so that it appears in the proper Player location.
Gateway page

The logo can be customized in two locations in the Player. The first location is on the Gateway page when you start up the Player. This graphic is called large_logo.gif. The second location is in the top left corner of the Player interface. This graphic is called small_logo.gif.

Note: You can also use the Customize Logo tool in the Developer to replace the logo. If you use this tool, the logo should be no larger than 230x44 pixels.

Other Player graphics, such as the banner, search icons, preferences button and the help button can also be customized.

To change these graphics globally, replace the graphics in the System/Publishing/Styles/<category>/Player/img folder.

To make one time changes to published output, replace the graphics in the \Publishing Content\PlayerPackage\img folder in the location where you published your output.

<table>
<thead>
<tr>
<th>Label</th>
<th>Logo Graphic Filename</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>small_logo.gif</td>
<td>162x44</td>
</tr>
<tr>
<td>B</td>
<td>banner_image.png</td>
<td>1pixel (placeholder) or fixed size (425x54)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Note below for more information.</td>
</tr>
<tr>
<td>C</td>
<td>searchbtn.gif</td>
<td>23x21</td>
</tr>
<tr>
<td>D</td>
<td>clear.gif</td>
<td>23x21</td>
</tr>
<tr>
<td>E</td>
<td>prefs_button.gif</td>
<td>16x16</td>
</tr>
<tr>
<td>F</td>
<td>help_button.gif</td>
<td>16x16</td>
</tr>
<tr>
<td>G</td>
<td>large_logo.gif</td>
<td>243x60</td>
</tr>
</tbody>
</table>
Note: The banner image can be a 1 pixel (banner_image.png) or a fixed size (banner_image.png), depending on your application. If banner_image.png is 1 pixel and you change the size of the logo (small_logo.gif), the banner image automatically resizes to the proper size. If banner_image.png is a fixed size and you change the height of the logo, you must resize the banner image 10 pixels higher than the new height of the logo.

When you have modified the file to the correct size, save it as the appropriate .gif file name and copy it into the publishing project files or the published content located in the Library.

Customize Player Header Elements

You can customize the Player header to fit your corporate look and feel. Aside from changing the Logo, Banner and Preference and Help icon graphic, you can change the gradient color of the header and the height and color of the divider bar. These changes are made by editing the associated lines in the skin.css file. Skin.css is located in the System/Publishing/Styles/<category>/Player folder of the Library. For example, if you want to increase the header divider height, find the .headerDivbar element in the skin.css file and change the height from 21px to the desired height.

<table>
<thead>
<tr>
<th>Label</th>
<th>CSS Element</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>.header</td>
<td>Specifies the color of the gradient fill. This changes the color of the right column of the color table that controls the gradient color. The left column of the table is #FFFFFF (white) and can not be edited. Changing the color only applies if the banner_image.png is 1 pixel.</td>
<td>background-color: #5A75A2</td>
</tr>
<tr>
<td>B</td>
<td>.headerDivbar</td>
<td>Specifies the height of the header divider bar. Changes color of the header divider bar.</td>
<td>height: 21px background-color: #CDE2FD</td>
</tr>
</tbody>
</table>
You can customize stylesheet elements to change the look and feel of the Player search frame and TOC. Locate the CSS Element you want to change in the skin.css file and change it to the desired value. For example, if you want to change the background color of the search area, find the .tocSearchColor element in the skin.css file and change the color value. The skin.css file is located in the root directory of the Player publishing project document located in the System/Publishing/Styles/<category>/Player folder of the Library.

<table>
<thead>
<tr>
<th>Label</th>
<th>CSS Element</th>
<th>Description</th>
<th>Default Setting</th>
</tr>
</thead>
</table>
| A     | .tocSearch        | Defines the font type, size and color for the text within the search bar.   | font-family: Arial, Helvetica, sans-serif  
font size: 12px  
color: #000000 |
| A1    | .tocSearchColor   | Changes the background color in the search area.                            | background color: #CDE2FD |
| B     | .tocSelectionText | Defines the font type, size and color for the Applicable and My Roles link text. | font-family: Arial, Helvetica, sans-serif  
font size: 12px  
color: #000000 |
| C     | .tocFrameText     | Defines font type, size and color of the Results for and View Outline link text. Also defines the search results text that displays after Results for once the search is initiated. | font-family: Arial, Helvetica, sans-serif  
font size: 12px  
color: #000000 |
### Label | CSS Element | Description | Default Setting
--- | --- | --- | ---
C1 | .tocFrameText | Defines the color of the Outline background. | background color: #CDE2FD |
D | .treeControlNode | Defines font type, size, and color of text within the Outline. Changes the background color of the Outline text. | font family: Arial, Helvetica, sans-serif; font size: 10px; color: #000000; background color: #FFFFFF |
 | .thover | Changes the color of the text while hovering. Changes the background color of the text while hovering. | color: #00CCFF; background color: #FFFFFF |
D1 | .tselected | Change background color of text when selected in the Outline tree. | color: #FFFFFF |
D2 | .tselected | Change font color of text when selected in the Outline. | color: #003366 |

### Customize the Player Mode Buttons

You can customize the color of the Player's Mode buttons to fit your corporate look and feel. These changes are made by editing the associated lines in the skin.css file. Skin.css is located in the System/Publishing/Styles/<category>/Player folder of the Library. For example, if you want to change the color of the mode buttons upon mouse over, find the .navCellOn element in the skin.css file and change the color value.

---

<table>
<thead>
<tr>
<th>Label</th>
<th>CSS Element</th>
<th>Description</th>
<th>Default Setting</th>
</tr>
</thead>
</table>
A | .navCellOff | Changes the color of the buttons when the mouse is not hovering over the button. | background color: #305BA2 |
 | .navCellOn | Changes the color of the buttons when the mouse is hovering over the button. | background color: #467ED8 |
B | .dividerColor | Changes the color of the divider lines between the buttons | background color: #3E5782 |
Customize the Player Interface Margins

You can customize the color of the Player interface margins to fit your corporate look and feel. These changes are made by editing the associated lines in the skin.css file. Skin.css is located in the System/Publishing/Styles/<category>/Player folder of the Library. For example, if you want to change the color of the vertical margin, find the .tvertical element in the skin.css file and change the color value.

<table>
<thead>
<tr>
<th>Label</th>
<th>CSS Element</th>
<th>Description</th>
<th>Default Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>.thorizontal</td>
<td>Changes the background color of the horizontal bars at the top and bottom.</td>
<td>background color: #94B8E9</td>
</tr>
<tr>
<td>B</td>
<td>.tvertical</td>
<td>Changes the background color of the vertical bars at the left and right.</td>
<td>background color: #94B8E9</td>
</tr>
<tr>
<td>C</td>
<td>.tsep</td>
<td>Changes the background color of the vertical divider bar in the middle.</td>
<td>background color: #94B8E9</td>
</tr>
</tbody>
</table>

Customize the Bubble Header Bar

In the See It!, Try It, and Know It? playback modes, there is a header bar with the mode name at the top of the bubble. You can change the color of the header bar and the color and font of the text.

Header Bar Color

To change the color of the header bar, you edit graphic files. You must change the color in all of them in order to change the color of the entire header bar. The graphics are located in the System/Publishing/Styles/<category>/Player/img folder in the Library.

b_01.gif - The left end of the header bar.

b_02.gif - The middle section of the header bar.
b_03empty.gif - The right end of the header bar for the windowed See It! mode. This graphic only affects windowed See It! mode. It does not affect the standard Player, as a Close button graphic is used instead.

**Header Bar Text Color and Font**

To change the color of the text in the header bar of the bubble, you edit values in the Player.css file. It is located in the System/Publishing/Styles/<category>/Player folder of the Library.

**Note:** If you change the font size of the header text, you may experience unexpected results. Publish a sample topic with the new settings to verify the results before you publish the final package for release.

<table>
<thead>
<tr>
<th>CSS Element</th>
<th>Description</th>
<th>Default Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>.CurvedBoxText</td>
<td>Changes the color and font of the mode name text to the left in the bubble header in See It!, Try It, and Know It? playback modes.</td>
<td>COLOR: white; FONT-FAMILY: Arial, Helvetica, sans-serif; FONT-SIZE: 9pt; FONT-WEIGHT: bold; TEXT-DECORATION: none</td>
</tr>
<tr>
<td>.CurvedBoxNav</td>
<td>Changes the color and font of the &quot;Actions&quot; text in the bubble header in See It! and Try It! playback modes.</td>
<td>COLOR: #ccffff; FONT-FAMILY: Arial, Helvetica, sans-serif; FONT-SIZE: 9pt</td>
</tr>
</tbody>
</table>

**Header Bar for Do It!**

To customize the header bar color and the text color, you edit the guideit.xslt file. This is located in the System/Publishing/Styles/<category>/Player folder of the Library.

Edit the color in these statements to change the background color:

```xml
<td id="movePopup" valign="middle" style="BACKGROUND-COLOR: #003366;"
    nowrap="yes">
<td id="movePopup" valign="top" width="100%" align="right"
    style="BACKGROUND-COLOR: #003366;">
```

Edit this statement to change the font size or font color:

```xml
<a style="FONT-SIZE: 10pt;COLOR: white;FONT-WEIGHT: bold;FONT-FAMILY: Arial, Helvetica, sans-serif">
```

**Note:** If you change the font size of the header text, you may experience unexpected results. Publish a sample topic with the new settings to verify the results before you publish the final package for release.

**Customize Windowed See It! Mode**

You can customize various screen elements and graphics for the windowed See It! mode. Graphic elements can be changed by replacing files in the Player Package. Other elements, such as the color of the frame, the click symbol, the navigation buttons, and the navigation bar can be changed in the skin.css file. As with customization for the Player as
a whole, you can make changes to the Player publishing style, which will affect all published content, or make one-time only changes in the published Player package.

The various elements are labeled in the graphic and table below.

<table>
<thead>
<tr>
<th>Label</th>
<th>Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Content area border</td>
</tr>
<tr>
<td>B</td>
<td>Frame</td>
</tr>
<tr>
<td>C</td>
<td>Navigation buttons</td>
</tr>
<tr>
<td>D</td>
<td>Navigation bar</td>
</tr>
<tr>
<td>E</td>
<td>Preferences and Help buttons</td>
</tr>
<tr>
<td>F</td>
<td>Bubble</td>
</tr>
<tr>
<td>G</td>
<td>Action area (rectangle)</td>
</tr>
<tr>
<td>H</td>
<td>Click symbol</td>
</tr>
</tbody>
</table>

**Window Elements**
You can customize the color of the frame, the content area border, the navigation bar, and the navigation buttons.

<table>
<thead>
<tr>
<th>CSS Element</th>
<th>Description</th>
<th>Default Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>.background</td>
<td>Changes the color of the frame (B)</td>
<td>background-color: #94B8E9</td>
</tr>
<tr>
<td>.PlayerCombination</td>
<td>Changes the color of the content area border (A), the navigation buttons (C), and the navigation bar (D).</td>
<td>#3E5782</td>
</tr>
</tbody>
</table>

**Preferences and Help Buttons and the Click Symbol Graphic**
To change the Preferences and Help buttons as well as the graphic for the click symbol, you edit graphic files. The graphic files are located in the System/Publishing/Styles/<category>/Player/img folder in the Library.

prefs_button.gif - 📃 - The Preferences button. (E)
Customize the My Roles, Preferences and Jump In Windows

You can customize the text attributes and background colors of the Player's My Roles and Preferences window to fit your corporate look and feel. These changes are made by editing the associated lines in the skin.css file. Skin.css is located in the System/Publishing/Styles/<category>/Player folder of the Library. For example, if you want to change the size of the font of the text in the My Roles and Preferences windows, find the .textWindow element in the skin.css file and change the font size value.
<table>
<thead>
<tr>
<th>Label</th>
<th>CSS Element</th>
<th>Description</th>
<th>Default Setting</th>
</tr>
</thead>
</table>
| A     | .textWindows | Defines font type, size and color of the text in the My Roles and Preferences windows. | font-family: Arial, Helvetica, sans-serif  
font-size: 12 pxf  
color: #000000 |
|       |              | Defines background color of Preferences window.                            | background color: #EEEEEE |
| B     | .windowsBgColor | Defines background color of the My Roles window.                           | background color: #FFFFFF |

**Control "For Example" Text in String Inputs**

If meta entries are used in a string input step, you may prefer to remove the "for example" text (e.g. "Tuesday") from appearing during playback. When you suppress the "for example" text, the bubble for a meta entry changes from Enter a valid value e.g. "Tuesday" to Enter a valid value. When you remove the "for example" text from string inputs, both the Do It! and Know It? playback modes are affected since both use the same string input template.

You can edit the template.js file in the js folder to control the display of “for example” text. Open the file in any text editor, such as Notepad. To suppress the “for example” text, change the "0" to a "1" in the following command:

```javascript
var template_stringp_suppress_example=0
```

**Suppress Scores in Know It Mode**

When a user plays a topic in Know It? mode, the Introduction frame displays the score that is needed to pass the topic. At the end of a Know It? topic, a frame appears displaying the user's final score and if the user passed the topic assessment.

You can prevent the user from seeing either the score needed at the beginning of the topic or the final score frame at the end of the topic by editing the topic.js file in the js folder. To suppress scoring information, edit the following variable:

```javascript
var ShowScoreNeeded = true. Change this to “false” if you want to suppress the score needed at the beginning of the topic and the final score frame at the end of the topic.
```

Another option is to display the score needed at the beginning of the topic, but suppress the scoring screen that appears at the end of the topic. To use this option, leave the ShowScoreNeeded as “true” and make the following change:

```javascript
var trackFeedback = “true”. Change this to “false” if you want to suppress the final score frame at the end of the topic only.
```

**Hide Click Graphic in See It! Mode**

In See It! mode, when the animation plays for an action step, there is a graphic that looks like an "impact" symbol which appears when the mouse simulates the clicking action. You can prevent the user from seeing this graphic by editing the topic.js file in the js folder. This can be useful if you are creating the equivalent of a PowerPoint slide show and have hidden the bubbles for the topic. (See Show Bubbles Property for more information.) In this case, it would be desirable for the click graphic to be hidden.
To suppress this graphic, edit the following variable:

```
var Hide_Click_Mark = false.
```

Change this to “true” if you want to suppress the graphic.

## Localize Player Resources

You can publish the Player in many different languages. You can also localize the Player interface into other languages by modifying the text in the resource.js file in the Player Package publishing style.

You can open this file in any text editor, such as Notepad. The resources to be translated are all enclosed in quotation marks ("."). Be sure not to translate anything else or erase the quotation marks. Save the changes and import the file back in to the appropriate publishing style in the Library. See Customize Publishing Styles for more information.

## Customize the Presentation Format

The Presentation output uses a Microsoft PowerPoint template called PresentationTemplate.pptx to control the format and layout of the presentation. Each language has is own template file. A folder for each language is located in the lang folder within the print style. To make any customization, you modify the PowerPoint template.

---

**Important Publishing Note:** If you are using Microsoft Office 2003 or Microsoft Office XP SP3 and you want to publish or customize document formats, the HP Quality Center output, or the Presentation output, you must install the Microsoft Office Compatibility Pack for Word, Excel, and PowerPoint 2007 File Formats. You can download this compatibility pack from the Microsoft Office Download Center. In addition, all Microsoft Office Products must have the latest updates and security fixes.

---

The template contains two slides with pre-defined layouts and text, one for the title slide and one for the steps.

### Change the Logo

The logo appears at the top left corner of each slide. You can change this logo as desired by replacing it on the two slides in the template with your own company logo. With this method, it can be any size that fits appropriately on the slide.

**Note:** You can also use the Customize Logo tool in the Developer to replace the logo. If you use this tool, the logo should be no larger than 230x44 pixels.

### Change the Slide Theme

You can apply any slide theme or design you wish. Depending on the position of the elements in the design, you may need to adjust the position of the placeholder images and text boxes. You can also apply a background color to the slides.

### Configure the Slide Layout

The second slide in the presentation contains the default layout for the steps. You can rearrange or resize these text boxes as desired. Note that at a minimum, there must be one image placeholder for the graphic and one text box placeholder for the bubble text for each step.
Adjust Paper Size
By default, the slides are sized for an onscreen show. If you will be printing the presentations, you can set a page size in the Page setup dialog box.

Change Font and Font Attributes
You can change the default font in the text boxes as desired. You can also change the font attributes such as color, size, and weight (bold).

Title of Slide
You can change or delete the title of the slide.

Transition Effects
By default, there are no transition effects. You can set the default transition effect as desired.

See Customize Publishing Styles for more information about copying, renaming and editing publishing styles.

---

Note: If you create custom publishing styles, you should document your customizations so you can easily re-apply them, if necessary, after a software upgrade.

---

Customize the HP Quality Center Output
The HP Quality Center output results in a Microsoft Excel .xlsx file. The publishing process uses ColumnSpec.xml, which contains column definitions for all the columns that can be exported from the Developer into the Excel file. The xml file is located in the lang folder within the HP Quality Center publishing style. Each language has a ColumnSpec.xml; customize the languages you need.

To customize the output, edit the .xml file in an editor of your choice. Before you customize the style, it is highly recommended that you make a copy of it and then make your modifications to the copy. See Customize Publishing Styles for more information about copying, renaming, and editing publishing styles.

---

Important Publishing Note: If you are using Microsoft Office 2003 or Microsoft Office XP SP3 and you want to publish or customize document formats, the HP Quality Center output, or the Presentation output, you must install the Microsoft Office Compatibility Pack for Word, Excel, and PowerPoint 2007 File Formats. You can download this compatibility pack from the Microsoft Office Download Center. In addition, all Microsoft Office Products must have the latest updates and security fixes.

---

Include or Exclude Columns
You can specify the columns you want in the Excel spreadsheet. By default, the columns that are required for import into HP Quality Center are included. In addition, the .xml file contains definitions for all of the data that can retrieved from the Developer database. Within each column definition, between the <col> and </col> tags, there is an export parameter with a yes or no value. Yes means that the column will be included in the Excel spreadsheet.
**Note:** The Output and Required Fields columns have an additional parameter for fixed width font. These columns contain the information in the Output and Required fields tables. In order to represent the tables within a column in Excel, table columns are separated by spaces, and each table row is on a separate line. This information is easier to read when the cell is formatted with a fixed width font such as Courier. Therefore, by default, the fixedWidthFont parameter has a value of Yes for these two fields. If you want these fields to appear in a proportional font, change the parameter to No. The font has no effect on importing the worksheet into HP Quality Center.

**Change the Column Name**

Another parameter within the column definition tags is header. This value is the text for the column name. You can change the text in between the `<header>` and `</header>` tags to whatever you wish. Do not change the xml:id reference or its value.

**Repeat Topic Data**

By default, the data in the columns in the spreadsheet repeats for every row in the topic. If you do not want this information to repeat for every row, you can use the repeat parameter in the `<data>` tag. A value of Yes causes the data to appear in each row of the topic; a value of No causes the data to appear in the first row of the topic only.

**Set a Default Value**

You can use the `<defaultvalue/>` tag to set a default value for a column if the value specified in the `<data>` tag is blank. Modify the `<defaultvalue/>` tag so that it has begin and end tags, and enter the text for the default value between tags. For example, `<defaultvalue>XYZ Company</defaultvalue>` which place the XYZ Company text in the field if the `<data>` tag returns a blank value.

**Set Column Width**

Each column is set with a default width. The `<width>` tag specifies the width of the column expressed in the number of characters. This is the same unit that Excel uses. For example, if the default font is Arial 10, then a column width of 10 displays 10 characters, which is equal to 75 pixels. If the font is changed to Courier New, the column width still displays 10 characters, but the column is resized to 85 pixels in Excel. You can edit the value of the `<width>` tag to suit your needs.

**Customize Document Formats**

Document outputs use a Microsoft Word template called PrintTemplate.docm to control the format and layout of the document. The template contains bookmarks, styles, document settings, and pre-defined text. Bookmarks are the mechanism used to insert and position the fields in the document and styles are used to format the fields. Document settings affect the page layout, such as paper size and margins. Pre-defined, or static, text can appear in several places in any template, usually the header and footers and the labels for the fields in the body of the document. The template also contains a toolbar which allows you to insert the desired bookmarks in the template you want to customize.

**Important Publishing Note:** If you are using Microsoft Office 2003 or Microsoft Office XP SP3 and you want to publish or customize document formats, the HP Quality Center output, or the Presentation output, you must install the Microsoft Office Compatibility Pack for Word, Excel, and PowerPoint 2007 File Formats. You can download this compatibility pack from the Microsoft Office Download Center. In addition, all Microsoft Office Products must have the latest updates and security fixes. In addition, to customize the template using Word 2003, you must have SP3 and all available updates from Microsoft.
Each print style has a lang folder, and within it is a folder for each language. Each language has its own template file. To make any customization, you modify the publishing style for the specific format.

Note: If you create custom publishing styles, you should document your customizations so you can easily re-apply them, if necessary, after a software upgrade.

Follow these basic steps to customize a document format:

- Create a new publishing style. See Customize Publishing Styles for more information about copying and renaming publishing styles. It is highly recommended that you do not customize a standard template; you should make a copy and make your edits to the copy.
- Open the new publishing style package that you copied, navigate to the lang/<language> folder, and open the PrintTemplate.docm file.
- Make the edits to the PrintTemplate.docm file as desired by inserting or deleting bookmarks, Word fields, static text, or graphic elements. Be sure to use Check Syntax to verify that there are no errors in your changes to the bookmarks.
- Save the edited template in the publishing style, and then save the package.
- Publish the content using your new publishing style. Be sure to select the correct category and language on the Advanced Publishing Options page.

Use Bookmarks

Bookmarks have two parts: the bookmark name and the descriptive text in angled brackets (<>). The entire bookmark is enclosed in grey square brackets ([ ]). To display the grey brackets, you must turn on all formatting marks, plus select the Bookmarks option on the View tab of the Options dialog box in Microsoft Word. This is important, because if you want to move a bookmark, you need to make sure that you select the entire bookmark.

Types of bookmarks

There are three basic types of bookmarks:

- Single field: Bookmarks with a single piece of data, such as topic name, status, document ID, or creation date.
- Multiple fields: Bookmarks with multiple fields, most often in a table. Examples include the Required fields table, Output table, and Table of Properties in the Business Process Document, the Instructor Guide notes, and the table of Context IDs.
  This type of bookmark also includes the bookmarks which insert the concepts for the modules, sections, and topics as well as the list and table of action steps, the table of attachments, the screenshot, and the table of glossaries.
- Repeating: Bookmarks that contain definitions to allow insertion of multiple items, such as rows in a table or multiple attachments to a frame. These bookmarks may also contain table definitions, placeholders for graphics, and static text.

Publishing Template Toolbar

The PrintTemplate.docm file includes a toolbar. There are five menu items, three of which allow you to insert bookmarks. In some cases, the menus will insert several bookmarks or an entire structure, such as a table of action steps for a topic.
If Word is set to English, Spanish, French, German, or Japanese, the Publishing Template toolbar appears in the same language by default when you open the template. If Word is set to any other language, the template toolbar appears in English by default. You can use the Language menu to choose the language in which the toolbar is displayed.

If you are working with Word 2007, you must use the Add-ins ribbon to view the toolbar. If you are using Word 2003 with the compatibility pack and the toolbar does not appear automatically, you should check the macro security. It must be set to Medium or lower. You must also have the latest updates from Microsoft (sp3).

**Outline Menu**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outline Name</td>
<td>Inserts the name of the outline. The outline name is the text in the tab that was active when you published.</td>
</tr>
<tr>
<td><strong>Modules and Sections</strong> <strong>submenu</strong></td>
<td>Note that the bookmarks on this submenu only apply to multi-topic documents; i.e. the Training Guide and the Instructor Manual.</td>
</tr>
<tr>
<td>Module and Section</td>
<td>Inserts the pair of repeating tags required to define the beginning and end of the module or section. Any bookmarks for the contents of the module or section should be included between these bookmarks, such as the module or section name, concept, or topics.</td>
</tr>
<tr>
<td>Name, with Style Defined in Template</td>
<td>Inserts and formats the names of modules and sections, using the style defined in this template. With this bookmark, all the modules and sections use the Heading 1 style in Word, and all of the topic names use Heading 2. These are the default bookmarks.</td>
</tr>
<tr>
<td>Name, with Style Referenced to Outline Level</td>
<td>Inserts and formats the names of modules and sections, using the outline level style. The outline levels use the various Heading styles in Word. You may need to modify several styles, depending on how many levels you have in your content.</td>
</tr>
<tr>
<td>Concept, with Format Defined in Template</td>
<td>Inserts and formats modules and sections concepts, using the style and formatting in the template. These bookmarks will honor the text alignment as set in the Developer.</td>
</tr>
<tr>
<td>Concept, with Format Defined in Developer</td>
<td>Inserts module and section concepts using the formatting from the Web Page Editor in the Developer. Any formatting or style changes you make in the template will be ignored.</td>
</tr>
<tr>
<td>Table of Context IDs</td>
<td>Inserts a table of Context IDs for modules and sections. The context ID table has three columns: Context Name, Application Name, and Context IDs. Each of these columns contains a corresponding bookmark to insert the data. There is also a hidden bookmark at the beginning of the heading row to allow the rows to repeat for multiple Context IDs.</td>
</tr>
<tr>
<td><strong>Topics</strong> <strong>submenu</strong></td>
<td></td>
</tr>
<tr>
<td>Topic</td>
<td>Inserts the pair of repeating tags required to define the beginning and end of a topic in a multiple topic output format. When used, these bookmarks should be between the beginning and ending tags for the module and section. Any bookmarks for the contents of the topic should be included between the beginning and ending topic bookmarks, such as name, concept, or action steps.</td>
</tr>
<tr>
<td>Menu</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Name, with Style Defined in Template</td>
<td>Inserts and formats the names of modules and sections, using the style defined in this template. You can, therefore, create a style specifically for the topic name, no matter its position in the outline hierarchy.</td>
</tr>
<tr>
<td>Name, with Style Referenced to Outline Level</td>
<td>Inserts and formats the name of the topic, using the outline level style. The outline levels use the various Heading styles in Word; topics are always Heading 2.</td>
</tr>
<tr>
<td>Concept, with Format Defined in Template</td>
<td>Inserts and formats topic concepts, using the style and formatting in the template. These bookmarks will honor the text alignment as set in the Developer.</td>
</tr>
<tr>
<td>Concept, with Format Defined in Developer</td>
<td>Inserts and formats topic concepts, using the formatting from the Web Page Editor in the Developer. Any formatting or style changes you make in the template will be ignored.</td>
</tr>
<tr>
<td>Play Modes</td>
<td>Inserts a list of topic play modes, as specified in the Properties toolpane for the topic.</td>
</tr>
<tr>
<td>Know It? Remediation Levels</td>
<td>Inserts the Know It? remediation levels, as specified in the Properties toolpane for the topic.</td>
</tr>
<tr>
<td>Know It? Required Score</td>
<td>Inserts the Know It? passing score, as specified in the Properties toolpane for the topic.</td>
</tr>
<tr>
<td>Number of Frames</td>
<td>Inserts the number of frames in the topic.</td>
</tr>
<tr>
<td>Frames submenu</td>
<td></td>
</tr>
<tr>
<td>Frame</td>
<td>Inserts the pair of repeating tags required to define the beginning and end of a frame. These bookmarks should be between the beginning and ending tags for the topic.</td>
</tr>
<tr>
<td>Table of Action Steps</td>
<td>Inserts a customizable table of action text, including the introduction frame text. This set of bookmarks also includes the begin and end tags for the frames. There is a hidden bookmark in the heading row of the table which controls the multiple rows. When you select this menu, a dialog box appears allowing you to select various options. You can choose whether the text style for the action steps is controlled by the style in the Topic Editor or by the style you set in the template. A series of check boxes allows you to choose whether to include action images for each step, attachments, Context IDs, and Decision and alternative path action text, for example, Go to step x on page y.</td>
</tr>
<tr>
<td>List of Action Steps</td>
<td>Inserts a customizable list of action text, including the action text. This set of bookmarks also includes the begin and end tags for the frames. This option creates a list of the action steps that does not use a table. When you select this menu, a dialog box appears allowing you to select various options. You can choose whether the text style for the action steps is controlled by the style in the Topic Editor or by the style you set in the template. A series of check boxes allows you to choose whether to include action images for each step, attachments, Context IDs, and Decision and alternative path action text, for example, Go to step x on page y.</td>
</tr>
</tbody>
</table>
### Menu  
**Description**

**Table of Attachments**
Inserts customizable table of attachments. This set of bookmarks must be included between the begin and end tags for the frame. When you select this menu, a dialog box appears allowing you to select various options. You can choose whether the text style for web pages is controlled by the style in the Topic Editor or by the style you set in the template. Check boxes allow you to choose whether to include action attachment icons and images in packages.

**Publication Date**
Inserts the date on which the document was last published.

**Table of Glossaries**
Inserts a table of glossary terms, as in the Training Guide. There are bookmarks to define the beginning and ending of the Glossary table. In addition, there is a bookmark to insert the glossary term and another one to insert the glossary definition.

### Details Menu  
**Description**

**Checked Out by Author**
Inserts the person's name to whom the document is checked out as indicated in the Checked Out By field in the Details view in the Developer.

**Checked Out on Workstation**
Inserts the workstation's name on which the document is checked out as indicated in the Checked Out Hostname field, which can be added to the Details view in the Developer.

**Creation Date**
Inserts the date on which the document was created as indicated in the Creation Date field, which can be added to the Details view in the Developer.

**Document ID**
Inserts the document ID as indicated in the Document ID field, which can be added to the Details view in the Developer.

**Keywords**
Inserts the keywords assigned to the module, section, or topic in a comma separated list, as specified in the Properties toolpane for the topic.

**Language**
Inserts the language of the module, section, or topic, as specified in the Properties toolpane for the topic.

**Last Modified By**
Inserts the person's name who last modified the document as indicated in the Last Modified By field, which can be added to the Details view in the Developer.

**Last Modified Date**
Inserts the date on which the document was last modified, as indicated in the Last Modified Date field in the Details view in the Developer.

**Links From**
Inserts the number of items linked from the document as indicated in the Link Count field, which can be added to the Details view in the Developer.

**Links To**
Inserts the number of items linked to the document as indicated in the Links To field, which can be added to the Details view in the Developer.

**Owner**
Inserts the person's name who owns the document, or to whom it is assigned, as indicated in the Owner field in the Details view in the Developer.
### Menu

| **Roles** | Inserts a list of roles assigned to the document, as specified in the Properties toolpane for the topic or in the Roles field in the Details view. |
| **State** | Inserts the state of the document, such as Draft, as specified in the Properties toolpane for the topic or in the State field in the Details view. |
| **Type** | Inserts the document type, such as Section or Topic, as indicated in the Type field, which can be added to the Details view in the Developer. |
| **Version** | Inserts the version of the document as indicated in the Version field in the Details view of the Developer. |

#### Topic Properties Menu

<table>
<thead>
<tr>
<th><strong>Menu</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Business Process Document submenu</strong></td>
<td><strong>Output Table</strong> Inserts a table of output results. This is the Output - Results and Comments table for the Business Process Document as specified in the Properties toolpane for the document. Each column has a bookmark to insert the data. There is a hidden bookmark at the beginning of the heading row to control the repetition of multiple rows in the table.</td>
</tr>
<tr>
<td><strong>Required Fields Table</strong></td>
<td>Inserts a table of required fields. This is the Required Field(s) and Comments table for the Business Process Document as specified in the Properties toolpane for the document. Each column has a bookmark to insert the data. There is a hidden bookmark at the beginning of the heading row to control the repetition of multiple rows in the table.</td>
</tr>
<tr>
<td><strong>Table of Properties</strong></td>
<td>Inserts a table of properties. This is the first table in the Business Process Document. It includes Department, Responsibility/Role (list of roles), File Name (this is a Word field), Revision (version number appended to the document type at publication), Document Generation Date (the date on which the document was last published), Date Modified, Last Changed By (BPD property field; the person's name who last modified the document in the Developer), Status (BPD property field), Trigger (BPD property field), and Additional Information (BPD property field). All of these fields are as specified in the Properties toolpane in the Developer.</td>
</tr>
<tr>
<td><strong>Test Document submenu</strong></td>
<td><strong>Additional Validation</strong> Inserts the Additional information to validate the test, as specified in the Test Document section of the Properties toolpane in the Developer.</td>
</tr>
<tr>
<td><strong>Estimated Time</strong></td>
<td>Inserts the Estimated time to complete the test, as specified in the Test Document section of the Properties toolpane in the Developer.</td>
</tr>
<tr>
<td><strong>Purpose of Test</strong></td>
<td>Inserts the Purpose of the test, as specified in the Test Document section of the Properties toolpane in the Developer.</td>
</tr>
</tbody>
</table>
Insert, Move, and Delete Bookmarks

You can add bookmarks to the PrintTemplate.docm file from the Developer Publishing Toolbar or from the Bookmark dialog box in Word. You can use the toolbar to add extra information to the template easily.

You can also make substitutions with the toolbar. For example, the default template for the Training Guide uses the text formatting for concept web pages as set in the template. If you want to use the formatting as it is in the Developer, you can delete everything between and including the ModuleSectionConcept beginning and ending tags, and then use the toolbar to easily insert the bookmarks for the Developer-formatted web pages.

You can also insert bookmarks using the Bookmarks dialog box in Microsoft Word. You can access this dialog box with the Bookmarks command from the Insert ribbon in Word 2007 or the Insert menu in Word 2003. You will see in the list that the bookmarks have numbers appended to the name. In Word, each bookmark must have a unique name. The numbers are also used to identify beginning and ending bookmarks for a block, such as ForEachAttachment_Begin_1 and ForEachAttachment_End_1. The Check Syntax feature uses these numbers to verify that all necessary pairs are present.

See the Bookmark Reference topic in the Customize Document Formats chapter of the Content Development manual to determine the bookmark that you want to insert, then enter it in the Bookmark Name field at the top of the Bookmark dialog box, appending a number. You can insert any bookmark, including those, such as FrameID, that are not present by default in any of the output formats.

**Note:** If you insert Developer bookmarks in the headers or footers of the template, they will be ignored during the document processing. Microsoft Word fields, such as the document name, the page number, or the date of publication will be honored.

Move and Delete Bookmarks

When you select bookmarks to move or delete them, you should make sure that you select the entire bookmark, including the grey brackets at the beginning and the end and the no-width non breaking space before the bookmark.

You cannot copy bookmarks; you must move them using cut and paste. When you delete multiple bookmarks, especially a block of bookmarks, make sure you delete both the beginning and ending tags. If there are extra tags, you will receive an error when you check the syntax or attempt to use the template.

At the end of the template, there are bookmarks that you should not delete. These bookmarks control the images for the action areas, screenshots, packages, and web pages. If they are missing, the template will not be processed correctly during publishing.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Setup</td>
<td>Inserts the Test setup, as specified in the Test Document section of the Properties toolpane in the Developer.</td>
</tr>
<tr>
<td>Instructor Manual Notes</td>
<td>Inserts the Instructor notes, as specified in the Instructor Manual section of the Properties toolpane in the Developer.</td>
</tr>
<tr>
<td>Job Aid Revision</td>
<td>Inserts the Job Aid Revision, as specified in the Job Aid section of the Properties toolpane in the Developer.</td>
</tr>
</tbody>
</table>
If you delete these bookmarks, you must insert them manually in the Bookmarks dialog box in Word.

**Insert Word Fields, Static Text, and Graphic Objects**

In addition to bookmarks, the template contains static text the label fields or parts of the document and Word fields.

**Insert Word Fields**

You can insert any standard Word fields, such as date printed or last saved date. You can also use these in the header and the footer. You access the Field dialog box using the Field command on the Insert ribbon in Word 2007 or the Insert menu in Word 2003.

**Insert Static Text or Graphic Objects**

You can edit existing static text or add any static text anywhere on the template. You can also add graphic images or drawings, such as a line to separate sections or a graphic on the title page of the training manual.

**Format Bookmarks and Text**

If you have standard Word styles that you use for your documentation, you can copy them into the print template and use them for the printed outputs. You can also modify the existing styles in the template.

---

**Note:** If you use bookmarks that use the formatting as set in the Developer, any formatting in template will be ignored.

---

You can also format bookmarks by formatting the name of the bookmark. This will override the style that is applied to the bookmark. For example, if you want the Start frame text to be bold or larger than the text for the action frames, you do not need to create another style.

**Bookmark Reference**

The following list contains all of the bookmarks available in the PrintTemplate.docm template. It also indicates whether you can insert the bookmark through the menus on the Developer Publishing Template toolbar, or if you need to insert it manually in the Bookmark dialog box in Microsoft Word. See the Publishing Template Toolbar topic in the *Customize Document Formats* chapter of the Content Development manual for more information. This list will be useful if you delete a bookmark by mistake and want to insert it again, especially if the bookmark is not available from the toolbar.

<table>
<thead>
<tr>
<th>Bookmark</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActionText</td>
<td>Inserts action text with formatting indicated in this template. Action text refers to the bubble text. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>AdditionalInformation</td>
<td>Inserts additional information to be published with the document, as specified in the Business Process Document section of the Properties toolpane in the Developer. It is inserted as part of the Table of Properties on the Business Process Document submenu of the Topic Properties menu.</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Result</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AdditionalValidation</td>
<td>Inserts additional validation as specified in the Test Document section of the Properties toolpane in the Developer. It can be inserted from the Test Document submenu of the Topic Properties menu.</td>
</tr>
<tr>
<td>ApplicationName</td>
<td>Inserts the application name as indicated in the Topic Editor. It is inserted as part of the Table of Context IDs on the Modules and Sections submenu of the Outline menu.</td>
</tr>
<tr>
<td>AttachmentIcon</td>
<td>Inserts the attachment icon for items attached to frames in a topic. It should be located between the ForEachAttachment repeating tags. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>BPDRevision</td>
<td>Inserts the revision number appended to the document type at publication as specified in the Business Process Document section of the Properties toolpane in the Developer. It is inserted as part of the Table of Properties on the Business Process Document submenu of the Topic Properties menu.</td>
</tr>
<tr>
<td>CheckedOutByAuthor</td>
<td>Inserts person's name to whom the document is checked out as indicated in the Checked Out By field in the Details view in the Developer. It can be inserted from the Details menu.</td>
</tr>
<tr>
<td>CheckedOutonWorkstation</td>
<td>Inserts workstation's name on which the document is checked out as indicated in the Checked Out Hostname field, which can be added to the Details view in the Developer. It can be inserted from the Details menu.</td>
</tr>
<tr>
<td>ContextIDs</td>
<td>Inserts the context IDs as indicated in the Properties toolpane or the Topic Editor. It should be located between the ForEachModuleSectionCtx repeating tags. It is inserted as part of the Table of Context IDs on the Modules and Sections submenu of the Outline menu.</td>
</tr>
<tr>
<td>ContextName</td>
<td>Inserts the context names as indicated in the Properties toolpane or the Topic Editor. It should be located between the ForEachModuleSectionCtx repeating tags. It is inserted as part of the Table of Context IDs on the Modules and Sections submenu of the Outline menu.</td>
</tr>
<tr>
<td>CreationDate</td>
<td>Inserts the date on which the document was created as indicated in the Creation Date field, which can be added to the Details view field, which can be added to the Details view in the Developer. It can be inserted from the Details menu.</td>
</tr>
<tr>
<td>DecisionFrameType_Begin</td>
<td>Beginning of a repeating bookmark for decision frame paths. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Result</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DecisionFrameType_End</td>
<td>End of a repeating bookmark for decision frame paths. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>DecisionHeader</td>
<td>Inserts the header text for a decision frame. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>DecisionText</td>
<td>Inserts the text of a decision frame path. It must be located between the ForEachDecision repeating tags. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>Define_Hotspot_Begin</td>
<td>Beginning of a bookmark that controls the hotspot graphics within the template. Do not delete. Must be inserted manually.</td>
</tr>
<tr>
<td>Define_Hotspot_End</td>
<td>End of a bookmark that controls the hotspot graphics within the template. Do not delete. Must be inserted manually.</td>
</tr>
<tr>
<td>Define_PackageImage_Begin</td>
<td>Beginning of bookmark that controls the package graphics within this template. Do not delete. Must be inserted manually.</td>
</tr>
<tr>
<td>Define_PackageImage_End</td>
<td>End of bookmark that controls the package graphics within this template. Do not delete. Must be inserted manually.</td>
</tr>
<tr>
<td>Define_Screenshot_Begin</td>
<td>Beginning of repeating bookmark that controls the screenshot graphics within this template. Do not delete. Must be inserted manually.</td>
</tr>
<tr>
<td>Define_Screenshot_End</td>
<td>End of repeating bookmark that controls the screenshot graphics within this template. Do not delete. Must be inserted manually.</td>
</tr>
<tr>
<td>Define_WebpageImage_Begin</td>
<td>Beginning of bookmark that controls the webpage graphics within this template. Do not delete. Must be inserted manually.</td>
</tr>
<tr>
<td>Define_WebpageImage_End</td>
<td>End of bookmark that controls the webpage graphics within this template. Do not delete. Must be inserted manually.</td>
</tr>
<tr>
<td>Department</td>
<td>Inserts the department as specified in the Business Process Document section of the Properties toolpane in the Developer. It is inserted as part of the Table of Properties on the Business Process Document submenu of the Topic Properties menu.</td>
</tr>
<tr>
<td>DeveloperWebpageText</td>
<td>Inserts web page text with formatting as defined in the Developer. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu on the toolbar, as well as Concept, with format defined in Developer, on the Topics and Modules and Sections submenus on the Outline menu.</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Result</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DocType</td>
<td>Inserts the document type, such as Section or Topic, as indicated in the Type field, which can be added to the Details view in the Developer. It can be inserted from the Details menu.</td>
</tr>
<tr>
<td>DocumentID</td>
<td>Inserts the document ID as indicated in the Document ID field, which can be added to the Details view in the Developer. It can be inserted from the Details menu.</td>
</tr>
<tr>
<td>EndFrameType_Begin</td>
<td>Beginning of a repeating bookmark for end frames. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>EndFrameType_End</td>
<td>End of a repeating bookmark for end frames. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>EstimatedTime</td>
<td>Inserts the estimated time as specified in the Test Document section of the Properties toolpane in the Developer. It can be inserted from the Test Document submenu of the Topic Properties menu.</td>
</tr>
<tr>
<td>ForEachAttachment_Begin</td>
<td>Beginning of a repeating bookmark for attachments. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>ForEachAttachment_End</td>
<td>End of a repeating bookmark for attachments. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>ForEachDecision_Begin</td>
<td>Beginning of a repeating bookmark for decision frames. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>ForEachDecision_End</td>
<td>End of a repeating bookmark for decision frames. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>ForEachFrame_Begin</td>
<td>Beginning of a repeating bookmark for frames. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>ForEachFrame_End</td>
<td>End of a repeating bookmark for frames. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>ForEachGlossary_Begin</td>
<td>Beginning of a repeating bookmark for glossaries. It is inserted as part of the Table of Glossaries on the Outline menu.</td>
</tr>
<tr>
<td>ForEachGlossary_End</td>
<td>End of a repeating bookmark for glossaries. It is inserted as part of the Table of Glossaries on the Outline menu.</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Result</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ForEachModuleSection_Begin</td>
<td>Beginning of a repeating bookmark for modules and sections. It is inserted as a pair with the end tag. It can be inserted from the Modules and Sections submenu on the Outline menu.</td>
</tr>
<tr>
<td>ForEachModuleSection_End</td>
<td>End of a repeating bookmark for modules and sections. It is inserted as a pair with the begin tag. It can be inserted from the Modules and Sections submenu on the Outline menu.</td>
</tr>
<tr>
<td>ForEachModuleSectionCtx_Begin</td>
<td>Beginning of a repeating bookmark for table of context IDs. It is inserted as part of the Table of Context IDs on the Modules and Sections submenu of the Outline menu.</td>
</tr>
<tr>
<td>ForEachModuleSectionCtx_End</td>
<td>End of a repeating bookmark for table of context IDs. It is inserted as part of the Table of Context IDs on the Modules and Sections submenu of the Outline menu.</td>
</tr>
<tr>
<td>ForEachTopic_Begin</td>
<td>Beginning of a repeating bookmark for topics. It is inserted as a pair with the end tag. It can be inserted from the Topics submenu on the Outline menu.</td>
</tr>
<tr>
<td>ForEachTopic_End</td>
<td>End of a repeating bookmark for topics. It is inserted as a pair with the begin tag. It can be inserted from the Topics submenu on the Outline menu.</td>
</tr>
<tr>
<td>FormattedActionText</td>
<td>Inserts action text with formatting indicated in the Developer. Action text refers to the text in the bubble. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>FrameID</td>
<td>Inserts the frame ID as indicated in the Topic Editor. It must be inserted manually.</td>
</tr>
<tr>
<td>GlossaryDef</td>
<td>Inserts the glossary definition in the glossary table. It should be located inside the ForEachGlossary repeating tags. It is inserted as part of the Table of Glossaries on the Outline menu.</td>
</tr>
<tr>
<td>GlossaryTerm</td>
<td>Inserts the glossary term. Inserted as part of Table of Glossaries. It should be located inside the ForEachGlossary repeating tags. It is inserted as part of the Table of Glossaries on the Outline menu.</td>
</tr>
<tr>
<td>Goto_Begin</td>
<td>Beginning of a repeating bookmark for GoTo steps for alternatives and decision frames. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>Goto_End</td>
<td>End of a repeating bookmark for GoTo steps for alternatives and decision frames. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>HotSpotImage</td>
<td>Inserts a placeholder for the action image. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Result</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>IfIMNotes_Begin</td>
<td>Beginning of a conditional bookmark if there are Instructor Notes. It is inserted as part of the Instructor Manual Notes command on the Topic Properties menu.</td>
</tr>
<tr>
<td>IFIMNotes_End</td>
<td>End of a conditional bookmark if there are Instructor Notes. It is inserted as part of the Instructor Manual Notes command on the Topic Properties menu.</td>
</tr>
<tr>
<td>IMNotes</td>
<td>Inserts the Instructor Notes as specified in the Instructor Manual section of the Properties toolpane in the Developer. It should be between the IfIM_Notes repeaters. It is inserted as part of the Instructor Manual Notes command on the Topic Properties menu.</td>
</tr>
<tr>
<td>IfRemainingSteps_Begin</td>
<td>Beginning of conditional bookmark if there are remaining steps for an alternative or decision path. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>IfRemainingSteps_End</td>
<td>End of conditional bookmark if there are remaining steps for an alternative or decision path. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>IteratingRowAlternatives</td>
<td>Controls alternative step repeating and numbering. Do not delete. Must be inserted manually.</td>
</tr>
<tr>
<td>IteratingRowOutputResult</td>
<td>Controls repeating rows in the in the Output Results table in the Business Process Document. Do not delete. Must be inserted manually.</td>
</tr>
<tr>
<td>JARevision</td>
<td>Inserts Job Aid revision appended to the document type at publication as specified in the Job Aid section of the Properties toolpane in the Developer. It can be inserted from the Topic Properties menu.</td>
</tr>
<tr>
<td>Keywords</td>
<td>Inserts the keywords assigned to the document in a comma separated list, as specified in the Properties toolpane for the topic. It can be inserted from the Topic Properties menu.</td>
</tr>
<tr>
<td>KnowItRemediation</td>
<td>Inserts Know It? remediation levels as specified in the Topic section of the Properties toolpane in the Developer. It can be inserted from the Topics submenu on the Outline menu.</td>
</tr>
<tr>
<td>KnowItScore</td>
<td>Inserts Know It? required scores as specified in the Topic section of the Properties toolpane in the Developer. It can be inserted from the Topics submenu on the Outline menu.</td>
</tr>
<tr>
<td>Language</td>
<td>Inserts the language of the content as specified in the Properties toolpane in the Developer. It can be inserted from the Details menu.</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Result</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LastChangedby</td>
<td>Inserts the person's name who last modified the document as specified in the Business Process Document section of the Properties toolpane in the Developer. It is inserted as part of the Table of Properties on the Business Process Document submenu of the Topic Properties menu.</td>
</tr>
<tr>
<td>LastModifiedBy</td>
<td>Inserts the person's name who last modified the document as indicated in the Last Modified By field, which can be added to the Details view in the Developer. It can be inserted from the Details menu.</td>
</tr>
<tr>
<td>LastModifiedDate</td>
<td>Inserts the date on which the document was last modified, as indicated in the Last Modified Date field in the Details view in the Developer. It can be inserted from the Details menu.</td>
</tr>
<tr>
<td>LeadinFrameType_Begin</td>
<td>Beginning of a repeating bookmark for lead-in frames text. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>LeadinFrameType_End</td>
<td>End of a repeating bookmark for lead-in frames text. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>LinkCount</td>
<td>Inserts the number of items linked from the document as indicated in the Link Count field, which can be added to the Details view in the Developer. It can be inserted from the Details menu.</td>
</tr>
<tr>
<td>LinksTo</td>
<td>Inserts the number of items linked to the document as indicated in the Links To field, which can be added to the Details view in the Developer. It can be inserted from the Details menu.</td>
</tr>
<tr>
<td>ModuleSectionConcept_Begin</td>
<td>Beginning of a repeating bookmark for concepts. It is inserted as part of Concept, with Format Defined in Developer and Concept, with Format Defined in Template on the Modules and Sections menu on the Outline menu.</td>
</tr>
<tr>
<td>ModuleSectionConcept_End</td>
<td>End of a repeating bookmark for concepts. It is inserted as part of Concept, with Format Defined in Developer and Concept, with Format Defined in Template on the Modules and Sections menu on the Outline menu.</td>
</tr>
<tr>
<td>ModuleSectionName</td>
<td>Inserts module and section names, with style defined in this template. It can be inserted from the Modules and Sections menu on the Outline menu.</td>
</tr>
<tr>
<td>NormalFrameType_Begin</td>
<td>Beginning of a repeating bookmark for normal frames. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Result</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>NormalFrameType_End</td>
<td>End of a repeating bookmark for normal frames text. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>OLMODULESectionName</td>
<td>Inserts module and section names in outline, with style referenced to outline level. It can be inserted from the Modules and Sections menu on the Outline menu.</td>
</tr>
<tr>
<td>OLTOPICName</td>
<td>Inserts topic name in names in outline, with style referenced to outline level. It can be inserted from the Topics menu on the Outline menu.</td>
</tr>
<tr>
<td>OutlineName</td>
<td>Inserts the outline name. The outline name is the text in the tab that was active when you published. It can be inserted using the Outline command on the Outline menu.</td>
</tr>
<tr>
<td>OutputComment</td>
<td>Inserts the output comment as specified in the Output table in the Business Process Document section of the Properties toolpane in the Developer. It is inserted as part of the Table of Properties on the Business Process Document submenu of the Topic Properties menu.</td>
</tr>
<tr>
<td>OutputResult</td>
<td>Inserts the output result as specified in the Output table in the Business Process Document section of the Properties toolpane in the Developer. It is inserted as part of the Table of Properties on the Business Process Document submenu of the Topic Properties menu.</td>
</tr>
<tr>
<td>Owner</td>
<td>Inserts the person’s name who owns the document, or to whom it is assigned, as indicated in the Owner field in the Details view in the Developer. It can be inserted from the Details menu.</td>
</tr>
<tr>
<td>PackageImage</td>
<td>Inserts a placeholder for an image in a package. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu on the toolbar, as well as Concept, with format defined in Developer, on the Topics and Modules and Sections submenus on the Outline menu.</td>
</tr>
<tr>
<td>PlayModes</td>
<td>Inserts play modes as specified in the Topic section of the Properties toolpane in the Developer. It can be inserted from the Topics submenu on the Outline menu.</td>
</tr>
<tr>
<td>PublicationDate</td>
<td>Inserts the date on which the document was published. This is a Word field. It can be inserted from the Outline menu.</td>
</tr>
<tr>
<td>RequiredField</td>
<td>Inserts the required fields as specified in the Business Process Document section of the Properties toolpane in the Developer. It is inserted as part of the Table of Properties on the Business Process Document submenu of the Topic Properties menu.</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Result</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RequiredFieldComment</td>
<td>Inserts the required field comments as specified in the Business Process Document section of the Properties toolpane in the Developer. It is inserted as part of the Table of Properties on the Business Process Document submenu of the Topic Properties menu.</td>
</tr>
<tr>
<td>Roles</td>
<td>Inserts a list of roles assigned to the document as specified in the Properties toolpane for the topic or in the Roles field in the Details view of the Developer. It can be inserted from the Details menu.</td>
</tr>
<tr>
<td>ScreenShotImage</td>
<td>Inserts a placeholder for a webpage or package graphic. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>State</td>
<td>Inserts the document state, such as Draft, as specified in the Properties toolpane for the document or in the State field in the Details view. It can be inserted from the Details menu.</td>
</tr>
<tr>
<td>Status</td>
<td>Inserts the status of the document as specified in the Business Process Document section of the Properties toolpane. It is inserted as part of the Table of Properties on the Business Process Document submenu of the Topic Properties menu.</td>
</tr>
<tr>
<td>TableHeader</td>
<td>Controls table row repeating and step numbering. Do not delete. Must be inserted manually.</td>
</tr>
<tr>
<td>TargetFrameNum</td>
<td>Inserts target frame number for Decision frame paths and alternative paths. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>TargetPageNum</td>
<td>Inserts target page number for Decision frame paths and alternative paths. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu.</td>
</tr>
<tr>
<td>TDRevision</td>
<td>Inserts test document version appended to the document type at publication as specified in the Test Document section of the Properties toolpane in the Developer. It can be inserted from the Test Document submenu of the Topic Properties menu.</td>
</tr>
<tr>
<td>TestPurpose</td>
<td>Inserts the purpose of the test as specified in the Test Document section of the Properties toolpane in the Developer. It can be inserted from the Test Document submenu of the Topic Properties menu.</td>
</tr>
<tr>
<td>TestSetup</td>
<td>Inserts the test setup as specified in the Test Document section of the Properties toolpane in the Developer. It can be inserted from the Test Document submenu of the Topic Properties menu.</td>
</tr>
<tr>
<td>TopicConcept_Begin</td>
<td>Beginning of a repeating bookmark for concepts. It is inserted as part of Concept, with Format Defined in Developer and Concept, with Format Defined in Template on the Topics menu on the Outline menu.</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Result</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>TopicConcept_End</td>
<td>End of a repeating bookmark for concepts. It is inserted as part of Concept, with Format Defined in Developer and Concept, with Format Defined in Template on the Topics menu on the Outline menu.</td>
</tr>
<tr>
<td>TopicFrameCount</td>
<td>Inserts the number of frames per topic. It can be inserted from the Topics submenu on the Outline menu.</td>
</tr>
<tr>
<td>TopicName</td>
<td>Inserts the topic name, with style defined in this template. It can be inserted from the Topics menu on the Outline menu.</td>
</tr>
<tr>
<td>Trigger</td>
<td>Inserts action or condition that triggers the business process as specified in the Business Process Document section of the Properties toolpane in the Developer. It is inserted as part of the Table of Properties on the Business Process Document submenu of the Topic Properties menu.</td>
</tr>
<tr>
<td>Url</td>
<td>Inserts a URL link. It must be located between the UrlType repeating tags. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu on the toolbar, as well as Concept, with format defined in Developer, on the Topics and Modules and Sections submenus on the Outline menu.</td>
</tr>
<tr>
<td>UrlType_Begin</td>
<td>Beginning of a repeating bookmark for inserting URLs. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu on the toolbar, as well as Concept, with format defined in Developer, on the Topics and Modules and Sections submenus on the Outline menu.</td>
</tr>
<tr>
<td>UrlType_End</td>
<td>End of a repeating bookmark for inserting URLs. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu on the toolbar, as well as Concept, with format defined in Developer, on the Topics and Modules and Sections submenus on the Outline menu.</td>
</tr>
<tr>
<td>Version</td>
<td>Inserts the version of the document as indicated in the Version field in the Details view of the Developer. It can be inserted from the Details menu.</td>
</tr>
<tr>
<td>Webpage_Begin</td>
<td>Beginning of a repeating bookmark for web pages. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu on the toolbar, as well as Concept, with format defined in Developer, on the Topics and Modules and Sections submenus on the Outline menu.</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Result</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Webpage_End</td>
<td>End of a repeating bookmark for webpages. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu on the toolbar, as well as Concept, with format defined in Developer, on the Topics and Modules and Sections submenus on the Outline menu.</td>
</tr>
<tr>
<td>WebpagelImage</td>
<td>Inserts a placeholder for an image in a web page. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu on the toolbar, as well as Concept, with format defined in Developer, on the Topics and Modules and Sections submenus on the Outline menu.</td>
</tr>
<tr>
<td>WebpageText</td>
<td>Inserts web page with formatting defined in this template, with the exception of the alignment of images. Images will reflect the alignment as it is in the Developer. It is inserted as a part of the Table of Action Steps and the List of Action Steps, both of which are on the Frames submenu of the Outline menu on the toolbar, as well as Concept, with format defined in Developer, on the Topics and Modules and Sections submenus on the Outline menu.</td>
</tr>
</tbody>
</table>

**Style Reference**

The following is a list of styles used in the template.

<table>
<thead>
<tr>
<th>Word Style</th>
<th>Font &amp; Formatting</th>
<th>Where Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Arial, 14 point, Bold</td>
<td>Use for the name of the document type in the header.</td>
</tr>
<tr>
<td>Footer</td>
<td>Arial, 10 point</td>
<td>Used for the footer text.</td>
</tr>
<tr>
<td>Heading1</td>
<td>Arial 16 point Bold, space before 12 point, space after 3 point, Keep with next</td>
<td>Used for the Glossary header and all level 1 items in the outline, usually the Outline name. Text with this style will appear in the Table of Contents.</td>
</tr>
<tr>
<td>Heading2</td>
<td>Arial 16 point Bold, space before 12 point, space after 3 point, Keep with next</td>
<td>Used for all level 2 items in the outline. Text with this style will appear in the Table of Contents.</td>
</tr>
<tr>
<td>Heading3</td>
<td>Arial, 14 point, space before 12 point, space after 3 point, Keep with next</td>
<td>Used for all level 3 items in the outline. Text with this style will appear in the Table of Contents.</td>
</tr>
<tr>
<td>Heading4</td>
<td>Arial Bold, space before 12 point, space after 3 point, Keep with next</td>
<td>Used for all level 4 items in the outline. Text with this style will appear in the Table of Contents.</td>
</tr>
<tr>
<td>Heading5</td>
<td>space before 12 point, space after 3 point, Keep with next</td>
<td>Used for all level 5 items in the outline. Text with this style will appear in the Table of Contents.</td>
</tr>
<tr>
<td>Heading6</td>
<td>space before 12 point, space after 3 point, Keep with next</td>
<td>Used for all level 6 items in the outline. Text with this style will appear in the Table of Contents.</td>
</tr>
<tr>
<td>Word Style</td>
<td>Font &amp; Formatting</td>
<td>Where Used</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Heading7</td>
<td>space before 12 point, space after 3 point, Keep with next</td>
<td>Used for all level 7 items in the outline. Text with this style will appear in the Table of Contents.</td>
</tr>
<tr>
<td>Heading8</td>
<td>space before 12 point, space after 3 point, Keep with next</td>
<td>Used for all level 8 items in the outline. Text with this style will appear in the Table of Contents.</td>
</tr>
<tr>
<td>Heading9</td>
<td>space before 12 point, space after 3 point, Keep with next</td>
<td>Used for all level 9 items in the outline. Text with this style will appear in the Table of Contents.</td>
</tr>
<tr>
<td>procedure</td>
<td>Times New Roman, 11 point, bold</td>
<td>This style defines the formatting of the word “Procedure”. This text will not appear in the Table of Contents.</td>
</tr>
<tr>
<td>infoblock</td>
<td>Times New Roman, 11 point</td>
<td>Used for formatting the icon for the frame-level attachments.</td>
</tr>
<tr>
<td>highlighttext</td>
<td>Times New Roman, 11 point, 12.5% shading</td>
<td>Used for highlighting the text in the action steps, such as Go to step and End of Procedure.</td>
</tr>
<tr>
<td>titlepagetitle</td>
<td>Times New Roman, 16 point, Bold centered</td>
<td>This style is used for the Title on the Title Page of the Training Guide and the Instructor Manual.</td>
</tr>
<tr>
<td>titlepagedate</td>
<td>Times New Roman, 14 point, Bold centered</td>
<td>This style is used for the date on the Title Page of the Training Guide and the Instructor Manual.</td>
</tr>
<tr>
<td>Leadintext</td>
<td>Times New Roman, 11 point</td>
<td>This style is used for all lead-in text information.</td>
</tr>
<tr>
<td>Steptext</td>
<td>Times New Roman, 11 point</td>
<td>This style is used for the text that appears in the action steps.</td>
</tr>
<tr>
<td>Glossarytext</td>
<td>Times New Roman, 11 point</td>
<td>This style handles the definitions of the words in the glossary section.</td>
</tr>
<tr>
<td>Glossaryword</td>
<td>Times New Roman, 11 point, Bold</td>
<td>This style handles the glossary words (may or may not be a style).</td>
</tr>
<tr>
<td>AFORWARD</td>
<td>Arial 18 Small caps</td>
<td>This style formats the &quot;Copyright &amp; Trademarks&quot; text.</td>
</tr>
<tr>
<td>tocheader</td>
<td>Times New Roman, 20 point</td>
<td>This style formats the text “Table of Contents”.</td>
</tr>
<tr>
<td>TOC1</td>
<td>Times New Roman, 12 point, Bold, 6 point space before</td>
<td>This is the first level heading that appears in the Table of Contents. All items that are Heading1 style will appear in the TOC using this style.</td>
</tr>
<tr>
<td>TOC2</td>
<td>Times New Roman, 11 point, Bold, 6 point space before Indented left 0.15&quot;</td>
<td>All topics that are H2 style will appear in the Table of Contents using the TOC2 formatting.</td>
</tr>
<tr>
<td>TOC3</td>
<td>Times New Roman, 10 point, Indented left 0.30&quot;</td>
<td>All topics that are H3 style will appear in the Table of Contents using the TOC3 formatting.</td>
</tr>
<tr>
<td>TOC4</td>
<td>Times New Roman, 9 point, Indented left 0.45&quot;</td>
<td>All topics that are H4 style will appear in the Table of Contents using the TOC4 formatting.</td>
</tr>
<tr>
<td>TOC5</td>
<td>Times New Roman, 9 point, Indented left 0.60&quot;</td>
<td>All topics that are H5 style will appear in the Table of Contents using the TOC5 formatting.</td>
</tr>
<tr>
<td>Word Style</td>
<td>Font &amp; Formatting</td>
<td>Where Used</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>TOC6</td>
<td>Times New Roman, 9 point, Indented left 0.75&quot;</td>
<td>All topics that are H6 style will appear in the Table of Contents using the TOC6 formatting.</td>
</tr>
<tr>
<td>TOC7</td>
<td>Times New Roman, 9 point, Indented left 0.90&quot;</td>
<td>All topics that are H7 style will appear in the Table of Contents using the TOC7 formatting.</td>
</tr>
<tr>
<td>TOC8</td>
<td>Times New Roman, 9 point, Indented left 1.05&quot;</td>
<td>All topics that are H8 style will appear in the Table of Contents using the TOC8 formatting.</td>
</tr>
<tr>
<td>TOC9</td>
<td>Times New Roman, 9 point, Indented left 1.20&quot;</td>
<td>All topics that are H9 style will appear in the Table of Contents using the TOC9 formatting.</td>
</tr>
</tbody>
</table>

**Modify the Header or Footer**

One of the most common items to customize is the header and footer of any of the document types. You can change the logo, insert any Microsoft Word fields, or add static text. Note that you cannot insert bookmarks from the toolbar in the header or footer, only standard Word fields such as page number or document name. If you do put bookmarks in the header or footer, they will not be processed and will appear as static text in the published document.

**Change the Logo in the Header**

Each print document displays a default logo in the header. The graphic is embedded in the Microsoft Word template. You can use the copy and paste functions within Microsoft Word to embed your logo graphic. Be sure to size the graphic properly so that the header is not stretched out of proportion.

*Note:* You can also use the Customize Logo tool in the Developer to replace the logo. If you use this tool, the logo should be no larger than 230x44 pixels.

**Add the Document Name to the Footer**

You can add the document name to the footer of the document using a Microsoft Word field. In the PrintTemplate.docm file, choose Field from the Insert menu.

**Check Syntax**

After you have made your changes to the PrintTemplate.docm file, it is highly recommended that you check the syntax. This tool checks:

- For repeating pair omission: The begin or end half of the pair was found, but not the other half. Check that the tag exists and that the bookmark name is spelled correctly.
- For begin and end tags in the wrong order: The end tag appears before the begin tag for the same repeating pair. Delete the pair and insert them in the correct order.

The syntax checker starts at the beginning of the file. When it encounters an error, the check Syntax dialog box opens with an explanation of the error that was found, and the error is highlighted in the document. Make the correction, close the Check syntax dialog box, and start the syntax checker again. Repeat this process as necessary to find and correct all errors.
NOTE: The syntax checking process is manual; it does not happen automatically when the document is saved.

Customize Logos by Category

Although you can manually customize the logo in each publishing style such as the Player, the Presentation, and the document formats, you can also globally change the logo in all publishing styles and languages for a specific category in the Library.

You should always make a copy of original publishing styles installed with the software before you make any modifications. Also consider adding a new category in which to store the customized publishing styles. When you publish content, make sure you choose the appropriate category that contains the customized publishing styles.

NOTE: If you create custom publishing styles, you should document your customizations so you can easily re-apply them, if necessary, after a software upgrade.

Use the Customize Logo Tool

To customize logos globally for all publishing styles in a category, you can use the Customize Logo command on the Tools menu. This command prompts you to choose a category of publishing styles and an image file. You can choose to replace the default logo with any image in .gif, .bmp, .jpg, .jpeg, .tif, or .png file format. The Developer converts and renames it to small_logo.gif, and replaces all instances of small_logo and large_logo in all output styles for the selected category. This process will override any existing graphics that are in the existing publishing styles.

NOTE: The image that you use is not resized, cropped, or otherwise edited. You should use an image of the recommended pixel size (230W x 44H).

Multi-user Considerations

For changes to be made to a document using this tool, the document must be checked out. If you plan to use this tool offline, you should check out all affected documents before going offline.

When you execute this process, the Developer searches through all of the documents in the selection, regardless of their check in/out state. If a change is necessary and the document is not checked out and if you are working online, the Developer automatically checks the document out to you and makes the change. If the document cannot be checked out, for example, if it is open in another editor or checked out to another user or you are working offline, it is skipped. At the end of the process, a summary message appears with a link to an activity log. Clicking the View activity log link in the message displays a list of the documents that were checked out to you during the process and those that could not be checked out. After you save any changes, you should check in the documents to make them available to other authors and add the changes to the Developer's version control system.

Also note that you must have Modify permission to the folder where the publishing styles (or project documents) are stored for the category you select to successfully change logos.
To globally customize logos for a category of publishing styles:

1. On the **Tools** menu, choose **Customize Logo**.
2. Select a category or accept the default.
3. Browse to the location of the image file and select it.
4. Click OK to process the changes. When the process is complete, you can view the activity to determine the changes that were made.
5. Click OK to close the Update dialog box.

**Command-Line Publishing**

You can launch the publishing process from a command line. This allows you to create a batch publishing task that can be scheduled and run automatically at a time when the server or network is not as busy, such as at night or on the weekend.

You must publish content first to create a publishing task. This creates a folder structure and at least three files that are needed for command line publishing. The selection.xml, publishing.project.xml and at least one configuration (<format_guid>.config.xml) files are created at the root of the destination folder.

The selection.xml file contains a list of the documents to publish, the publishing.project.xml contains global parameters that apply to all publishing formats and a list of all configuration files (<format_guid>.config.xml) - one for each output format. The <format_guid>.config.xml contains the parameters that apply to a particular format.

The output from command line publishing will be stored in the same location as it would be if the publishing process was launched from within the Developer.

**Command-Line Publishing**

To use command-line publishing, you create a command line in the following format:

```
\path\commandlinepublish <settings> /profilename:<profile_name>
/passwd:<password>
```

or

```
\path\commandlinepublish <settings> /profile:<profile_path>
/passwd:<password>
```

You can use either the profilename or profile parameter; you do not need to use both. The password parameter is optional. See the descriptions below for details.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;settings&gt;</td>
<td>Path to the selection.xml file in the destination location for the published content.</td>
</tr>
<tr>
<td>/profilename</td>
<td>The name of the user profile to use for the publishing process. This profile must exist in the UserProfiles folder of the computer on which the publishing job is being run. If the password is not stored with the profile, you must use the /password parameter.</td>
</tr>
</tbody>
</table>
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/profile</td>
<td>The path and file name of a user profile, such as \path&lt;profile&gt;.xml. If this is not an absolute path, it is interpreted as a path relative to the publishing utility's folder. Use this parameter to specify a profile that exists outside of the UserProfiles folder. If the specified profile file does not include the password, you must use the /password parameter.</td>
</tr>
<tr>
<td>/password</td>
<td>If the specified user profile requires a password, and the password is not stored in the profile, this parameter is required.</td>
</tr>
</tbody>
</table>

You must put the path for the commandlinepublish.exe file in the batch file, or issue a command to change into the appropriate directory first. The commandlinepublish.exe must reside in and be executed from the folder where the Developer is installed. In addition, the location where the Developer is installed and the destination location for publishing must be in accessible locations.

**Note:** If the path to the commandlinepublish.exe or the settings file contains spaces, you must enclose the entire path in quotes.

### Execute Batch Publishing

You can execute multiple publishing jobs in a batch. Each job must be on a separate command line in the batch file.
15. Export/Import Content

You can exchange content between libraries and database servers and create backup copies of your content using export and import. When selecting content to export, you can choose a single document or folder, a selection of related documents, a collection of folders, or even an entire Library. The export process creates a single archive file that contains all of the documents included in the selection. Import adds all of the contents of an archive file to your Library, including their folder structure. If any errors occur during either process, they are written to an activity log, which is available for viewing upon completion of the process.

The export/import functionality allows you to:

- Deliver content to your clients, allowing them to import it into their own libraries on their own servers and modify it further
- Share and/or combine content among multiple developers working in single-user environments
- Modify publishing styles
- Share content defaults
- Localize content
- Share (Import/Export) sound files
- Prepare a backup archive of your current content that can be imported back into the same Library for content restoration or recovery if necessary

**Note:** Use of export/import as a means of backing up your content is especially recommended for single user installations, as this type of installation does not include version control.

The export command is available only from the Library and Outline Editor, whereas import is a global menu command. Both commands are invoked from the Tools menu.

All document content in the Library, such as topics, sections, web pages, glossaries, and so on, can be exported and hence imported as well. Included with each exported document are its embedded document properties, such as document name and language, as well as information about its links to other documents and its location within the folder structure of the Library. This information is included in the export archive even if the folders and/or the targets of the links themselves are not. Likewise, the folder structure is recorded in the export archive even if no folders are selected for export. The links and folder structure are rebuilt upon import as needed.
Multi-user Considerations

Unlike embedded document properties, external document properties are not included in the export of a document. These properties, such as State, are generally workflow-related and are stored on the server rather than as part of the document. When you import a document into a new Library, you must reset these properties as needed.

Also excluded from export, and therefore import, are document history and deleted documents. As a result, export/import provides only a partial backup in a multi-user environment. Therefore, you should use export and import for backup only as a supplement to your standard server backup procedures.

Folder permissions are not exported.

You can export and import whether online or offline. To export while offline, you must have the documents in your local cache. If you import while offline, you should check in the imported documents the next time you are working online, to make them available to other authors and add any changes to the Developer's version control system.

Export Content

Export, in combination with import, allows you to exchange content between libraries and database servers and create backup copies of your content. You can export your content from either the Library or the Outline Editor. An advantage of exporting from the Library is that you can choose a wider range of content to export by selecting multiple folders or multiple documents that are not necessarily linked to each other. In fact, you can export your entire Library by selecting the root folder.

Tip: You can back up all or part of your Library using the export command. Select the root folder of the Library to export and backup your entire Library.

Exporting from the Outline Editor allows you to easily select all or part of a specific outline for export. However, you cannot select unrelated documents or multiple, independent outlines from the Outline Editor.

Tip: You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click). You can select all items in a folder by choosing Select All from the Edit menu.

After selecting content and initiating the export process, your next step is to set the export options.

The first option is the location in which to save the export archive. The default location is the My Documents folder on your local hard drive, but you can choose any other location on your computer or server for which you have Write permissions. You must also specify a name for the archive file, which has the extension .odarc.

The second option allows you to export your selection only or your selection and all related documents. In general, documents linked as children of the documents in your selection are included as related, whereas those linked as parents are not. Click the View related documents link to display a list of all documents related to your selection.
Note the following points about related documents as applied to export:

- If the selection is a folder, related documents include all documents related to the documents contained in the folder, regardless of where they are located in the Library. The folder structure of the related documents is recorded in the archive file as well.

- Any glossary assigned to a document selected for export is included as a related document, along with all packages and web pages used for definition links.

- When you export a glossary document directly (by selecting it from the Library), its related documents include all packages and web files used for definition links. Documents to which the glossary is assigned are not included as related documents.

- Icon packages (both standard and custom) are included as related documents of topics containing frame links.

- Role lists are not included as related documents for export. However, roles assigned to each topic are included, because they are part of the topic's properties. If you wish to export a role document, you must explicitly select it from the Library.

- Custom-recorded sound is saved as part of its topic and is therefore included when the topic is exported.

- Templates are not included as related documents for export. To export a template, you must select it directly from the Library (System/Templates folder).

- Packages containing template and object name sound are not included as related documents of templates. To export these packages, you must select them directly from the Library (subfolder of the System/Templates folder). Alternatively, you can select the parent folder to export the template and associated sound together.

- Packages, role documents, and templates do not have related documents.

**Multi-user Considerations**

In a multi-user environment, when you are online, you also have the option to choose local or server content. Local content includes the locally edited copies of all selected documents that you have checked out and the server versions of those not checked out to you. Use this option for documents in progress for review. Server content includes only the checked in versions of the selected documents. Any local changes to checked out documents are ignored. Use this option for final versions of documents.

Also note that you can export while offline, but to do so, you must have the documents in your local cache.

During the export process, all of the selected content is written to a single compressed archive file with the extension odarc. The archive file also includes the absolute Library folder structure for each document, as well as information about all links to and from the documents. A summary message appears if some of the documents you selected could not be processed. Clicking the View activity log link in the message displays a list of the results for each document.
Export/Import Content

**Note:** A utility exists to uncompress and recompress odarc archives, if you need to work with the constituent files outside the Developer. See *Understand Developer Archives*.

Selecting Cancel during the export process displays a message with a link to a list of the documents that have already been exported. Although the partial archive file resulting from the cancelled process is not deleted automatically, this archive file is unusable and cannot be successfully imported. In addition, you cannot continue an export process that has been cancelled, and you cannot add to an existing archive file. To obtain a usable archive file in this case, you must restart the process from the beginning.

To export content:

1. From the Library or Outline Editor, select the folder(s) and/or document(s) you want to export.
   
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
2. On the **Tools** menu, point to **Export** and choose **Documents**.
3. Set the export options.
4. Click **Export** to execute the process.

   The export tool analyzes and processes the selected documents, creating a single archive file in the specified location.

   If any errors occur, they are written to an activity log, and a Partial Export message box appears. You can click the View activity log link to view the results of the export or click OK to close the message box.

Import Content

Import, in combination with export, allows you to exchange content between libraries and database servers and restore backup copies of your content. You can import a content archive file from the Tools menu.

When importing, you can select a single archive file, identified by the extension odarc. The Developer validates the archive structure when you initiate the import process. Therefore, you cannot choose to import only specific pieces of an archive; you must import the entire archive as a unit.

Next, you specify the Library location into which the contents of the archive are to be imported. You can browse to select an existing folder or type a new folder name, including Library path if necessary, to create a new folder for the imported material.

Finally, you have the option to overwrite existing documents or not. You should choose the overwrite option if the archive contains updated versions of documents that are already in your Library. In contrast, you might choose not to overwrite existing documents to import only new documents from an archive containing some documents that are new and some that are already present in your Library. Skipping the existing documents in this way speeds the import process.

In general, the import process writes the contents of the archive file to your Library in the selected location, re-creating the documents and their Library structure as necessary, as well as links to and from the documents. A summary message appears if some of the documents you selected could not be processed. Clicking the View activity log link in the message displays a list of the results for each document.
The specific results of importing an archive depend on the contents of the archive, the existing contents and structure of the Library, and the specified import options, as detailed next.

- The Library folder structure represented in an archive corresponds to the absolute folder structure relative to the root of the Library from which the archive was created. During import, this folder structure is created relative to the import location specified in the Import dialog box. Therefore, to exactly reproduce the folder structure of the Library from which the archive was created, you should select the root ("/") as the import location.

- If the Library folder structure represented in an archive already exists in the specified import location, the contents of the archive folders are written to the existing Library folders, which has the net effect of merging the corresponding folders. Otherwise, the archive folder structure is created in the specified location.

- For the purpose of overwriting during import, documents are identified solely on the basis of Document ID, not title, language, or any other document property; location in the Library is also not important. Therefore, for a given document in an archive, the following three situations can arise:

  No document with the same ID exists in the Library - The new document is created in the specified import location.
  
  A document with the same ID exists in the Library but overwrite is not selected - The archive document is skipped.
  
  A document with the same ID exists in the Library and overwrite is selected - The document is overwritten in its current Library location, regardless of the selected import location. That is, documents are never moved within the Library when they are overwritten during import.

- For the purpose of re-creating links during import, documents are again identified solely on the basis of Document ID; location in the Library is not important. Therefore, if a document links to a child document with a given ID and a document with the same ID as the child already exists in the Library (or is imported at the same time as the parent), the link is re-created. If no such child document exists, a broken link results.

- If the imported content includes new documents that were stored in the System folder, the new documents are always imported into the System folder and not in the folder specified for the import.

The following table summarizes the results of import for different combinations of import options:

<table>
<thead>
<tr>
<th>Content</th>
<th>Folder Structure</th>
<th>Overwrite</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>New</td>
<td>NA</td>
<td>New folder structure is created in the specified Library location; new documents are created in these folders.</td>
</tr>
<tr>
<td>New</td>
<td>Existing with the root selected as the import location</td>
<td>NA</td>
<td>New documents are created in the existing folder structure (the folders are merged).</td>
</tr>
<tr>
<td>Existing</td>
<td>New or existing</td>
<td>No</td>
<td>Existing documents that are not overwritten are not imported.</td>
</tr>
<tr>
<td>Existing</td>
<td>New or existing</td>
<td>Yes</td>
<td>Existing documents are overwritten in their current Library locations.</td>
</tr>
</tbody>
</table>
### Content

<table>
<thead>
<tr>
<th>Content</th>
<th>Folder Structure</th>
<th>Overwrite</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mixture of new and existing</td>
<td>New or existing with the root NOT selected</td>
<td>Yes</td>
<td>New folder structure is created in the specified import location, and new documents are created in these folders; existing documents are overwritten in their current Library locations.</td>
</tr>
<tr>
<td></td>
<td>as the import location</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mixture of new and existing</td>
<td>Existing with the root selected as the</td>
<td>Yes</td>
<td>Existing documents are overwritten in their current Library locations, and new documents are created in the existing folder structure.</td>
</tr>
<tr>
<td></td>
<td>import location</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Selecting Cancel during import stops processing after completion of the current document and displays a message with a link to a list of the documents that have already been imported. Click the View activity log link in the message to display a list of the results for each document.

Also note that, during import, the Developer identifies all roles used in the imported content. It then compares these roles to the master role list of the same language. If any of these roles is not included in the appropriate master role list, the Developer attempts to add the role to the role list. If the role cannot be added to the list, for example, if the master role list is open in an editor, the role is still kept in the content but is not included in any role list. You can later update the master role list to include these roles, if desired.

---

#### Multi-user Considerations

For a document to be overwritten during import, it must be checked out. Therefore, before initiating the import process, you should ensure that any documents that must be overwritten are either checked out to you or checked in to the server. If you plan to import an archive while offline, you must check out all such documents before going offline.

However, if a document that needs to be overwritten is not checked out and you are online, the Developer automatically checks the document out to you and replaces it with the corresponding document from the archive. If the document cannot be checked out, for example, if it is open in another editor or checked out to another user, it is skipped.

Note that, if a document in the archive existed in the Library but had been deleted, overwriting moves the document from Deleted view to Library view, thus restoring the document. The document is restored in its original location, regardless of the selected import location.

Also note that, if the Developer needs to add roles to a master role list during import, this master role list must be checked out. If the role list is not checked out and you are online, the Developer automatically checks it out to you and adds the necessary roles. If the role list cannot be checked out, for example, if it is open in an editor or checked out to another user, the roles are kept in the imported content but are not added to the role list. You can later update the master role list to include these roles, if desired.

After you complete the import process, you should check in all affected documents (new and overwritten) to make them available to other authors and add the changes to the Developer's version control system. If a document was overwritten, its version number is incremented only if its contents have changed. That is, if a document in the archive was identical to the same document already in the Library, overwriting on import does not affect the document's version history.
To import content:

1. On the Tools menu, point to Import and choose Documents.
2. Set the import options.
   - To exactly reproduce the folder structure of the Library from which the archive was created, select the root ("/") in the Import content to field.
3. Click Import to execute the process.
   - The import tool analyzes and processes the selected archive, adding the archive documents and re-creating their relative folder structure in the specified Library folder.
   - If any errors occur, they are written to an activity log, and a Partial Import message box appears. You can click the View activity log link to view the results of the import or click OK to close the message box.

Export Sound Files in Bulk

Export, in combination with import, allows you to store your sound files in a central location. Sound files can be exported in bulk from the Outline Editor or the Library.

**Note:** You can not export sound on webpages in bulk. You can export sound files on a frame by frame basis or on a webpage from the Topic Editor. See Export a Sound File for more information.

When exporting sound files, you can select the location of the exported files. By default, the files are exported to \MyDocuments\<category>\Sound. The Export process creates a Bubble folder under the Sound folder to store your sounds.

Additionally, a Sound Report is created in the Sound folder. This report provides information about each exported sound file and is useful in identifying missing sounds that need to be created. The Sound Report can produce a report of all sounds related to See It/Try It modes or Do It mode.

**Multi-user Considerations**

In a multi-user environment, when you are online, you also have the option to choose local or server content. Local content includes the locally edited copies of all selected documents that you have checked out and the server versions of those not checked out to you. Use this option for documents in progress for review. Server content includes only the checked in versions of the selected documents. Any local changes to checked out documents are ignored. Use this option for final versions of documents.

Also note that you can export while offline, but to do so, you must have the documents in your local cache.

Import Sound Files in Bulk

Import, in combination with export, allows you to store your sound files in a central location. Sound files can be imported in bulk to the Outline Editor or the Library.
Note: You can not import sound on webpages in bulk. You can import sound files on a frame by frame basis or on a webpage from the Topic Editor. See Import a Sound File for more information.

When importing sound files, you can select the root folder of your audio files and import the entire sound folder structure. Importing the file structure that matches the exported file structure, you can bulk import directly into the proper topic locations. By default, the files are imported from \MyDocuments\<category>\Sound. Upon completion of import, an activity log is generated showing the import status, file names and topics where the files where imported.

To import sound files:
1. On the Tools menu, point to Import and choose Sound.
2. Set the import options.
3. Click Import to execute the process.

The import tool analyzes and processes the selected archive, copying the sound files into the appropriate locations in the Library.

Extract a Developer Archive

If you plan to edit any of the documents contained in an archive, you must first extract the archive file. To do this, you use the command-line utility OdArc.exe. After saving your changes to the documents, you use the same OdArc.exe utility to recompress the archive so that it can be imported.

OdArc.exe is stored in the directory in which the Developer is installed. Therefore, you must change to this directory in order to execute OdArc.exe from the command line.

The syntax for extraction is as follows:

```bash
odarc /x <archive_path> <destination_folder>
```

where

- `<archive_path>` is the filename, including absolute path, of the archive to be extracted
- `<destination_folder>` is the location for the extracted files

During archive extraction, the OdArc utility processes the selected archive and writes its contents to the specified location in the form of an archive manifest and a collection of folders for the documents contained in the archive. Because the functioning of the archive depends on its relative structure, you should always extract each archive to a clean, empty folder, so that the folder contains only the extracted archive files. This destination_folder location can be a subfolder of the directory containing the archive to be extracted, or it can be a completely different location. However, you should not extract an archive into the same folder in which the archive itself is located.

As an example, consider a Developer archive file named "test.odarc" that was exported to the "temp" directory at the root of the local computer and is to be extracted to a subfolder named "extract" in the same directory, the command line should read:

```bash
odarc /x c:\temp\test.odarc c:\temp\extract
```
Tip: As with all command-line utilities, you must enclose folder names and paths in double quotation marks ("") if they include spaces. For example, if the archive mentioned above had been exported to a folder named "export" on the desktop of the local computer, the command line should read:

odarc /x "c:\documents and settings\userid\desktop\export\test.odarc" "c:\documents and settings\userid\desktop\export\extract"

Understand Developer Archives

1. The export process writes all of the selected content to a single compressed archive file with the extension odarc. The import process then takes a single odarc file as input to re-create the contents of the archive in the current Library. Therefore, to exchange documents between libraries, you need not open any archive files. However, if you plan to edit any documents contained in an archive outside the Developer, you need to extract the archive and understand its structure and contents. When you are done making your changes, you must then recompress the archive to make it available for import. See the Extract a Developer Archive and Recompress a Developer Archive topics in the Import/Export Content chapter of the Content Development manual for more information. The overview of Developer archives provided here can help you determine which files you need to edit to make your desired changes.

Each archive file consists of several components representing the documents it contains and their relative structure. In particular, the archive consists of an archive manifest and a folder for each document, labeled with the document ID. The manifest lists all of the Library folders and documents included in the archive, and each document folder in the archive contains all necessary information and files required to re-create the document in the Developer upon import. The specific contents of each archive folder therefore depend on the type of document, as summarized later in this section.

Manifest File
The manifest file, manifest.xml, begins with a list of the Library folders making up the absolute Library paths of all documents in the archive. The manifest then lists each document, along with several properties, including absolute Library path, document ID, title, type, and language. The schema used to render the document type upon import is also included.

The manifest file therefore functions as a table of contents for the archive, defining the documents it contains and their relative folder structure. Upon import, the Developer reads the manifest and verifies that appropriate archive folders exist for all documents listed therein. All of the documents specified in the manifest must be present for the archive to be imported. This manifest information then directs how the archived documents are re-created during import from the contents of the archive folders.

Warning! Do not rename or delete any of the files and folders contained in a Developer archive, as this renders the archive unusable.

Module/Section Archive Folder
The archive folder for each module and section contains the following three files:

- section.xml - List of several properties of the module/section, including document schema, template, glossary (if assigned), screen resolution, and directly linked children
The archive folder for each topic contains the following three files, as well as a varying number of graphics files depending on the number of frames in the topic:

- **topic.xml** - List of several properties of the topic, including document schema, template, glossary (if assigned), screen resolution, playback modes, and topic context; also includes detailed information specific to each frame of the topic, such as screenshot file name, action, hotspot, and custom bubble text.
- **linksto.xml** - List of document IDs of all linked attachments and link icons, as well as the template and glossary (if assigned).
- **search.xml** - Search proxy file used to speed text search, spell checking, and glossary markup in the Developer; includes all searchable text in the topic, such as bubble text, keywords, and decision frame text.
- **n.png** - Graphics files containing screenshots for all frames, numbered in the same order as the frames in the Frame Structure window of the Topic Editor.

**Package Archive Folder**

The archive folder for each package contains the following subfolder:

- **Parts subfolder** - contains all package files and folders, if applicable.

**Web Page Archive Folder**

The archive folder for each web page contains the following three files and one subfolder:

- **webpage.xml** - List of properties of the web page, including document schema and glossary (if assigned).
- **linksto.xml** - List of document IDs of any packages or other web pages linked through hyperlinks inserted in the web page; also includes glossary (if assigned).
- **search.xml** - Search proxy file used to speed text search, spell checking, and glossary markup in the Developer; includes all searchable text in the web page, such as visible text and hyperlink tooltips.
- **Parts subfolder** - contains index.html, the web page document itself; also contains an images sub-subfolder for embedded graphics, if used in the web page.

**Note:** Images inserted in a web page from a package are represented in index.html by the "file not available" indicator. However, the link to the package graphic is maintained and is restored upon import as long as the web page was exported with its related documents or the same package already exists in the new Library.

Images inserted in a web page from a URL remain linked and visible in index.html.

**Glossary Archive Folder**

The archive folder for each glossary document contains the following three files:

- **glossary.xml** - List of glossary terms, including document IDs or URLs of definition links, tooltips, and matching conditions (match whole word, match case).
• linksto.xml - List of document IDs of packages and web pages used as definition links (does not include URL definition links)
• search.xml - Search proxy file used to speed text search, spell checking, and glossary markup in the Developer; lists text of all glossary terms and tooltips

Role Archive Folder
The archive folder for each role document contains the following file:
• roles.xml - List of the roles included in the role document
• search.xml - Search proxy file used to speed text search, spell checking, and glossary markup in the Developer; lists text of each role

Template Archive Folder
The archive folder for each template contains the following two files:
• template.xml - Detailed listing of all template components, such as context-specific template bubble text and associated sound files
• template.xsl - Stylesheet transformation file for processing the template

Publishing Style Archive Folder
The contents of the archive folder for a publishing style depend on the specific output format selected. In general, each publishing style includes files with instructions for executing the publishing process (the two most important being project.xml and style.xml), as well as components needed to build the output. Also included are settings for the publishing style in the Developer publishing wizard and options pages.

The types of components included in a publishing style vary depending on whether the selected publishing format is a document or Player output. For example, styles for document outputs include document templates, as well as logos, stylesheets, and stylesheet transformation files. Styles for Player-type outputs require many more components, including stylesheets and associated transformation files, graphics and icons, framesets and default frame pages, and JavaScript programs for managing Player-specific functions such as displaying attachments.

See the Customize Publishing Styles topic in the Publish Content chapter of the Content Development manual for more information.

Recompress a Developer Archive
After making changes to documents extracted from an archive, you must recompress the archive to prepare it for import. To do this, you use the same command-line utility as used for extraction, OdArc.exe.

OdArc.exe is stored in the directory in which the Developer is installed. Therefore, you must change to this directory in order to execute OdArc.exe from the command line.

The syntax for compression is as follows:

```
odarc /a <source_folder> <archive_path>
```

where

• `<source_folder>` is the location of the extracted files
• `<archive_path>` is the filename, including absolute path, of the recompressed archive
During archive recompression, the OdArc utility processes all files contained in the source_folder location and uses them to create the specified Developer archive file. Therefore, you cannot recompress an archive to the source_folder location or any subfolder thereof, as this would create a loop in which the utility was essentially trying to compress the archive into itself. In addition, because the functioning of an archive depends on its relative structure, you should not remove files/folders from or add files/folders to the directory containing an extracted Developer archive, as the archive obtained upon recompression unusable. In general, this means that you should extract each archive to a clean, empty folder; edit the extracted files in place; and then recompress the archive from the same folder.

As an example, consider a Developer archive file named "test.odarc" that was exported to the "temp" directory at the root of the local computer and then extracted to a subfolder named "extract" in the same directory. To recompress this archive back to its original name and location, the command line should read:

```
odarc /a c:\temp\extract c:\temp\test.odarc
```

Note that the name and path of a recompressed archive do not need to match those of the original archive. For example, you might use a name to indicate that the archive had been edited, such as "test_edited.odarc" in the above example.

Tip: As with all command-line utilities, you must enclose folder names and paths in double quotation marks (") if they include spaces. For example, if the archive file mentioned above had been extracted to a subfolder named "extract" within the folder "export" on the desktop of the local computer and was being recompressed to a folder named "edited archives" in the same location, the command line should read:

```
odarc /a "C:\Documents and Settings\userID\Desktop\export\extract"
```

```
"C:\Documents and Settings\userID\Desktop\export\edited archives\test.odarc"
```
16. Localize Content

Once you have created content in one language, you might want to translate it into one or more different languages. The Developer provides functionality that facilitates this aspect of the localization process.

The Developer localization flow involves four main steps:

- Create a duplicate of the existing content to be translated
- Re-record each topic to update screenshots, actions, and object names and apply the appropriate template for the target language to update template text
- Translate custom Developer text, including custom bubble text, web page text, link tooltips, and glossary terms
- Translate external content, such as package files and graphics, and relink these documents to the translated Developer content, if necessary; update glossary links

The first step in any localization task is always to create a duplicate of the content to be translated. The remaining steps involve the translation of different types of content and can be performed in any order, and even concurrently.

Create a Duplicate

To begin the localization process, you must first create a duplicate of the content to be translated. You do this using the Copy command and the Duplicate (selection and related) option of the Paste Special command. This creates new copies of the entire selection and all related documents, including glossaries, and updates the links so that the new parent documents link to the new child documents. The resulting documents serve as placeholders that will be overwritten with the translated content. Therefore, you need to create one duplicate of the original content for each language into which you plan to translate. For example, to translate English content into French, German, and Japanese, you need to create three separate duplicates of the original content.

For simplicity in managing translations, especially those involving multiple languages, it is recommended that you create the duplicate for each target language in a separate, clearly identified Library folder. For the example above, if the English content were an outline titled "Document Basics" stored in a folder of the same name, you might create the folders "Document Basics - FR", "Document Basics - DE", and "Document Basics - JA" and paste one duplicate outline into each folder.

Re-record Topics

A crucial aspect of localizing content is capturing the screenshots and actions of each topic in the target language. To do this, you can use the re-record flow in the Topic Editor, which allows you to easily re-create the same series of actions in the new language using the original topic as a guide. You must also update the template bubble text in the topic by selecting the appropriate template for the target language from the Properties toolpane. This provides a localized version of the automatically generated portions of a topic.

Note: The Developer provides a standard set of Default and Microsoft templates for all supported languages. Therefore, you do not need to translate template text unless you use a custom template or translate your content into an unsupported language.

Translate Custom Text

In addition to recording topic steps, you can also customize your content by adding custom bubble text, using modules and sections for organizational headings, and linking to
attachments such as web pages to provide additional information. The text you produce while modifying your content in this way must also be translated for localization. The Developer provides a Localization export and import flow to assist in the translation of this custom text.

The custom text included in the Localization export/import flow depends on the document type as follows:

<table>
<thead>
<tr>
<th>Type</th>
<th>Text included</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module</td>
<td>Document name</td>
</tr>
<tr>
<td>Section</td>
<td>Document name</td>
</tr>
<tr>
<td>Topic</td>
<td>Custom bubble text, including formatting and markup for playback modes and Player and print outputs</td>
</tr>
<tr>
<td></td>
<td>String input text</td>
</tr>
<tr>
<td></td>
<td>Implicit text (for string input action)</td>
</tr>
<tr>
<td></td>
<td>Object names</td>
</tr>
<tr>
<td></td>
<td>Jump-in points</td>
</tr>
<tr>
<td></td>
<td>Topic properties such as document output properties, keywords, and roles</td>
</tr>
<tr>
<td></td>
<td>Frame link tooltips</td>
</tr>
<tr>
<td>Package</td>
<td>Document name</td>
</tr>
<tr>
<td>Web Page</td>
<td>Document name</td>
</tr>
<tr>
<td></td>
<td>Body text, including formatting</td>
</tr>
<tr>
<td></td>
<td>Image alternative text</td>
</tr>
<tr>
<td>Glossary</td>
<td>Document name</td>
</tr>
<tr>
<td></td>
<td>Glossary entries</td>
</tr>
<tr>
<td></td>
<td>Glossary entry tooltips</td>
</tr>
</tbody>
</table>

You can export this text in Word format for manual translation or XLIFF format for use in professional translation software that supports this format. The export results in a single file that contains a listing of all custom text in the source language that needs to be translated, divided into individual translation units, along with processing information required to ensure that each unit of text is imported correctly. During translation, you add translated text to the Word or XLIFF file so that the file includes the translated text in the target language in parallel with the original source text. After completing the translation, you then import the modified file back into the Developer, using the Import for Localization command. During import, the documents that were originally exported in the source language are overwritten with the translated text provided in the Word or XLIFF file, and the Language property of these documents is updated to match the target language.

**Note:** Because the import process overwrites the text in the original documents, you MUST make a duplicate of the content to be translated before exporting it for localization; otherwise, you will overwrite the content in the original source language.

For a detailed discussion of this process, see *Export for Localization* and *Import for Localization*. 
Translate External Content and Update Glossary Links

The third type of content to translate is external material such as package and URL attachments. For example, you might link to an Excel spreadsheet or an external web site from a topic frame, or you might include an embedded graphic in a web page. Such external content is not included in the Localization export/import flow and must be translated separately. After translating such package files, graphics, and so on, you might need to update links in your translated content to ensure that they point to the appropriate targets. For example, if you translate the name of a file in a package, you must ensure that all links in the translated content are updated to reflect the new package file name.

Tip: To avoid having to update links to package files in translated content, you should apply a language-neutral naming convention for package items. You can then differentiate package files of the same name based on the name of the package in which they are contained, which can be translated without breaking any links.

After all text in your content has been translated, you should update glossary links in the translated documents. Because glossary documents are included in the duplication process and the Localization export/import flow, the appropriate glossary, including translated terms and tooltips and updated definition links, will already be assigned to each translated document. However, the links themselves are not preserved during the localization process so as to allow flexibility in the treatment of glossaries.

Note that, aside from glossary links, the only links that might need to be updated in the translated content are those to package files, which are identified, in part, by file name. For other document types, which are identified solely on the basis of Document ID, links are updated automatically when you duplicate the selected content and related documents. Therefore, as stated above, duplication should always be the first step in the localization process.

Multi-user Considerations

You can use the State workflow property as a means of tracking the various stages or a localization project. For example, you could create State values that identify the typical events that occur such as Released for Translation, Sent to Translation, Translation Review, Translation Complete, and so on.

Export Content for Localization

The purpose of exporting documents for localization is to extract the text added while customizing your content in a format that makes it convenient for translation.

Before exporting any documents for localization, you must create a duplicate of the complete set of related documents to be translated. The duplicated documents serve as placeholders for the translated content; therefore, one set of duplicates must be created for each target language. It is recommended that you create the duplicate for each target language in a separate, clearly identified Library folder.

After creating the duplicate, you can export it for localization from either the Library or the Outline Editor. If you create the duplicate in a separate folder as recommended, you can simply select the folder itself from the Library. Alternatively, you can select one or more individual documents.
After selecting content and initiating the export process, your next step is to set the export options.

The first option is the location in which to save the localization file. The default location is the My Localization subfolder of the My Documents folder on your local hard drive, but you can choose any other location on your computer or server for which you have Write permissions. You must also specify a name for the localization file. This file name does not in any way affect the processing or translation of the documents it contains, but it is recommended that you use a meaningful name that reflects the intended translation process. For example, you might use the name Document Basics_EN_HU for content to be translated from English into Hungarian. Also note that certain reserved characters are not permitted in localization file names.

In addition to specifying the file name, you also must select the translation file format as either Microsoft Word or XLIFF. In both cases, the same text components of the selected documents are exported; the difference is in the intended translation process. Exporting to Microsoft Word format (file extension doc) provides an easily readable listing of text that is amenable to manual translation. Exporting to XLIFF format (file extension xlf) provides an XML-based file for use with translation tools that support this format. See Localization Using Microsoft Word and Localization Using XLIFF for more detail.

The second option allows you to export your selection only or your selection and all related documents. In general, documents linked as children of the documents in your selection are included as related, whereas those linked as parents are not. Any glossary assigned to one or more documents in the selection is also included as a related document. Click the View related documents link to display a list of all documents related to your selection.

The third option is to specify the source and target languages. The source language is determined by the Developer and reflects the Language property of the selected document(s). The target language is the language into which the content is being translated. Note that only one target language can be selected. If the same content is intended for translation into multiple languages, this content must be duplicated multiple times, and each set of duplicated content must be exported separately with the appropriate target language specified.

Multi-user Considerations

In a multi-user environment, when you are online, you also have the option to choose local or server content. Local content includes the locally edited copies of all selected documents that you have checked out and the server versions of those not checked out to you. Use this option for documents in progress for review. Server content includes only the checked in versions of the selected documents. Any local changes to checked out documents are ignored. Use this option for final versions of documents.

You can also export while offline, but to do so, you must have the documents in your local cache.

Nevertheless, it is recommended that you check in all documents to be exported for localization and export the server content to ensure that you include the most up-to-date versions.
During the Localization export process, the Developer extracts the custom Developer text included in the selected document(s) and writes it to a single localization file of the selected format (Microsoft Word or XLIFF). Included with the text is some required processing information, such as document and translation unit IDs, that is essential for the text to be imported successfully after translation and must not be changed. (See Localization Using Microsoft Word and Localization Using XLIFF.) The custom Developer text that is exported for localization depends on the document type as follows:

<table>
<thead>
<tr>
<th>Type</th>
<th>Text included</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module</td>
<td>Document name</td>
</tr>
<tr>
<td>Section</td>
<td>Document name</td>
</tr>
<tr>
<td>Topic</td>
<td>Document name, custom bubble text, including formatting and markup for playback modes and Player and print outputs</td>
</tr>
<tr>
<td></td>
<td>String input text</td>
</tr>
<tr>
<td></td>
<td>Implicit text (for string input action)</td>
</tr>
<tr>
<td></td>
<td>Object names</td>
</tr>
<tr>
<td></td>
<td>Jump-in points</td>
</tr>
<tr>
<td></td>
<td>Topic properties such as document output properties, keywords, and roles</td>
</tr>
<tr>
<td></td>
<td>Frame link tooltips</td>
</tr>
<tr>
<td>Package</td>
<td>Document name</td>
</tr>
<tr>
<td>Web Page</td>
<td>Document name, body text, including formatting and image alternative text</td>
</tr>
<tr>
<td>Glossary</td>
<td>Document name</td>
</tr>
<tr>
<td></td>
<td>Glossary entries</td>
</tr>
<tr>
<td></td>
<td>Glossary entry tooltips</td>
</tr>
</tbody>
</table>

A summary message appears if some of the documents you selected could not be processed. Clicking the View activity log link in the message displays a list of the results for each document.

Selecting Cancel during the export for localization process displays a message with a link to a list of the documents that have already been exported. Although the partial localization file can be edited and imported, it will include only a subset of the documents intended for translation. Therefore, it is recommended that you delete the partial localization file and restart the process from the beginning.

To export content for localization:

1. From the Library or Outline Editor, select the folder(s) and/or document(s) you want to export for localization.
   You can select multiple documents using the standard Windows selection keys (CTRL+click and SHIFT+click).
2. On the Tools menu, point to Export and choose Localization.
3. Set the export options.
4. Click OK.
Localize Content

The Developer processes the selected documents, creating a single file containing all extractable text, and associated processing information, in the specified location.

If any errors occur, they are written to an activity log, and a Partial Export message box appears. You can click the View activity log link to view the results of the export or click OK to close the message box.

Import Localized Content

After editing the exported localization file to include translated text, you use the Localization import command to add the translated content to your Library. This process overwrites the text in the set of duplicate documents that you exported for localization with the translations contained in the imported file.

When importing for localization, you can select a single Microsoft Word or XLIFF localization file. The Developer reads the selected import file and identifies the documents to be replaced according to the Document IDs recorded during export. The replacement of source text by translated text within a document is then based on the translation unit IDs contained in the localization file. If no translation is provided for a particular translation unit, the source text is left unchanged.

In addition to adding the translated text to the imported documents, the import process also updates the Language property of each document to the target language selected during export. If the language of a document has changed since it was exported, you will not be prevented from continuing with the import process, but an informational message will be added to the activity log.

Tip: If the imported content includes topics for which role assignments were translated, you should update the master role list for the target language to include these roles. If no master role list exists for the target language, you should create a new master role list before importing the translated content.

A summary message appears if some of the documents you selected could not be processed. Clicking the View activity log link in the message displays a list of the results for each document.

Selecting Cancel during import stops processing after completion of the current document and displays a message with a link to a list of the documents that have already been imported. Click the View activity log link in the message to display a list of the results for each document.
Multi-user Considerations

For a document to be overwritten during import, it must be checked out. Therefore, before initiating the import process, you should ensure that any documents that must be overwritten are either checked out to you or checked in to the server. If you plan to import a localization file while offline, you must check out all such documents before going offline.

However, if a document that needs to be overwritten is not checked out and you are online, the Developer automatically checks the document out to you and replaces it with the corresponding document from the localization file. If the document cannot be checked out, for example, if it is open in another editor or checked out to another user, it is skipped. At the end of the process, a summary message appears with a link to an activity log. Clicking the View activity log link in the message displays a list of the documents that were checked out to you during the process and those that could not be checked out.

After you complete the import process, you should check in all affected documents to make them available to other authors and add the changes to the Developer's version control system. When you check in a translated document, its version number is incremented, reflecting the fact that its contents have changed.

It is recommended that you always manually check out all documents to be overwritten during import, to ensure that all documents are processed during import of localized content.

To import content for localization:

1. On the Tools menu, point to Import and choose Localization.
2. Click Browse and navigate to the translated file you want to import.
3. Click OK.

The Developer processes the selected file, replacing the text in the original documents with the translated copy.

If any errors occur, they are written to an activity log, and a Partial Import message box appears. You can click the View activity log link to view the results of the import or click OK to close the message box.

Localization Using XLIFF

e XLIFF, or XML Localization Interchange File Format, is an XML-based format that was developed specifically for use in translation projects. As its name and origin suggest, XLIFF was designed to facilitate the exchange of information across different systems during document localization. In general, source text of an arbitrary file format is converted into XLIFF by a filter that depends on the source structure. This filter extracts the translatable content as plain, unformatted text, allowing the translator to concentrate on the meaning of the text to be translated, regardless of the original source file format, structure, or appearance. Such additional information about the source is still preserved in the XLIFF file in the form of tags, which are used to apply the appropriate processing to the translated text so that the original structure and formatting are reproduced upon conversion of the translated text back to the original format.

It is assumed that, if you choose to localize your Developer content using XLIFF, you are already familiar with basic XLIFF concepts and are working with an XLIFF tool or sending your content to a localization vendor who does. Therefore, the discussion here provides
only a description of the content of Developer-generated XLIFF files and the subset of XLIFF applicable under these conditions. For further information on XLIFF in general, see the web site of the OASIS Technical Committee on XLIFF at http://www.oasis-open.org/committees/tc_home.php?wg_abbrev=xliff.

**Developer XLIFF Processing**

When you execute the Export Localization command, the Developer applies a filter to the selected content, extracting all translatable text and rendering it in a form that complies with XLIFF specifications. The text extracted depends on the type of document selected, as discussed later in this section. Within the XLIFF file, the text is organized by document and then by translation unit within each document. Therefore, as you process the XLIFF file, you proceed sequentially through each of the exported documents.

**Warning!** During the Localization export process, the Developer applies a unique ID to each translation unit that includes information regarding the document ID, document type, and text type (if the document can have multiple translation units; see below). Therefore, you should neither merge nor split translation units during processing in XLIFF, as this could lead to problems upon import. Specifically, if the file selected for import contains translation units with invalid IDs or other problems, the Developer will skip such translation units, thus not importing the corresponding text.

For module, section, and package documents, the only text exported for translation is the document name. Each of these document types corresponds to a single translation unit containing just the unformatted document name.

For glossary documents, in addition to the document name, each term and each definition link tooltip is also exported as a separate translation unit. Therefore, the number of translation units created for a glossary document equals the number of terms plus the number of tooltips plus 1. These translation units also consist of unformatted text.

Each web page document is exported as at least two translation units, one for the document name and one for the body of the web page, regardless of the amount of text it contains. As for the other documents, the translation unit for the document name contains only unformatted text. However, unlike the preceding document types, web pages can include such elements as formatted text, images, and hyperlinks. Although such information is not relevant to the translation of the text itself, it is important for ensuring that the translated document has the same structure and appearance as the source document. Therefore, the XLIFF generated by the Developer includes such information within web page translation units using the standard XLIFF processing tags `<bpt>` (begin paired tag) and `<ept>` (end paired tag). These tags surround appropriate pieces of text in the source translation unit and contain XHTML code (generated by the Web Page Editor) corresponding to the formatting and/or processing needed.

For Developer web pages, the XLIFF processing tags can contain three basic types of XHTML code: text formatting, paragraph formatting, and image and hyperlink properties. Tags for text formatting that are supported by the Web Page Editor include `<font>`, `<strong>`, `<em>`, and `<u>`, for font properties (such as font family/style, size, and color), bold, italic, and underline, respectively. Paragraph formatting tags supported by the Web Page Editor include `<p>` (with the optional align attribute), `<br>`, `<ul>`, `<ol>`, and `<li>` for paragraph return (including paragraph alignment, if necessary), line break, unordered (bulleted) list, ordered (numbered) list, and list item, respectively. Both text and paragraph formatting tags should be copied, unchanged, from the source text to the corresponding portion of the translated text. This ensures that the appearance of the translated text matches that of the equivalent source text.

For images (`<img>` tag) in web pages, the processing tags always include the image source attribute (src) and might also include attributes representing the properties that
can be set using the Image Properties dialog box, namely, alternative text (alt), size (style), border (border), and alignment (align). Likewise, for hyperlinks (<a>, or anchor, tag) in web pages, the processing tags always include the hyperlink target attribute (href) and might also include an attribute representing the tooltip (title). In general, image and hyperlink processing tags should also be copied from the source text to the corresponding portion of the translated text. However, you might want to translate the alternative text for an image or the tooltip for a hyperlink. You can do so by directly editing the corresponding <bpt> processing tag to include the appropriate translation in the alt or title attribute, respectively.

Note that, except for URL images or URL hyperlinks, you should not need to edit the image source (img src) or hyperlink target (a href) attributes in web page translation units. Rather, these values are updated when you create a duplicate of your content (including related documents) before exporting it for localization. If you need to change these attributes further, you should edit the image properties or edit the hyperlink properties from the Web Page Editor after importing the translated web page.

**Note:** Hyperlinks are included in translation units only for manually created links, not for glossary links. Rather, you should update glossary links from the Developer after importing the translated content and glossary (or glossaries).

Topics can consist of a large number of translation units, and the translation units corresponding to bubble text can include both formatting and markup for playback modes and outputs. Specifically, each of the following components of a topic, if present, corresponds to an individual translation unit:

- Document name
- Custom bubble text (one or more translation units per topic frame, depending on playback mode and output markup)
- Object name
- Decision frame header
- Decision path name
- Jump-in point
- Frame link tooltip
- Implicit text
- String input text
- Topic properties, including each Business Process Document, Instructor Manual, Job Aid, and Test Document field; Keywords; and Roles

Except for custom bubble text, all of the other topic translation units contain unformatted text.

Custom bubble text can contain both text and paragraph formatting, as well as bubble text links. As for web pages, this information is included within bubble text translation units using the standard XLIFF processing tags <bpt> (begin paired tag) and <ept> (end paired tag). These tags surround appropriate pieces of text in the source translation unit and contain XML code (generated by the Topic Editor) corresponding to the formatting needed.

For topics, the XLIFF processing tags can contain three basic types of XML code: text formatting, paragraph formatting, and hyperlink properties. All text formatting supported
by the Topic Editor is specified using the <fmt> (format) tag, including the attributes font, sty, clr, and unbr, for font family and size, style (with possible values b for bold, i for italic, and u for underline), color (specified using hexadecimal color codes), and nonbreaking text. The only paragraph formatting tag supported by the Topic Editor is <p> with the optional align attribute, for paragraph return including paragraph alignment, if necessary. As for web pages, both text and paragraph formatting tags in custom bubble text should be copied, unchanged, from the source to the corresponding portion of the translated text. This ensures that the appearance of the translated text matches that of the equivalent source text.

For hyperlinks (<a>, or anchor, tag) in bubble text, the processing tags include only the hyperlink target attribute (href). In general, these hyperlink processing tags should also be copied, unchanged, from the source text to the corresponding portion of the translated text.

Note that, except for URL hyperlinks, you should not need to edit the hyperlink target (a href) attributes in bubble text translation units. Rather, these values are updated when you create a duplicate of your content (including related documents) before exporting it for localization. If you need to change these attributes further, you should update the bubble text link from the Topic Editor after importing the translated topic.

Note: Hyperlinks are included in translation units only for manually created links, not for glossary links. Rather, you should update glossary links from the Developer after importing the translated content and glossary (or glossaries).

In addition to formatting and hyperlinks, custom bubble text can also include markup for playback mode (visible in See It/Try It, Do It, and/or Know It modes) and output (visible in Player and/or print outputs). If all of the custom bubble text in a topic frame is marked for the same playback modes and outputs, it is exported as a single translation unit. However, if the same bubble contains custom text marked for different modes and/or outputs, multiple translation units are generated, one for each unique set of playback modes and outputs.

For example, consider the bubble containing the text "This text is valid in all modes. All of the text is valid in both outputs. This text is valid only in Know It? mode." In the Topic Editor, the first two sentences are marked to appear in all playback modes, whereas the third sentence is marked to appear only in Know It mode; all of the text is marked for both Player and print outputs. When this topic is exported for localization, two translation units are created for this bubble: One contains the text "This text is valid in all modes. All of the text is valid in both outputs." The second contains the text "This text is valid in all modes. All of the text is valid in both outputs." This text is valid only in Know It? mode." The IDs of the two translation units indicate the difference in markup in the source, with the first being specified for See It/Try It and Do It modes and both outputs and the second being specified for Know It mode only and both outputs. If the output markup of any of the bubble text had also differed (for example, if the second sentence had been marked for print only), these translation units would have been divided further to reflect these differences.

Despite the obvious overlap in content, these translation units should be translated and maintained as two separate units because they represent different combinations of mode and/or output markup. Upon import, these translation units will be written to the same frame bubble, with the first marked to appear only in See It/Try It and Do It modes and the second marked to appear only in Know It mode. That is, where the original bubble text consisted of three sentences, the translated bubble text will appear as five sentences overall, one set of two sentences from the first translation unit and another set of three sentences from the second translation unit. Although this approach leads to some duplicate translation and repetition in the bubble of text appearing in different markup
combinations, it ensures that the playback mode and output markup of the source text is accurately reproduced in the translated bubble text, so that the translated topic publishes correctly. In addition, this approach simplifies the translation process. That is, translators are frequently comfortable with formatting attributes such as bold or font name, but might find it more difficult to interpret and appropriately process the mode and output markup, which are specific to the Developer. Moreover, use of a translation memory can minimize the impact of any duplication.

Summary
In summary, the translation of custom Developer text using XLIFF is relatively straightforward, with most translation units consisting simply of unformatted text. The exceptions are web page body text and custom bubble text, which can include formatting and processing information in the form of <bpt>/<ept> processing tags. For the most part, these tags should be copied directly from the source text to the linguistically equivalent portion of the translated text.

In addition, in cases where the mode and/or output markup of the text within a bubble differs, multiple translation units are created for a single bubble. Because the IDs of the resulting translation units contain information on markup, these translation units should always be processed individually, even if they contain similar text. This preserves the appropriate bubble text markup upon import of the translated content. A translation memory should prove helpful in automating translation in such cases.

Localization Using Microsoft Word
If you will not be using XLIFF-based translation tools, you should use the Microsoft Word option for localizing your content. Exporting to Microsoft Word provides an easily readable listing of text that is amenable to manual translation.

The same initial processing is applied to your content when you execute the Export Localization command, regardless of whether you choose to export to XLIFF or Microsoft Word. Specifically, the Developer applies a filter to the selected content, extracting all translatable text and creating a list of translation units, or logical segments of text, organized by document. The text extracted depends on the type of Developer document selected, as discussed later, but is the same for both XLIFF and Microsoft Word. In XLIFF, the translation units are presented as plain, unformatted text, with any necessary formatting or processing information managed through the use of processing tags. In contrast, in Microsoft Word, any formatting applied to the text in the Developer is directly reflected in the exported file, so that you can see how it actually appears in the source documents. You then replicate this formatting in the translated text using standard Microsoft Word formatting controls so that the translated content has the same appearance in the Developer upon import.

Localization File Structure
The localization file created upon export to Microsoft Word consists of a series of tables, one for each Developer document exported. Each table is labeled with the Document ID and Data Type (these fields must not be edited) and contains all translatable text from the document, with one row for each translation unit. (The number of translation units depends on document type and contents, as explained further below.) The five columns in each table are as follows:

- **Id** - Translation unit ID; this field must not be edited
- **Source** - Source text extracted from Developer content, labeled with the appropriate XML/HTML language code
- **Translation** - Placeholder for translated text, labeled with the appropriate XML/HTML language code
Note: Field available for notes about the translation, if necessary; added after export

System Data - Processing information needed for translation unit, such as image properties; this field must not be edited

The Source, Translation, and possibly Notes columns are the primary focus for translation; the information in the remaining columns can help provide context for the text to be translated but is required for system processing and should not be changed.

**Warning!** Do not edit any system information contained in the exported localization file, including Document IDs, document data types, translation unit IDs, and System Data entries. Doing so can cause the import process to fail, either for the entire localization file or for any directly affected document(s).

Use of a Microsoft Word file for localization is straightforward: Simply translate each source translation unit in the Source column and add the translated text to the appropriate table cell in the Translation column. If a particular translation unit, such as a technical term, does not need to be translated, you can copy the source text directly to the Translation column without modifying it or leave the table cell empty. If the source text is formatted (which might be the case only for bubble text and web page body translation units, as explained in detail below), you should apply the same formatting to the translated text so that it matches the appearance of the source. If desired, you can also use the Notes column for communication with the translator about the translation. For example, you might include the note "Do not translate" for a translation unit that should be kept in the source language. Likewise, a translator could include notes about particular translation units, such as questions about the translation of technical terms.

Upon import, the Developer processes each document and each translation unit in the localization file, overwriting the original source content with the text provided in the Translation column. If no translation is provided for a particular translation unit, the source text is left unchanged. The import and overwriting process is based solely on document and translation unit IDs; it is not affected by any changes that might have been made in the Developer content after it was exported or in the Source column text of the localization file. Any entries in the Notes column also do not affect the import process.

**Translation Unit IDs**
As mentioned above, you can localize your Developer content using Microsoft Word by considering only the Source and Translation columns in the localization file. However, an understanding of the surrounding system information can be helpful in providing context for the text to be translated, if needed. Therefore, a detailed explanation of the translation unit IDs appearing in Developer-generated Microsoft Word localization files is provided here for reference.

The same translation unit IDs and other system information are also included in Developer-generated XLIFF localization files. However, this information generally remains hidden during XLIFF processing because it is not exposed by most XLIFF translation tools.

Translation unit IDs depend on the function of the text within the document. As a result, each type of Developer document can correspond to only certain types of translation unit IDs.

For module, section, and package documents (Data Type = plaintext), the only text exported for translation is the document name. Each of these types of documents corresponds to a single translation unit containing just the unformatted document name.
Therefore, the only translation unit ID possible for module, section, and package documents is

- **TXT_Title = document name**

For glossary documents (Data Type = plaintext), in addition to the document name, each term and each definition link tooltip is also exported as a separate translation unit. Therefore, the number of translation units created for a glossary document equals the number of terms plus the number of tooltips plus 1. These translation units also consist of unformatted text. The translation unit IDs possible for glossary documents are

- **TXT_Title = document name**
- **GLEm.trm**, where \( m \) is a unique integer = glossary term
- **ILn.tt**, where \( n \) is a unique integer = glossary link tooltip

Each web page document (Data Type = xhtml) is exported as at least two translation units, one for the document name and one for the body of the web page, regardless of the amount of text it contains. If the web page contains one or more embedded image(s), one additional translation unit is created for each image. Therefore, the translation unit IDs possible for web page documents are

- **TXT_Title = document name**
- **H_Body = web page body text**
- **I_m_E**, where \( m \) is a unique integer = image inserted in web page

As for the other types of documents, the translation unit for the web page name contains only unformatted text. However, unlike the preceding document types, web pages can include such elements as formatted text, images, and hyperlinks. In addition to translating the text, you must also address these aspects of web page translation units.

If the source web page contains text and/or paragraph formatting (such as bold, italics, bulleted lists, and so on), you should apply the same formatting to the translated text using Microsoft Word's formatting tools. However, you should use only the types of text formatting supported by the Web Page Editor, as all other formatting will be removed upon import. In addition, if the source web page has a background color, the cells corresponding to the Source and Translation of the web page body translation unit have the same background color. However, this color is provided for illustration only, simply to match the appearance of the source document. Changing this color does NOT change the background color of the translated web page document upon import into the Developer.

If an exported web page contains an image, a small placeholder graphic appears in the source web page body translation unit to indicate its position in the layout of the web page. You should copy this graphic to the same location in the layout of the translated web page to include the image in the translated web page upon import. In addition, as mentioned above, a separate translation unit is created for the image itself. The translatable text in this translation unit is the alternative text of the image, if assigned. Even if there is no source alternative text, you can add text to the Translation column that will be imported as the alternative text for the image in the translated web page. Image translation units also always contain an entry in the System Data column that specifies the source of the image, as well as other image properties (such as size, border, and alignment), if assigned. You should not edit any system data.

If an exported web page contains a hyperlink, the hyperlink also appears in the source translation unit for the web page body. Use the Microsoft Word controls for editing and inserting hyperlinks to create the same hyperlink in the corresponding location of the
translation (from the equivalent text or the placeholder graphic, as appropriate). You should use exactly the same Address for the hyperlink target in the Edit Hyperlink dialog box for the two hyperlinks. However, you can translate the hyperlink tooltip, or add a tooltip for the translated web page even if none is provided in the source web page, by clicking the ScreenTip button in the Edit Hyperlink dialog box and editing the text as necessary.

Note that, except for URL images or URL hyperlinks, you should not need to edit the image source or hyperlink target attributes in web page translation units. Rather, these values are updated when you create a duplicate of your content (including related documents) before exporting it for localization. If you need to change these attributes further, you should edit the image properties or edit the hyperlink properties from the Web Page Editor after importing the translated web page.

Note: Hyperlinks are included in translation units only for manually created links, not for glossary links. Rather, you should update glossary links from the Developer after importing the translated content and glossary (or glossaries).

Topics (Data Type = xml) can consist of a large number of translation units, and the translation units corresponding to bubble text can include both formatting and markup for playback modes and outputs. Specifically, each of the following components of a topic, if present, corresponds to an individual translation unit:

- Document name
- Custom bubble text (one or more translation units per topic frame, depending on playback mode and output markup)
- Object name
- Decision frame header
- Decision path name
- Jump-in point
- Frame link tooltip
- Implicit text
- String input text
- Topic properties, including each Business Process Document, Instructor Manual, Job Aid, and Test Document field; Keywords; and Roles

Except for custom bubble text, all of the other topic translation units contain unformatted text. They correspond to the translation unit IDs listed below. In examining this list, note that many translation unit IDs consist of prefixes and suffixes, where the prefix represents the general category and the suffix describes the specific type of text. Prefixes include A for action, BUB for bubble text, F for frame, IL for frame link, and TXT for plain text. Suffixes (such as on and tt) are detailed below in terms of the specific translation units to which they apply.

- TXT_Title = document name
- BUB_m.txt_[DP_CP_AP_DD_CD_AD], where $m$ is an integer and the portion in brackets varies depending on mode and output markup = custom bubble text (see further detail below)
(the integers $m$ in multiple translation units for text from the same bubble always match)

- $An.on$, where $n$ is a unique integer = object name
- $Fq.dhl$, where $q$ is a unique integer = decision frame header
- $Ar.dt$, where $r$ is a unique integer = decision path name
- $Fs.jip$, where $s$ is a unique integer = jump-in point
- $ILt.tt$, where $t$ is a unique integer = frame link tooltip
- $Au.iit$, where $u$ is a unique integer = implicit text (for string input action)
- $TXTv$, where $v$ is a unique integer = input text (for string input action)

The remaining translation unit IDs are all for topic properties, as assigned using the Properties toolpane.

- $TXTw$, where $w$ is a unique integer = role
- $TXTx$, where $x$ is a unique integer = keyword
- $bpddep = Business Process Document Department property$
- $bpdver = Business Process Document Revision property$
- $bpdlcb = Business Process Document Last changed by property$
- $bpdst = Business Process Document Status property$
- $bpdtr = Business Process Document Trigger property$
- $BPDRFy.n$, where $y$ is an integer = Business Process Document Required fields property
  Required Fields field  
  (the integers in the translation units for an $n/c$ pair always match)
- $BPDRFy.c$, where $y$ is an integer = Business Process Document Required fields property
  Comments field  
  (the integers in the translation units for an $r/c$ pair always match)
- $BPDOOUTz.r$, where $z$ is an integer = Business Process Document Output property
  Result field  
- $BPDOOUTz.c$, where $z$ is an integer = Business Process Document Output property
  Comments field  
- $bpdai = Business Process Document Additional information property$
- $imnot = Instructor Manual Instructor notes property$
- $javer = Job Aid Revision property$
- $tdver = Test Document Revision property$
- $tdpps = Test Document Purpose of test property$
- $tdest = Test Document Estimated time property$
- $tdstp = Test Document Test setup property$
The translation units for custom bubble text require additional explanation for two reasons: formatting and mode and output markup.

If the source bubble text contains text and/or paragraph formatting (such as bold, italics, paragraph alignment, and so on), you should apply the same formatting to the translated text using Microsoft Word's formatting tools. However, you should use only the types of text formatting supported by the Topic Editor, as all other formatting will be removed upon import.

If exported bubble text contains a hyperlink, the hyperlink also appears in the source translation unit for the bubble text. Use the Microsoft Word controls for editing and inserting hyperlinks to create the same hyperlink from the corresponding text in the translation. You should use exactly the same Address for the hyperlink target in the Edit Hyperlink dialog box for the two hyperlinks.

Note that, except for URL hyperlinks, you should not need to edit the hyperlink target attributes in bubble text translation units. Rather, these values are updated when you create a duplicate of your content (including related documents) before exporting it for localization. If you need to change these attributes further, you should update the bubble text link from the Topic Editor after importing the translated topic.

**Note:** Hyperlinks are included in translation units only for manually created links, not for glossary links. Rather, you should update glossary links from the Developer after importing the translated content and glossary (or glossaries).

In addition to formatting and hyperlinks, custom bubble text can also include markup for playback mode (visible in See It/Try It, Do It, and/or Know It modes) and output (visible in Player and/or print outputs). The ID of each custom bubble text translation unit indicates the mode(s) and output(s) in which the text is set to appear. In the generic example of a bubble text translation unit listed above, BUB_m.txt_[DP_CP_AP_DD_CD_AD], it is the portion in brackets that specifies mode and output markup. Specifically, in each pair of letters, the first letter indicates the playback mode and the second indicates the output. The codes for playback mode are:

- **D** = See It/Try It mode
- **C** = Do It mode
- **A** = Know It mode

The codes for output are:

- **P** = Player
- **D** = Print (document) output

For example, the translation unit ID BUB24.txt_DP_CP_DD_CD corresponds to text that appears in only See It/Try It and Do It mode in both outputs, whereas the translation unit ID BUB32.txt_DP_AP corresponds to text that appears in See It/Try It and Know It modes but only in Player outputs.

If all of the custom bubble text in a topic frame is marked for the same playback modes and outputs, it is exported as a single translation unit. However, if the same bubble contains custom text marked for different modes and/or outputs, multiple translation units are generated, one for each unique set of playback modes and outputs. In this case, the
same integer appears after the prefix BUB in all translation units corresponding to the same bubble, but the mode and output codes differ as needed to reflect the text markup.

For example, consider the bubble containing the text "This text is valid in all modes. All of the text is valid in both outputs. This text is valid only in Know It? mode." In the Topic Editor, the first two sentences are marked to appear in all playback modes, whereas the third sentence is marked to appear only in Know It mode; all of the text is marked for both Player and print outputs. When this topic is exported for localization, two translation units are created for this bubble: One contains the text "This text is valid in all modes. All of the text is valid in both outputs."; it has a translation unit ID of the form BUB15.txt_DP_CP_DD_CD. The second contains the text "This text is valid in all modes. All of the text is valid in both outputs. This text is valid only in Know It? mode."; it has a translation unit ID of the form BUB15.txt_AP_AD. If the output markup of any of the bubble text had also differed (for example, if the second sentence had been marked for print only), these translation units would have been divided further to reflect these differences.

Despite the obvious overlap in content, these translation units should be translated and maintained as two separate units because they represent different combinations of mode and/or output markup. Upon import, these translation units will be written to the same frame bubble, with the first marked to appear only in See It/Try It and Do It modes and the second marked to appear only in Know It mode. That is, where the original bubble text consisted of three sentences, the translated bubble text will appear as five sentences overall, one set of two sentences from the first translation unit and another set of three sentences from the second translation unit. Although this approach leads to some duplicate translation and repetition in the bubble of text appearing in different markup combinations, it ensures that the playback mode and output markup of the source text is accurately reproduced in the translated bubble text, so that the translated topic publishes correctly.

**Summary**

In summary, the translation of custom Developer text using Microsoft Word is relatively straightforward, with most translation units consisting simply of unformatted text. The exceptions are web page body text and custom bubble text, which can include text and paragraph formatting and processing information such as hyperlinks. For the most part, this formatting should be exactly reproduced in the linguistically equivalent portion of the translated text. Any formatting present in the translated text that is not supported by the Developer is removed during import.

In addition, in cases where the mode and/or output markup of the text within a bubble differs, multiple translation units are created for a single bubble. Because the IDs of the resulting translation units contain information on markup, these translation units should always be processed individually, even if they contain similar text. This preserves the appropriate bubble text markup upon import of the translated content.
**Note:** If you localize your content using Microsoft Word, the maximum number of documents that can be imported from a single localization file is 65,535. If you need to process more documents than this, you have a variety of options. You can export the documents in multiple batches that stay below the 65,535 limit. You can export all of your documents into one Microsoft Word file and then copy the extra tables beyond this limit to a new Word file that you import separately. Finally, you can change the limit on the number of tables processed during import of a Microsoft Word localization file. You do this by modifying the tableIndex parameter in the RunMe macro in the wordtoxliff.dot file in the installation folder. Specifically, edit the line

While (tableProcessed < ActiveDocument.Bookmarks.Count / 5 And tableIndex < 65535)

and replace the value 65535 with the maximum number of documents you plan to process at one time.

**Summary of the Localization Process**

Create a duplicate of all documents to translate.

- Creating a duplicate must be the first step.
- You need one new duplicate for each language into which content is being translated.
- It is recommended that you create each duplicate from the Library, using a separate, clearly labeled folder for each language.

Re-record topics.

- Re-recording captures screenshots and object names in the target language.
- This provides a translation only of automatically recorded content.
- Apply the appropriate template for the target language to update template text.

Use export/import for localization of custom Developer text.

- You can export to Word and/or XLIFF formats.
- It is recommended that you check in all content to be translated prior to exporting and export the server version.
- Translation is performed external to the Developer.
- Importing overwrites exported documents with translation added to localization file.

Translate external content and update glossary links.

- Package files containing text, package graphics, and URL attachments must be translated separately from custom Developer text.
- If necessary, fix any links to package files that might have been broken during the translation process (for example, if the name of a linked package file was changed).
- As a final step after all content has been translated, update glossary links.
17. Customize Templates

Templates are used for a variety of purposes in the Developer. They generate bubble text automatically for frames, determine the instructional text to be shown during Know It mode playback, and control the example text given with string input events. You can customize these templates to reword the text or even translate it into any language not provided in the Developer.

Templates are stored in the /System/Templates folder in the Library. There is a subfolder for each supported language, named according to the language code.

Each folder contains two existing template sets, Standard and Microsoft. Each template has a template.xml file which contains the customizable text. These existing templates should not be customized, because when you upgrade to newer versions of the Developer, they will be overwritten and your customizations will be lost. Instead, make a copy of one of the templates, rename it, and make your customizations to the copy.

Start the Template Editor

The Template Editor is a tool included with the Developer that provides an interface that enables you to easily edit the template.xml file to customize a template. The interface has several sections, each of which allow you to modify different parts of the template. You can change existing text elements or add text, or localize the text into any language. In addition, you can preview the results of your changes immediately.

You can launch the Template Editor from the Windows Start menu. The installation process creates a shortcut in the same program group as the Developer.

To start the Developer:

1. Click the Start menu.
2. Point to the All Programs command.
3. Point to the User Productivity Kit command.
4. Click the Template Editor command.

To create and customize a template:

1. Open the Library.
2. Navigate to the System/Templates folder, and then open the folder for the language templates you want to customize.
3. In the language folder, select the template set you want to copy.
4. On the Edit menu, choose Copy.
5. On the Edit menu, choose Paste.
6. Select the copy you just made.
7. On the Edit menu, choose Rename.
8. Type the name for the customized template.
9. Press ENTER.
10. Right-click the template set and choose Open.
11. Copy the template.xml file to your local drive or a network drive.
12. Start the Template Editor.
13. Open the template.xml file in the Template Editor.
14. Modify the text as desired, referring to the following sections.
15. Save the template.xml file.
16. Copy the modified file into the template document in the Library.
17. Close and save the template document.
18. Apply the template to topics as appropriate. See Template Property for more information.

**Edit the Template.xml File**

The template.xml file has several different sections.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Styles</td>
<td>Statements used to format parts of the template text.</td>
</tr>
<tr>
<td>Events</td>
<td>Lists all events (actions) that are possible.</td>
</tr>
<tr>
<td>Classes</td>
<td>Lists all classes (types) of supported objects.</td>
</tr>
<tr>
<td>Defaults</td>
<td>Generic template definitions used when a specific template definition does not exist for a Class.</td>
</tr>
<tr>
<td>KeyNames</td>
<td>The names of the special keys on the keyboard, such as Enter, Insert, Delete, Home, End, and Escape.</td>
</tr>
<tr>
<td>Instructions</td>
<td>Instructional text, such as &quot;Press Enter to continue&quot;, found in the Player.</td>
</tr>
</tbody>
</table>

The template text in the bubble is defined in the Classes and Defaults sections. The Classes define the objects, such as combobox, menuitem, pushbutton, or radiobutton. Each class has the same list of events, such as LClick1 or Drag. In the Template Editor, a pane at the top of the window displays the list of Classes. The Template section displays the Events in the left pane. The elements that make up the text for the event appear in the main pane, while the preview appears at the bottom of the window. See the following sections for details about how to use these panes to edit the template text.

There is a Default template for each event. However, a particular Class may need a specific template, called a local template. For example, the Default template for the LClick1 action (single left click) is "Click the". However, for the Column class, the local template for the single left click action is "Click an entry in the". If there is a local template for a Class, it appears in the Events list in bold text. If it is a Default template, it appears in non-bold text.

To open the template.xml file:

1. In the Template Editor, select the File menu and choose Open.
2. Navigate to the location on the network or local drive to where you copied the template.xml file.
3. Select the template.xml file and click Open.

**Edit a Class**

A class defines a single type of object, for example a button or a menu. The list of classes appears in the Classes pane at the top of the Template Editor window. Each class has four attributes, displayed in columns in the Classes pane.
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique identifier for the object type; for example, ROLE_STANDARD_ACTIVEX. You cannot change this attribute.</td>
</tr>
<tr>
<td>List Name</td>
<td>Text that appears in the object type list in the Frame toolpane in the Topic Editor, for example ActiveX.</td>
</tr>
<tr>
<td>Display Name</td>
<td>Text that appears in the template-generated text when the &lt;ObjectType/&gt; attribute is used within a template definition.</td>
</tr>
<tr>
<td>Gender</td>
<td>Used to refer to the appropriate set of gender templates in the Defaults section. This affects languages other than English. See the Use Genders topic in the Translate Templates chapter of the Content Development manual for more information.</td>
</tr>
</tbody>
</table>

To edit a class definition:

1. In the Template Editor, open the Template.xml file you want to edit.
2. Scroll the list of Classes as necessary and double-click the Class definition you want to edit.
3. Edit the text in the List Name and Display Name boxes as desired.
4. Change the Gender, if necessary.
5. Click OK.

**Edit an Event in a Class**

An event definition is a sequence of elements that produces the default template text. Keep in mind that if you edit an event definition that is in non-bold text, you are changing the definition for all Classes that use the Default definition.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>text</td>
<td>The static template text appears between &lt;Text&gt; and &lt;/Text&gt; tags in the template.xml file. Note that a template may contain multiple text statements.</td>
</tr>
<tr>
<td>ObjectType</td>
<td>The ObjectType element is a placeholder used to insert the display name of the object type as defined in the Class.</td>
</tr>
<tr>
<td>ObjectName</td>
<td>The ObjectName element is a placeholder used to insert the name of the object on which the action is performed.</td>
</tr>
</tbody>
</table>

To edit an event definition:

1. In the Template Editor, open the Template.xml file you want to edit.
2. Scroll the list of Classes as necessary and select a class.
3. In the Event list, click the event definition you want to edit.
4. In the pane to the right of the Event list, double-click the element you want to edit.
5. Edit the element properties as desired.
6. Click OK.
To add elements to an event:

1. In the Event list, click the event definition to which you want to add an element.
2. In the pane to the right of the Event list, click Add.
3. In the Create New Element dialog box, click the Type list and select the type of element you want to add and click OK.
4. Edit the element properties as desired.
5. Click OK.

To reposition elements in an event:

1. In the Event list, click the event definition.
2. In the pane to the right of the Event list, click the element you want to move.
3. Click Move Up or Move Down to move the element to the desired position.

To delete elements in an event:

1. In the Event list, click the event definition.
2. In the pane to the right of the Event list, click the element you want to delete.
3. Click Delete.

Add a Local Template to an Event

You can create a local template for an Event that uses the Default template. This allows you to customize the template for a specific event without affecting other events.

You can also remove a local template so that the event for the Class reverts to the Default template. Be aware that you cannot undo this operation. If you decide you want a local template again, you must add it and create the elements manually.

To add a local template to an event:

1. In the Template Editor, open the Template.xml file you want to edit.
2. Scroll the list of Classes as necessary and select a class.
3. In the Event list, right-click the event definition to which you want to add a local template.
4. On the shortcut menu, click Add Local Template.
5. Edit the elements in the template as desired.

To remove a local template from an event:

1. In the Template Editor, open the Template.xml file you want to edit.
2. Scroll the list of Classes as necessary and select a class.
3. In the Event list, right-click the event definition to which you want to add a local template.
4. On the shortcut menu, click Remove Local Template.

Change Instructional Text

When a user plays a topic in the Player, instructional text appears in various situations. During See It, Try It, Do It and Know It mode playback, navigational instructions appear in
certain frames, such as "Press [Enter] to start" on the Start frame. Know It mode has additional instructions plus remediation which appears when a user has performed a step incorrectly. In addition, a string input frame, which instructs the user to enter text, has example text.

Each instruction may have more than one text element. The Leading Space option in the Element Properties dialog box enables you to insert a space before a text element to separate the text.

**Change Instructional Text for the Player**

In the Player, instructional text appears in See It, Try It, and Do It modes for the Start and End frames and on Explanation frames. In addition, there is a Pause link, which allows the user to pause the playback in See It mode, and the instructional text that appears at the top of a Decision frame. You can customize this text in the template.xml file.

This text is defined in the template elements in the Instructions toolpane, as shown below.

<table>
<thead>
<tr>
<th>Template Context</th>
<th>Text appears in</th>
</tr>
</thead>
<tbody>
<tr>
<td>leadin</td>
<td>Start frame</td>
</tr>
<tr>
<td>leadout</td>
<td>End frame</td>
</tr>
<tr>
<td>continue</td>
<td>Explanation frame</td>
</tr>
<tr>
<td>decision_headline</td>
<td>Text at the top of a Decision frame</td>
</tr>
<tr>
<td>pauselink</td>
<td>Pause link in bubble</td>
</tr>
</tbody>
</table>

**Note:** When you select certain instructions, the text in the Template area displays in raw XHTML format because it contains formatting that is not supported in the native template. The text you can edit is located between the `<a class>` and `</a>` tags. As you edit this text, be careful not to change or delete any of the other text or codes in the template definition, or the template may not work properly.

To change instructional text for the Player:

1. In the Template Editor, open the Template.xml file you want to edit.
2. From the Edit menu, choose Instructions.
3. In the Instructions toolpane, select the instruction you want to edit: leadin, leadout, continue, pauselink, or decision_headline.
4. In the Template toolpane, double-click the text element that you want to edit.
5. Change the text as desired.
   or
   Edit the text in the XHTML code as desired.
6. Select the Leading Space option, as necessary.
7. Click OK.

**Change Instructional Text for Know It? Mode**

During Know It mode playback in the Player, instructional text appears for the Start and End frames and on Explanation frames. In addition, there are four levels of remediation that can appear if a user performs a step incorrectly. There is also text which informs a user the score needed to pass at the beginning of the topic, the score achieved at the end...
of the topic, and whether the user passed or failed. You can customize this text in the template.xml file.

This text is defined in the Instructions section. The Template Contexts are defined as shown below.

<table>
<thead>
<tr>
<th>Template Context</th>
<th>Text appears in</th>
</tr>
</thead>
<tbody>
<tr>
<td>knowit_leadin</td>
<td>Instructional text for the Start frame</td>
</tr>
<tr>
<td>knowit_leadout</td>
<td>Instructional text for the End frame</td>
</tr>
<tr>
<td>knowit_explanation</td>
<td>Instructional text for the Explanation frame</td>
</tr>
<tr>
<td>knowit_nextstep</td>
<td>Show Step text</td>
</tr>
<tr>
<td>leadin_score</td>
<td>Text informing the user of the score needed at beginning of the topic</td>
</tr>
<tr>
<td>knowit_warningL1</td>
<td>Text for the first level of remediation</td>
</tr>
<tr>
<td>knowit_warningL2</td>
<td>Text for the second level of remediation</td>
</tr>
<tr>
<td>knowit_warningL3</td>
<td>Text for the third level of remediation</td>
</tr>
<tr>
<td>knowit_warningL4</td>
<td>Text for the fourth level of remediation</td>
</tr>
<tr>
<td>scoring</td>
<td>Scoring information at the end of the topic</td>
</tr>
<tr>
<td>scoring_YES</td>
<td>Indicates that the user has passed</td>
</tr>
<tr>
<td>scoring_NO</td>
<td>Indicates that the user has not passed</td>
</tr>
<tr>
<td>knowit_continue</td>
<td>Indicates that the user should continue working to complete the task</td>
</tr>
<tr>
<td>knowit_confirmdemo</td>
<td>Confirms that the user wants to view the step in See It mode</td>
</tr>
<tr>
<td>knowit_dragwarning</td>
<td>Warns the user that the step is a drag and drop and that it will be completed for them</td>
</tr>
<tr>
<td>knowit_finish_close</td>
<td>Gives the user a choice to exit without being scored or to return to Know It mode</td>
</tr>
</tbody>
</table>

**Note:** When you select certain instructions, the text in the Template area displays in raw XHTML format because it contains formatting that is not supported in the native template. The text you can edit is located between the `<a class>` and `</a>` tags. As you edit this text, be careful not to change or delete any of the other text or codes in the template definition, or the template may not work properly.

To change instructional text for Know It? mode:

1. In the Template Editor, open the Template.xml file you want to edit.
2. From the **Edit** menu, choose **Instructions**.
3. In the Instructions toolpane, select the instruction you want to edit.
4. In the Template toolpane, double-click the text element that you want to edit.
5. Change the text as desired.  
   or  
   Edit the text in the XHTML code as desired.
6. Select the **Leading Space** option, as necessary.
7. Click **OK**.
Change Example Text for String Input Events

During topic playback, steps in which a user is asked to enter text are called string input events. The bubble for a string input event frame has example text, which you can customize.

This text is defined in the Instructions section. The Template Contexts are defined as shown below.

<table>
<thead>
<tr>
<th>Template Context</th>
<th>String Input text</th>
</tr>
</thead>
<tbody>
<tr>
<td>strinp_something_text</td>
<td>Text shown when Something is the metadata selected for the string input event</td>
</tr>
<tr>
<td>strinp_something_text_noexample</td>
<td>Text shown when Something is the metadata selected for the string input event, and the example text has been turned off</td>
</tr>
<tr>
<td>strinp_anything_text</td>
<td>Text shown when Anything is the metadata selected for the string input event</td>
</tr>
<tr>
<td>strinp_anything_text_noexample</td>
<td>Text shown when Anything is the metadata selected for the string input event, and the example text has been turned off</td>
</tr>
<tr>
<td>strinp_nothing</td>
<td>Text shown when Blank is the metadata selected for the string input event</td>
</tr>
<tr>
<td>strinp_or</td>
<td>Connector used when there is a list of valid values</td>
</tr>
</tbody>
</table>

A definition may have the #VALUE parameter, which refers to the default value that was input when the topic was recorded. Do not change this parameter.

To change instructional text for Know It? mode:

1. In the Template Editor, open the Template.xml file you want to edit.
2. From the Edit menu, choose Instructions.
3. In the Instructions toolpane, select the instruction you want to edit.
4. In the Template toolpane, double-click the text element that you want to edit.
5. Change the text as desired.
   or
   Edit the text in the XHTML code as desired.
6. Select the Leading Space option, as necessary.
7. Click OK.

Change the Font Format for Template Text

In the template text generated for the bubble, there are certain items which have special formatting.

<table>
<thead>
<tr>
<th>Text Item</th>
<th>Style name</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object name</td>
<td>ObjectName</td>
<td>dark blue color, bold</td>
</tr>
<tr>
<td>Text entered in a string input</td>
<td>Content</td>
<td>red color, bold</td>
</tr>
<tr>
<td>Key name</td>
<td>Key</td>
<td>dark blue color, bold</td>
</tr>
<tr>
<td>Link</td>
<td>Link</td>
<td>light blue color, bold</td>
</tr>
</tbody>
</table>
If you want to change this formatting, you cannot use the Template Editor; you must open the template.xml file in the xml editor of your choice. The statements in the Styles section at the beginning allow you to customize the color or the font weight of the text. The style is made up of three parts, as shown in the example below:

```xml
<Style Name="ObjectName" Bold="true" Color="#000080"/>
```

The Bold element is a Boolean value; it can be true or false. The Color element is the HTML code for the color. You can change either of these two values as desired. Do not change the style name.

**Translate Templates**

The Developer includes templates in several languages. If you need language(s) other than these, you can create a new template set for that language and translate the appropriate text in the template.xml file.

First, create a subfolder for the language in the System/Templates folder. You must use the correct language codes, for example hu for Hungarian or pl for Polish. For a list of these codes, go to the following site:


Follow the instructions for customizing the templates, except when you make a copy of an existing template, paste it into the new language folder. You can then translate the text in the template.xml file.

The following items should be translated.

**Template text in the bubble**
See Edit the Template.xml File for more information.

**Instructional text for the Player**
See Change Instructional Text for the Player for more information.

**Instructional text for Know It? mode**
See Change Instructional Text for Know It? Mode for more information.

**Example text for String Input events**
See Change Example Text for String Input Events for more information.

---

**Note:** Many of the templates have multiple elements. When you translate the templates into other languages, the order of these elements may need to be changed to account for differences in word order in various languages.

**Edit Event Names**

In the template.xml, there is a list of event types with corresponding names. These names should be translated.

To edit Event names:

1. In the Template Editor, open the Template.xml file you want to edit.
2. From the Edit menu, choose Event Names.
3. In the Name list, click the event name once to select it.
4. In the Name list, click the event name again to edit the text.
5. Change the text as desired.
6. Press ENTER.

**Edit Key Names**

In the template.xml, there is a list of all of the names of the non-alphanumeric keys on the keyboard. The names of the keys should be translated.

To edit key names:

1. In the Template Editor, open the Template.xml file you want to edit.
2. From the **Edit** menu, choose **Key Names**.
3. In the **Name** list, click the key name once to select it.
4. In the **Name** list, click the key name again to edit the text.
5. Change the text as desired.
6. Press ENTER.

**Edit Shift Key Prefixes**

When there is an event that uses a keyboard combination, such as Shift+Click, the text in the bubble is "Press the Shift key and click...". There is a second template for multiple keyboard combinations, such as Alt+Ctrl+Click, for which the template text in the bubble is "Press Alt+Ctrl and click". These prefixes should be translated.

For the multiple keyboard combinations, there are also separators that you can edit.

To edit the shift key prefixes:

1. In the Template Editor, open the Template.xml file you want to edit.
2. From the **Edit** menu, choose **Shift Key Prefixes**.
3. In the Prefix toolpane, click **ShiftKeyPrefixSingle** or **ShiftKeyPrefixMulti**.
4. In the Template toolpane, double-click the text element in the Text column that you want to edit.
   
   **Note:** There may be no text in the Text column for the names of the keys. The name in the Shift Key field is the default. When you double click one of the names, you can add custom text to be used instead.
5. Change the text as desired.
6. Select the **Leading Space** option, as necessary.
7. Click **OK**.

**Use Genders**

In English, there is only one gender, called neutral in the English templates. In languages other than English, you may need to use multiple genders. For example, in English, a pushbutton and a radiobutton

To create and use genders, follow these basic steps:

- Create the gender: When you create a new gender, it is copied from an existing gender of your choice.
- Edit the class to use the appropriate gender: After you have created the genders as necessary, you must assign the correct gender to the class.
• Edit the text for the events: Edit the text to be gender-appropriate for the events in a class. If the event uses the default template, then all events that use the default template for that gender are also updated.

To create a new gender:

1. In the Template Editor, open the Template.xml file you want to edit.
2. In the Gender toolpane, right-click the gender you want to copy to create a new gender.
3. From the shortcut menu, click Create New Gender.
4. Enter a name in the Name field for the gender.
5. Click OK.

To edit the gender for the class:

1. Scroll the list of Classes as necessary and double-click the Class definition you want to edit.
2. Click the Gender list and select the appropriate gender.
3. Click OK.

To edit the text for an event:

1. In the pane to the right of the Event list, double-click the text element you want to edit.
2. Edit the element text as appropriate for the gender.
3. Click OK.
18. Appendix A: Considerations for Setting Defaults

When you use the Developer to create content, you may have many content authors working on the same project. Before you begin to record the content, it is important to determine certain defaults so that the finished content is consistent, no matter which content author created it. These defaults fall in to three basic categories: the content author's workstation, the target application, and the content defaults in the Developer.

Set Workstation Defaults

The Developer captures the entire screen, so how the screen looks on each computer is critical. Users can get confused if the data is inconsistent. Using default settings, then, is extremely important to provide consistency across all topics. You should determine these default settings before you begin development.

Set the Windows Default Color Scheme

The color scheme on the development computers should be set to the company standard color scheme. The suggested color scheme for Windows 2000 is Windows Standard, for Windows XP is Default (blue), and for Windows Vista is Windows Aero or Windows Vista Basic.

Set the Video Resolution and Color Depth

The color depth should be set to 256 or higher. The video resolution should be set to the lowest common resolution in the company, as it may impact the playback in See It! and Try It! modes. The bubbles may not be placed correctly, or the user may need to scroll to view the entire screen.

Change the Taskbar Settings

The Always on top and Auto hide options for the taskbar should be selected before you record. These settings prevent the taskbar from appearing in the screen captures, and yet the taskbar is still easily accessible when needed.

Turning Off Other Applications

When you create content, you take screen shots of the entire screen. Therefore, items that appear on the desktop can also appear in the screen shot. You should close any other applications that are running or toolbars that appear. Also, turn off any memory-resident programs that might interrupt the screen capture process; for example, programs that automatically notify you when you have e-mail. This procedure not only prevents these things from appearing in the screen shots but also reduces the load on system resources. A partial checklist of applications includes:

- Mail programs, especially those with automatic notifications
- Shortcut bars, such as the Microsoft Office shortcut bar
- Customized menu bars
- Virus protection software, where possible

Note: You should also be sure to maximize the target application window while you are recording content.
Set the Defaults in the Target Application

In many applications users can configure their GUI with colors and fonts. In addition, the user profile may have other defaults set as well, such as the date format or the default screen at startup. For the authors creating content, these defaults should all be reset to the defaults in general use at the company. This creates a uniform look and starting place for every topic.

In addition, you should maximize the window for the target application when you are recording content. If the target application's window covers the entire screen, then the Windows desktop icons will not show in the screenshot. If possible, turn off tooltips in the target application as well.

Set Content Defaults

Content defaults act as a default set of properties for the creation of new frames and Web Pages. When the content defaults are changed, any existing content will not be affected.

These defaults must be set on each individual workstation and should be done before you begin development. You do not have to change the original default settings in the Developer; changing these defaults is a matter of choice to create the "look" you want for the content. Consistency is the key element. After creating a standard set of content defaults, you should export these defaults and distribute the export (.ops) file to the other authors developing content.

Certain changes that are highly recommended are indicated as such in the sections below.

**Note:** When choosing font and background color defaults, it is recommended that you choose web safe options. For example, Arial is a font style widely used in web page development. For more information, go to a Web site such as www.visibone.com for web safe color options.

Set Bubble Defaults

The Bubble page in the Content Defaults category contains the options that allow you to change the icon, pointer position, background color, and font for the bubble. In addition, the Bubble page contains the options that control if template text appears in the bubble and if custom text appears above (the default) or below template text.

Set Other Font and Color Defaults

You use the pages in the Content Defaults category to set the font and color defaults for the following components:

- **Introduction/End Frame:** These frames appear at the beginning and end of each topic, displaying introductory and concluding text that the content author enters in the Topic Editor. In addition, the Introduction text for each topic displays in the Introduction pane in the Outline Editor and Player windows. By default, Introduction and End frame text uses the 8 point Arial font and a pale yellow background color. Changing these options affects the appearance of the Introduction pane, as well as the Introduction and End frames in all playback modes.

- **String Input:** String inputs are events that occur while recording a topic when you are typing, such as entering information into a field. When a user plays the topic in Try It! mode, the user must enter the specified text to move to the next step. The action area (the area in which the user must type the text) uses the default MS Sans Serif font and white background color shown in the sample box in the String Input page. You can change these options to better simulate the application in which you are recording.
• **Web Page:** Web pages contain extra information that can be attached to the content. Web pages can display a simple note or definition of terms, or display a more complex arrangement of text, graphics and hyperlinks. The default setting is an 8 point Arial font and a white background color.

**Set the Frame Delay**

In See It! mode, there is a predetermined delay time between each action. This delay controls the amount of time that elapses between the appearance of the frame and the start of the action. The delay gives the user time to read the text in the bubble before the action starts. By default, the delay for all frames is 5 seconds. However, you can change the default frame delay time. You can either use a selection from the Frame Delay list or enter another delay time manually. If you choose the 0 or skip option, a "0" frame delay will be applied to all action frames and "Skip" will be applied to non-action frames. As a result, the playback for action frames will start immediately when the frame appears and for non-action frames, the playback will skip the frame and move immediately to the next frame. If you choose the Infinite option, the playback will wait for the user to press ENTER before advancing to the next step. The bubble will automatically display the text "Press ENTER to continue." when this option is selected.

---

**Warning!** Be careful when setting the default Frame Delay to 0 or skip. This setting causes the playback in See It! mode to skip the Introduction, End and Explanation frames for all newly recorded content.

**Set Know It? Defaults**

Know It? mode is the assessment mode for the playback. If you intend to make this mode available to your users, you can select the defaults for the mode in the Know It? Options section on the General page, under Content Defaults, in the Options dialog box.

Know It? defaults affect new content in a different way than other content defaults. Content defaults, as found on the Bubble, Introduction/End Frame and String Input pages, only affect a topic at the time of recording. You can create your entire outline and set those content defaults just before you start the recording process. The recorded topics will reflect the new content selections. Know It? defaults, however, affect a topic when you add it to the outline. Newly created topics, even those without content, inherit the defaults in the Know It? Options section. Therefore, it is best to set your Know It? defaults BEFORE you add topics to your outline.

---

**Note:** You can change the Know It? defaults for existing topics by selecting the desired topics and opening the Properties toolpane. To open the Properties dialog box from the Library or Outline Editor, select the View menu and the Properties command or click the Properties icon on the toolbar. You can also right-click your selection and select the Properties command from the shortcut menu. To disable Know It? mode entirely for the selected topics, deselect the Know It option in the Play Modes property list.

**Set the Default Passing Score**

After users complete the task in Know It? mode, they are presented with their score, the passing score for the topic, and an indication of whether they passed or failed the topic. A separate passing score for an individual topic can be set in the Properties toolpane.

**Set the Remediation Levels**

When a user fails to complete a step in Know It? mode, they are marked incorrect for that particular step and presented with up to four levels of remediation. The first three levels of remediation prompt the user to complete the step with increased support at each level.
You can reduce the default number of remedial steps by eliminating levels. You can eliminate any of the first three levels; the fourth level completes the action for the user and cannot be removed. You can apply separate remediation settings for individual topics in the Properties toolpane.
19. Appendix B: Development Considerations

This appendix describes various considerations for developing content.

Assign Development Tasks and Flow

You can assign the development tasks as best suits your available resources. Listed below are the major tasks and a suggested division of responsibility for each task.

<table>
<thead>
<tr>
<th>Task</th>
<th>Resource</th>
</tr>
</thead>
<tbody>
<tr>
<td>Develop standards</td>
<td>Project leaders. Includes content, formatting, and naming conventions.</td>
</tr>
<tr>
<td>Create content</td>
<td>Content authors. Includes recording topics, adding Introduction and End frame text, creating and linking attachments, adding Glossary terms, Jump-in points, and adding bubble text (including Know It? mode text) as necessary.</td>
</tr>
<tr>
<td>Edit content (initial)</td>
<td>Content authors or Editors. Includes playing topics in all playback modes in the Developer to check for correct screens, correct text, correct web pages, and so on. May also need to publish and test Jump-in points in the Player window. This task could be done by a separate team of editors, or the content authors could check each other’s work.</td>
</tr>
<tr>
<td>Spelling/grammar check</td>
<td>Content authors. Includes checking spelling and grammar, or creating a printed reference document.</td>
</tr>
<tr>
<td>Create glossary terms</td>
<td>Editors, Project leaders, or Content authors. Includes creating glossary terms.</td>
</tr>
<tr>
<td>Create roles</td>
<td>Editors or Project leaders. Includes creating and attaching roles to the topics.</td>
</tr>
<tr>
<td>Attach keywords</td>
<td>Editors or Project leaders. Includes attaching keywords to the topics.</td>
</tr>
<tr>
<td>Testing (QA)</td>
<td>Project leaders. Includes playing the topics in all modes in the Player.</td>
</tr>
</tbody>
</table>

In addition to assigning development tasks, you should create a development flow through the various tasks. A good flow can make the process smooth from first development through final editing. A bad flow can extend the process far longer than necessary. A recommended flow is shown below:

1. Create scripts for the transactions (Development Team)
2. Record initial content (Content authors)
3. Test the recorded frames (Content authors)
4. Make corrections or re-record frames as necessary (Content authors)
5. Add text to recorded topics, i.e. Introduction/End frames, extra bubble text, Know It? mode text (Content authors)
6. Create and link attachments (Content authors)
7. Create and update Glossary terms (Editors or Project leaders, Content authors)
8. Test the recorded topics (Editors)
9. Verify text in Introduction/End frames, bubbles, attachments (Editors)
10. Make necessary corrections (Content authors or Editors as appropriate)
Appendix B: Development Considerations

11. Create and associate Roles (Editors or Project leaders, Content authors)
12. Assign keywords (Editors or Project leaders, Content authors)
13. Perform spell check and final glossary update (Content authors)
14. Test topics in the Player

Create Scripts

Before you begin to create content with the Developer, you should first create scripts that identify the tasks your audience will use in the target application. These scripts should contain a list of the steps in each task and valid test data from the target application to complete the task. It can also include supplemental information about the task, such as the following:

- Why and when the task is performed
- Required and optional input fields
- Appropriate results of the task, e.g. a printed report or a file
- Any hints, tips, and tricks for the user

When you are creating scripts, keep in mind the needs of your users. Try to anticipate the questions your audience will have and what information they will need to use the application and perform the task successfully. For example, if there is prerequisite information needed before a task can be accomplished, or if specific information should always be used, these instructions should be available to your audience.

Suggestions for Developing Content

The following are some suggestions that may help you develop and organize content more effectively and efficiently:

- Be consistent in naming modules, sections, and topics in the outline. If the naming convention is not consistent, it is much more difficult for the user to locate a topic.

- If you will be authoring content as a team in a multi-user installation of the Developer, or if you will be linking content from multiple outlines, it is a good idea to develop a draft outline before you start creating content. Also, you may want to designate a small number of people to make changes to the outline. This can help avoid confusion about who is working on what content.

  Note: If you are using the multi-user version of Developer, you can use the Owner property to assign documents to authors.

- Create an overview course with topics that cover the basics of using the target application. This could include logging in, using the interface, general navigation (menus and shortcuts), and using searches to find valid values for data entry. Introducing the user to these techniques allows you to shorten the task topics by assuming a basic level of knowledge for the user.

- Avoid using search features when recording most topics. This is most important for accurate steps in Do It! mode. The dialog boxes that open when a user searches for valid data offer many options. If a user chooses a different option than the one indicated by the Player in Do It! mode, the steps will not match and the Player will not be able to display the appropriate information.
Appendix B: Development Considerations

- If you want to include navigation in the topic, use the shortcuts instead of the menu path if possible. This shortens the number of steps, as some menu paths may be quite long.

- Create "stem" topics for those tasks that start with the same steps. Then, you can copy and rename the topic and insert the necessary frames to complete the task.

- Use only template text in the bubbles as much as possible. As changes are made to the system, the template text is updated more easily than custom text.

Create Content in Multiple Languages

At some organizations, content must be deployed in several languages. The Player is available in Chinese (Traditional and Simplified), Danish, Dutch, Italian, Norwegian, Portuguese, Swedish, Spanish (Mexican), French (Quebec), Russian, Hungarian, Finnish, Polish, Korean, and Turkish.

As you develop content, keep in mind that the default text in the bubbles is generated from templates. If you apply a template set in another language, the template text is "translated" into that language. The templates do not affect other text items, such as user-entered text in bubbles, Introduction and End frame text, web pages, and object names in bubbles. These items must be translated manually. In addition, the graphics that are captured will remain in the original language.

When you create content in a different language you should install the Developer and set the primary authoring language to match the language that you are creating content in. Add your content in the language that you want and make sure all documents that you create have the appropriate language template assigned. When you publish the content, make sure you use the correct publishing style that matches the content language.

Target application screens in each local language; Developer content in local language

In this situation, you need to localize not only the text in the content, but the screenshots as well.

To help you in recording the content, you record the content in one language, e.g. English, first. Then, create a duplicate of the content and assign the target language and template to the content. Open the application in the other language and use rerecord to guide you through capturing the screens and actions in the localized language.

You can manually translate the bubble text for your content in-house or use localization to package the content for translation. After an exported package is localized, you import the package back into your Library.

If you need to supply content for a language not supported by Developer, you can translate the supplied templates.

Target application screens in same language; Developer content in local language

In this situation, you only need to localize the text in the content. To do this, you should create a duplicate copy of the content and assign the target language and template to the content. You can manually translate the bubble text for your content or use localization to package the content for outside translation.

Note: See Localization for more information on localizing content.
Development Tips

Create the Outline

- Be consistent in verb tense when naming outline items.
- Create the outline even if it has not been finalized. You can always go back and rename and reorganize outline items.
- Avoid using special symbols such as &, $, *, and so on when naming modules, section, and topics since they may cause problems when publishing.

Before You Record

- Test the steps of the task to make sure you have all the steps and adequate test data.
- Test the data before you record it and make sure it works. This will help prevent errors in your topic.
- Make sure you set up the target application at the correct screen for the beginning of the topic. This may include logging out and logging in again to clear any “sticky” data.

As You Record

- Go slowly when you are recording to be sure that the Developer has had time to read the objects on the screen completely and the screens in the application have a chance to refresh.
- Make sure that the step you want to record is showing in the Next screenshot records area of the Recorder window before you press PRINTSCREEN.
- Make sure that the action displayed in the Last recorded event area of the Recorder window accurately reflects the action you wanted to record. If it does not, click the Undo button in the Recorder window and re-record the action.
- If you are not sure, record the action. It is easier to delete extra frames than insert ones that you missed.

After You Record

- Immediately preview the topic in Try It! mode before you add attachments, bubble text, Introduction/End frame text, and so on. If you discover errors and have to re-record the topic, you will not lose a lot of extra work.

Editing Content

- You can not move (drag and drop) a frame in the Frame Structure window in the Topic Editor so make sure you insert it in the right place. However, you can copy frames within a topic and from topic to topic.
- Be sure you know on which frame an Alternative Path starts and ends. However, if you choose the wrong end frame, you can change it.

Fonts and Colors

- Changing the defaults in the Developer has no effect on the text fonts or colors for the printed outputs if you use the default Word template. If you want to change them, you should customize the PrintTemplate.docm file in the Styles folder for the appropriate print output. See the Customize Print Output section for more details.
Multi-user Considerations

- When working in a multi-user installation, be sure to check in your checked out documents so that they are under version control and available to other authors. Before leaving on a vacation, check in all of your documents.

- If you have converted content from a previous version of the Developer, use Check In All to make sure that all of the converted content is available and saved under version control. If the converted content contains roles or custom icons, those related documents will be checked out to you, and therefore, not available to other authors. Check In All ensures that all of your checked out documents are checked in.

- If you need to work on a portion of an outline, only check out those documents that you need to edit.

Test the Content

Before content is deployed to the user community, it should undergo a QA review. It should be tested for the accuracy of the information, to make sure that the topics play correctly in each mode, and that items such as web pages, packages, jump-in points, and alternatives are in the right place and launch correctly. While much of this can be done using the Developer, it is a good idea to publish it to a Player environment and have a small group of users test it.

Playback Modes

Play the topic in each playback mode that your audience will be using. Ask the following questions for each playback mode.

See It! Mode

- Is this mode an appropriate mode for this topic?
- Does the user have enough time to read the bubble text before the Player advances to the next step, or does the delay time need to be adjusted?
- Is the action area in the correct location on the screen?
- Is the text in the bubble appropriate for the screenshot?
- Do all the paths of the available Decision frames work correctly?

Try It! Mode

- Is this mode an appropriate mode for this topic?
- Can the steps be completed correctly based on the information in the bubble?
- Do the Alternative paths and actions work correctly? Do the paths rejoin at the appropriate place?
- Do all paths of the Decision frames work correctly and/or rejoin at the correct location?
- Do the web pages, packages, and URLs launch correctly? Do the links appear in the correct location?
- Do the glossary terms work? Are they assigned correctly?
- Are the screenshots accurate?
Appendix B: Development Considerations

**Do It! Mode**

- Is this mode an appropriate mode for this topic?
- Are any necessary "set-up" instructions explained in the Concept pane or on the Introduction frame, e.g. "You must have the Purchase Order number before you start this topic?"
- Are the instructions for each step generic enough to allow for different situations in the target application?
- Should any step be displayed in the window with the step following it? (Using the Keep with next option, especially for menus and drop-down lists).
- Do the Alternative paths and actions work correctly? Do the paths rejoin at the appropriate place?
- Do all paths of any Decision frames work correctly and/or rejoin at the correct location?
- Do the web pages, packages, and URLs launch correctly? Do the links appear in the correct location?
- Do the glossary terms work? Are they assigned correctly?

**Know It? Mode**

- Is this mode an appropriate mode for this topic?
- Does the user have the appropriate objective statement before beginning the topic?
- For each step, are there hints and tips, if appropriate, to allow the user to complete the step successfully? For example, indicating what choice to make from a drop-down list or what to enter in a string input frame?
- Do the glossary terms work? Are they assigned correctly?
- Is the assigned score appropriate for the topic?
- Is the correct remediation level assigned to the topic?

**Player Window**

Publish the content for the Player environment that your audience will use. Ask the following questions about these features:

- Does the correct information display in the Concept and Introduction panes when the user clicks an outline item?
- Do the Jump-in points work correctly for each topic?
- Does each role display the correct content?
- If you published content by role, were the correct modules, sections and topics included in the published package?
- Does the Search feature (if available) display the correct content?
- Does the Applicable option display the correct list of topics?
Printed Documentation

Publish the content for the documentation format that you will use. Ask the following questions about the format and contents:

- Does the document contain all the information that you want your audience to have?


- Are there enough screenshots in the document, or should there be more or less?
20. Appendix C: Develop Content for Different Deployments

You have many choices for deploying your content to your audience. When you create content, you can easily publish the content for the Player, as separate topics, and for printed documentation.

When you create standards for authoring content, you should take into account the type of deployment method(s) you will use. Depending on the deployment method you choose, there could be an impact on how you organize the content in an outline, how and where you use web pages and packages to convey information to the user, and where other information, such as Introduction or custom bubble text, appears.

Develop Content for Deployment in the Player

If you will be deploying your content via the Player, you are essentially creating online training. Typically, content for online training is brief and to the point. Online users are generally more interested in learning by doing, i.e. performing the steps, rather than reading text on the screen. The following table lists the items where you can add information to the topic and indicates suggested uses for each.

<table>
<thead>
<tr>
<th>Item</th>
<th>Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concept pane</td>
<td>Provides helpful and/or critical information by links to web pages, package documents, and URLs at the module, section, or topic level for all modes.</td>
</tr>
<tr>
<td>Topic frame and bubble text</td>
<td>Frame and bubble text links provide helpful and/or critical information by linking to web pages, package documents, and URLs. Frame links appear for all modes and bubble text links appear for Try It! and Do It! modes.</td>
</tr>
<tr>
<td>attachments</td>
<td></td>
</tr>
<tr>
<td>Introduction frame</td>
<td>Introduces a task in all modes.</td>
</tr>
<tr>
<td>End frame</td>
<td>Identifies the completion of a task in all modes.</td>
</tr>
<tr>
<td>Explanation frame</td>
<td>Calls attention to an area of the screen or provides an explanation of an action.</td>
</tr>
<tr>
<td>Custom bubble text</td>
<td>Adds specific information in bubbles for all modes, only simulated modes, or only Do It! or Know It? mode.</td>
</tr>
<tr>
<td>Glossary terms</td>
<td>Provides definitions for specialized terms and links to package files or URLs.</td>
</tr>
<tr>
<td>Print It! mode</td>
<td>Allows the user to print the topic steps from the Player in a Job Aid or Business Process Document format for those topics for which the Print It play mode is enabled.</td>
</tr>
</tbody>
</table>

Outline

While users can use the Search feature in the Player interface to locate topics, it is recommended that the outline is in a logical flow. This could mean an outline for training, with the topics grouped in a hierarchy of modules and sections that build on previous modules and sections, or an outline for reference, with the topics grouped in modules or sections that contain all the topics that have to do with a specific subject. You could also build an outline in which each topic in a section is a different task in a particular business process.
Attachments: Web Pages and Packages

You should consider what information should be placed into attachments, and then where the attachment should be attached: a frame, a topic, a section, or a module. When you link an attachment to a frame, an icon appears in the bubble during playback. When you link an attachment to a module, section, or topic in the Outline Editor window, it appears in the Concept pane in the Player window. You may also want users to launch attachments through glossary hyperlinks.

**Note:** Frame link attachments are not available in See It! or Know It? modes. Attachment links to bubble text appear in text marked to display in Know It? mode.

When you link an attachment to a frame, you choose from icons that will appear in the bubble in Try It! mode or at the top of the checklist in Do It! mode. It is highly recommended that you use these icons consistently to indicate the different types of information the attachment can contain.

**Note:** If you do not enter a tooltip when you link an attachment, the default tooltip "Link" appears when the user points to the attachment. No tooltip appears if you delete the "Link" text.

What Appears in Which Playback Mode

There are several choices you can make about how you transfer information from a script into the Developer. You can place any of this information in various places, including attachments, Explanation frames, bubble text, and Introduction and End frames, but it is important to consider in which mode the information will be available to the user. The following table lists what features are available in each playback mode.

<table>
<thead>
<tr>
<th>Feature</th>
<th>See It!</th>
<th>Try It!</th>
<th>Do It!</th>
<th>Know It?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction/End text</td>
<td>X</td>
<td>X</td>
<td></td>
<td>if text is marked for Know It?</td>
</tr>
<tr>
<td>Attachment icons</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bubble text links to attachments</td>
<td>X</td>
<td>X</td>
<td></td>
<td>if text is marked for Know It?</td>
</tr>
<tr>
<td>Glossary terms</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jump-in points</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Explanation frames</td>
<td>X</td>
<td>X</td>
<td></td>
<td>if text is marked for Know It?</td>
</tr>
<tr>
<td>Alternative Actions</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Alternative Paths</td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Decision frames</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

Fonts and Colors

Since content in the Player can be delivered through a browser window, users could have widely varying screen resolution and color depth settings. Therefore, it is important to consider the fonts and colors that you use in the content. Not all fonts are easily readable on the screen, and not all colors appear correctly. In general, sans-serif fonts such as Arial are recommended for anything appearing on the screen, since they appear more clearly. Also, avoid special fonts that every user may not have installed on their computer.
Different colors may appear differently on a user's computer, depending on the color depth that is set on the machine. For example, if a user has a lower color depth setting on his or her machine, a particular color may appear so dark that it prevents them from reading the text or viewing a graphic. For more information, go to a Web site such as www.visibone.com for web safe color options.

Develop Content for Deployment as Printed Documentation

You can publish content for printed output in four different document types: Business Process, Training Guide, Job Aid, and Testing. In addition, you can publish an Instructor Manual, which is a training guide that also includes instructor notes, or publish topics that can be exported via a Microsoft Excel spreadsheet to HP's Quality Center. Each of these documents has a different format and includes slightly different information from each topic.

The following table lists the items where you can add information to the topic and indicates suggested uses for each.

<table>
<thead>
<tr>
<th>Item</th>
<th>Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concept pane</td>
<td>Provides helpful and/or critical information or images at the topic level in the Business Process document, Training Guide and Instructor Manual formats.</td>
</tr>
<tr>
<td>Web pages</td>
<td>Provides helpful and/or critical information at the concept (module, section, topic) or frame level for the Business Process Document, Training Guide and Instructor Manual formats.</td>
</tr>
<tr>
<td>End frame</td>
<td>Identifies the completion of a task in all outputs.</td>
</tr>
<tr>
<td>Explanation frame</td>
<td>Appears in all printed document outputs.</td>
</tr>
<tr>
<td>Custom bubble text</td>
<td>Adds specific information in the procedure steps for all printed document outputs.</td>
</tr>
</tbody>
</table>

Outline

In the Training Guide and Instructor Manual formats, the publishing process creates a single Word document for the entire selection. Each document has a table of contents, which is the same as the outline in the Developer. The outline, therefore, should reflect an outline for training, with the topics grouped in modules and sections that build on previous modules and sections.

In the other printed output formats, the publishing process creates a separate document for each topic. There is no table of contents, so the hierarchy of the outline is not used in the documents other than the outline and/or topic name, which may appear in the header.
Appendix C: Develop Content for Different Deployments

Attachments
If you will be publishing the content for printed training materials or a Business Process Document, keep in mind that the printed output will include web pages, graphics in packages, URLs as static text plus hyperlink, and link icons. In addition, linked bubble text appears as plain text; it is not underlined and hyperlinked as it appears in the actual topic. In addition, attachments that appear in the Concept pane will appear as concept (discussion) text in the printed training guide output.

What Appears in the Printed Outputs
There are several choices you can make about how you transfer information from a script into the Developer. You can place any of this information in various places, including web pages, packages, URLs, Explanation frames, bubble text, and Introduction and End frames, but it is important to consider in which mode the information will be available to the end user. For example, you may not want to put critical information in the Introduction frame if you are using one of the printed output formats that do not include the Introduction frame.

The table below gives a brief summary of the features that appear in each of the modes:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Concept attachments</td>
<td>X - for topics</td>
<td>X - for all outline items</td>
<td>X - for all outline items</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Introduction frame</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>End frame</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Explanation frames</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Alternatives</td>
<td>included*1</td>
<td>included*1</td>
<td>included*1</td>
<td>excluded*1</td>
<td>included*1</td>
</tr>
<tr>
<td>Web pages</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>URLs</td>
<td>hyperlink</td>
<td>hyperlink</td>
<td>hyperlink</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graphic files in packages</td>
<td>included*1</td>
<td>included*1</td>
<td>included*1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Images in web pages</td>
<td>included*1</td>
<td>included*1</td>
<td>included*1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decision frames</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Bubble text from:</td>
<td>See It/Try It*1</td>
<td>See It/Try It*1</td>
<td>See It/Try It*1</td>
<td>Do It*1</td>
<td>Do It*1</td>
</tr>
<tr>
<td>Instructor notes</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Screenshots</td>
<td>Topic settings*1</td>
<td>Topic settings*1</td>
<td>Topic settings*1</td>
<td>None*1</td>
<td>Topic settings*1</td>
</tr>
</tbody>
</table>

Control Bubble Text for Print Output
The playback mode for which custom text is marked determines in what playback or print output the text will appear.
<table>
<thead>
<tr>
<th>Text marked for these Playback modes</th>
<th>Appears in these Print Outputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>See It!/Try It!</td>
<td>Business Process Document</td>
</tr>
<tr>
<td></td>
<td>Training Guide</td>
</tr>
<tr>
<td></td>
<td>Instructor Manual</td>
</tr>
<tr>
<td>Do It!</td>
<td>Job Aid</td>
</tr>
<tr>
<td></td>
<td>Test Document</td>
</tr>
<tr>
<td></td>
<td>Quality Center</td>
</tr>
</tbody>
</table>

However, you may want custom text to appear during playback, but not appear in your training manual. Conversely, you may want text to appear in the printed documentation, but not in the Player. By using the Visible in Player and Visible in Print buttons, you can control whether your custom text appears for Player output only, a Print output only, or in both.

**Warning!** Selecting or deselecting the Visible in Player or Visible in Print buttons affects the visibility of the selected text in all selected playback modes for Player or print output. If custom text is marked for both See It!/Try It! and Do It! modes, deselecting the Visible in Print button means that the text will not appear in any printed output.
21. Index

Action area • 6-38
Action Properties • 6-25
Action types • 6-25
Add meta entries to the input text • 6-44
Add new text to the input text list • 6-44
Clear the input text entry list • 6-45
Control For Example text in string inputs • 14-25
Copy an action area • 6-39
Create a new action area • 6-38
Delete input text • 6-43
Disable an action area • 6-40
Ignore context information • 6-38
Input text options • 6-43
Keyboard action options • 6-42
Move an action area • 6-40
Object name • 6-37
Object type • 6-26
Replace input text • 6-43
Resize an action area • 6-39
Set frame delay • 6-41
Set the default text entry • 6-45
String input defaults • 1-23
String input formatting options • 6-42
String input scoring in Know It mode • 6-45
Use Keep with Next • 6-40
Add custom text • 6-20
Add text to an Introduction or End frame • 6-19
Bubble Properties • 6-19
Add custom text • 6-20
Add text to an Introduction or End frame • 6-19
Bubble Properties window • 6-19
Change font format for template text • 17-7
Change the background color • 6-25
Change the pointer • 6-25
Change the template text font • 6-20
Control text for Player and print output • 6-23
Defaults • 1-21
Edit custom text • 6-21
Format custom bubble text • 6-22
Format custom text • 6-21
Hide the bubble • 6-23
Insert template text as custom text • 6-20
Use templates for a frame • 6-19
Change local cache location • 1-3, 1-4, 2-1
Check in/out • 2-7
Cancel check out • 2-11
Check in a document • 2-9
Check in all documents • 2-10
Check in and out documents • 2-7
Check out a document • 2-10
Open a checked in document • 2-12
Content Permissions • 2-22
Context IDs • 6-10
Convert content • 1-33
Copy and Paste • 3-18
Create and Manage Content Profiles • 1-3
Custom Library View • 3-26
Customization • 14-16
Decision frame • 6-16
Developer • 1-10
Configure toolbars • 1-5
Display and position toolpanes • 1-7
Display multiple toolpanes • 1-9
Get started • 1-1
Move a toolpane • 1-8
Resize a toolpane • 1-8
Review the Developer interface • 1-1
Split the work area • 1-6
Start the Developer • 1-2
Understand the Developer basics • 1-10
Use the Developer in a Multi-user environment • 2-1
Use the Properties toolpane • 12-1
Developer Defaults • 1-17
Document Editors • 1-13
Undo/Redo Actions • 1-17
Documents • 3-9
Close a document • 3-15
Create a new document • 3-9
Delete a document and related documents • 3-15
Document Properties • 1-16
Link an existing document • 4-7
Move a document in the Library • 3-17
Open a document from the Outline Editor • 4-2
Open a document in the Library • 3-14
Rename a document • 3-17
Save a document • 3-12
Sort documents • 3-23
View document properties • 12-1
Work with documents • 3-9
Find and Replace • See Find and replace text
Folders • 1-11
Copy a folder • 3-5
Create a new folder • 3-2
Delete a folder • 3-7
Manage folder conflicts • 2-14
Move a folder • 3-4
Rename a folder • 3-3
Reserved characters • 3-3
User folders and documents • 1-11
View folder content • 3-22
Work with folders • 3-2
Get • 2-6
Glossary • 1-15
Glossary terms • 10-1
Import • 15-4
Keywords • 12-8
Know It? mode • 13-3
Library • 3-1
Add and remove columns • 3-24
Change local cache location • 1-3, 1-4, 2-1
Configure view column sort order • 3-27
Configure view columns • 3-27
Configure view filter • 3-28
Content Permissions • 2-22
Copy a custom view • 3-32
Copy and Paste in the Library • 3-19
Copy and Paste Special in the Library • 3-20
Copy documents in the Library • 3-18
Delete a custom view • 3-33
Edit an existing view • 3-32
Library view • 2-21, 3-26
Lost documents • 1-18, 1-19, 1-20
Manage the Library • 3-1
Move a document in the Library • 3-17
Move a folder • 3-4
Open a document in the Library • 3-14
Open and close the library • 1-11
Rearrange columns • 3-23
Refresh the Library and Outline Editor • 2-14
Restore a deleted document • 2-17
Size columns • 3-25
Sort documents • 3-23
Switch the Library Login • 2-4
Understand the System folder • 1-12
Undo/Redo Actions • 1-17
Update Library (Service Packs) • 3-35
User folders and documents • 1-11
View deleted documents • 2-17
Work with folders • 3-2
Links • 4-7
Add a tooltip to a frame-level link • 6-49
Change a link target • 7-39
Change the tooltip of a frame link • 6-49
Create a custom icon • 7-46
Delete a document link • 4-8
Link • 7-32
Link a new module • 4-4
Link a new section • 4-5
Link a new topic • 4-6
Link an existing document • 4-7
Link Related Documents • 1-15
Link to an attachment • 6-48
Link to an attachment from a topic frame • 6-47
Manage linked attachments • 7-39
Localization • 16-1
Import content for localization • 16-6
Language property • 12-10
Localization using Microsoft Word • 16-11
Localization using XLIFF • 16-7
Localize content • 16-1
Summary of the localization process • 16-18
Lost documents • 1-18, 1-19, 1-20
Master role list • 3-34
Modules • 3-10
Create a new module • 3-10
Multi-user environment • 2-1
Online/Offline • 2-4
Delete documents while online or offline • 2-16
Get documents for offline use • 2-6
Manage folder conflicts • 2-14
Switch between online and offline operation • 2-6
Use the Developer in a Multi-user environment • 2-1
Work online or offline • 2-4
Outline Editor • 1-14
Add and remove columns • 3-24
Build a content outline • 4-1
Change the Outline Editor view • 4-3
Copy and paste a document from the Outline Editor • 4-12
Delete a document link • 4-8
Developer the outline • 4-3
Expand & Collapse • 4-1
Link a new module • 4-4
Link a new section • 4-5
Link a new topic • 4-6
Link an attachment as a concept in the Outline Editor • 7-32
Link an existing document • 4-7
Move a document in the Outline Editor • 4-10
Navigate the outline • 4-1
Open a document from the Outline Editor • 4-2
Outline Editor • 1-14
Print an Outline • 4-14
Refresh the Library and Outline Editor • 2-14
Packages • 1-14
Preview • 13-1
Profiles • 2-1
Add a Login Profile • 2-1
Change password • 2-4
Create and manage Login Profiles • 2-1
Delete a Login Profile • 2-3
Switch the Library Login • 2-4
Properties • 12-2
Add document Revision text • 12-19
Assign content state • 2-19
Assign document responsibility • 2-20
Change document properties • 12-2
Context Property • 12-5
Document fields • 12-17
Document Properties • 1-16
eywords property • 12-8
General Properties • 12-4
Glossary property • 12-7
Language property • 12-10
Manage workflow • 2-18
Name property • 12-11
Play Modes property • 12-15
Resolution property • 12-11
Roles property • 12-11
Show bubbles • 12-16
Template property • 12-12
Topic Properties • 12-13
Use the Properties toolpane • 12-1
View document properties • 12-1
Publishing • 14-1
Advanced publishing options • 14-13
Behavior in publishing • 7-16, 7-28
Change the Player logo • 14-16
Command line publishing • 14-49
Create publishing styles • 14-15
Customize publishing styles • 14-14
Document publishing formats • 14-6
Execute batch publishing • 14-50
In published document formats • 14-6
Player formats for publishing • 14-1
Publish content by state • 14-12
Publishing preview defaults • 1-29
Rename a publishing style • 14-15
URL behavior in publishing • 7-30
Use the Publishing Wizard • 14-11
Publishing formats • 14-14
Business Process Document format • 1-25
Document publishing formats • 14-6
HP Quality Center document format • 1-26
Instructor Manual document format • 1-26
Job Aid document format • 1-25
Player formats for publishing • 14-1
PowerPoint format • 14-9
Standalone topic files format • 14-5
Tables for the Business Process Document • 12-18
Test Document format • 1-26
Training Guide document format • 1-25
Recorder • 5-1
Related documents • 1-15
Reports • 4-14
Roles • 3-34
Sections • 3-10
Create a new section • 3-10
Share Custom View • 2-22
Sound • See Enhance Content with Sound
Best Practices • 8-1
Config • 8-3
Edit Sound • 8-8
Enable Sound • 8-3
Export Sound • 8-7
Import Sound • 8-7
Insert Sound • 8-6
Play Sound • 8-14
Record Sound • 8-2
Record Sound on a Topic • 8-4
Record Sound on Topic with Sound Editor • 8-5
Record Sound on Webpage with Sound Editor • 8-6
Sound Editor Toolpane • 8-8
Sound Recording Deskband • 8-4
Spell check • 4-20
Spell check content • 4-20
Spelling defaults • 1-31
String input • 1-23
Add meta entries to the input text • 6-44
Add new text to the input text list • 6-44
Change example text • 17-7
Clear the input text entry list • 6-45
Control For Example text in string inputs • 14-25
Delete input text • 6-43
Input text options • 6-43
Replace input text • 6-43
Set the default text entry • 6-45
String input defaults • 1-23
String input formatting options • 6-42
String input scoring in Know It mode • 6-45
Toolpanes • 1-7
Topic Editor • 6-1
Change the Print setting for a frame • 6-12
Control text for Player and print output • 6-23
Create a Jump-in point • 6-41
Delete a frame • 6-9
Insert • 6-16
Insert a missing frame or frames • 6-3
Insert a No-context frame • 6-6
Insert an alternative action • 6-13
Insert an alternative path • 6-13
Insert an Explanation frame • 6-5
Launch the Topic Editor • 6-1
Link an attachment as a concept in the Topic Editor • 6-46
Index

Link to an attachment from a topic frame • 6-47
Manipulate frames • 6-3
Navigate frames in the Topic Editor • 6-1
Preview frame text for playback • 6-23
Recapture a screenshot • 6-9
Recapture an action • 6-10
Recapture Context ID • 6-11
Record paths • 6-16
Remove paths • 6-18
Rename paths • 6-17
Reposition paths • 6-18
Re-Record a topic • 6-4
Save a topic • 6-2
Set the current action as the default action • 6-14

Topics • 3-11
Assign to topics • 11-7
Copy frames • 6-7
Create a new topic • 3-11
Link a new topic • 4-6
Preview a topic • 13-1
Record a paste topic • 5-4
Record topic content • 5-1
Record topic steps • 5-4
Re-Record a topic • 6-4
Save a topic • 6-2

Versioning • 2-12

Web pages • 1-14
Add and format text • 7-19
Behavior in publishing • 7-28
Copy and paste web page content • 7-26
Create new • 7-18
Delete • 7-27
Edit • 7-19
Edit a linked web page • 7-42
Edit an image in a web page • 7-26
Enhance content with web pages • 7-17
Insert a hyperlink • 7-21
Insert an image • 7-23
Remove a hyperlink • 7-23
Rename • 7-27
Web page defaults • 1-23
Web Page Editor overview • 1-14